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Eclipse, Hiulith, HHTEZM! MyEclipse, B2 HH T F! B E A .

BN, SRR B CRENED), T B SO, Sk T4 50 B s 4
WA REESAEZ AR, DSSEIN TR, AR, Ak, AA
TR 4R 5eE, RIS, DM ARTS .

AL PHE MyEclipse 6 JF & Java EE AN TR . & BAHPHE T H i 5
AT SSH (Spring. Struts. Hibernate). JSF. JPA [{JJT %, [AIHART SOA SZHLFHEAT
--Web Service [T RIEAT TR B T SE B, WA GBS R4 A 41 4
X T HA— I RER M B WS 7, B IS S #12% 3 41 H MyEclipse B 2%
Fo, Wl VE R EF DN 4 Bh 2k

AAS P — TN DL Java Bt DL R KR FE R MyEclipse & T B (1) N8R 305
s B R A A I T R A TG L 7 A B T R R T R 5 3 DU
Eclipse FFRIMFIATANH; B NA-2H ] ] MyEclipse & BRI 1 58 TLE T AL
T IDBC MINH; HE7N T WA 2H Wy 7645 BRI i 5545 2R LR fE DY F 3 9 3841 A 24
Hibernate [MPRIEFF ks 2 )\ FAES ST AL LAGHERLT) Web N H (ISP, Serviet) 1)
Tk HILENBE— BN Struts 1 1FF A % T L0244 Spring ¥ 10C, AOP Fll#4
Hibernate ()77 /& ; 2B+ 844 Spring 44 Struts. Hibernate {7 & fE; B+ %
WA 4R BT A HH Y IPA BV S LR T A Dhfig s 25+ =554 Java EE 5 ML HEH 1) Web
JEHEHE ISF [IF Rk RE s S5+DUFE 23 SOA % 41: FET Xfire 1) Web Service [ HLis
FERd RS BT HFIHE T BIB 3 MIFA; ST 8T W T WA AT UML #AE .

h TR REE AR S s TAE R RIS A Myclipse, & 7241 K 246 K/ 44
MyEclipse 6 T I[N, tHaiE AR50 I/ E ABORE e 4 iR T R b 78, i A
SERE T TS BRIt H R AR FIAH DGR, BRI 223 Re 8 S8 LS BR Prh N 2%, PN
7o

Huy M BT b Eclipse + 4 7 R EMAE MR 2, SRWREN . HA A4
MyEclipse 6 HEAT PRI H R E B>, ARFNLE THI A, B RO PRIR I I K )
A&, %4 1 5381 Hibernate 425, JPA Tk 55, 1EHICHA T Bl A 1L brig Il 25,
KR TR MyEclipse 2 S AR 52 27 A2 TR _F 15238 XRA0T, A 50 i b D D) 1 e 4 8 3
IR

MyEclipse 6.0 24 E WAL/ T i 4L T Eclipse I L T & T2 MyEclipse ) 241
BHRA . Eclipse CE 7M. http://www.eclipse.org ) fEIBMA & 15 R ZKJTJ5 %
Pty LA Javatil B & TR, SR1K 2 H0E T-Eclipse — X IT K& 14 5 T & T H. A1
UIMyEclipse, IBM WSAD, BEA Workshop, Jbuilder 2007 2525482 fiMbr= i, 3 51F
Eclipse H & i % 9% (T, X ECERAEARE S 2 A/, 91 WiMyEclipse 6.0 2 30 K1
M, dW2 JE R BT . Y Javadt k T HAURIIIY 7 13, A 53R %A —3KIDE

(Integrated Development Environment, ££ T & 3355 ) AT DL IF 38 36 304 F) Visual Studio
EYIIR

MyEclipse 6.0 & T FFUEFIFI AR B TF R SCHRE IR 2 BOHESE, J7 (8 55 1, DhRESR K,
PAFT T RIF RN %« HE kTR O R4k Eclipse 285 2 Ak Hidi {4 2 e 22 7 fH Pl
M2, UAR 2 AV B e AT 5L BRI T o e SCREIT R E T Spring, Hibernate,
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Struts, JSF, JPA, EJB, Web Service % Java EE HiRMINH, & SCHREEBUEIL UML, A
ok MyEclipse /& Java EE NHHATRHRIZERINH, HB0 WA TARNEER
MyEclipse B SCH . BUOMESE RACEA I, ARFBA ] fe b MyEclipse 54 Eclipse [1)/7
Dy, AXHE) A A T RN RS2 A .

Btz Ab, Ay LUAT ] — S5 40 2% (1 53 Ikt Javadt & T H o4& Sun® B i -5
%9k INetbeans 6, SZHrffif1Java EE 5 £, {H/2A 3 ¥¢Spring, Hibernate, ‘& [JSwing
ST AR L AT A4 T R TR BL & ISF R AL AR T H ATk U6 AL T 405G I AL B
(www.netbeans.org) : %% /N 5 [ Windows ~ () JF & T H Gel ({5 1-FF Kk T,
www.gexperts.com); ‘SR I Javalt kT H — — @ik, tigst: Intellid IDEA 7

(www.jetbrains.com/idea/); Y 4MEH —ZKWindows | 7 A& A I/NT R T H, HRid A
Y BRIRAS, 1EH)2F P L H .. JCreator (www.jcreator.com); 4t BEA Workshop,
W2 JFORIIMT, JE R BEBEAKIE T, 47 5 2 (ISP YwH as A, B MERRCAS SCHF Struts,
Spring, Hibernate, 521X A4 T Eclipse )1 & 1T H (R MALRE EEAS NN K 2 B 01
Al RN 2K (workshopstudio.bea.com ); WSAD (IBM WebSphere® Studio
Application Developer), IL{EM# 47 & Rational Application Developer for WebSphere
Software, [XJjRational (HEAGE RHIAEROSEIXMNUMLER T H) #ZIBMIIE T,
B A (www-306.ibm.com/software/awdtools/developer/application/); Oracle U 7E 5 1 i) Sk
T JBuilder[JifY, JEKHEH T vk IDeveloper, XA ISF ] AL T & ShBgAn
Oracle> ¥ (www.oracle.com/technology/global/cn/software/products/idev/) #B & 3k & )
Bl XA Ik T H, WAE—"MUEEPUE T Javatt ik T 2R EL LA & Java) 2 [ i (1)
PRk

FIE R A NI TR AGRAR 55110, RO LR R L TIRZ To R R N AR R FR A
TS AT HER) D by I o 15 29 I 1) 5 S A o

KA fi#RE: SSH, IXEWATIY Struts + Spring + Hibernate ¥4 H R 1 #R .

SCRS B
A H 14 =3 P
1.0 2007.12 % 2008.? XK F—hR
B ML

AIER T T a8 MyEclipse 6 #£17 Java EE JT A 1f) Java #1244 . WiIRA
—E Java i 5 54 EL#E Eclipse fEHEL:, XA AR D).
AT EAR RO R A BT B
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KREH B TR RN, WO, LSRG s A AT . AT
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B, BN ARG AN, VMRS BCEPE G — =320 T 7 2 T 32 de )
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FTEACRE AT E AR SCRE DL R SRAS ol 1 WU S

WURE T EEW, E RIS beansoft@126.com #i ) A FH H .

RKTE#

X, HEr AR E A, Y PRl TR 1. 1 {FSynnex Chinazy
H ARG A Javaitii. A\ 2001 A — H L T-davady [ 15 S RT k. FrdEdf Java
& http://www.blogjava.net/beansoft/ 4 3k#3 2007 4= 12 H (FEF ) A& Mg HHELE
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FH—E RIEIT KIS

AEE N B PEARK T g JavaFi E s e S ) DL R ik, A RsAT, MR LA
FEBkR) 1.7.2.1 ALL in ONEJWRAS ) 225 — AT 57 2], BT I S6 AN FH OG0 I S840 15 1 N 25

Wi EAEWindows ‘% 2éMyEclipse, ] LA B MR E JDK, Eclipse 3.3, &
UL E 2% MyEclipse ALL in ONE WA 24 BB o R INBE IS OL R, ARSI #RAES
7EWindows XP 44 H SChicEAE R 48 T iFT .

AN RS HE AN http://www.blogjava.net/beansoft/archive/2007/09/24/147651.html
MyEclipse 6 SEMF K MAMAT] 00 TH %F iE4T Helloworld,
http://www.blogjava.net/beansoft/archive/2007/09/26/148267.html MyEclipse 6 SZHFF A
YHEMSANT 1 23E4T Mysql, MySQL-Front %3, JDBCHelloWorld FF& .

11 REGEHK

I U 222 IDK I MySQL 255 e, U 32 256MB A7 1 sk il L T o J il ok,
WK B ZHIHEH MyEclipse 6, A UCHMELE % /> 512MB F A7, #ifE 1G BiH 2
W1E, Bk MyEclipse 35455 25 i H] 200 2 MB IR 5E N AE . 2238 )5 I i 10 25 ) 4
600 MB, UL SR 3/ 1G WA= 0] . #Hhyilfivh, i Java Tk i BRI 1 A7 A
R 1P

1.2 JDK B TE, ZHEMEE (k)

HRE: W s MyEclipse ALL In ONE JitA, FA'E B T JRE, AN 2l R 3R
L% IDK, WA AT T & (HAZR N IJRE ANt Java ZEHIEARAD, R AS 223% IDK K
LA S IDK ZEYEACHS, BRI H (KT % .

1.2.1 T#; JDK

JDK {44 Java(TM) SE Development Kit, Bl Java #x#fEfi (Standard Edition)
TR THA. X2 Java FFRFEATINIEA- & . i)l it i A H Java 15 5 90 'S R 2L
BATHVE AT S, T et LLgw i Java fUHE 4 2830 .

HE: AR JRE (Java Runtime Environment, Java iz 47 345), K2 JRE A
5 Java HiiEds A IDK KU .

N AZIDK AT LAY 1) B 7 M http://java.sun.com/javase/downloads/index.jsp , — &Kk
YN EH AR, HAr R e A ZEIDK 6. FTJF R TUG, 156 o5 o Ui i
Download #%4l. 41 FFiR:
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K 1.1 IDK R4t 9 i Download #%4l
S AE T BE B H (P30 W 48 22 A B TR IR P “ W e 7 F L AR 452, I IR B 3 0L 1T
TR IDK, WA FEMN:

1.2 i Accept #ZEIH:Z MY
s ESL Accept JEE T LA R IDK 236 Ch 1. M B T N NEW
SAFHIHER

Windows Platform — Java™ SE Development Kit 6 Update 3

EalH

Download the full version as a single file.

¥ Windows Offline Installation, Multi-language 65.64
I ! ALl jdk-6u3-windows-i586-p.exe
TERXARATAT ! MB
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373.39
™ |* Windows Online Installation, Multi-language _ |idk-6u3-windows-i586-p-iftw.exe KB
Linux Platform — Java™ SE Development Kit 6 Update 3
8]

[T . _ . o . 61.64
[ Linux RPM in self-extracting file jdk-6u3-linux-i586-rpm.bin VI
Ly . . . . . . 65.40
[ | *Linux self-extracting file jdk-6u3-linux-i586.hin e

Solaris SPARC Platform — Java™ SE Development Kit 6 Update 3

FANE
. . . . . . 69.99
[ * Solaris SPARC 32-bit self-extracting file jdk-6u3-solaris-sparc.sh VB
] ; ; . _ 116.45
[ = Solaris SPARC 32-bit packages —tar.Z jdk-6u3-solaris-sparc.tar.Z VB
] : . . . . . 10.69
[ = Solaris SPARC 64-bit self-extracting file jdk-6u3-solaris-sparcv9.sh VB
l ; . . . 13.58
[ Solaris SPARC 64-bit packages — tar.Z jdk-6u3-solaris-sparcv9.tar.Z B
Solaris x86 Platform — Java™ SE Development Kit 6 Update 3
8]
I . _ . o 64.47
[ Solaris x86 self-extracting file jdk-6u3-solaris-i586.sh VI
I : . . 110.51
[ Solaris x86 packages —tar.Z jdk-6u3-solaris-i586.tar.Z VB

Solaris x64 Platform — Java™ SE Development Kit 6 Update 3

FANE]

[ “ Solaris x64 self-extracting file jdk-6u3-solaris-amd64.sh 7.19 MB
. . 10.21

[ * Solaris x64 packages — tar.Z jdk-6u3-solaris-amd64.tar.Z Vi

Linux x64 Platform — Java™ SE Development Kit 6 Update 3

FijH
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56.16

[ Y Linux x64 RPM in self-extracting file jdk-6u3-linux-amd64-rpm.bin B

Ly L _ _ , 59.26

[ = Linux x64 self-extracting file jdk-6u3-linux-amd64.bin VI
Windows x64 Platform — Java™ SE Development Kit 6 Update 3

¥ [E]
. . 38.63
[ L Windows x64 executable jdk-6u3-windows-amd64.exe VB

Kl 1.3 IDK A F#p R

HHEIATES] IDK SCRFZ A ERIRAE RGMBE- G 12282, 45 Windows, Linux,
Solaris XL FRAERGEATFHIRCAS . TTEEAST- 6 XX 53 T B AR R 1) (F2 2252
CPU [f)), x86 it M5 H s fiff) 32 2 CPU, i1 Intel Fl AMD [¥]; x64 Njj& 64 17
CPU, —MJHLEMRSS s o Bl FATHESGE Windows x86 JRASHIHIATLL T, il 3
R — A HITHE T

Windows Platform — Java™ SE Development Kit 6 Update 3

TEIXAN T AN 2467 %148 Windows Offline Installation,
Multi-language [#)/& Windows 538 @4k weet, ZHRF2ME S IRA, kiR, —
e R N BOX AN AR B T BT . i R i AN R /N Windows Online
Installation, Multi-language, W& F5 BEAEL LEE 1), 220 Ik f w2 B A v BL, %5+
— B R L DR AN, DRI AN o e BB S R A S B R R, 5]
WX FL AT LN % jdk-6u3-windows-i586-p.exe.

Linux N RISCHERCASE, X4k executable (H$447) H self-extracting ¢ [ fi#/5)
PR B 2R A, NS ANBER T H chmod +x xxx.bin 45 SCAE I T AL R 5 1 20 . HAA
(4075 PR TR R I AN e T

1.2.2 %3 IDK

Mk NG A KIbn) IDK 223558 EXE SCf, B mia i Windows
Installer JF4f 2225 72, 4~ Fios:

1.4 i3 IDK ZHEREF
QX R R MG, N BT el AR I Windows Installer 5 Fiat, A% 7 FL i 1)
Windows Installer g % & & & 31 ( F  # H Hb
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http://www.microsoft.com/downloads/details.aspx?FamilylD=889482fc-5f56-4a38-b838-d
e776fd4138c&displaylang=zh-cn Windows Installer 3.1 Redistributable (v2)). # k)
LRGP gkl 4t ILVE TR P SO TR AE I s e 32 (A)>
FA T A AR e o XN o5 I B B RN TRAE, a1 R KT

Kl 1.5 [ SR ihE

FEIXAN BEFCFRATT T LG B BRI 2235 #6422 3] c:\Program Files\Java\jdk1.x.Xx_xx, #X1fj,
XA AR T EIATEN, SEES(A).. FZHADR B IDK (1225 B3k, s fa i A A
T C:\jdk1.6.0 IXAEMIAELE 2, WA T SCR AR I U IR e TIXFERI KA A
HEFFR): C:\Java 52 AIDK 1.6 Z Jt AXFEAHURE DR R B A2ty 258 o A I 2 Hh AN b B2 (1)
), L Java FEFISAT RN, a7 LS & PATH Fil CLASSPATH I HBL—£6 1]
B BAEVR AL N B (R A2 11 C:\jdK1.6.0, SRJGHEH T — B 4 4545 7 Z0mit vl LA
SERLHET

1.2.3 BEEFERE (k)

X, WAL, dn RFT 54 ] MyEclipse KT TR, A& T T4 3AR,
A DA SE 4 21X — 5 1 P 2%

BN EEEE RS E R JAVA_HOME . 7EZRBIEAN b oS sE, k8 BM, 74
B R T AE TR PE R B AR %, ARG IR AR B, 75 LIRS B G HE (1) R
BE(S)FH Sl gicdl, MU RGN AR TEE, AL R4 A JAVA_HOME,
{H4 JDK %3 Hk, filln: C\IDK1.6.0(fu Tomcat 2 IX AN B ik Ak IDK). 4
NE TR
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PR SRJURAAR 5 B g A4S 5 CLASSPATH, BUE N . (FEE: RIECEM
FIFRF L, RoRMErH 3, XA R Java BN RIS, B kT EE
IDK [N R P AR N R G Path AR & rh, fiiiR a4k 815K H 400 Path 48 4,
s g () A, BT B e PATH MIAR B (. — ok i Al L 75 BTk
%JAVA_HOME%\bin; GERANZEH T C2ME):), ARG Sk d ol N Epr
AN

Kl 1.7 5k Path KRG

HE: AP AZREMRGAT R X A2 A& K0t Windows H4HETER AT M, 1M
FRGA 5 2T AT (1 FH P #8450

X LAR B RCE AR, T DA A AT BT AR R R E . sy Windows [RFF
R, ERBATR). .. N O 51 4, XHg S B TR H . WA Javac I
fie FIRI%E (Enter) B, WIRAEHEZIWR M5, WPAEEAL & DA N E 1)
C:\Documents and Settings\BeanSoft> javac
Mk javac <EID <RI
b, ATHER)E AL

-8 A BT A TR S

—g:none AN ATAT RS B

—-g: {lines, vars, source} A e /135 B

—nowarn AN BT Ar] 2 4L

—-verbose A DS PR IEAE AT IO ERAE 7 B

—deprecation AR S APT YR B

~classpath <47 i 58 B SO E R AL BT P A7

—cp <EFE> P e A P SR R AL EERE P A

K 1.8 IE I JE javac 4 % H
SIS SR R ke IR K

javac' At E AN A, WA AT IS T R B AR BE ST AF .
ERER S R, WU A E RS RN T, TR SR P R
X2 VRt al UGS AR g0 'S Java U8R JE T ar 247 10 5 Aok B FIE AT T .

1.2.4 JDK 6 H3C3CRYF bbb (ZIP,HTML,CHM) (AJ3%)

JDK [ 3¢ APL SCRYAT B T B AN 24 3] Java 15 LAY, (HJE WK FiE 2 75 3 ik
HAEIZEWT AR 1293 Javadoc. N7 CHM A& Ut AT LT, Biset ke Ebig 5 fd, ik mr LA
MR,

HHG7E http://developers.sun.com.cn . 1E & A kA Java SE 6 APl H1 3R

KRG A AT LA LT R hE T 25
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* HTML % B2y
( http://download.java.net/idk/jdk-api-localizations/jdk-api-zh-cn/publish/1.6.0/html/zh _CN/

api/index.html )

* zip % Ry
( http://download.java.net/idk/jdk-api-localizations/jdk-api-zh-cn/publish/1.6.0/html_zh CN
2Zip )

* CHM 1 i

( http://download.java.net/jdk/jdk-api-localizations/jdk-api-zh-cn/publish/1.6.0/chm/JDK_A
Pl_1 6 zh CN.CHM )
B wiEHE (Sun FrE XD
http://gceclub.sun.com.cn/NASApp/smeljive/thread.jsp?forum=35&thread=44422

1.3 Tomcat IR 23 T E, ZEEAIBIT(AIIE)

K MyEclipse 6 CL28 4 & T — i & ) Tomcat 6(MyEclipse Tomcat), FTLAAT Py 2%
AP IESRAE, AR BREURERE T AT A

Tomcat/e — T % 2 (ISPl 55 4, 7T LAFE http://tomcat.apache.org/ N #Jf %3¢
Tomcat 5 5# 6.

K 1.9 F4k Tomcat

AR EEA A (U442 apache-tomcat-6.0.14.zip), 1fiA+& Windows Service
Installer () EXE % % 3C fF . #F s 40 B W0 A H s, 30 F % ke i 42 4
c:\apache-tomcat-6.0.14, 1 IDK [#)22é—#F, b 15 H R4 R, W R4a i sie A 22
AT 2%, I Program Files. I IS4 T HORMR A4 280 K ZIP 1% 2 F 24 £ 1 I i
(1 WInRAR) T I AR 46 1% T c:\apache-tomcat-6.0.14\apache-tomcat-6.0.14 iX
FEM 2238 1842

£ Windows RiAN {7 2% & CATALINA_HOME XMz ] LLUZ1T Tomceat, Qi
PRECE T XA, AR H i B KiE L Ee a3 k'S T CATALINA_HOME ¥4
Tomcat, A5l U IREEZ A Tomeat RAH A7, FARERE CATALINA_HOME. fif{
H MyEclipse #:47FF & s, AT EZX AR WURIRARRE, gl d A sis, 44
CATALINA_HOME, HUEA Tomcat [#)4:%% H 345141 c:\apache-tomcat-6.0.14.

22 U =
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i Tomceat %3¢ H % M bin 1 H 3%, nJ LU 3| startup.bat 1 shutdown.bat. it
starup.bat i3 Tomcat k%525, K= A a0 B 1 45 S
{5 E\: The Apache Tomcat Native library which allows optimal performance in produ

ction environments was not found on the java.library.path: D:\Java\jdk1.7.0\bin;

4 CAWINXP\Sun\Java\bin; C:\WINXP\system32;C:\WINXP;%JAVA_HOME%\bin;C:\oracle\ora
92\bin; C:\WINXP\system32;C:\WINXP; C:\WINXP\System32\Wbem;%JAVA_HOME%\bin;E:\_Por
tableJava\jdk1.6.0\bin;C:\oracle\ora92\bin;C:\WINXP\system32;CAWINXP; CAWINXP\S
ystem32\Wbem;E:\ PortableJava\jdk1.6.0\bin;C:\oracle\ora92\bin;C:\WINXP\system32
;CAWINXP; CAWINXP\System32\Wbem;E:\ PortableJava\apache-ant-1.6.2\bin;E:\ Porta
bleApps\SSH

2007-12-4 15:22:08 org.apache.coyote.http1l.Httpl1Protocol init

{5 E\: Initializing Coyote HTTP/1.1 on http-8080

2007-12-4 15:22:08 org.apache.catalina.startup.Catalina load

{5 EL: Initialization processed in 2049 ms

2007-12-4 15:22:08 org.apache.catalina.core.StandardService start

{5 E\: Starting service Catalina

2007-12-4 15:22:08 org.apache.catalina.core.StandardEngine start

{5 E\: Starting Servlet Engine: Apache Tomcat/6.0.14

2007-12-4 15:22:13 org.apache.coyote.http1l.Httpl1Protocol start

{5 E\: Starting Coyote HTTP/1.1 on http-8080

2007-12-4 15:22:13 org.apache.jk.common.ChannelSocket init

{5 E\: JK: ajp13 listening on /0.0.0.0:8009

2007-12-4 15:22:13 org.apache.jk.server.JkMain start

{5 E\: Ik running ID=0 time=0/46 config=null

2007-12-4 15:22:13 org.apache.catalina.startup.Catalina start

{5 B\ Server startup in 4859 ms

K 1.10 Ji3) Tomcat Hi % 4%
5 S I /5 £ Server startup in 4859 ms {5 5, Tomceat st 8h5e 7. 2
ﬂ% HILEE R, ToVkAE). ZOCH Tomeat g5 s, ATLASCHIXAS CMD & H, AT A
1217 shutdown.bat.
PEAEAET NS 2% PN http://localhost:8080/ IR E I/ T . i K B fs:
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1.11 Tomcat Xt i i
HE: ARG ] A2 4 Tomeat [MERIA MG 1, 15 HISCA g 251 7T Tomcat
2 H sRconflserver.xml, 6340 K& X
<Connector port="8080" ... , & 8080 A /RAEL 1y R W] . fi i ik 80, MinT LA
AW St LA ) «
http://localhost/ 5 | & http:/localhost: # ¥ 1/ B(#  http://127.0.0.1: 8 % F1/
Localhostali# 127.0.0.1 2 MRFERI M Ee L, S ACRIRAH LI AL

1.4 JBoss MR TH, ZEMEZIT (F]ik)

HERE: WRIRARTIF R BEIB N, AT NG EZREAT.

WRAREA %% IDK, JBoss ¥ Ioiksia)a s, {Ha] LL{E MyEclipse B iE ¥ A 50

JBoss FE - #K IF YR f B 1 X FFEIB 3.0 FIJISP, JIMS %[ N R 45 88 .
http:/labs.jboss.com/ibossas/downloads £ —A> 4.2 8# 5.0 AL, X EHEEE
AR http://downloads.sourceforge.net/jboss/iboss-4.2.2.GA.zip H# F#. T ek
JEfF R —AZIPCAF, filtnjboss-4.2.2.GA.zip, AR BTS20 10 H Sk RIAT, 4l dn
c:\ jposs-4.2.2.GA. {EWindows AN EEAR L i 1) 7 22 i 5 IBOSS_HOMEAZ & .
%3 8) JBoss HE AN JBoss F [ M bin ¥ H 3 X i run.bat Bl B, % 41 c:\
jpboss-4.2.2.GA\bin\run.bat, J3 3544 =28 N g o H

JBoss Bootstrap Environment
JBOSS_HOME: C:\jboss-4.2.2.GA

JAVA: D:\Java\jdk1.7.0\bin\java

JAVA_OPTS: -Dprogram.name=run.bat -server -Xms128m -Xmx512m -Dsun.rmi.dgc.cli
ent.gclnterval=3600000 -Dsun.rmi.dgc.server.gcinterval=3600000

CLASSPATH: D:\Java\jdk1.7.0\lib\tools.jar;C:\jboss-4.2.2.GA\bin\run.jar
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09:13:48,015 INFO
09:13:48,015 INFO

[Server] Starting JBoss (MX MicroKernel)...
[Server] Release ID: JBoss [Trinity] 4.2.2.GA (build: SVNTag=

JBoss_4_2_2_GA date=200710221139)

09:13:48,015 INFO
09:13:48,015 INFO
09:13:48,031 INFO
09:13:48,031 INFO
09:13:48,031 INFO
09:13:48,031 INFO
ult/

09:13:48,031 INFO

09:13:48,031 INFO
p
09:13:48,031 INFO
09:13:48,984 INFO
09:13:48,984 INFO
Microsystems Inc.
09:13:48,984 INFO
09:13:49,703 INFO
09:13:52,359 INFO
/
09:13:52,359 INFO
ce:jboss-log4j.xmi
09:13:53,390 INFO
version) - JBoss Inc.
09:13:53,390 INFO
and JMX layer
09:13:53,937 INFO
09:13:54,031 INFO
09:13:54,031 INFO
eference
09:13:57,281 INFO
09:13:57,593 INFO
09:13:57,593 INFO
09:13:57,609 INFO
09:13:57,640 INFO
09:13:57,640 INFO
09:14:00,031 INFO
09:14:00,031 INFO
0837)
09:14:00,953 INFO
09:14:01,156 INFO

[Server] Home Dir: C:\jboss-4.2.2.GA

[Server] Home URL: file:/C:/jboss-4.2.2.GA/

[Server] Patch URL: null

[Server] Server Name: default

[Server] Server Home Dir: C:\jboss-4.2.2.GA\server\default
[Server] Server Home URL.: file:/C:/jboss-4.2.2.GA/server/defa

[Server] Server Log Dir: C:\jboss-4.2.2.GA\server\default\log
[Server] Server Temp Dir: C:\jboss-4.2.2.GA\server\default\tm

[Server] Root Deployment Filename: jboss-service.xml
[ServerInfo] Java version: 1.7.0-ea,Sun Microsystems Inc.
[Serverinfo] Java VM: Java HotSpot(TM) Server VM 11.0-b08,Sun

[Serverinfo] OS-System: Windows XP 5.1,x86
[Server] Core system initialized
[WebService] Using RMI server codebase: http://127.0.0.1:8083

[Log4jService$URLWatchTimerTask] Configuring from URL: resour
[TransactionManagerService] JBossTS Transaction Service (JTA
[TransactionManagerService] Setting up property manager MBean

[TransactionManagerService] Starting recovery manager
[TransactionManagerService] Recovery manager started
[TransactionManagerService] Binding TransactionManager JNDI R

[EJB3Deployer] Starting java:comp multiplexer

[STDOUT] no object for null

[STDOUT] no object for null

[STDOUT] no object for null

[STDOUT] no object for {urn:jboss:bean-deployer}supplyType
[STDOUT] no object for {urn:jboss:bean-deployer}dependsType
[NativeServerConfig] JBoss Web Services - Native
[NativeServerConfig] jbossws-native-2.0.1.SP2 (build=20071021

[Embedded] Catalina naming disabled
[AprLifecycleListener] The Apache Tomcat Native library which

allows optimal performance in production environments was not found on the java
Jibrary.path: D:\Java\jdk1.7.0\bin;.;C:\WINXP\Sun\Java\bin;C:\WINXP\system32;C:
\WINXP;%JAVA_HOME%\bin;C:\oracle\ora92\bin; C:\WINXP\system32; C:\WINXP;C:\WINXP\S
ystem32\Whem;%JAVA _HOME%\bin;E:\_PortableJava\jdk1.6.0\bin;C:\oracle\ora92\bin;C
AWINXP\system32;C:\WINXP; CA\WINXP\System32\Wbem;E:\ PortableJava\jdk1.6.0\bin;C
N\oracle\ora92\bin;C:\WINXP\system32;C:\WINXP; C:\WINXP\System32\Wbem;E:\ _Portabl
eJava\apache-ant-1.6.2\bin;E:\_Portable Apps\SSH

09:14:01,234 INFO
.1-8080
09:14:01,234 INFO
09

09:14:01,250 INFO
09:14:01,250 INFO
09:14:01,250 INFO
09:14:01,312 INFO
09:14:01,453 INFO

[Http1l1Protocol] Initializing Coyote HTTP/1.1 on http-127.0.0
[AjpProtocol] Initializing Coyote AJP/1.3 on ajp-127.0.0.1-80

[Catalina] Initialization processed in 285 ms

[StandardService] Starting service jboss.web

[StandardEngine] Starting Servlet Engine: JBossWeb/2.0.1.GA
[Catalina] Server startup in 70 ms

[TomcatDeployer] deploy, ctxPath=/, warUrl=.../deploy/jboss-w

eb.deployer/ROOT.war/

09:14:02,296 INFO

[TomcatDeployer] deploy, ctxPath=/invoker, warUrl=.../deploy/

http-invoker.sar/invoker.war/

09:14:02,421 INFO

[TomcatDeployer] deploy, ctxPath=/jbossws, warUrl=.../deploy/

jbossws.sar/jbossws-context.war/

09:14:02,546 INFO

[TomcatDeployer] deploy, ctxPath=/jbossmqg-httpil, warUrl=.../

KA
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deploy/jms/jbossmg-httpil.sar/jbossmg-httpil.war/

09:14:03,359 INFO

[TomcatDeployer] deploy, ctxPath=/web-console, warUrl=.../dep

loy/management/console-mgr.sar/web-console.war/

09:14:03,781 INFO
09:14:03,953 INFO

[MailService] Mail Service bound to java:/Mail
[RARDeployment] Required license terms exist, view META-INF/r

a.xml in .../deploy/jboss-ha-local-jdbc.rar

09:14:04,000 INFO

[RARDeployment] Required license terms exist, view META-INF/r

a.xml in .../deploy/jboss-ha-xa-jdbc.rar

09:14:04,062 INFO

[RARDeployment] Required license terms exist, view META-INF/r

a.xml in .../deploy/jboss-local-jdbc.rar

09:14:04,109 INFO

[RARDeployment] Required license terms exist, view META-INF/r

a.xml in .../deploy/jboss-xa-jdbc.rar

09:14:04,203 INFO

[RARDeployment] Required license terms exist, view META-INF/r

a.xml in .../deploy/jms/jms-ra.rar

09:14:04,328 INFO

[RARDeployment] Required license terms exist, view META-INF/r

a.xml in .../deploy/mail-ra.rar

09:14:04,390 INFO

[RARDeployment] Required license terms exist, view META-INF/r

a.xml in .../deploy/quartz-ra.rar

09:14:04,390 INFO
09:14:04,484 INFO
r of thread: main

09:14:04,515 INFO
09:14:04,515 INFO
09:14:04,515 INFO

[QuartzResourceAdapter] start quartz!!!
[SimpleThreadPool] Job execution threads will use class loade

[QuartzScheduler] Quartz Scheduler v.1.5.2 created.
[RAMJobStore] RAMJobStore initialized.
[StdSchedulerFactory] Quartz scheduler 'DefaultQuartzSchedule

r' initialized from default resource file in Quartz package: 'quartz.properties’

09:14:04,515 INFO
09:14:04,515 INFO
TERED started.

09:14:05,968 INFO

[StdSchedulerFactory] Quartz scheduler version: 1.5.2

[QuartzScheduler] Scheduler DefaultQuartzScheduler_$_NON_CLUS

[ConnectionFactoryBindingService] Bound ConnectionManager 'jb

oss.jca:service=DataSourceBinding,name=DefaultDS' to JNDI name ‘java:DefaultDS'

09:14:06,609 INFO
09:14:06,625 INFO
09:14:06,625 INFO
09:14:06,625 INFO
09:14:06,625 INFO
09:14:06,656 INFO
09:14:06,656 INFO
09:14:06,656 INFO

09:14:06,656 INFO
09:14:06,703 INFO
0.0.1:8093

09:14:06,750 INFO
09:14:06,843 INFO

09:14:06,875 INFO

loy/jmx-console.war/

09:14:07,203 INFO
080

09:14:07,375 INFO
09:14:07,390 INFO

[A] Bound to JNDI name: queue/A

[B] Bound to JNDI name: queue/B

[C] Bound to JNDI name: queue/C

[D] Bound to JNDI name: queue/D

[ex] Bound to JNDI name: queue/ex

[testTopic] Bound to JNDI name: topic/testTopic

[securedTopic] Bound to JNDI name: topic/securedTopic
[testDurableTopic] Bound to JNDI name: topic/testDurableTopic

[testQueue] Bound to JNDI name: queue/testQueue
[UILServerlLService] JBossMQ UIL service available at : /127.

[DLQ] Bound to JNDI name: queue/DLQ
[ConnectionFactoryBindingService] Bound ConnectionManager 'jb
oss.jca:service=ConnectionFactoryBinding,name=JmsXA' to JNDI hame 'java:JmsXA'

[TomcatDeployer] deploy, ctxPath=/jmx-console, warUrl=.../dep
[Http11Protocol] Starting Coyote HTTP/1.1 on http-127.0.0.1-8

[AjpProtocol] Starting Coyote AJP/1.3 on ajp-127.0.0.1-8009
[Server] JBoss (MX MicroKernel) [4.2.2.GA (build: SYNTag=JBos

s 4 2 2 GAdate=200710221139)] Started in 19s:344ms

1.12 J33) IJBoss k554

MFEF| Started in 33s:188ms MG BJE, MRGSMEsIEE T, ENHE H A E

BIRBCT

B e W e BT N http://localhost:8080/ kMR & s TS . Wi T KB iR
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K 1.13 JBoss 4.2 [f¥ i ifi
HE: JBoss AW E T ISP ks Lhfie, 1 H e bWy i) 2 8080, JitLA
Tomcat 1 JBoss JEANRER N E— & MR 201 BRIATEOL T IBoss HEWT localhost 11/
K, L SR R LR U 1) JBoss M4y, WEEMT AT T NS ECRIEAT
run.bat —b 0.0.0.0

1.5 MySQL 5 B FER S8 T&, ZHFEMIEIT (i)

[X 2 MyEclipse 6 77 T —#kiik Az Java %4k &= Derby(MyEclipse Derby), /&% JF & 1l H,
DAL AR T Py A T R 1

MySQL 2 FH 1 LA vz 1A s 200 1) s 2 i 2 R 25 4

151 MySQL 5 & RAN FimaEs:, &

A LA YE ) MySQL B O Mouh R 2R R 42 $E FE P R JDBC K B, W U7 I -
http://dev.mysgl.com/downloads/mysgl/5.0.html#win32 , 1 FFis:

Windows Essentials (x86) 5.0.45 22.9M Pick a mirror
MD5: 9efd5d841174b1476a317e94becf8786

Windows ZIP/Setup.EXE (x86) 5.0.45 42.4M Pick a mirror
MD5: 1566£1960b22cda4903e03d4f6cfa205 | Signature

Without installer (unzip in C:\) 5.0.45 50.0M Pick a mirror

MD5: c40bab7fe2ecb96519ca88897b6e7d8b | Signature
X ZANRAS IR PR — AN 5 AN, siili Pick a mirror JG R AR 2%, 235 X i Next
B Yes el de. R IRGg Al A3l Rg), TARIRT LH3).
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MySQLIJDBC 3Kz #thhtA7 T http://dev.mysqgl.com/downloads/connector/j/5.1.html:

Source and Binaries (tar.gz) 515 7.8M Pick a mirror
MD5: 85289174093a2b165d42f5ac38850d18 | Signature
Source and Binaries (zip) 515 8.0M Pick a mirror

MD5: b207959597d8974545ef99d5a2ceeb62 | Signature
A3k — T N, IR 575 3) mysqgl-connector-xxx.jar HiE s FERE K T .

1.5.2 MySQL 5 SR T 8 ZHe FIBAT

BeanSoft MySQL Java JF &K E34% MySQL 5.0 JIk454%, & ¥ T H JDBC &A1 Java i
) 5040 2 1 s A R

1521 T#

http://gro.clinux.org/frs/download.php/2106/portable_mysgl.exe 4.02MB ( H fi# 1+ fL)
L NG R4 2R AT AT B, AR X PStart.exe JF4R, 5630 MySQL i
&, RJERIATgiiz T IJDBC M A,

HEE: XA RAN MySQL LR SRERCR IR GBK, WHERARIE S T 0 74545,
MySQL-Front 4 {7 A ELAD .
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1.5.2.2 FHEE®

K 1.14 MySQL Zi(f il 3= A i
F 50, i mysql_start 53 MySQL Jik4s4%, it mysqgl_stop 51 MySQL /%%
%o TEAIHIVEXGE ML mysql 240Kk KT filt.
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K] 1.15 Xt 5 MySQL-Front Ja3h &P T H

E:\MyEclipse6_Video\software\jdbc>java -cp .;mysql-connector-java-3.1.11-bin.jar
JDBCHelloworld

5

jpa test Yt

jpa password

6
bt HH

A A
e RS

9
user
password

1
JDBC 3zl
SRR

E:\MyEclipse6_Video\software\jdbc>pause
TG AT YRS, | .

1.16 Xiti 3 St 132 AT IDBC BEA T4l A FHE HUE R I
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1.6 Eclipse 3.3 I T &, =FHEMIEIT

Eclipse J&—aEAln, JrEAestdavalt ik TR, Hurtkimiir. Eclipse 3.3 A LA
7t http://www.eclipse.org/ F#, #EAH GG Download %4, Wik EHR:

K 1.17 Eclipse 1 Ui
s ik J AT BATE BT B0 e 4

K 1.18 ~# Eclipse
Eclipse 3.3 73 th T JUMN R M, AN M Javadt K, AT e s LT,
miili Eclipse IDE for Java Developers #irlBL N8 T . 2B A2t B Java EETF &
SCREIN), BAREIB, ISP, JSFINFF A ;s % =AN R CICHH T R AL HEPUAN &% [ TdE T FIRCP
(Rich Client Platform, & % /i V-4, IBMEH#EIET Eclipselt) SN T R4, #t
A PR R G2 R B A Eclipse AN AL D TFA I 8B HAEAE S M EClipse FEtL,
HiEclipse V-4, Javaltk T HARHEIT K .
R E N E4E1 eclipse-java-europa-fall2-win32.zip, filt B 45 5] ¢:\fG 2> A 5013
#] c\eclipse XA H 3%, XFEHUHEZRTEET .
3817, #EANHE c\eclipse, Xili eclipse.exe, minlLLEZ)F1i21T Eclipse 7. )i
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B FE P b s R LE£E workspace, il OK fHlwl iT LL4RZL R 3l ik B BT

1.19 JA sl % $E workspace
FE: WAARARE LG HRXANMER, EH ZIEHE Use this as the default and do not
ask again ],
S A s SN BRSO T (Welcome), e F 1 &5 B bR 5 P ¥ 1T
i, 2 5] DUi— e mtif) Java N T A& . X S~ s

1.20 Eclipse %t

2t Eclipse BiH 2358 T .

HE: WA B Eclipse 1 30 5008 2 1X /2 K4 MyEclipse %A H1 3
EEEA LU, WK R T Eclipse HOGE S, BARAHIEAS RIS A 5E s
TR R . Y341 Eclipse - SCiE 540t IBM 48Bh, 1822 ARiE th T A5 7 5 J5t DR B 36 (1)
JEHIREL, Ji4b Java AR ZHUER — TR LU AR 2 ik I & TR (il Jbuilder,
IDEA) #f5/2 HUE USSRy, BRI A SR R R T PR FFAT SO 1 — 30, A B 11k
HHG KBNS T 1027 2] Java AV LS IF R T H. fEEIEARERIEE AR 8 — e & H
TSR ) Eclipse HEATIT % o

5 SERR FF R AN o] T o5 il B LU BRI ) ), 3 300 TR 4 4222 (1) Eclipse TGIKIZAT
M —Fh S T b O e T IEMRCA 1) IDK HE ENAE 3 S IHRET 1 ). a8 3
XPHESL, 1B NOZAL A R Eclipse WA LT, WA EA LHIN . i
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BTN ARG R, SRR T IEFIRCARR) IDK Ak, B g T — L)
PURIRASY) IDK, ll142%% Oracle BU# HELLHF 5, 23 H Caedd—28 JDKL.3 5 Hifikhi
A M1 IDK. Eclipse J& 855G Eclipse T {E H & jre H X 34K java.exe, 2RJE M
WA 5 PATH thdk, ARG F MR 4k U AR e AR b 3R . TS A A
S a7 LU IR 7 2ok v 55 —Fh, % IDK 22355 H 56 R 16 jre 7 H sk 5¢ 3 2 | 2] Eclipse
ZHEHE, Flan: M C:\jdk1.6.0\re &3 c:\eclipse\jre, & ill5¢ il 5 NV iZREE 2 java
R 2R FEF c\eclipse\jre\bin\java.exe, 2 J& 5 Eclipse, #tlf 1. &A% —Frs, 2
7t eclipse Hx FAIE#E—N B gRAAEE SO run.bat, HAEA:

eclipse.exe —vm C:\jdk1.6.0\bin\javaw.exe

o IXAAFRE T Eclipse i3 i NAZAE FHIRAS IVM, k& FHIEAS javaw.exe. LUEIEAT
(1) IR B Tk 3% N LA BE ST A I B EP AT

1.7 MyEclipse 6 I~ £, ZEMNEIT

MyEclipse 6 +&—#k i\ 5 T EclipseftiJava EESE S IT & T H., Hhyifiii A2 2™
Mo B 7k A2 http://www.myeclipseide.com/.
MyEclipse 112355 MG ERRART ALL in ONE fiiA, Hrft ALL in ONE AT A 255 4
N E JDK, Eclipse 3.3, BT RARSTH O f# 28 4F MyEclipse, 1HiL+¢
ALL in ONE HRA

1.7.1 T

FIIFE O ik SO A 23424 - , ZJhkFIMyEclipse 6 [ R
WU, 5 AR IR IA A REREAT T 3
MyEclipse challenges the misconception that good development tools have to be
expensive by delivering the most cost-effective and full featured Eclipse-based J2EE IDE
on the market today.
You can try MyEclipse free for a 30-day trial membership to test drive the full package and
see if it is right for you. Want to learn more? Reqister for a FREE MyEclipse Webinar!

1.21 $25 MyEclipse 6 [ F# iX
. i DOWNLOAD #4535k 21 5L 1F 1S 25 00 [ «

Downloads: Eclipse 3.3 Downloads

1. MyEclipse Enterprise Workbench 6.0.1 GA for Windows 98/2000/NT/XP/Vista (10/16/2007)

33 U =



MyEclipse 6 Java JT&H SCHFE

Description:

MyEclipse Enterprise Workbench 6.0.1 - Windows Edition is now available for
download. Make sure to review the release notes. Also make sure Eclipse 3.3.x and
JDK 1.5.0_08 or a later release are installed if downloading other than the All-in-one
installer. The All-in-One installer is bundled with Eclipse and JRE, and also supplies
users with MyEclipse SNAPs. You can download Eclipse Directly from the Genuitec
Mirror site or at Eclipse.org here.

MyEclipse is also available for download through Pulse - the new and easy way to
download and manage all of your Eclipse Installs.

Version: 6.0.1 GA | File size: 176.33 MB

MD5 : For All-in-One : 1eba3b2521e66870c07b9db3d62addc2 | For Windows Plugin:
504fcOaaale9b1252773f816e443f9d8

Added on: 16-Oct-2007

1.22 FEAFERA MyEclipse 6
W95 K 1RG5 5 22651 ALL in ONE A : 45 b 2 (k2 4@ (PLUG-IND
FRAS,  TEANUAS (1) 22 208 75 BEAR 4 HERT SCIRARUR 43 1) #0f2¢%% IDK B K Eclipse 3.3; 4’5
1 3 )& MyEclipse #rif th ST 206 i) A 8 TR e TH . XFsea ki, 4]
HEFF NEALL in ONE, BEA AT AR 400l S ST E M RA (o HigH—H
AL JEEPRI R T B, PO SCAOR, K24 200 MB, I DR 220554 o 1T ALL
in ONE WA AN S B K o

1.7.2 %3

1.7.2.1 ALL in ONE KA %3

ALL in ONE B #XUt SCAsin] LUS AT, JoRs 0 2 I (XA B 30 SO 44 v] g2
MyEclipse_6.0.1GA_E3.3.1_FullStackInstaller.exe). 15 —/NH AN TUH, M
Next #EH4k 2, X — T BoRIE VPRI ML, M Y

sl Next A4k gk 2ede, P REBRME 2B, BN w2 F C\Program
Files\MyEclipse 6.0, R il CL4 bl Java B 7EIX Fh k45 N al RE £ AN 0 B ) fE,
DRI LA AT 22 B8 IR s B — N AN A (1 e e ik AT, N R
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Kl 1.23 &2k MyEclipse 11435 H 3 AN 258 (1) 42
, A — % N Next 428 5545 H 21 55 56 e e By

1.7.2.2 #fF (PLUG-IN) PRAS[# 23

TR I 2B A BRI EIR—3, A B R Z UG ¥ o ML — eI A
Eclipse 3.3 Z23% H 3k X IHHE, a0 N roR:

K 1.24 %A Eclipse 3.3 [H%3E H 5%
fidi Choose.. ¥4l ik v 223547 1#) Eclipse 3.3 Fife H =140 c:\eclipse 4R & — % s i
Next fZEHRI ],
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FER: WURRIZ LR T HTR ) Eclipse AN 3.2 4545, e dkal, (H2 23
seE )5 MyEclipse 4 Joi% =W 3 s AL ] -

1.7.2.3 ffF ALL In ONE hgA$ifE MyEclipse &)k

MyEclipse ALL In ONE JitA BUAR 2247 (0, AH /& A7 Hogk i, il 2ehe i RN ) K IC
T, 1 H— BT 5 H SR RER sl A & o AR SRR AR e B B sh A b, s R s I
ERAR LA AR A b, sF RS RS RS L= A, X 2Rt (i T !

LHEEE A B — AT H sk, A FRATT AR A o — AN SO, i — A
A3 BAT SCHFJamh il LASEEL MyEclipse 6 (1% 2351847 T, Hefyid Ui aA1nT LURAER 5
i b3 2 CAsRiE NS B QAR TN E)

Epw e I IE RS

BATVIAE XA H 5 F Bt — 304 MyEclipse 6.0.bat , SCFRZF:
start eclipse\eclipse.exe -vm jre\bin\javaw.exe

Fe N ok A2 —A Eclipse ffifh BCE SCAEHE T LSRR B s dT T, AT e AL 3
ARG IT NI A 30 com.genuitec.eclipse.MyEclipse.link:

SCAF IR AR A AN s

path=d:\\Java\\MyEclipse6.0\\myeclipse

XA ZARE myeclipse XA H SR IALE I, FATHEE SUSAHRT B4R R
path=..\\myeclipse

OK, 5 L7, # MyEclipse 6.0 #4~H & HIBIIRIF SN AERL T8l 206 « LU 4R
ARG EMEE EAEB R T MRS Java TR E5, b3 5e
ff: MyEclipse 6.0.bat B 7281 i35 MyEclipse >k TAE! S iFI2IE4E AT H S 0F &= 1%
RN SR B F D), WATLARIRE RSN, o R BAT 2R Mie B 2 . A, FEIHEIE
paan iy i N U S e AP e
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1.7.3 &84T

A Windows RS FFERSE R G IE BT B R, R J51EF: MyEclipse 6.0 T
4] HLTH /) MyEclipse 6.0.1 Bl a[iz47, i N FR:

Kl 1.25 ik pdE )y izfT MyEclipse 6
JE B R S PR R E RE workspace,  pii OK s v LA4kSE 5 8l, wini &l 1.19 ft
Ne H—UHBNE A BoR— MG (Welcome) sk o TG E2 B R 5 P0G 7T
M, ZJastal LT IR R T o XIS R s

K] 1.26 MyEclipse 6 T 1F #ifi
i R ) 3K 8 E 3RS T MyEclipse ()3 MF RS, BT LLRE 3% . MyEclipse >
Subscription Information... K#i N, IXFEUREE T LA IR FISh REBR 1A H - MyEclipse
(T e

11 L3521 %% MyEclipse Il &5 Uninstall MyEclipse 6.0.1 J5 %348~ — 4 A7 Next
JEL BRI AT o

1.8 /N

WA A, NAZRE T TATETEAI Java, Hdn 2 LIRSS s BTN 2

37 U =



MyEclipse 6 Java JT&H SCHFE

B, WEMIEAT R FEXRORE W FAE T MyEclipse 6.0 All in ONE fliAs, K4 KA
W 22 M FE
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B RS Java MR

2.1 v A

AZE IR LT T R FEH MyEclipse FF & 55— Helloworld 1#] Java f£/3, il
FRTF T EHARSFE I & TR A& R

KN ESHEZRAN: http://www.blogjava.net/beansoft/archive/2007/09/24/147651.html
MyEclipse 6 LK TFRPEMSRAIT 0: T# %% &1T Helloworld.

2.2 FIH%E, %wiFHieiT Java EfF

BERAT AT P AR, T 550 B G H R A DK [ ML R NIRRT
B AFIDKIT RIS .

Xk b R BRI U A, H W C A, PRI RS L T R(T)... —~ U RIE T (O). ...,
LT B BE WoR CRISCIER I Y 44 -

2.1 & Windows BT ST R4
o IXFEAIR H )72 0 T BLJS REJT M X 43 oK Hello.txt, Hello.java, Hello.class x4t
ANER SRR, B T AT AR A AN 2 B ARSI 40 3R AT 285 (R R e I 4 AR AT 1

HelloWorld.java.txt.
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SRIGERE Windows [IFFAESE L, KL R A T2 P — M~ 0 AR 3 3l SUAR G 4
WHA, LR LU B 28I ORI AHFIn EditPlus, UltraEdit, Notepad2,
Notepad++%4%, {HEAZAEH] Word IXFEERARE RS, BaEHA .

public class HelloWorld {

public static void main(String[] args) {
System.out.printin("fx 4 {HF1");

}
}

P 5 pahi ] FEA I S SO — R AR, A8 IR 1 SO DR AE OGS U HE T O % AR
C:\HelloWorld.java, %A J& st b il HE (R A7 3 H /I vy

HE: FAEHUKLKNEEIAGS R, FRBANE R R A ZAE R bSO 5
ERAFRERMNREE, 502 B ICTE N IS Do

A TA T E g RSAT XN s IR, BT, A emd JG AU
FHL R S SRR 2% . BB R4

cd C:\
javac HelloWorld.java
java HellowWorld

IR M HUEFTEHR T, RS FTEIH

PRhf 5

2.3 f#f Eclipse/MyEclipse R4 5, 4miFHizfT Java F2/F

MIEHR:EFE File > New > Java Project, #%# 43171 New Java Project

GHr# Java

WHD S, WK 2.2 fios. 76 Project name (3L H &85 T A\ HelloWorld, 57 Finish
BB FHH G AR EHE, IXFE—A> Java Tl H St 2565 T s
S T ARE B R (R PR A 2E 0 N R TR

IR HiR

Contents T N2

Create new project in workspace | 7E_LAEX FP Al @B i H

Create project from existing | AIAARS P EIEEITH , 71 Directory Al SCAHE 4 A
source AT H ) H =%

JRE WP H 1) JIRE

Use default JRE(Currently | fffH 2N JRE, T LA it Configure default... 5EEk AL

‘MyEclipse6.0")

BBV IRE

Use an execution enviroment JRE

FEIEAT IR DI FE 1 JIRE

Layout

I H A J5

Use project folder as root for
sources and class files

I H H A AR AR MR H k. R XA
RAHESE, KA .java Fl.class SRy —ik

Create separate folders for

sources and class files

2 FF 09 H 5% K3 AR ARG RN S0, 1X Rl 5 X
et . LS Configure default.. A2k lid & 2RI
(30 H A Je o

40
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K 2.2 Brik Java HiH
FHAE R 2125 53— N D) 40 A0 T TR TG E -

2.3 D12 N (P AR P 16 TR AE
AT R S (R RRT, FRATT— LR No 3L nT UL T . B35 1L B8 5 File > New
>Class, SRJE B2 I TEAE R L T
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2.4 HTEEISIRNT TR AR
7t Name ¥ AHEH 4 A HelloWorld, sidisgk, M LAI7E Package HA 1 CAy 2 H
ML o B K g iE g JL T IR RS A8 U & R BT :

public class HelloWorld {
public static void main(String[] args) {
System.out.printin("fx 4 {HF1");
}

}
o YIRS YR S SR EE S, MyEclipse 23 H BB A 4 12 25 S
BRI LS B T, ESESH Run — Run & NEREERE Ctrl+F11,
WA LA 2 Eclipse 2 HahH Java it kées, SRJ51E Console LI H % “/Raf, tHH”,
W B TR

K 2.5 BT F AR FRIA
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2.4 /NG5

WL A, AT LLE IR T Fr 4 Java Project #b, 1] Eclipse kT % Java 2% 4%
TFETRGEN 2 . 1fi H Eclipse 3k mo SR FES R IE D) 68, IXAEMOC LI H eIt
HH. R, Eclipse MFF A AXEMT TRIEAT K+, FHELLOE java SO, it

(Eclipse & N E HaBEas) DLAISAT I .
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=3 Eclipse WEME, AENFEH

ARFEHNFILEXT Eclipse AN T f#, (#T LUG /28 MyEclipse R k. Wit
1L IR AT Eclipse T H, LBk iX — 2 11 N 2%

3.1 F AR

O WLE Y S AR —FE, Eclipse tHSCERARAER A28 5 5@ LM S . 531
S JRE 2% E 2.19,

3.113¥KH

i IS4, SRR A S (I File) RAIZERLIL (U File — New),
SE BT R 1 T B8 SR TSR (g Window — Show View — Console). 41 F Efis:

K 3.1 34
AT T RKEHThEE, ARmAE W Windows #44-ANA], MyEclipse [ & AN gE4s
A I o 2 R SE
3.1.2 TH#

BT SRBA NI THA . W N EPR:

K 3.2 T A

THRAA T R Kb . H55h T HES R ol LU Sl SRR 8 . PRI T
LI MyEclipse T B A= F8H S HOGH Y 1 D fig -

i BRI = 17
FTEP » Bt UML Rk
i) JAE) AIAX PR g% | A #i# Web Service
A Ja%) Web Service 3% rfj KA Java EE 3 H |k
5 %48
G BalEILEE RS S | @ J53) MyEclipse %3
e
= OB H 80 T E | Ly JE ly FhL I A 3%
Hx Sk
(8 - s [k 7 EJB 3 Bean
35 - PR Q- BITFY
Q- IEAT AN T H a3 Bk Java il H
B B G - Bk
= FIIFRR ¥ W%
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¥ IT Spring bean 5 X o B4 L] UL
v Tk 2 i — bR

1) 4

ir
W RIE AL E <~ DR A

i

4

SCAERHT— 7

3.1.3 #EME (Perspective) V]#eas

P TR BRA MK Z Eclipse F5 A 1Y THAL: BV E . 0FE s

& 3.3 B V) e 2
sl E e T LA R AN B ) . A BB i S A A — A

PR, s AR A RS 4 7, AT R R AR T ShaEREER AR, BRoRBL —A
EMEAM T A A . — BB ORAT T RS, TR DL ALK
N AR, WoRHERPARE, rTRAE N RO EDR IR SO KA 5 o

LML, 1 A E A i, AR SRR L $E Close R

Ao BRI, W BN s B AL B A RRBI AT o W SRR B BRI SR AN R
sl B 3.3 FARETI#AS T (1 Other.. TN, £E N [HIFT < 1T T IZ AU B 1EHE A 3k Honf
NRERLIE, AR5 i OK BIW]
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Kl 3.4 i1 B L K
FERXANEI AT AN SLIEHE Show all, G lilik e vl LIS h & 2 MyEclipse #15% ()
—EFENE, Fl WTP Java EE, KLk A ZAT . MyEclipse [FERIAGERL K &
MyEclipse Java Enterprise,

3.1.4 ME (View)

PR W AE BRI R — NG, T DU KA, MR, TR S K
MAEE, LARRH . BT THEAL, SeRARRNRESAEZ A, Eclipse HF A XA —A
ARG DGR, GO P T Eclipse SR 257y N HIFZ KR

Kl 3.5 MK
FEANVLEAHE L, SRR I /ML, P LR DASRR FE] = AR I RE 4
PRV 5 TR S /s (R b R, 6 33K AN B AR T LAAE 5 i P RS S LI A7, P o o A
W) 2 D) 48 S RS L PR ) PR s R b A 8 ol o B K Ak e O n] LA 2 i L P o 4 3
AN e AT EEE A O MR IR o e T MG S T, I Y I A
N AN B BRI R AE S LS, B A A RR AR L, W N E TR

K 3.6 f/ME R AL
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HEh T A BRI | AT LU St ML SR IR B et & B AT LA S M

HTAIRL B AL AU, it/ ME R IR AT BLEF I 7 ORI PRE DT Fast View) 1
PR S B N 2 o SRR IBCAE S AE L 380 mT AR R IET A0 S R o it B ) T R A 42
AT RAPRAT XS I (R Zh BE s 10 s kA2 B = JU AT DA A0 22 i AL B A SR IR P B g oo

AR A DN LR G, W GERL SIS FRITIT: Window — Show View, 41k
B, Al AP 28 7R (AL I -

K 3.7 AL e i
WERAE BB A BLE s ALK, TRk Other . S5, SRS 7T A IIALIE 7R
R WoR AL, E PR

K 3.8 s AL IERHHE
T LAZE type filter text IXAMHEA A AR R 70 4% TR 2 4k, IXFFRENS PR E A7
FEERIIA .

i AL RL I R AL T Rg
Package Explorer Java 451 Hierarchy KEK (EKXR)
Outline KN, Wi Problems xR, BESEER
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Tasks 1454 TODO #Frid Web Browser X 28 31
Console BEHG, By Servers &gl Bl
Properties JE Image Preview &) F i v
Snippets R B

3.1.5 ETF3CKE (Context Menu)

AEF I FAEAT 35 i o BURR A BB 38 R PR By TR SC3E B, RE T M 10 S A B BT
e VA WENEAERE B R pTWe SRIEOP S PRI RI i

3.1.6 JRZA&FE (Status Bar)

AEF TR B B /s B RASAS, AXIRAR,  Eclipse FPIRASFZDhAE RS9, BRI E
LIREME AR E . W B FrR:

4 3.8 ARAH

3.1.7 %wiE# (Editor)

AE S A o R B A B B8 SOAR P S AP i A o 30 s AR P A 3 AT
L, thgsm KA AME, T AR BoR 2R 00, Wy TR, mHA —A
IREFIR AL RR 4%, W R A i e M I (L S 4 s, B4 B oRdT s, Bk, 4
W, WSRO AR o SR A HLI (1 A BT R U, S AERRE I R xS AR
IR

3.9 Yiikas
RIS FTTFF A AR, 2 BoRbRZE TR WAHEGI W>>,, T RN TH Z /DA FFN
A ARAE iR A I BoR . BL>> T DU R SO S SRIE R, R A A AE T S o
F-RERBOIVLAC AT S W F B R:
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310 SCAFSIRRIEHEIE
3.2 W B MR

3.2.1 JiH (Project)

Eclipse H1 T4 (7] LG RIS AT 1) BE R U Z0UBCAE T H H, BpdT IR SCHHR 2 Dhie AN mT
TH LR T — RPNV SCRREE (BIREAE, deasdinl, RATHBAESENRE),
— kit H s R ).project Al.classpath X AN SCERRGR T 24175 H 1945 & o 47 700 H mr LA
Sk AN E AN H , ARG ESESE . Project — Open Project, o8 A Bk Hk
Open Project. X FIITH AI LAk i 2256 (K AN B0 2N H , SRS 1B #E3¢ 4 Project —
Close Project, & mififi#ik$ 52 H Close Project.

3.2.2 THEX (Workspace)

—> Eclipse \TUAAT 24 TAEX, WA TAEXEE T2NIH, DB AR ERS
SIS Jey, SCFRAN, g5 ds g LAEA . EE > TAEX L AER: 114 Eclipse HERE(E
e F3AME AT H WL A BIA R TAEX

TER: MR AR H s A IR AT RE N AL T TAEX AP i H S0k TARX Hars i —
40 .metadata 1) H SRR T BCEAE B £E Eclipse JA BRI 2 ik VR IE £ 248 I Y
TAE . Wi RE A TAEX H % AMEAE, Eclipse 2 HEh A1 E .

3.2.3 8. B JavaliiH

3.2.3.1 BATH

R T E Eclipse I H WA SO S, BATTAT DA e R NS ETY Eclipse TAF
XARJG ARG . S5 File—~Import, SRJE7E#H I Import XFEHEH £ JT General
H 3%, % $ Existing Projects into Workspace, #:5 ri i Next 4441 . 24k #1ik 4l Select
root directory: N r] LA i Browse.. 4% A & 50 H (S0, an a8 5 H 1) st )
PLZEH I Projects FIZRHEH ow; 14k rh ik 4l Select archive file: i n] DL S
Browse.. #ZHET RS IHK ZIP E4it, 35D H Ffsinl LET A Projects
FIFRME WoR . B i Finish #2800 nT LU NI H IEHTIF T a0 T B FR:
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K311 S AIH
3.2.3.2 BT H

R File—Export, #RJE7E5H ) Export XHEHEF I General Haxk, #%#%
Archive File, % /5.ii Next {44l . #kJ57E To archive file: iy HHE 3% h ZRAE ) SC1E 4
— WS I H 4.zip, ARG i Finish 3EIRIAT S H Y ariH » 01— Mo U2 T LI,
Fl WINRAR 5% WInZIP %6 T HARTTLL, 56 el TR Fro gy JF0 H e H %, Bt
A CAHAR BRI T HRAT ORI H X T .

3.2.4 RIEBE IEREE IR

7 Eclipse (X124 & 4 55 AU LK G 198 2 Sl ot 480 HH R PR B R 3 0 75 JRAE L )l
RIS AT 1 IR 2% L R 20 LA R e AT ¥ o e el T W B 2 1 PRAERE Crl+1 (30
S Edit > Quick Fix)n LB B IER K, JFEBIERT2aTibi. W FEps:

3.12 PusfE IEAR AR
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3.2 5 b RAFIE

Rpgrh 2w 2 S N RIS, Wil Source — Organize Imports % 7E%
B bN o R SE T Source — Organize Imports, ¢ % N B EE
Ctrl+Shift+O th ] LR E 4 2 24570 FI I 28R,

3.2.6 ¥im, &, Mk IJRE

Wit ¥ Window — Preferences, #RJ5ik# Java > Installed JREs, nJ LAF] Rt
1. Eclipse 2w 5 R Il I 1K) IRE #1136 SEHEE ) IRE Z2EIAM JRE, &4 H Bk
T B3 H RAE A i AR 3 ) IRE (BRARFETI H 1 Build Path tHiEE T HER JRED. A
Ll Add.. AZEERIET Y IRE S (FEFH XIEHE T IE £ Browse.. &8 AR 5 1k
JDK [ Ak, 2 iy OK BImp), Edit.. 354 L& JRE & X, Remove %41 1]
UMER IRE & X, & AR JRE [ G R EAE BN JRE. HSR MyEclipse
AER8 [ 22N I Wom—A IRE, U2 SR Z A BUR ZN I — A~ IDK RIEATIF &, M T &% IDK
YRS NG h I GEf8 WoR R R R e W R ER:

K 3.13 il E %30 JRE

327 EBEFEREN, BERMIE

A e L EH HES, ] LAFESn s 1 L R SR A E £ Open Declaration, (3
EPSEH Navigate — Open Declaration, (&% N F3 8. WG IXAN O T VRIS (4]
W1 IDK R, HnT LA 29SS, 0 R GEE BIZR M 7 AR A5 R .

BRERINGAZR, v B SR k#: Open Type Hierarchy, 5
EHF . Navigate — Open Type Hierarchy, (& 4% F F4 8, K 2als s
Hierarchy #L18, whn] LA7E Hierarchy #iLEIG BIZE M40 A2 X, 2 Ja sk n] ULl xt .1 28
FIEXT .
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3.2.8 HEIAEIH (Open Type)

PP B B AR e L, EF K Navigate — Open Type, i#E 4 F
Ctrl+Shift+T #, B4 F THEAE ., i LU I Open Type 4fifHE, 7E Enter
type name prefix or pattern ¥ AHEH AT S LA TR, 8t m) LT H 2R FE (1)
T BC AT RO A 4R, XEHE N T 17138 ok 25 BoRVCEC 2R S, 1E P a1 36 rh 7R 1) F AN B
B AT SORFTIFE o W FIXANZEOCHR T 565 (11 IDK BT 25D, #tn] LAE BIPEARHS,
L BEE BRI 7 AR s B R E R

K 3.14 Open Type X} iFHE
3.2.9ELHF, #HKR, Library FIgRIFSRRARE

M3 ¥ Project — Properties zi# 7t Package Explorer I H ™7 i b4 8 ik
BB SCEH ) Properties, ol HPUERE Alt+Enter, W LAFTIFI0H J@ X URAE . EHE
2ty Java Build Path, w] AZEA B0 H S8R A2 A S E AR T1. Source G
N TS H s TR — ANl 240, BRSO 2 gnit) LUK Java I AU 2
PG PP AE B T AE IO H sk o IR B SR ] LIME o, YEARAS H sn] DA N sl I 5
Package Explorer #LEIERIAEA SRS B M. a0~ B s

K 3.15 Y5 H A H A
iy Libraries UUE AT DABEE 2 R5 00 H F92REAR, XSS AR gm PR SO -
T EFTR:
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3.16 KJF

Add JARs &4 R] LK i H T jar SCHEIINEIZE 42, Add External JARs UK
NI H AR jar SCERIZE R4S, Add Variable FshAS &, Add Library #] LLRIZEEE (—
ANEHZA jar CHFIN&ES, BIFR T H2 R HD, Add Class Folder Ui H sk
G5, Edit a] LMESUITESSE ¥ E, Remove U 4% A I g v 1 28 )%

FE T R HR AN T 38 4 1) 7 S R ARAS (1) g B 3 1 nf A IDK 1.6 SR ITF RKsokig AT 1
JDK1.4 BT H, ABAXEHET EW B a5, 5 PR R S IR g A ot
MANGERE H bR IDK TR, s o 00 H & M XRHEHE T 1) Java Compiler ] DLz B ACRS 1) 4 345
gole N BTN

3.17 A go

W R IR SO AT E g g g, T LAkt S IEHE Enable project specific
settings, #XJ57E Compiler compliance level A5~ HiHE R E B H AR5, Bl
5.0, 1.4 %2, 6w L4 Use default compliance settings B EHEIETIRA, kit —
VE . XY B2 R B ARSI RS A, B AR 1.4 ORI H ] 5.0
LSS, &€ 2 SIRETT.

WER LS ST A I H BN G B, i Configure Workspace Settings... k41 7F
A )R B UGAE, IX A R E LT — R, AR T .

3.2.10 AR getter A setter Hik

7E5 JavaBean [ W EE — LB ALY getXXX ()R setXXXO)IXAE) ik, FRArl
Al LA Eclipse K H 8h 42 X Se R Ak (1K) 732, B private String name; iX£E[K)48 &g
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X, RIGIEFESR L Source — Generate Getters and Setters... B0 75 g serh dith 4k
EFESE A Source — Generate Getters and Setters... 5t 1] LL3T I Generate Getters and
Setters XFUEHE, FEXTIHHE LS AL 77k, ARG i OK 44 RIm] .

3.2.11 A

A W AR T 5 AR EL, IX I AT BLSE G B A AR ORI RE 2 % Uk A i S
T A A ), ik FESE B Source — Format B0 78 g 4 2% o oo 7 o vk PR B
Source — Format 5§ i HeEst Ctrl+Shift+F et i AR ks Ak sl T B sz (1) 4%
Ko XAMEAELE MyEclipse 11t al LU 4k XML, ISP, HTML S5 304

3.2.12 B R

FEFHPREERE Ctrl + /7 AT LURSRE P R AU BRIZE RIS I B 2545t AN REER (D UM R R

3.2.13 F LA BHBhGIF

WARR AR, B )L T NEARS, fiH Eclipse >k A 3h9w s 2 — s
RN —AT RIS 2 A )8 Shdm B as R Er b A, MR AR S REAY) (X2
Eclipse [{1— M2 il i) o X a] LAY)#e Eclipse 9 H 804 130 F T4k, s
H. Project — Build Automatically [FEFARAEE, THBAR K TF Tk PR
B L )42 A 22 PR o XN TR ARt AN 2 B s A gm PRt 1, A
S R PR (RS, IXREAT B TP ) S AR o OIS AT G P 0] LLE R Project
— Build Project k& 4ar i Huk# Project — Build All SR rE I H .

3.2.14 BRI Java YRS A0

Eclipse 3.3 SCRF—ANTh g R BB L) 2 Java Y5RE S, 14 an ~ s AR AL

S 3 B AR L
public class YetAnother {
}

M4 sk Edit — Paste m{# 7t Package Explorer #1535 H 5 it R S0k
ik Paste, BU#E % NEERE Ctrl +V, JEA Eclipse 2R X BLACRS F 3028 AN
ff).java SCEFIEREE IS 2 155 0 H 9548 H b .

3.2.15 BT B H 1 3C4

15tk Package Explorer #LIE [ SCAF Y i (Java el Ml SCAFAS T B, 84 i
T3 Edit — Copy Hi#7c Package Explorer #iLE (K30 H 4 A [ F SCsesrp ik £
Copy, B % FIRGEEE Ctrl + C, 2 Ja FHERERING 115, 270 ZERGIG 147 2 A1) 8 )5 4h S A
MIEIAS, an 2RI 2 H 3ME SO e s P n IR AN R I8 24 K . WHRRYE Windows
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{3 SO0 s R 0B R — A SO s SR R, 2 A PEAE Eclipse ORI, I8 AKX A SO ER
e S SV H PO AN BT S I S e e AT PSRN AN i IO P/ S A TR

3.2.16 Wi AR A

FEVEACHS (KT 05 4% X0k b T AU 75 78 2B 4T i B il (break point), Wikl @
B RS, W EPR:

Kl 3.18 M
Z Ja ®ATT LLIE i 32 . Run—Debug, #¢# Run — Debug As — 1 Java
Application, It T HAEMES =, sefdlst FL1, s 7ogiditas i bR Scseih
& Debug As — 1 Java Application KJAZNIHIRES . 2 1418 2 Wr m it & e >
AR I U e 2 AL . IR IE L 4 Wox Debug ML, Variables #LIA,
Breakpoints YLK F1 Expressions #L1E . 7) WiFeAT T FE 7 PRI 4k s

3.19 Debug #LK
Debug M H EIR T Y ET A IS AT o I ZRFE LU T AT I AR BT AE (A 2
T g 4 2 PR s LR A 8 e AT 1 s s AT A AL &, an N IR

K 3.20 PRI AU s as
1M Variables 4 B U 7 >4 fir e R AT B A s b 1 Ja i, 42 Jm A AR B

4] 3.21 Variables ¥
KRR DR, Al Debug FLEI P Resume f4l ok 4k 8:4E N AT, ZEH
Hl n] DL B AN R, AR5 S UL Suspend %4, 4747 FIAACHS, ATRL AT
Step Over FZHLRAE FHAT, siFi% N F6 . H&IER, bl Wigdl.
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R Eclipse H RS IREIR 535, (HBfEHABAER 2%, HiEgm PRl i3 1IBM
TR N bavk sk Eclipse ’J “Ebiﬁl R RlEX EmAEZNAET .

3.2.17 PuE A MHER jar £.3] Build Path

e jar SCE S IR E T (2% S E ST, R G fEPackage Explorer
M fjar ot B A, Pk ABuild Path — Add to Build Path #tr] LUKixANjar
AEIMABUIl Path; IR H IBuild Path 1 2: 45X NarSCfF, Tk F R S
Build Path — Remove from Build Path.

Wit & MyEclipse 1 Web i H (#71, 4544 jar SC{4% i) WebRoot/WEB-INF/lib T
J&, MyEclipse 25 HAE SRS H o a5 R IUB I I SO A 2715 Eclipse 7,
Al LA7E Package Explorer #LE R IERE bR SRR 1) Refresh 5i# 4% N PLfEdd F5 5t n] LA
BHT .

3.2.18 &F M R LR 5]| A

PRI H R AR BRI I e R TS T, RS R B R R Bk
HIRRE P A R . W LAfEgn AR 2R 1) R SRR L $E References — Project Sk ik
Y RTI EHWRELSR G B T, 2% References — Workspace KE ¥4 TAEX HL b
WEIRGIH BT . Aikg R EIRTE Search fLE

3.2.19 WERBR T, BEMERTS

BRINGE DL T Eclipse AT SR 48 & A 74T 5 1, 2575 el BUE S R 5 Window —
Preferences... Kk#1JI Preferences W B X UGHE, JLT- {7 Eclipse ¥ & 1L I#S v] LAYEIX
EEE £ ?&E?ﬁﬁ, AT LUEIFYY A General — Editors — Text Editors, 7471
Bk Z%EHE Show line numbers BIA] . 4 [ fin:

K 3.22a WoRiTS
SRIM BP0 7 RIL R g a4 (e RS bl il, fegf i i pREE i ik R ik
¥ Show Line Numbers BRI, ZfEainf LERIITS T dbidfan F & 3.22b . W
R TAT S g iE s i 3.23 AR,
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3.22b i g i A b A A B A R AT S

Kl 3.23 WoR TAT5 MgmiEA
TG iR A I Ak, AT LI Preferences #HTHER) General — Appearance —
Colors and Fonts, ZJasin] LAEA MIME SC7 4K T o

FE: RN TR E Basic—Text Font, 2 J5Aidi Change.. %250 E1A], 41 R
B

3.24 Bl 1Ak

3.2.20 Link {4

Eclipse SZRF—FhErZR FIMES MY Link S, HESZFT Windows [P EE 7 20X A& 2 E
AR, EFSEE File - New — File 5 File = New — Folder, o] LLFTHFHi L
Pl H S HERE, W R EFTR:
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3.25 Link Jy A\ glg et

X i Advanced #2401, R )5 H S IEHE Link to file in the file system, 2
Jamtnl L it Browse.. JZE1 Rk I H 2 AN e SCfE . e A g i SO — 4> Link
A, M TR R, BIER N EAAELE c:\HelloWorld.java 7, {HSF 0 H XA~
A RIE 2 B B E B c\HelloWorld.java H1 2%, sl f- 50X A SO A8 24 R0 00 H i —FE.
B SE YISO bR b R AL SR B AN SO A Link SO, ek G pe,
H S B bR B R FE: Eme Link B30 Java YAt v] LLUID A BIJEARHS H S rp 2
AT

FERE: B Link 75 s SCHRH T SCHF R G A5 B8 AT, PRLIHEAS it 30 F R oy ok
PRI H FT A A 25 N RATH

3.2.21 w&EHE M

BAMEE M C:\Java\MyEclipse6.0 Ak MyEclipse %35 H%, — &%) Eclipse
R E 413 C:\Java\MyEclipse6.0\eclipse\plugins FIaigi A LAz 355, IXFEM)
R A jar SCfF. WA I NN ARAEEAS ZIP K HOR B R 4 S i
eclipse 1 H 3%, IBFHEH S B E H13) C:\Java\MyEclipse6.0 7 i eclipse H s a] 58 i
B (FEE: NEMIBRZEN eclipse H3).

3.2.22 FREU Bh AN [ 1525 Bl 30

AR BT F1 BE, Eclipse 23 WsAHOCH#E B SO S8 3 i 35 B Sop m DAIE ¢
. Help — Help Contents K[, 44 KZ %1 MyEclipse F1 Eclipse [N /EUtH, #HK
() —LE R, #nT DAAERS B SoRrh R3], BRI AR, HR AN AR AR A, B SO
J%[J. MyEclipse Learning Center HL[¥N %24 MyEclipse [ B4 /EFBRE SCRYS
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3.2.23 CVS HB\FERGEE (FEL L)

5% IBM JF RN BAt X — 5 SRk 3
{11 Eclipse V-3t 480 — —Eclipse fifaf fi U5 AC AT i A< 45 11

http://www.ibm.com/developerworks/cn/linux/opensource/os-ecshare/index.html.

3.2.24 B RIFRmIY

Eclipse WA A SO 2 RIS A BRI Gm b, B I H < UTF-8 54w,
1 .properties CAFERIN A fEARAE 1SO8859-1 [(4wtt, EARAEIXFEM CAFh ST, HE
P O E R X N gn RS RI AT o AB ST vR: A ST SRR L Properties, SRR 4E
Text file encoding FHIEFFIEH Other, $:45 it A gmts 513, — ket vh S0k
GBK #tlf 7. WHRREI java XfF(Linux P& F)2E UTF-8 g, fRtLnl L&
B .GBK [, fZ=F] Windows "~ nJ fgat L ELAD i T

3.3 /NG

FERTER AN T WL —LE Eclipse M4 AW, K24 MyEclipse 3T Eclipse, ft
DI 2 py 2540 3% FH T MyEclipse, 76 2% )b R b e 52 4k ) ] DL S 28 i R R IRk
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$VIE H MyEclipse Database Explorer
B R

KBNS 4 MyEclipse Database Explorer, AN fifAs 2 ) Py 2 48 o] GE7
Ja £k A3 E K Hibernate, JPA, EJB 3 RSCAFITF AR IR R AfE . AFER: 2/ 4 anfel 48
MyEclipse Database Explorer K4 2 MySQL %4k /7 Fil MyEclipse Derby %4 7: .
Derby 4l EILAEFR }y Java DB, &8k 1 IDK 1.6 [1)—fi5), &2 — ki % o
VAR, AR ) e e 58 T2l Java AT T K .
K E NS HAN: http://www.blogjava.net/beansoft/archive/2007/09/26/148274.htm
MyEclipse 6 SESIF R BEfEIRA [T 2 H MyEclipse Database Explorer & #
MySOL ¥ .

4.1 Thee— W

MyEclipse Database Explorer SZHpZEFE T 3 R IDBC KA (1R A, v LA B4
PEPEFNR S5 R, W RAVE SRS B, A OF AT SQL A, Gl BliRT1%5% .
HANE X Oracle, SQL Server, MySQL “5E50di FEFE 4L T A SZ Fr I g -

SRR B EA R —LeDfe:

o Database Browser A DLl % Hd e 1) 45 74

o HLIRPIRIEE schema, %, ¥, sequence 4, ...

ER Designer n] DA3& s 72 45 K 1 B AL Ko

o Ha M LILK R

o XTEIEICHE AT HEBERAE
CRe P NANVIP S Pl P~

o AT LAWCE BRI A

o ‘TN IPG K
o Database Explorer &K B ChEpEaimss, WK 4D
o fEHM AR, SMEMERT]
o SQL ZufHds (WK 4.2)

o iBkER

o KA ESL R

o RAL A TEKIER

0 KadniR A FEE AT ORI AT SQL AR v Bt
o CRFE B ZANBIE PR
e SQL T H (WK 4.3)
o RFZMHURE
Axion Mimer SQL
Hypersonic DB MySQL

o
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61

InstantDB Oracle
Interclient Pointbase
Firebird PostgresQL
ODBC Bridge SAPDB

JTDS Sunopsis XML
Mckoi Sybase
Microsoft SQL Server ThinkSQL

4.1 Database Explorer i [4

Kl 4.2 MyEclipse SQL ZwfH ey, SCRpAUHE S8 it AT

KA
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K 4.3SQL R T A

4.2 ffH MyEclipse Database Explorer #EH1LE

4.2.1 K4

Java [k N T & B85 AN TTF % R 8l 1 - MyEclipse #2444t T Database Explorer (LA R
faiFk A DE, Hlls PR baay) SKCF BRI T A, DE #2467 — R4 10 T ok SR8 e
FF K. EaA N LfE:

o R 25 B X It JIDBC IR

o QAN R PR R B A — A o 2 AN B

o Bl EERLIA:

SORBIE AR, BInERS, 1, PR
FRG B i e
TEYNFRAS JEm B H A
SQL AT s
o HREEEIEEAE R
o SCHFRRRLSERLY SQL duihas

BRI R Frs

O O O O
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K 4.4 MyEclipse Database Explorer it %]
FRA XA HREAG 2215 S IEFL B AT ZENCE () MyEclipse Derby #4522 Jn FE A 4 AT 34 4%
F MySQL s 2. IXFEAC S fadfE, T T fi#.

4.2.2 3| MyEcipse Derby $3E e

TR A S B eSS4, 7 Servers AL H L MyEclipse Derby, 285 fidh T
LR b O BB e R 45 45

4.5 Ji%) MyEclipse Derby %t %
Z J5ifE Console fLE H an FATEIH :

Apache Derby Network Server — 10.2.2.0 - (485682) U /3 #hJf H & #E 4% U
2007-12-10 09:42:37.312 GMT IN{rdill 1527 3Eszi%s:

B2 K P R 55 B Bk ok T
4.2.3 Y)#:%| MyEclipse Database Explorer E#{ K&

DIMGEM A R Ipis, T oIEaE 2% EIE (Perspective) Uiffedt. —FlHLE bR
IMERIR AR, S TR R E T LR 2 ANE L D, i 3.3
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P, SR My Eclipse Database Explorer B nJ Y42 tiE L 55— Mpipik
PR H Window > Open Perspective > Other > MyEclipse Database Explorer>k i
ARFTIFIER XS HE, AR5 i OKAZ L, i N i

K 4.6 #TJT MyEclipse Database Explorer i# il

424 ST EEEE:

ZRNIEUL T DB Browser 1 NG —ANELF B A 4 #;: MyEclipse Derby, XA
EF:T URL 42 jdbc:derby://localhost:1527/myeclipse, H ' 4 % i # 2 classiccars. nf
LU DB Browser T IFHLAT (40 PE 4z, 7T UM i Aok TR LS e ok 4T TP
PR, B AT LR SR LR IESE Open connection.. B AT BL. 2 JEtnT LAY
B PERATERAE T o W F B R:
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K 4.7 7 DB Browser &1 T 58 14 i b2

SSCI {52 1 SR T AT FF A B2 MO B BT R B, T LW R e T RS LI e ok
FUIFEC e, s s ii A BN B SO 6 $% Open another connection... 1] L,

FIF T B0 B e 2 Jegh vl AR E R 122 T o JRATT T LA B B PR 4 4, $04T SQL,
iR EE, BERSEMES, #HrLl

FT IR e Bl e i B 0 7 R L2 — R

4.2.5 KA EERE

ATLLERE DB Browser M THAL LI GHDK s . B 2, A4
FHK S BAANER: GXAMEHL A AT 8% Connected to MyEclipse Derby i £ 5 4 Al LA
FD, 17 5 A FE SR 6 P T A B P e .o
4.2.6 DB E IR L

FITF T 808 2 2 Je e vl LA 56 B0 e i 25 04 o 1 R B B s o 5 vl DL B 24 m iE L b i
5% (schema) %1)%:
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4.8 W H P8R

FHEIT classiccars XA Hg ] LB /R B EH IR, Rack, ESEL, WK 4.7
fik. BERZ R RIER, BRSNS ESERMERPHIEE (BER A
T (EERD HEA.

Ty AN ARIE A P AL AT CLBE R R T M B B 2 A5 B, X AN 4 S
DB Connection Info (EdliPEiEH:45 ) Al Table/Object Info (CER/N%A5E), 1
TP E R

4.9 DB Connection Info #{ &

<l 4.10 Table/Object Info {4
1t Table/Object Info #LEIH 4T 7 MFRZETL, W] LLE B Ik v 1 2 I 1415 5
Columns /8 TRMFIEE, Indexes B/ TRIIMFEE, Primary Key s T 4,
Foreign Keys %o 41, Exported Keys &tz 13 AT, Preview N s 1
1% HLI A%, Row Count Sz 1A% HLAR 4T 8. b Preview Ar& KWL A
FHIARZENE, 4 R s

411 FERASE
4.2.7 YuiBAAT SQL ARG
PAEN LU 5 SQL dwfa a8 K gmth SQL, MR IMERTLL, 5 —F e e Bn A E B s
b (ERE: HAEAEXAS LERD S, SRJ51EH New SQL Editor, RIA4TJF
gmiEge, W NEPTR:
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Kl 4.12 1T SQL Zml#s
P —Fh MRk PR B File > New > SQL File, #RJG4TFFH 4 SQL b, 2)5
AT LAFTIF SQL dmf ek T, Wi NEIFTR:

4.13 Hrik SQL etk
PR AT LLE S SQL et 7, W FEFR:

Kl 4.14 SQL %i%E ¢
XA AT SQL W LUME A R, FEas o AahiRaRDhfe, v ABATHEA
) SQL, iy B KIbreliE i FHERE Ctrl + FO m] LLHAT IEZESR AR SQL, TS
b4 WoR7E Results #LEH, W FEFTR:

Kl 4.15 SQL #7455 R B/R1E Results #1LE
[ IS RT3 1 SQL 2344473 SQL History ¥LEl, W LAMIEAR LS B s e, i
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BRUbR AT B ] LAE B E S 5, Al LA4T JT(Open in editor), M 77 52 HIER (Remove from
history) 2 & HIEIBYH (Copy to Clipboard). Ui FEFR:

4.16 SQL $AT I L MHE

4.2.8 EFSEARR (ER) B

B e 2 (R R OC R BT DUAE s ok, AEBOE PE AR Y o0 bRt A B, ARG IE PR
New ER Diagram, #n] LA w1 24 il—NER (Entity Relation, SE4ASCHR) &,
Kl 4.17 fiion. X2 )54 i nCreate New ER Diagram i i HE R b B 7245 i I ER B 1Y
R, WK 4.18 fin, fOKIZHL, 2 BB A ok RIMER MG HECreate ER
Diagram, 18 4.19 fi7r. 7EE T idiAdd--> A1 Add All-->32 41 AT DLk £ 34 5 se 2,
2 Ja s diFinish A R AT A= ok R ARG 4T T . & EERE WK 4.20 . RRIX K
Krfesx Aok, @i I KIER Diagram Overview #10utlines e H B . ¢ T- w47
THLEIE S % N 2.

4.17 7E% ER B[Sk

K 4.18 Wi ER FEXHHE
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4.19 %P ER K EAS RS

K 4.20 4R ER K
LEIX AN L FRATT AT DL o e ok R 1 R B A R RN o AE B L A A B ] DL RS R
Export As JPEG... KK IXAE S oA B R SO LLUSAZ i -

4.2.9 YRR RS EIE

BHE R S s R T g B Y T g, {f DB Browser MLE kK, ARG LR
sgErrhikd Edit Data, WK B TR
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4.21 fE I F3CEREH Edit Data
B w v LLZE BT 2R I Edit table “CLASSICCARS”.” OFFICE” ¥ I Hh & i 2 M 5 7
W E TR

4.22 SRR H

4.2.10 BRI

i 4.21 7R, 76 DB Browser MK HIEF R, ARG LT ICERH LS Delete All
Rows, il LM R S IHI 0 B Bdis, R A B AN %

4.2.11 BRI A BRFAS

PO EA%, TTLAZE SQL 4wiR2s i A create i1, SR 5 H4T, BT LL7E DB Browser
M RS srbik s New Table, #RJ5AH] MyEclipse S 4t (158 &g Bt 2k dt 4 .
W 4.23 fizn. S fidds Add.. A% A T gl X, sk Edit... n] U SoE
15152 o

PR, nTLAFESR FA B skt Drop Table B,
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K 4.23 iRk S

4.2.12 B FIMIBR S o

K 4.21 Fron, 76 DB Browser fREAFEF K, REE LSRRG IES New
Foreign Key, ZJaitn] LAEshGIESMEN NS, S% K 4.25. MR SQL BRI E
VRS TEPL, 5 FX iR HE R 1RGN A il 2% SQL Bk

B R /M EE 2 7E Table/Object Info ¥l Foreign Keys #2584 5155 1 sl
i, SRJE1%$E Drop Foreign Key Hin]. Q1 K& fiR:

K 4.24 s ok
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4.25 GgtshEEn)
4.2.13 RIEFMIBRE S|
i 4.21 iR, 76 DB Browser L HIEF R, ARG E LR SRk New Index,

Zastal LR sl @A a5, WK 4.26. 48R SQL iEA kRGNt iF o Bibh, SR
SHEHER PR = iS5 % SQL 2,
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K 4.26 BRG] S
BN B 2R )RR L T R R G E 2 AL, /E Table/Object Info 41 f)
Indexes &R G153 Lt AHE, SR)5%F Drop Index EIHA],

4.2.14 H R SQL B4
7t DB Browser MLk, RIGE LR CSER A kY Generate, 761 lijn]
PR SELECT s DDL (& iE1)), [FFE{E Table/Object Info #LIE ¥ Indexes,

Foreign Keys S&br%: A RIS (S 4.24), ri b A BE AT 20N R 2 B SQL
WA AERUA 1 SQL R4 A SIIHERTH) SQL i as

Kl 4.27 "R SQL iEA)
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4.2.15 E3.3] MySQL $38 B 354

76 AN B A KL % RS MyEclipse Hil I MyEclipse Derby 3% 58 1
(1), ISALESLFRIT R h—ROe 2 7 A F A M EdEE, TR IRA T2 H MySQL
R FE KR 3 (1) LA, PIHCAST A 4T3 42 31 MySQL. 15 2 46 s TR RIAT (1 A 25 .

e RMYSQLIR %5 2% L& i sh 3 H OO & N T M N JIDBCEK 5, 1R IE S %
MySOL 5 Edfi el 55 2% Fak, HEFNaly (nfik) — TR 2.

PUBAEER, Wi N EFTRAE DB Browser MLEF)_E R SRR LR New... oKk 8 8B i
UK, n) el 4.29 .

&l 4.28 JABlET XS A 3
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Kl 4.29 Kl gRs 1n T

I AT ) FRUEHE P AR 25 AME,  IX 24 AKE K& (IR R P

HIAGE W B

Driver T Bl R A FR, F4s ioR Database Browser #EEIHI SQL gl & H

name

Connection | & B RS/, BRI ESAT A W& R, fl

URL jdbc:mysql://<EHL4>[<:3306>)/<EHH FE 44> .

User Name | 75 Bl P P G S P 4

Password | & B PR P () 365 Sk i

Driver 2 P B CHAER JAR SCIEFIER, XS IK ) 3 BE AR (1 2R Bk A2 . AR AE

JARs BRINIE Java R 42 A GG MBdE FEIR NS, TR XFRiff) JAR SCAF A%
BemEx E . S Add JARS F WA A 1) JAR A FIIZ Bk

Driver 7= JDBC IRZRINEHRY . XN RUIGERTE Java 2Kik1e (Eclipse )i B

classname ERIRAS) 1 Driver JAR #1431,

Save 4 P IX AN LI I, B  ORAFAL R o 75 UVEE IR FT I B33 P P ok 48

Password N R TN T

Open on | P IXANIE I G BRI Eclipse 3 I g #8 25 B 238 33X AN Htls 1

Eclipse

Startup

R AL K i TR AE f A B

A EEFBIMYSQLEHE E, TATIX B 7 ZAEDriver nameH i Amysqls (X444
SEAFEM)D, 1MAEDriver Template FHHEH £ HMySQL Connector/J, Connection URLH!
% A jdbc:mysqgl://localhost:3306/test?useUnicode=true&characterEncoding=GBK , User

Name i A root, Password#ij A B %%,

Driver JARs I 5 tHAdd JARs T2 M HL i _F Fk 3]

I 2 ity mysql-connector-java-xxx-bin.jargk Ji i i SO T AE B 3T FF 42 8 TR ek,
Driver classnamelll] it 4741 % % Fcom.mysql.jdbc.Driver, 4R )5 sidiFinish 4L m]

SERBIEE R . b, &R ] T MySQLE R E T,
TN ARE R BIMYSQLEURE T, 2 )5 M B HAE# EAH [ 1
R EESOER N S, T LALE DB Browser fRLEI#)_EF SCEHL LS Edit..

Derby %4 75—

PUE ] LLS 2% 1422 MyEcipse

. KRB

IRAMESOEHE, XD EAE WK 4.28 Fios.

4.3 /NG

RS T MyEclipse Zfs 2 W28 A vk, XA 2 AR LU S D)4 3
MyEclipse Database Exploreri#E K, F1HFEdEAEER:, W HEdaEL Y, #72MySOL

B FENER:, XLy

4.4 BT

(I AT L

7E http://myeclipseide.com/ContentExpress-display-ceid-67.html#quickstarts MyEclipse

PR (30 W LUR RIR 2 B 7 MyEclipse 24 «

A X JDBC (¥ W %% 7] LA A Sun  Microsystems

BT RS XA BE oK AR 2

http://java.sun.com/products/jdbc/index.html .

75
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AR B 2 I BT LU R 51 %450 40 www.google.comal# www.baidu.com K%

FHE & IDBC MH

A ) I B AN T B e B4R AE T davaul o s 1) B s PR IX 2 — AN et i ik
T mHEI#dava, T 1 2 A D Al e b AN T8 o IS A AT Y A
T E 3 25 H vh 1 IDBC; i) £k 126, A8 ) 2080 P &My SQL 5.0, il i) #ed 5 5li #% Derby
WA PLSE X AR, FURERE SO, WS DU N AR B a0 5ok
5

AN RS HE AN http://www.blogjava.net/beansoft/archive/2007/09/26/148267.html
MyEclipse 6 £ FF R B AT] 1 LB Mysal, MySQL-Front % 3,
JDBCHelloWorld FF&.

5.1 REFK

AR5 P 75 B 2B MY SQUYHIRE 15 % MySQL 5 HHRIE IS5 s T, S MIEAT (.
HE) 1 Py ek 22 I B My S QLB R LU 54 ¥ 1 IDBC R Bhjar S 1«
BITLLE M MyEclipse Derby % 4 56 oX AN 25 > .

5.2 AR R

X2 BRI H R UG, FEA BRI AR SUE BT R SR, AT A R R T e,
AT RER SR ELE XS B, SRR Al S WA BRI PR B R 2 o B UK BL e B il
IR R

H A A AR, AR SQL Wk ok

CREATE TABLE Student (
id int NOT NULL auto_increment,
username varchar(200) NOT NULL,
password varchar(20) NOT NULL,
age int,
PRIMARY KEY (id)
) ENGINE=MyISAM DEFAULT CHARSET=GBK

HRE: XAEMYSQLEWE M #RER) . XNRA A HMIDSE A 8, &HH
J14%, BERER =AM, ih - fJENGINE=MyISAM DEFAULT CHARSET=GBK{5E T
BN FFFE LGB SR, X — 0] &MySQLEFH M5k, 155 7% 5 DU FE 1 ) 28 AE
MyEclipse Database ExploreriZ#{[&{IDB Browser# K147 FFmysqls XANER, BT
FEikhtestB i g, ARG S i AP AT SQLACAS B —15 (1 N 54T FFSQLAw AR %%, HF Lk AR
M REIGRE 2L, ARG g T4l B SR B X A2

WHRIEH] Derby i EMOXANER ], KNI R ) 2

CREATE TABLE Student (
id int NOT NULL generated always as identity,
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username varchar(200) NOT NULL,
password varchar(20) NOT NULL,
age int,

PRIMARY KEY (id)

T BRI IE, FFARPTA s PEAR S RE B G g B, i ELAS [R) 1 £ e S B 3 g A=
J I S B A R B B I E 1T, 41 Oracle 4 H —4~1Y sequence M &R Al =8k . TP
230 AN B AR AR T e R E ) W T TR

CREATE TABLE Student (
id int NOT NULL,
username varchar(200) NOT NULL,
password varchar(20) NOT NULL,
age int,
PRIMARY KEY (id)

HI MyEclipse @& K3 AR L~ B Ps:

K 5.1 Hl MyEclipse Database Browser 1] £#%
o HIRXST MySQL #dls Pk i, AT LAY MySQL-Front, Navicat 4% T H R 5 {2
2, FTLAARAT 0 F A 2 T REI AR r Nz —.

5.3 A% Java I H

2% it H Eclipse/MyEclipse k%5, % Ifiz{TJavafe )y — 15 kAldE—1 2N
JDBCHelloWorldf#jJavalii H .

MR E 44T IF T MyEclipse Java Enterprise iBFLKl, K5 MSEHAF2IEHE File > New
> Java Project, #%#%4:37JT New Java Project [i]3:X1iHE, 7 Project name %A
JDBCHelloWorld, #iifi Finish 4% CHIAHEHE, XA Java W H st id v os ke 1. 55
RS — )BT A, T 8 St S 22 IR RRIOT,  FRATT— i £ No 42413k
LIV
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5.4 ¥~h0 JDBC ZXzh 2| Build Path

TR PR AL B IDBCEK B FE I A B35 H [¥Build Path, V4R LL 22 41
THUE P B SO AR BRin N . IR jartl #IBuild Path— 1P 2. AN [R]85 22 1 IDB C K 51
RIESCAF AR e TR BN B IR 5, MySQLIW ] LN J7 P st 4%, fi
MyEclipse Derby [ I1£7 T-Windows >4 {if F 7 (G SO/ H s R il 51 WiC:\Documents and
Settings\BeanSoft\.myeclipse\libs\derby 10.2.2.0\ derbyclient.jar. #=Windows {32443 %
A % T SO I A 3 B AR (R P2 PR gm iR — B, B SO b Rl A B RS A
WF L NHGHECH] + C), RJa MRSV BIMyEclipself & I, {:Package Explorer
PLBE R I NIR) 22 () IDBCHelloWorld i H , - $655 1T LM TR 3, s Edit —
Paste (¥ 7EJDBCHelloWorldIit H 15 sty B NSRS kS Paste, B 1% NR4ERE Ctrl
+ V, XI5 I S AL [ JAR ST 4451 inmysql-connector-java-3.1.11-bin.jarst & F 3 m 3] 7
LTI H o i R ORIE TR AN jar s, AR5 Hak bR A B, 1B PR #BuUild Path — Add
to Build Path #t Al LUK X ANjar SO i A Build Pathr, 40 K & s

5.2 $+3K3) jar XAF A Build Path

5.5 43'E JDBC a3k

RITFRIEL CAUERS LT T, ikt s Java By kU ) B e 1.

PR P File > New >Class, #RJ&(New Java Class) it R xHimtEmt i 7, &
K& 2.4, A Name iy ANHEF % N\ JIDBCHelloWorld, 558 . 245K 4 45 s HL T 11
AADAE SO i s

/*
* JDBCHelloWorld. java
* AT 2007 XM (BeanSoft@126 . com)
* Blog: http://www.blogjava.net/beansoft/
* RS GPL
*/
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import java.sql.SQLException;

/**

* ifi—/~ JDBC [f) HelloWorld F)y, #u#E/%Ei1n] MySQL.
@author BeanSoft@126.com

@version 0.3 2007-12-12

*
*
*/
public class JDBCHelloWorld {

public static void main(String[] args) {
/7 1. MRS
try {
Class.forName("'com.mysqgl . jdbc.Driver™);
} catch (ClassNotFoundException e) {
// TODO Auto-generated catch block
e.printStackTrace();

}/7 Mysql [H3Kz)

/756w SR, Al ARG

java.sql .Connection conn = nul l;/ /%44 % 4%
java.sgl.Statement stmt = nulll;// %) 2k
java.sql .ResultSet rs = null;//45 54

try {
/7 2. SR PR )
conn = java.sgl.DriverManager.getConnection(

"jdbc:mysql://1ocalhost:3306/test?useUnicode=true&characterEncodi
ng=GBK", "root", null); // root/EH )4, k=%

// 3. REGELIER
stmt = conn.createStatement();

/7 PATHINE ISR SQL
stmt.executeUpdate("'insert into Student(username, password,
age) values("7k—=", "1234%, 20)™);

// 4. HJT SQL
rs = stmt.executeQuery(‘'select * from Student™);

// 5. BoRgE S B s
while(rs.next()) {
System.out.printIn('45=" + rs.getint(1));
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System.out.printIn( A EH=" +
rs.getString(‘'username'));

System.out.printIn("#4=" + rs.getString(''password™));

System.out.printIn("/ =" + rs.getString('age™));

/7 PATIEREE ) SQL
// stmt.executeUpdate(''delete from Student'™);

} catch (SQLException e) {
e.printStackTrace();
} Tfinally {
// 6. BORHYR, @EUUSAEFinal Vy s a) h PR A oG 4 T
try {
rs.close();
} catch (SQLException e) {
}

try {
stmt.close();

} catch (SQLException e) {
}

try {
conn.close();

} catch (SQLException e) {
}

¥

’

Jdbc:mysql://localhost:3306/test?useUnicode=true&characterEncoding=GB
K X A & & #% 7 MySQL #t ¥ % i JDBC URL , X T X B R 4

ffj?useUniicode=true&characterEncoding=GBK & it LA 32 5 [ fr 7 #4 (Unicode)
Ji A EL GBK SO A R AR 1 4 B HCH e, T SR 2 2 A Ak 3 408 1) 50 22 11 RO 2 1 4 2
UTF-8, JIB4 XM GBK 4k UTF-8 Htnl LT o AR TR 73 a2 R X B A QR 1 4%
5, RJ57E MyEclipse Az Edit — Paste #ial DVAEBGXANESCAET o 40RIAE
455 ), MyEclipse 2 H gl AU g e S«

B R R AT LLSIT ST, PSR Run — Run & FIREERE Ctri+F11,
Wi LUE 3 Eclipse < H sl Java k2%, SRJ57E Console LA FR i .

5 =1
R4 =R =
#h=1234
k=20

AR AT I T o FHRAT— UK 2 P AT H s«
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Hi'g=1

FA g =k =
H=1234
Fi=20
'5=2

FApE =k =
H=1234
Fi=20

o WTLLEZID J& A Bl A .
R EESE R Derby Hofli i, KB PRI E RIS, S 40 7 k.

/*
* JDBCHel loWorld. java
* AT 2007 XK/ (BeanSoft@126.com)
* Blog: http://www.blogjava.net/beansoft/
* AU GPL
*/
import java.sql.SQLException;
/**
* —/A~ JDBC ] HelloWorld F&/%, #udliE i MySQL.
* @author BeanSoft@126.com
* @version 0.3 2007-12-12
*/
public class JDBCHelloWorld {

public static void main(String[] args) {
/7 1. VENHERE)
try {
Class.forName('org.apache.derby. jdbc.ClientDriver™);
} catch (ClassNotFoundException e) {
// TODO Auto-generated catch block
e.printStackTrace();

try {
/7 2. RN
conn = java.sql.DriverManager.getConnection(
"jdbc:derby://localhost:1527/myeclipse’,
"classiccars', "classiccars™);
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5.6 /g5

AN EBHE T W £ 1 MyEclipse JT 4 F JIDBC Vi [ 5l ZE 1Y) Java 25, JeA s
ARG, B, QIEIH, MANIKshE, I, ETUE ISR X LA,
IR g s A A IR 22 28 5 R 5 0 H B IR IR R, Rlkall IDBC 7 = s 22 s 1) AR ]

R A 2.

R AT AR BRI K - ) IDBC, W i A Sk sk IUE 245 .. X T JDBC

43T, PreparedStatement 55 =2 Y 45 1] LA Google % .
5.7 ZFE 5L

5.7.1 MR

¥ F  _JDBC 20 K 3 s N S AV I
http://www.blogjava.net/beansoft/archive/2007/10/23/155318.html|
¥ sQL ¥ ¥ m & w B Transact-SQL @ £
http://www.blogjava.net/beansoft/archive/2007/07/10/129354.html|

2

%

A TR F ERAA I — LA BUBLAER, BEw] DA 2 ST B0RE, S AT DA D JT A i
R R A T, Bk Bt 2 %e%% T SQL Server 2000 i HLIHI [ 7 1) 35 B SRS (1 — 047

5.7.2 JDBC E &

NIRRT A AT EL) JDBC B Al FREFRHIAE, X W EARAE

L) IDBC HM s 5% ikt
JDBC #i 4

1. R 5 20K B 122 70 B B . IR s i T A N R I i FE 4 1, java.sgl. ;5

TR R KT, a2 Bk 34 1 (java.sql. Driver).
DriverManager.getConnection(String url, String username, String password).
java.sgl.Connection ==> SZIIKE, AN,

class OracleConnection implements java.sql.Connection

createStatement() -> OracleStatement implements java.sql.Statement

feMtERAE => 1) # => EWRIT A

2. &) IJDBC I H (&M £ k)
T ek s
INSERT INTO TABLE_NAME [(%1] 1, %1 2, ...)] VALUES(fH 1, 14 2, ...)
DELETE TABLE_NAME [WHERE 444 7-f1]
54 = {8 AND %4 LIKE 'beijing%' OR %1 1 = 41 2
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UPDATE TABLE_NAME SET %4l 1= {1, #|2= {H 2, ... WHERE %f¥%]]

N N B |
SELECT *, sk H%I4 FROM [% 1 Hl4 1, % 2 54 1] WHERE /1]

PRI 3£ 1id = % 2.id 8% 4 1id = 4 2.id

select c.roomName from student s, classroom ¢ where s.id = c.student_id

1) KIS MAZF] classpath;

2)

I InZ BB 7

I ik a

new com.mysql.jdbc.Driver();

I 778 b &K IE

try {
Class.forName("com.mysql.jdbc.Driver");

} catch(Exception e) {

}

11 AT TP e 1 2

try {
String url = "jdbc:mysql://localhost:3306/test";
String username = "root";
String password ="/ ZSFMATLLE R "™ B null
Connection conn = DriverManager.getConnection(url, username, password);

Il B¥ish i executeUpdate(String sql)
Statement stmt = conn.createStatement();

/I Statement stm = con.createStatement(ResultSet. TYPE_SCROLL_SENSITIVE,

ResultSet. CONCUR_UPDATABLE);//35 53 7] B8 M AT R Bl i &5 L4k

83

String sql = "insert into student values(1, 'student1’)";
int rows = stmt.executeUpdate(sql):// & [0l 5zl i 5 s 147 %k

Il EEEUCEHE executeQuery(String sql)
sql = "select * from student";

ResultSet rs = stmt.executeQuery(sql);
/I rs = null;
while(rs '= null && rs.next()) {

11 U v DURR Y B bRl 1 44

String studentname = rs.getString(2);// FArM 1 TFiG
intid = rs.getint("id"):// M5 41 4 3RHL

KA
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byte[] bytes = rs.getBytes("face");// 2HL i3

I FETRBE YA
rs.close();
stmt.close();
conn.close();

} catch(Exception e) {

}

AR 1y 1) FBUAE -0 e () R 0 8, I A B IR A RERE TR, AR p Ay R A e
HIJAE try-catch iBR) 2 4b; 25 0 BIRe s isdt finally HLif.

I 3T T80 P
11 75 ) S B
Connection conn = null;
Statement stmt = null;
ResultSet rs = null;
try {
String url = "jdbc:oracle:thin:@hostname:1521:tarena”;
String username = "openlab”;
String password ="";// ZEMATLLVE L ™ 83 null
conn = DriverManager.getConnection(url, username, password);

Il # e s executeUpdate(String sql)

stmt = conn.createStatement();

/I Statement stm = con.createStatement(ResultSet. TYPE_SCROLL_SENSITIVE,
ResultSet. CONCUR_UPDATABLE);

String sql = "insert into student values(1, 'studentl')";

int rows = stmt.executeUpdate(sql);// % [0 Szl (%8 147 %1

Il SEEUEE executeQuery(String sql)
sgl = "select * from student”;

rs = stmt.executeQuery(sql);
/I rs = null;
while(rs '= null && rs.next()) {
11 B v AR 3 1 bRl 31 44

String studentname = rs.getString(2);// FAr M 1 TFiG
int id = rs.getint("id");// R4 51 4 3K HL
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byte[] bytes = rs.getBytes("face");// 2HL i3

} catch(SQLEXxception e) {
throw new £{4fs &b 2 2 W 7 ();
// throw SQLExeption
} finally {
I FETRBE YR
try {
rs.close();
} catch(Exeption ex) {

try {
stmt.close();
} catch(Exeption ex) {

try {
conn.close();

} catch(Exeption ex) {

11 T Ak

/I close(rs, stmt, conn);

close(ResultSet rs, Statement stmt, Connection conn) {
I RETBCBE U5
try {
rs.close();
} catch(Exeption ex) {

try {
stmt.close();

} catch(Exeption ex) {
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try {
conn.close();

} catch(Exeption ex) {

}
. MG R EPHF L2 L FEAHLELR, o LLH rs.getMetaData() >k 3k HL
ResultSetMetaData %1%, 118 2 HEAL & FH X PP I ME TR I B RO K347 B 2 (1))@ MR e 4
i1, 54N Hibernate.

ResultSetMetaData 7] ] T3k T ResultSet X% w41 (1) 2R & M4 B IR .
PLNARES B BB ResultSet %% rs, fil## ResultSetMetaData *}% rsmd, i H
rsmd &4k rs 72050, DK rs PSS EE R LIE WHERE FH)F i .

ResultSet rs = stmt.executeQuery("SELECT a, b, c FROM TABLE2");
ResultSetMetaData rsmd = rs.getMetaData();

int numberOfColumns = rsmd.getColumnCount();

boolean b = rsmd.isSearchable(1);

4. PreparedStatement 1 17k
PreparedStatement 4k7& [ Statement, Jif7 ] Statement FEHEAT M)A HLAAT LA
.
1) AT AL (T4 %)
2) filfk SQL %'
String sql = "select * from user where username = ?";
3) Hhnz etk
SQL A
String sql = "select * from user where username =" + username + "";
username #i A 1'="'1"or username = "7k —
select * from user where username ='1' ='1' or username = "5k —'

WGy a) AR PR R AR =
username.replaceAll("™", "™);

b) fil PreparedStatement.setString( N 45, username) [ 35 i A K245 BB Oy A9
(1 SQL [kt
%
1. #17F

PreparedStatement pstmt = conn.createPreparedStatement("select * from user where
username = ? and regdate = ?");
112, WE LR P H

pstmt.setString(1, "5k =");
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java.util.Date now = new java.util.Date();

pstmt.setDatetime(2, new java.sgl.Date(now.getTime()) );// ¥ & HiH
I3, AT AT B R

ResultSet rs = pstmt.executeQuery();//

rs = pstmt.executeQuery("select * ..:");//

int rows = pstmt.executeUpdate();// 5 #r

3. CallableStatement  Fik i - I FE( T %)

76 IJDBC Hii H CAF R B TR R s YRR RS RN L N AR AE T 7
5 ARG A REL LR

{call HFEA4[?, 2, )]

IR [E] 45 RS HN I RE I TERE N -

W

{? =call IFEA[(?, 2, ..)]}

Al SHI A A RE A TEIR SR
{call T4}

AN BIARHY

String procedure="{call Operator_login(?,?,?)}";
I WA I 7
CallableStatement callStmt=conn.prepareCall(procedure);
I A R s S ) SR Y
callStmt.registerOutParameter(3,java.sql. Types.INTEGER);
IR NS HU)E
callStmt.setString(1,this.operatorID);
callStmt.setString(2,this.password);
AT A7 it A
callStmt.execute();
IR 514 24
login_state=callStmt.getInt(3);

CallableStatement cs = conn.prepareCall("{call ec_get_cust_terms(?)}");
cs.setint(1, custNo);
rs = cs.executeQuery();
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FNE EHMNARS S

AN SN http://www.blogjava.net/beansoft/archive/2007/10/05/150563.html
MyEclipse 6 SZEFF R UHEMAAIT 5 MyEclipse 6 + Tomcat 6 Servlet A[THFXK -

6.1 &/

MyEclipse % £ix} ik 20 Fiw RS %% (Application Server) )50, ik, KA,
R kAN, WA, P, EFERS NG RES . KBRS AT Glassfish, JBoss,
Jetty, Jonas, JRun, Oracle, Orion, Resin, Sun App Server, Tomcat, BEA WebLogic
Server, IBM WebSphere 5%, MyEclipse il it 6 554N R 55 2 L & 4445 (Connector) K
B IX LRS54 o

ANid, MyEclipse HSCHFEAHL 222 M IR 55 25 B B, AR IR IR &5 d AT . )
Ab, XL A Ui IDK KH 5, REAZEMA JIRE. Ak, 7EsEErh kB Tomcat 5,
Tomcat 6 1 JBoss 4.2 J& A LUl JRE 1EH A s MEIEAT .

HA45 MyEclipse Java EE 25715 H (Enterprise, EJB 1 WEB) A fit | MyEclipse >k
BEAT R AR o

MyEclipse 6 Hi7 T —A> Tomcat fx45-#%, FIILER 77 & EIB WiH 4k, 1T LA AR
A% Tomeat JIRS5 55 -

6.2 Servers L&

Servers & —MFFE T MyEclipse #LIE, AT LA F 4> 10T A G 10 B FH IR 45 i e 14 1R
. XMHLKE A MyEclipse Java Enterprise ML —AMrdER 7> (3%1E 6.1).

MEEHAREF Windows > Show View > Other, 7 #ft H 5% 5 HE 3% £ 47 1
MyEclipse Java Enterprise > Servers, #in]LI4T I Servers #L1E . 1X ALK 0 T HA
P o3 O R 3 (W& P 2D ZRAE T R 43D, 2o i — (0 mT ARG B R 25 25% . JR B I HA,
A 320 P 000 DU) A B A A 035 R R RSS2 1A J2BE T H . 3 6.1 A TR T HA LT fE
) ] LA o

EE: XAEH T MyEclipse Derby & N & B PEIRS: 2%, 117 MyEclipse Tomcat
T2 P ) OSP IR 45 % o
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K] 6.1 Servers i B DL Az T H A $2401

Q | DusArREan sh ik i A g5 4

i | LURBER ST IE N T Ak S5 4% SCRFVER

T | RS GEEIL, BEED

W | T N AR 55 A

| BCE IR R S5 A I Ay

-8 | ¥7JT Deployment Manager CRATE A

W | MBEC &L KA J2EE T H

0 | TR AT 0 O BT J2EE TUH CROT R LB D

T SCAT 0 S8 R0 Ve e 55 4 140 1 2l A1 H 2 LUSCRAT T BR300 H SCAEBITAE K47
* 6.1 g5 s B T A D) e fiid

6.3 I B i Ak 55 AR IR AR

RG] [ TR R4S #3108, ATLLS T Servers LI (0 T 2R b 1) S ok 4T
TEHRSS S0 B EAE, o I T P 3% Window > Preferences, iXAEala] AT TFAC &
X IGAE .

MECEGTEHEFT S, AT DU TR ZAEM A, %5 MyEclipse > Servers, SR JE it il LA
FIRTFH N RS ae i Beas 7o W R EIFTR:
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K 6.2 BF WSS EIERARYIR
B ZR T AN E L (1) JBoss kg5 ds 1

6.3 JBoss 4 [l E
B T RSS2 112238 H 364k, e n] Lk & LeZa (s BA1R 81 2805555,

6.4 iL B x4

Fo & — MRS as A TORUET 22 2 2] 320, {045
1. FCE R AS AR 25
2. JA MRS
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3. IREJHs R ER) IDK 5 JRE (AiE).

VER: —SURRIR I IS5 % 75 B MO L B AE S, IR I R AT DL-2 7 75 56 I8 i 45 4% 140 44 P
Ul B DR B SRS DA K N EE AR SRR N A8 BRI B (AT RES AT 9D .

T T DA B %) Tomceat 5 41515k A 48 T e I B 4 2%
6.41%5 10 HEREZHEMNZERFR

BT TR 25 251 05 Tomeat 5.x, 285 il Browse.. J441 k% $¢ Tomeat ) 4%

MEHZ, WK 6.4 R, # K MyEclipse 23 221 Ik 25 2% (BN B A LS R EfR
B WK 6.5 Pras. ek $E ) «dé H 5 & E\apache-tomcat-5.5.20-cn.

K 6.4 %% Tomceat 12235 H 5%

K 6.5 ZRIAM Tomcat ¥ &5 15 5

6.4.2 % 2 JFHEERS

TAUE RIS 4, AU TIERSS, ZJRIRA REAE Servers HLEITE 2E I &
-

BT B, Wk 6.6 Fron. FRX— ] Uil OK #28lmwt il LLSE B & 1 o

6.6 J5 /1] Tomcat i% ;%8
6.4.3 3 3 i E#)E RS RHRET K JIDK

dJr— D TR A N IR S5 4R E A& A ) DK, % T Tomcat 5, Tomcat 6 £l

91 KA



MyEclipse 6 Java JT&H SCHFE

JBoss 4 ki, ERINM IRE (—M& 1.5 AR B =, 911 MyEclipse6.0) #trl AT, A
T2 IDK AR SRR A IR 55 8%, Bl Tomeat 4, W HEEEEE IDK 1.4 CREE
JRE 1.4), XINHeEm 42546 & JIDK. 11 Tomcat 5 WAZ e IDK 5 5y A . i A2
ff) IDK 5 55, ARJFHEFEAT MY Tomcat IDK name 5 ) IDK 512 RHuHE, A LA H X
WA ) IDK i R B T :

K| 6.7 Tomcat JDK % & 7 [
e a il OK 44l il LASE i & T .

6.4.3.1 AIE#RIE: &N IVM

TR BLAE ) IDK ARASTE 5138 B B, W 55 Add.. 4241k 5 8 Add IVM X EAE,
wE 6.8 Fin:

6.8 Add JVM X i
FERXASSTEAE L I i Browse.. $%8, ARJGAE HSRIEPETEHE & IDK 228 H IR
H3%, it c\dk1.5, TiA iR SLehr IRE T H3%, #l4 c\jdk1.5\re, 25 siti H ik
PR TEHE R B HcHR 7] Add IVM XHEHE, Xk JRE name fig AHES A3l — 444
B, AR AT AT T — A2 AR . IR mdi OK Ut 5e e T IVM IR In LAE, 3 Fk
PRt n] LAZE Tomeat JDK i & GUfE XA I 1) IDK T s
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6.5 KAiiz4T Java EE Ti H

6.5.1 Java EE T HK KAALKE

MyEclipse ¥ % fi Web, EJB Fl Enterprise Application i H F{F-{7 MyEclipse 37 ¥
(IR G54t b o B SRR R T A0 R AT o 5 HR R 55 4% (000 1) 805 SRR T At 1 SCRFRLEL R AT
H Bkt Tomcat Fil JBoss #f5 42 SRt & A 1 -

6.5.1.1 KM

IR AT — o TR R B R AT, MyEclipse 253 5T A 1S4 Java EE BUE IF H 5%
SR TBAE R S5 A I Rl H ok R o AEIXFPEIL T, MyEclipse &2 BB Sa i 3C k. it
ISP 3CfF, RICHFEERGI %, SCHABIFRD G, XMMES T ISP BUHAN Ty 2 A
At BEAE S D25 HELIBDHT 5 5 2T (0 45 2R o XX T AOR B A2 AR 5 () o (ERE 7 2245 2«
FHAEFTA RS H/ESRFRE KA, BBRMBAR Java EE MITEFMEKNE, Java EE
Ve R BRI RS AR L S RFHT B R AT T .

6.5.1.2 fTEXM

B A e Y 5 4 A EW Rl <3 PO (1 1 s Wl > WAV S e R SN R Pk =
U %L Java EE BEHT AN ZIP S0 54T RE2 . EAR, JAR, \WAR
S5, RJETREIR S 45 1 R AT H s T S8 R AT R o XA [k g 2 MyEclipse A
AR ZIP SCAF R 2, WIS BB R AT .

6.5.2 [ e 5528 A AR N

7t MyEclipse 6 1, [r] Ik 55 % A A N () dse PR die 75 {8 1R 7832 /2 £ Package Explorer #4
BRI H S, PR E Run > Run As > 3 MyEclipse Server Application, 2
Ji MyEclipse AIfig<s on— Al HIRIRSS 285105, Erp A ik 45 2 —#ilin MyEclipse
Tomcat Jf riili OK #41 J5,  #t4s B 3l KA s B R A N ISR 5 J3 s ks a5 an Rk i)
#& MyEclipse Tomcat iX /MRS 4%, HZ2n]LLHZI4TFF—4> MyEclipse Web Browser #{
K, AR B S5 TP AT IT Web TH 1 5 0T . XA 72 LA 7 (AR i e

G kAT, BRIKRZ, ATLLSH T ISR AT .

6.5.2.1 T R A FHEHE

P L TR EES A, s LAAT T Project Deployments SHEHE, 41 F
P
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Kl 6.9 I0 H KA ] X 1 AE
L R B Servers ML T EEAEHE4, M4 4T TT Servers Deployments %1%
M, WoRMAARAARTCS, W E PR

6.10 M55 s AcA [ AR AE
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6.5.2.2 mity Add $%41)5 ShHTE K AT EHE I SERR AT

L il &l 6.9 1) Add #2815, 7T LLA 3l New Deployment [ 45, 41~ Kl fros:

6.11 it R AR I AE
TEIX— AT LS e 0 B R AT B RS54, BLACORATIZRAL. fiids Server Al 7
HETE R0 B [ IR 452858 X, $% Deploy type TSI 2 — k488 RATHKM (L
R KA, TFRAE A TR kAT, AEr=HUEEXD, 1fi Deploy Location M &7
T AT H SO R AT B AR H . A Finish 38k v] LR R AT I RE 25 45 B 4%
FEMRATIERE « R AT 4R 523 7E Project Deployments X il HE BT i 7 JH 70 R A (1) 45 FLA
WA, W FEFR:

Kl 6.12 AT XTI HE
I R 6.10 FFUAM AR AT RS, Al Add F T FUR 0 1R HE B I 6 47 B AT AN [,
JCEMES R Z AT . S Remove FH & MBRIX /N R AG, At Redeploy 44
SHEPIRATIEANNH, i Browse $41 I 7E RS0 SO0 W a8 T AT I & A i (N H B
TEM H k.
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6.6 NV A 55-4% 1 & BN IR

6.6.1 B3I R4 2%

BEATIRSS 2 Wil pid, — R JEAE Servers LI FhIE b il 4528, 2 Ja s e T LA
1 QA DA TR S SIS 88, Bt o W DU 2 B S 28 . i i
FUH T HA2 E) Run/Stop/Restart MyEclipse Servers #4241k G sh k4%, N IE T
TN

K 6.13 THA LIRSk o545 12l
o IXFEHUAT LUR BIPTIE PRI IR 5545 T

6.6.2 W= k5548 JH shid ’e

M55 Insh 2 fa, i H G Bos7E Console #LEIH, T FATH A ER AT FH
SR T R 55 4 A2 15 12 R s 58 B il B B 2o 7 IR 1) Tomeat i 2558 52 [t H

—+
oD

6.14 Tomcat 5% )3 sh s Dh i H &40
6.6.3 {F1LARS 3

AL AT Console MUK T A [ BRamib & - RS #s bR, 8 AT LUE R Servers
PP Ly W e 103 5 AR5 2, T LUEE 1 6.13 1-f) WiStop 32 B IRURASE 11 G5 v
JIk 5545 % AR AR ) H S 4 B2/ Console #LKE .

96 U =



MyEclipse 6 Java JT&H SCHFE

6.6.4 PRk &AL N A

MyEclipsey” & T Eclipse ik 4%, XA & LIFEISPH 1 B W7 AOREAT IR, thaT LA
XTEIBHEAT PR o i LM AL W R s — 15 P/ AR R ISR 6T ISP E# Serviet i B il 7
o FE: WEH/—2ZURAEE3, 2% RS SE—AE. HErEEm
T RRES A R, T AT HOP AT SR o SRS T A Ik v 8k 13 A2 | 1) g i
PR, 28R o — PP R L (1 035 S /R AR HL T FH System.out.printin(ii 3045 5L") K4 Hi
R0,

Kl 6.15 % ISP #3471k
6.7 /NG

FEAF AR IA D I 1] MyEclipse JEAT ik 55 #4521, 10, Mo B A0 T T PR iistie,
AT N A0 LS B Web I H 19 TF AR KIS ) .
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®B+HE FF & Hibernate N H

AN SN http://www.blogjava.net/beansoft/archive/2007/09/27/148478.html
MyEclipse 6 SE&EF R IAEMMA [T 3 MyEclipse Hibernate HREAN[THEK .-

7.1 N1

76 B JPRIDBCN M, AN T Wl fi FIDBCK I & Vi vl #4i P2 1) Javafs
J¥o W LAE 2§ FHIDBCE R T AN LUARRIGUR) AR VFHT I 11 L o, AR A
FIMERE Y, AT FAT 4 ] FMyEclipseit {7 Hibernate [ 1 % . i i1 I MyEclipse
feftftHibernate i ) TAEHIAR, FITLATE 2 2340 A 58 A SO AR B TAE

KEAY T MyEclipse Enterprise Workbench JT%& Hibernate [J3:A1)6E,
RS AR . T PR AR UK I K — AN HEH ¢ Java Hibernate N H . X %AW
SR BANES, S B S5 Hibernate #Ei .
KRG T AT HEAT T 51 AR

B 5 Java TiHIN MyEclipse Hibernate =7 #F
ETH Rl Hibernate Mt & SC1F
Wl A 2 ) Session Factory
M Database Explorer 13 e X hEm Java 251 Hibernate 4 2 w it 3 14
(.hbm.xml)
ffH HQL JuiHa%
B AIEfEH Hibernate ¥/

7.2 Hibernate —'%

7.2.1 fEifr

Hibernate (3¢ 0 B2 & M8, KMEE U H AT T Hibernate & 5t Al H til:IDBC “ &/~
T (www.hibernate.org) &R AT T 2 THCEMIZATHIIE T IDBC (1%}
Z-RFAZWYS(JORM) 5%, et TRFEFMIRE, WA RET FLhhEe:

® PG g
TR IRE AL
AN GG 31 2 N R
BESE Sty
EZSPNIS
Al X SQL Arify

Hibernate {fH Java 4’5, &AL E MO,  nr LI iy Rp e & SO
AokHEHATECE . B MECE 4 F N hibernate.cfg.xml.  {EB B, Hibernate
WIXA XML B4 8 MR BEAT H0E,  BI 30 B e A AF s R i, Bl T &
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(database dialect), LSRG A7 E4%,  Hibernate 7E28BkAahd#kix AN, %
FhCE SCAE R SR S CotE B4 8 *hbm.axml), ‘¥4 JF Hibernate fi{i Jelsds
SEN Java A —AEE 2 AN EE PERAG IR E T . MyEclipse $@4t T T H kb
FRIX P APIC B S, I HoaT R e AT AR £ ZEFT Hibernate B (1) Java 28 1E ok
1T

Hibernate W] LLHIZEATfA] 75 20K Java X G R0 £ 2 38 4% b I 30 21T AR 1) Java
N, Bk, EEFRMWZEMZZER J2EE NAHPIRA M. AR N K
Hibernate f44%:

® [RIKIEH s Hibernate K% ORI JAR 2KPE

® g hibernate.cfg.xml SCEERA A aifa s ) £t 122

® TR AM Java FEA G BBk I iR A SO PR

W2 KT Hibernate MEEAFISZRFE, B WA{EA Hibernate AT I A& HIME .,

WEBEAREW 7.7 ZEEEEY

7.2.2 Hibernate & 5

AT BAREAH 2% 2] Hibernate (145 4E 808 SCR, AR 175 {HDRT A 75 (KD B A
T ABLAE S b A 1R A AR B 132 S SR AR R A 7 0

1. = W What, Why, When f+4 &, Rtt4, Az

what: /2 — OR Mappming(O Object X} % R relative X R E Weif) HESE
(framework)

why:

AR RIN S B SRR 1 LA

Person => id, name, age

MRS G 1 gy 2R pon) N O¢ R e ) SQL, FIBLfai Ak Java EdE T Kk, AR
JDBC KSZHLFE Ak (Persistence).

when:

1) D2 BRI S BT E I HE A fE A Hibernate.

2) Hdn R KR A FE SR AR Hibernate 1!

3) W EERAMW, MEHTE Hibernate, £ ifjliil)y A n] ik} (createSQLQuery(F5 1
HTE)))

2. Bal
1) 4Rl E S B Configuration JSAEHT (L& R HT #%)
a) BRI
hibernate.cfg.xml
SREUCECI B 1% 32 (1 2 20 (URL, username, password)
Ji5 (Dialect) & 1 AR R £ AR BOH Y ) SQL
b) 11 R LEmR S SO AL

Configuration &
Configuration 51 57 # Hibernate [WACE (5 E . Hibernate 1&47 i %
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BRI LR E SEI AT B, o LA G B Mt 3

4 PE URL

et R P

LG E SRR S T

H¥iJ7E IDBC KK

i 1 dialect, HIT0Re & s ZEFR AL SCRE,  JLrh 5 TR s Hos R vk

FISEEL, 4N Hibernate %428 2 24 w Hifs 22 2 s S 2L Ry i o 45
i/ Hibernate WAZE St X Lo LAl 5 LS8 Wl aa i TR, b Ja 4k /R Ao vt
%o IXLEEJEMEAE hibernate FL'E SCf: Chibernate.cfg.xml ) Sl i&.

LJ%JEH
Configuration config = new Configuration().configure();

i}, Hibernate 2 F 76 2417 ) CLASSPATH w48 5- hibernate.cfg.xml SC: 34 i
HC3 A7 TR A o ke i JE LG & . Configuration 25—k A7 783K HL SessionFactory
T 200 J, 3R SessionFactory 2 )&, I THLES B L4 M Hibernate 4E4 346 &
7ER[FIf¥) SessionFactory 2 |, PAIt— i 75 P L T # A

A SO
<?xml version="1.0' encoding="UTF-8'?>
<IDOCTYPE hibernate-configuration PUBLIC
"-//Hibernate/Hibernate Configuration DTD 3.0//EN"
"http://hibernate.sourceforge.net/hibernate-configuration-3.0.dtd">

<hibernate-configuration>

<session-factory>
<-- WorjEER SQL, ik -->
<property name="show_sql">true</property>
<property name="connection.username">classiccars</property>
<property name="connection.url">
jdbc:derby://localhost:1527/myeclipse;create=true
</property>
<property name="dialect">org.hibernate.dialect.DerbyDialect</property>
<property
name="connection.driver_class">org.apache.derby.jdbc.ClientDriver</property>
<property name="connection.password">myeclipse</property>

<l SEARBU IR >

<mapping resource="dao/User.hbm.xml" />

</session-factory>

2) SEARZJS(POJO Plain and Old Java Ojbect) JavaBean [f 2k
flixt%, A getter, setter, ¥ \V5% 7%
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O SERPSE SR VS )

public class User implements java.io.Serializable {

private int id;

private String username;
getxxx

setxxx

a) B EETEL
b) TP FIM(ZEAE, A BMEIENAE, A RS

3) SEARMLS S SEAA44 . hbm.xml

#UF Hibernate /&4 RMO G, MBS Am A K, BRI BIE A, DK
X . 3 FLI 81 44

AN ICAFBCE 2 A SRS W LU, — Ok U — N — M E SO
<?xml version="1.0" encoding="utf-8"?>
<IDOCTYPE hibernate-mapping PUBLIC "-//Hibernate/Hibernate Mapping DTD 3.0//EN"
"http://hibernate.sourceforge.net/hibernate-mapping-3.0.dtd">
<hibernate-mapping>

<class name="dao.User" table="users(¥#i /& £ %)" catalog="%k FE 4 7-">

<l-- THPBACE, hibernate A FATERT8E id, WIUE X-->

>

-—>

101

<id name="id" type="java.lang.Integer">
<column name="id" />
<generator class="increment" />
<l-- increment J&5E M\EHE FEEUER K 1D ARSI 1, FRAF N
assigned AT TIRAEZ— ID
auto, identify, sequence, native, uuid.hex, hilo 254§
>
</id>

<I-- property BRIAFEI ARG AR ] 4 7 1R A1, 2R IATAT LUE SOL st J5

<l-- BMELF R Hibernate type: string, int; Java J5[{4x44: java.lang.Integer

<property hame="username" type="java.lang.String">

<l-- SRS N HE T B AR R >

<column name="username" length="200" not-null="true" />
</property>
<property hame="password" type="java.lang.String">

<column name="password" length="20" not-null="true" />
</property>
<property hame="age" type="java.lang.Integer">
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<column name="age" />
</property>
</class>
</hibernate-mapping>

EDVEJINST IR i B EA =R Sy R

3. SessionFactory f1 Session
SessionFactory ==> %4/} - DriverManager, 75—,
SessionFactory 1 3ifilid Session S:fi. nJ LU Configuation 52454 4
SessionFactory:

SessionFactory sessionFactory = config.buildSessionFactory();

Configuration 524 config 4 AT RCE (S B, #i& SessionFactory 24334,
SessionFactory — H it 5e 5, B TR E ECERA R . MtEul, 25 config M
AT AR SR R 2 i 1] LB 21K SessionFactory 5249 (sessionFactory). 1S 2
LT Msh a1 config 5245t SessionFactory, 5% M config HFik)E—14
SessionFactory 524 .

Session ==> %4 JDBC H'[f) Connection
Session SZfif it SessionFactory S i) g«
Session session = sessionFactory.openSession();

SERER B

110, JNZRIEC & FoRsh4%, 2B Session 1) (A4 T###io# DriverManager)
Configuration config = new Configuration().configure();
SessionFactory sessionFactory = config.buildSessionFactory();

II'1. 4T7F session

Session session = sessionFactory.openSession();

Il 2. ¥7FF 955 (Transaction)

org.hibernate.Transaction tran = session.beginTransaction();

I1'3. AR SRR

User bean = new User();

II4. 4 bean WH{H

bean.setUsername("zhangsan™);

I1'5. DRAF B HEHT OF BT L RIVRAF 2K

session.save(bean);

I1'6. $RAT R 55 (FLAE H DR AT B 8T i aim)

tran.commit();

117, sy, Ee0Ed A T 4
String queryString = "from User";// HSQL £ 4F [f & 54k, AL Edh A £ k%
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Query query = getSession().createQuery(queryString);
I1'8. AT )45 R
java.util.List<User> result = query.list();

4. Transaction 4%
Hibernate /& JDBC W aHER, ASHARKHSEIRT . /HS5EHE,
Hibernate ¥ H.ZS4E45 58 2 ¢ IDBC 8 JTA,  DASEHLS 4545 BRI Th BE .
Hibernate [{ERiA 455 ALFEHLAISL T JDBC Transaction. A1 n) DAIE it i & S & K
ITA 1N 455 5 BRI«

<property name="hibernate.transaction.factory_class">
net.sf.hibernate.transaction.JTATransactionFactory
<!I--net.sf.hibernate.transaction.JDBCTransactionFactory-->
</property>

K55 M4ty IDBC HEATARFIICRE /L i ] #5273, Hibernate %I~ JDBC

155 ) e Ak ] R
AR I B -

session = sessionFactory.openSession();

Transaction tx = session.beginTransaction();

tx.commit();
M IDBC i, LA SEpr L R

Connection dbconn = getConnection();

dbconn.setAutoCommit(false);

dbconn.commit();
MERX A, Hibernate JF AT ML 2 s (SEbr EWBOEMCEZ 4, K
FERIXFE ) IDBC ALY REAT T B E .

5. fifX% Query(Hibernate 7% SCRY[1 2 11 %) Fl HSQL
e A ) bR

WSEIN AR 2T PreparedStatement)

g = session.createQuery("from User u where u.name= :name");
g.setString("name”, "7k =");

g = session.createQuery("from User u where u.name= ?");
g.setString(0, "5k =");

Native SQL 77 =C(H -5 1 1 250405 e 1) 25 1)
List cats=session.createSQLQuery(
"SELECT {cat.*} FROM CAT {cat} WHERE ROWNUM<10",

cat”,
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Cat.class

).list();

Listcat s=session.createSQLQuery(

"SELECT {cat}.ID AS {cat.id}, {cat}.SEX AS {cat.sex},"+
"{cat}.MATE AS{cat.mate}, {cat}. SUBCLASSAS {cat.class},..."+
"FROM CAT {cat} WHERE ROWNUM<10",

"cat",

Cat.class

).list();

R E R sk
select distinct cat.name from Cat cat
6. X%, ZX—, ZXZHHMEINE Lazy, Fetch
B Hibernate 7EALEE Session [FIHix E2 N E T RER INZALH, HAFEEIERAES
P PEERAE IS g, A o5 ECHE P it SR IUES I . 3K 25 >R i .
B an—xJ %
<set
name="addresses"
table="t_address"
lazy="false"
inverse="false"
cascade="all"

<one-to-many
class="org.hibernate.sample. TAddress"
/>
</set>
ZENEAMLS
Query g = getSession().createQuery("from User");
List userList = q.list();
TUser user =(TUser)userList.get(0);
System.out.printin("User name => "+user.getName());
Set hset = user.getAddresses();
session.close();//>% 4] Session
TAddress addr = (TAddress)hset.toArray()[0];
System.out.printin(addr.getAddress());

IBAT I

LazylnitializationException - Failed to lazily initialize a collection - no session or session
was closed

WERBA TR EE, ¥4 session.close RIS A 2, WA 2 R AR IXFE 1) 1) /. (H & — M DAO
PATET A FEICH] T session.

EEMWEE, HARNER N user XN address I, Hibernate 74 i &l i i

session MEH B N g s br i EE 5, i BT IRATEEL address 2T VA K T
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session, FrLAili session & 5% A fRAR % .
filt e i
1) Hibernate.initialize 77 3% n] LU it 5 il N2 IR S SE X — Dl fig:

Hibernate.initialize(user.getAddresses());
session.close();
2) /i HQL HlHi[ fetch

from User fetch all properties
3) lazy="false"

7. Hibernate 437

int currentPage = 0;// 47 i

int pageSize = 10;// T~id k%

String queryString = "from User";

Query gueryObject = getSession().createQuery(queryString);
11 V2B WS L5

gueryObiject.setFirstResult((currentPage - 1) * pageSize);

I B I8 UT

gueryObiject.setMaxResults(pageSize);

return queryObiject.list();

7.3 WEETAE

AT T My SQLEHE 2, 155 % MySQL 5 B FE AR 55 g R4, e fiiatr (]
PB) TN BT E BIMySQLEHE i LL KRR I 1) IDBCHK Bljjar LA

A A E ] MyEclipse Derby Hu#i eS¢ X ANgR 2], Foe R0 0L A0 e B g
SERIX AN 6

T2 i S o FIMySQUEH P (1345 e — 15 1) N AR 4 — A mysql5 %z 4
SRS R s A T L, B ST O N (R T LA T .

HE: W HMyEclipse Database Explorerss BB R FEX — 2= (N 28, 75 WA
(I PRSHE T R Th AR Joidh AT -

7.4 68 HibernateDemo T H

X4k T A4 HibernateDemo fTR B Java i H (IR FE, X ANI0 H A
A Hibernate SRORAF2EAAS BB — A BB s FE RS b o BRI A 22 B0l 1) 1) 24 B 1 0 A
FANE O R A BRI T A B, A TSRS I 219'E Java HE X SR SO
AR LA B

7.4.1 BB RK

3

M

5% 50 b T QA 2R R 1) AR I H P g B (A5 T MySQLEHE
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JE A Derby B A A5 ISQLIE 1)), X LA H RMySQLEE L I SQLIE 11

CREATE TABLE Student (
id int NOT NULL auto_increment,
username varchar(200) NOT NULL,
password varchar(20) NOT NULL,
age int,
PRIMARY KEY (id)
) ENGINE=MyISAM DEFAULT CHARSET=GBK

7.4.2 f]& HibernateDemo Java Project

FATSE kA — AN (4 4 HibernateDemo 1) Java TiH, XxANUH 8IS A $dE 3|
Student ¥ FE %

1. M MyEclipse 3ZHF%ik$¢ File > New > Project > Java Project, ##%4337JF New
Java Project [f]4F.
#i\ HibernateDemo %/ Project name
3. 7t Project Layout Ti%EH Create separate source and output folders HLi%4] .
4. P Finish RSEREXAN L, W F EIFR:
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7.1 % HibernateDemo i H

HE: WAl LLAE Web Project 2, Hibernate n LLZINE LB 28 Java JiH .
7.4.3 %50 Hibernate Capabilities Z|IAE TN H

AL HibernateDemo 1l H & fild, SRJEtn] LIS N MyEclipse Hibernate Ujfig %
EANTH o AP R AT a0 B AE

e NN Hibernate 25 (JARs) FIIiH k12

o {ELIHTAIEHECE hibernate.cfg.xml

o {ENIH®AIEE A% X Session Factory 25k fijfl Hibernate £xifiAb#f
PG H YN Hibernate DiRE, TH 4N 01K BRIEAT

1. /£ Package Explorer Hik#¢ HibernateDemo i H

2. ¥ Fk, M MyEclipse ¢ H¥.£:1%E# MyEclipse > Project Capabilities > Add

Hibernate Capabilities ... K53} Add Hibernate Capabilities 7], @1 FEKs:

107 U =



MyEclipse 6 Java JT&H SCHFE

7.2 JA4hs N Hibernate Capabilities 1]
B Kot Add Hibernate Capabilities % iEHE, 1R K Fis:

7.3 Add Hibernate Capabilities [a] 3% iH HE
3. fi&¥F Hibernate Specification 77l HL L% Hibernate 3.1 AR, X—PREIEH
Hibernate J5 % (1 hAS .
4. EPRIRTFEMNRIEES, XA RHIH Core KIELWE T .
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5. fr¥F Add checked Libraries to project build-path %
7t Add Hibernate Capabilities XiHHEF, A ADIED, A2 KA LRI B a1~ R FTR:

HETR

iR

Hibernate Specification

BRINEIH B Hibernate AAS S FFIhRE. A T I KR
FERFI MyEclipse Hibernate T H., #%7 Hibernate 3.1.

MyEclipse/User Libraries

A LA I EIR A0 H R AR R AR

Add checked
project build-path

Libraries to

P ISR SN B ORI H G B AR R, (EGE AR 1)
JAR SRR Aer BRI H . XL JAR U #5
o AERARE PN BB, R A s 5

Copy checked Library Jars to
project folder and add to
build-path

ISR JAR SCAFRE S I RIUR K I H JF AN £k i&
EAEh 2 GG AT R AMKAS T MyEclipse (X H 1
{5, B IAR AL SN ARARAT HID

Library Folder

KA [T I 1 ]
X TFELEDH B2, TRl scE A H ok,
Hibernate Z5ZE44 24k ) 3 & 10X B

# 7.1 Add Hibernate Capabilities ] 5 - %5 1 Tk K
6. 1%+% Next 4 ATHER] R — 7T, X —TUK 75 Create Hibernate XML configuration file
XA S, W6 Hibernate XML BR & S04, i N B Ts:

K 7.4 f% Hibernate XML fic & S0
I B I AR R BRI B AR S S Next $&41 st B T o S sk tun 5 DL T A7 78 1)
Hibernate fic & SCAF 15, 1) LL A ik Existing k)5 B Hibernate Fid & SC A1

HARRDET, SRS Rl Next #24H

7.8 P RE oRIESE Hibernate JT A8 H] (1 A EE R IRAEHE, Wik B B

109
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Wl 7.5 SRR PR (R TR AE

wiiti DB Driver A3 B A Hiis FEIE A2, 1B £ LLT g i i £ s 4240 - mysql5,
XI5 AH OC (P IEFAE DR 2 BB A BIRHEHES, XN 1) Hibernate J7 & 23 Uk £ i

(Dialect A MK FHr41) 2 0] Lk —Fh Hibernate T SZRFI 75D, 248Kt m) DA 4 15 1l
T Hx s NAEK) M . R IEHE Copy DB driver jar(s) to project and add to buildpath?
e 5 2s B S0 AAH . ) B PEIR BN S8 12 jar SR 21T H 2R AR . 25 s Next #%
FHRpAT .
R W ARA R A w8 B PR 4 JE 1k, 2244 Specify database connection details?
I THI (1) 52 e A R AT Bk ot
¥ Z: Enable dynamic DB table creation SiEHEQIREH, HB4 Hibernate Hf<x H A
Wb SO R BN A AR SRR B R AR G AT, AR Rl O VEA AR v 5, BT DA — Mok Ul AN ZEH] .

8. IXHHEkF ] TG — L, B —A4 SessionFactory. 7EiX— 4l Java package
ar NHEAT M e A D ) New .. FZHEROIE—/M, TATIXF4A dao, #RJ5 s Finish 444
RITT

HE: X EW R ER, WRRAEDUE & B A E e, 24 Create
SessionFactory class? ij [ ff) & EAHE R T Bk ¥ & I H 42 5t Finish 4241 52 il m) 5o

FHIESE LR FrR
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] 7.6 G4 SessionFactory X i fE

XA ) S5 AR E ARG REAT R I ERAE -

WRAESE — DU % 7 BHIRERIRIUH, ¥ 5E% Hibernate 284 (JARs) F3i H
SR H MR I B AR AL S %234 Hibernate 284

AT H AN IFACE hibernate.cfg.xml SC{:

I H Al — AN A X SessionFactory 28 (#4141 HibernateSessionFactory) K
faifk Hibernate [I<xifkbEE,

7.4.4 fEH] Hibernate FL B XX 4mE S O

111

/)7, MyEclipse < H#)#1JF hibernate.cfg.xml 4i#E#%, W ~EPiR:
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B 7.7 18 545K 5 i AL hibernate.cfg.xml 4 2%

] LLF = 2 S hibernate.cfg.xml AL T —ANNL X, FREIEASSCHH I 78R, X
&R F I MySQL #d: 4 JIDBC 1) URL Hbtik BUHIAL S T —AN&FRF, XA ERFE XML
TN % &amp; I CERF IR 700 E o DI ERATTEEAE URL A5 ¥ 4 AHE N BTN T T
o
jdbc:mysql://localhost:3306/test?useUnicode=true&amp;characterEncoding=GBK
s 5 R PR I AN R R AT

HE: AT AR S, N E0E XML B IR R AT a2 A

Hibernate fic & SCAFgwf a5 045 —/Mr28 0l Configuration, Design #1 Source. 7t
Configuration #2582 Hibernate MIACE (5 E . ZEXAMR2E fith Properties 415
M Add.. 34807 LA InFr i @ s B, M Edit... #40aT DUE O @ R,
Remove %41 AT DU ik b ) J@ PEfE B 10 Mappings 41 5L U AT LAY Hibernate 5%
PRI ST B AT 62 il DB Driver Al (134 32 1) 3¢ n] DA TR 7 ¥ B 0 34 402 31 g A
B2 10 Driver A5 % AHEN AT LATE 2 IDBC WK sh 272544, URL WA LASE SOE £z
Ik, Username JImT DLSE s 420K P 44, Password & 150% 5, Dialect A7l ]
WEHER LU %075, #iili Copy JDBC Driver and add to classpath 4% ) n] LUK 8K 5
Fhn 2|1 H 2% 4% . Design Fil Source NJE W/ MRCE SCAYEIS . 7]7E Source Fr%s
NEBAN RN, AR T T O SO AT g, T i S e (S
N CHRIE N

<?xml version="1.0" encoding="UTF-8"7>
<IDOCTYPE hibernate-configuration PUBLIC
""'-//Hibernate/Hibernate Configuration DTD 3.0//EN"

"http://hibernate.sourceforge.net/hibernate-configuration-3.0.dtd">

<I-- Generated by MyEclipse Hibernate Tools. -——>
<hibernate-configuration>

<session-factory>

<\-- BEEH SQL, @Fi -->

<property name="show_sql">true</property>

<property name=''connection.username'>root</property>

<property
name=""connection.url">jdbc:mysql://localhost:3306/test?useUnicode=tru
e&amp;amp;characterEncoding=GBK</property>

<property
name=""dialect'>org.hibernate.dialect_MySQLDialect</property>

<property name="myeclipse.connection.profile'">mysql5</property>

<property
name=""connection.driver_class'">com.mysql. jdbc.Driver</property>

</session-factory>
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|</hibernate—configuration>

7.4.5 {FH & [ TREHGE A R Java POJO 28, B SC4ER DAO

RiE##EFE: DAO /& Data Access Object, i X 41145 . POJO /& Plain and
Old Java Object, il F11H X ] Java MR M40 5, a5l Java K& . 17 Java
TER I 23 4 B & LS FE 46 5 1]

M TP REBZXENRNEART KR, RATCLE NS TRZ WA 8 F Rt
NN RSy A S A A Aets 2 FEARE ZEA BV 1 Java 28, Hibernate U 3¢
fF, 23847 DAO .

7, 44T JFMyEclipse Database ExplorersBE LKl . )i w0 A B Rl Ip%, i
PIE 5% B (Perspective) V)figs. — LB IMEZ IR —T5 A1), St TR

B2 Rt A T DL SR 2 ANE L e, WK 3.3 R, U5 LT My Eclipse

Database Explorer R A {14 2|t K s o5 Mrdpidid e H€ . Window > Open
Perspective > Other > MyEclipse Database Explorer X & /~§] T X IGHE, SR )5 A
THOKH%Z4 .

Bk DB Browser fLEHLE L —15 i A Hibernate Bt AL (1 84k
PERERE, i IF R T B L O BOIR R 4540, B BE BIURA S AL B R s R 1k, Fiids
K. ER: RATLUEP G A2 AN ER . AEIX M R IR 2 Student.
P i A AR R e b £ Hibernate Reverse Engineering..., X ¥ 8 8
Hibernate Reverse Engineering [ 5. 41 FEfiR:

K 7.8 7r DB Browser KA sl m LRE S
2 JG R Eh) Hibernate Reverse Engineering [i] 501~ & s :
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K] 7.9 Hibernate Reverse Engineering [1] 3 2 1 71
mithi 1 4bf) Java src folder s A4 fllff) Browse #4411, & ] ) Hibernate I H LL
SRS H s, X8 H S50k R A BUR 2 AR )R S . XLk HibernateDemo 1t H H1 (1)
src XAk,
fithi 2 4bf%) Java package % AHEA M) Browse #4, % dao 3, g Hrd—4
L VR AR TR AR P 7R PR
¥ 3 PSRN b, IXFER O A 2 R R AR G Hibernate B S SC A
(*.hbm.xmD), 4 hibernate.cfg.xml =55 A= B s SCAE I
7 4 ik %HE Java Data Object (POJO <> DB Table), XA AW S Fgsk
A2 O X % (POJO).
FE M RIE T 5 Ab RIS IEHE, XA AE AR G E 1) DAO K.
HE: A Hibernate 3 A R4 BLAE 115 i) LG Ji5 (1) S 1R E5c s 1 1) 5 5
HE: Spring DAO XA FRIEHLE A, Witk ay H N §EAE sk Spring+Hibernate [¥) DAO
(HibernateTemplate), 4] 2 X # (1) DAO 7E LA & /44
BJa. N T, BT Finish fdatn] DL AR I 2R il R miai JL R B
br, BT Hibernate SEARZE, WU SCE, A KTTE T2 NS U1 2] MyEclipse
Java Enterprise ZE LI 543 2045 K.
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7.10 |15 H AR Hibernate ZATm g S 4
W 2 T AT E O 1 AR S L 5 HibernateSessionFactory ,  StudentDAO ,
Student.hbm.xml, i1 Student. X822 [l R0 K TR .

Kl 7.11 A5 Hibernate A5 a] i) 5% 5
R XL LT A O T ZR I — D IR RIE S, A2 XS Hibernate 1R T ##.
HibernateSessionFactory /& — /3K H( Hibernate <xiG 0 L) 2%, &4 A3 n#k
Hibernate (K. E A, ARG EE & RE (thread-local) A8 8K &S L ar it . 1k
i LT EL ] getSession() it 1T LA3k fH—4~ Session %1%, ] closeSession() 5%
P 24 B 2R A AH S A Session A%, AU AR
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package dao;

import org.hibernate.HibernateException;
import org.hibernate.Session;
import org.hibernate.cfg.Configuration;

/**

* Configures and provides access to Hibernate sessions, tied to the
* current thread of execution. Follows the Thread Local Session

* pattern, see {@link http://hibernate.org/42_html }.

*/

public class HibernateSessionFactory {

/**

* Location of hibernate.cfg.xml file.

* Location should be on the classpath as Hibernate uses

* #resourceAsStream style lookup for its configuration file.

* The default classpath location of the hibernate config file is

* in the default package. Use #setConfigFile() to update

* the location of the configuration file for the current session.

*/

private static String CONFIG_FILE_LOCATION = "/hibernate.cfg.xml";

private static final ThreadLocal<Session> threadLocal = new
ThreadLocal<Session>();

private static Configuration configuration = new Configuration();

private static org.hibernate.SessionFactory sessionFactory;

private static String configFile = CONFIG_FILE LOCATION;

static {
try {
configuration.configure(configFile);
sessionFactory = configuration.buildSessionFactory();
} catch (Exception e) {
System.err
-printIn("%%%% Error Creating SessionFactory %%%%'");
e.printStackTrace();

}
}

private HibernateSessionFactory() {

}

/**
* Returns the ThreadLocal Session instance. Lazy initialize
* the <code>SessionFactory</code> if needed.

116 KA




MyEclipse 6 Java JT&H SCHFE

*

* Session
* HibernateException
*/

public static Session getSession() throws HibernateException {
Session session = (Session) threadlLocal.get();

iT (session == null || !session.isOpen()) {
iT (sessionFactory == null) {
rebuildSessionFactory();
by
session = (sessionFactory != null) ?
sessionFactory.openSession()
null;
threadLocal .set(session);
}
return session;
}
/~k~k

* Rebuild hibernate session factory
*
*/
public static void rebuildSessionFactory() {
try {
configuration.configure(configFile);
sessionFactory = configuration.buildSessionFactory();
} catch (Exception e) {
System.err
.printIn("%%%% Error Creating SessionFactory %%%%');
e.printStackTrace();

/**

* Close the single hibernate session instance.

*

* HibernateException

*/

public static void closeSession() throws HibernateException {
Session session = (Session) threadLocal.get();
threadLocal .set(null);
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if (session = null) {
session.close();

}

/**

* return session factory

*

*/

public static org.hibernate.SessionFactory getSessionFactory() {
return sessionFactory;

/**

* return session factory

*

* session factory will be rebuilded in the next call

*/

public static void setConfigFile(String configFile) {
HibernateSessionFactory.configFile = configFile;
sessionFactory = null;

}

/**

* return hibernate configuration

*

*/

public static Configuration getConfiguration() {
return configuration;

IBaseHibernateDAO & LT —AM:11, HIskw X3REL Session X G HHAE. Wi kT

N

package dao;

import org.hibernate._Session;

/**

* Data access interface for domain model
* MyEclipse Persistence Tools
*/

public interface IBaseHibernateDAO {
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public Session getSession();

}

BaseHibernateDAO W52 T x4, {#/] HibernateSessionFactory K341 .
F R ACHY R, XML (domain mode) i I IR V5 iR %% (DAO).
AU F/Z, HAM Spring, Hibernate S5 FJAESE LG, HILT &F 2 HE K4S AT
fift eI 21, AN A -« - S TR AR RS — 4% Java K.

package dao;

import org.hibernate._Session;

J**
* Data access object (DAO) for domain model

* @author MyEclipse Persistence Tools

*/

public class BaseHibernateDAO implements IBaseHibernateDAO {

public Session getSession() {
return HibernateSessionFactory.getSession();

K StudentDAO W 4k/& T LI HE I, JFSEBL T4 Student SEAASR K139 I 2 2 i 5%
A CLECE A Y eORBEAT A, T f g S UM O . AR K s

package dao;

import java.util_List;

import org.apache.commons.logging.Log;

import org.apache.commons.logging.LogFactory;
import org.hibernate.LockMode;

import org.-hibernate.Query;

import org.-hibernate.criterion_Example;

/**

* A data access object (DAO) providing persistence and search support
for

* Student entities. Transaction control of the save(), update() and
delete()

* operations can directly support Spring container-managed transactions
or they

* can be augmented to handle user-managed Spring transactions. Each of
these

* methods provides additional information for how to configure it for
the
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* desired type of transaction control.

*

* dao.Student
* MyEclipse Persistence Tools
*/

public class StudentDAO extends BaseHibernateDAO {
private static final Log log = LogFactory.getLog(StudentDAO.class);
// property constants
public static final String USERNAME 'username';
public static final String PASSWORD password™;
public static final String AGE = "age';

public void save(Student transientlnstance) {

log.debug(‘'saving Student instance');

try {
getSession() .save(transientinstance);
log.debug(''save successful'™);

} catch (RuntimeException re) {
log.error('save failed", re);
throw re;

public void delete(Student persistentlnstance) {

log.debug(‘'deleting Student instance');

try {
getSession() .delete(persistentinstance);
log.debug(‘'delete successful™);

} catch (RuntimeException re) {
log.error('delete failed", re);
throw re;

public Student findByld(java.lang.Integer id) {
log.debug(‘'getting Student instance with id: " + id);

try {
Student instance = (Student) getSession().get("'dao.Student",

return instance;

} catch (RuntimeException re) {
log.error('get failed", re);
throw re;
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public List findByExample(Student instance) {
log.debug("'finding Student instance by example'™);
try {
List results =
getSession() .createCriteria('dao.Student'™) .add(
Example.create(instance)).list();
log.debug("'find by example successful, result size: "
+ results.size());
return results;
} catch (RuntimeException re) {
log.error("'find by example failed"”, re);
throw re;

public List findByProperty(String propertyName, Object value) {
log.debug(*'finding Student instance with property: " +
propertyName

+ ", value: " + value);
try {
String queryString = "from Student as model where model."
+ propertyName + "= ?';

Query queryObject = getSession().createQuery(queryString);
queryObject.setParameter(0, value);
return queryObject._list();
} catch (RuntimeException re) {
log.error("'find by property name failed", re);
throw re;

public List findByUsername(Object username) {
return findByProperty(USERNAME, username);

public List findByPassword(Object password) {
return findByProperty(PASSWORD, password);

public List findByAge(Object age) {
return findByProperty(AGE, age);
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public List findAII {

log.debug(*'finding all Student instances');

try {
String queryString = "from Student';
Query queryObject = getSession().createQuery(queryString);
return queryObject._list();

} catch (RuntimeException re) {
log.error("'find all failed”, re);
throw re;

public Student merge(Student detachedlnstance) {

log.debug("'merging Student instance™);

try {
Student result = (Student)

getSession() -merge(detachedlnstance);

log.debug(''merge successful™);
return result;

} catch (RuntimeException re) {
log.error("'merge failed", re);
throw re;

public void attachDirty(Student instance) {
log.debug(“'attaching dirty Student instance™);
try {
getSession() .saveOrUpdate(instance);
log.debug(“'attach successful™);
} catch (RuntimeException re) {
log.error('attach failed", re);
throw re;

public void attachClean(Student instance) {
log.debug(“'attaching clean Student instance');
try {
getSession().lock(instance, LockMode.NONE);
log.debug(''attach successful'™);
} catch (RuntimeException re) {
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log.error('attach failed", re);
throw re;

B, ATUAE BB R SE 4K Student, ACRSAITR BToR

package dao;

/**
* Student entity.

*

* MyEclipse Persistence Tools
*/

public class Student implements java.io.Serializable {
// Fields

private Integer id;
private String username;
private String password;
private Integer age;

// Constructors

/** default constructor */
public Student() {
3

/** minimal constructor */

public Student(Integer id, String username, String password) {
this.id = id;
this.username = username;

this.password = password;

/** full constructor */
public Student(Integer id, String username, String password, Integer
age) {
this.id = id;
this.username

username;

this.password
this.age = age;

password;
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// Property accessors
public Integer getld() {

return this.id;

public void setld(Integer id) {
this.id = id;

public String getUsername() {
return this.username;

public void setUsername(String username) {
this.username = username;

public String getPassword() {
return this._password;

public void setPassword(String password) {
this.password = password;

public Integer getAge() {
return this.age;

public void setAge(Integer age) {
this.age = age;

THHNEAT — AL AR SO Student.hbm.xml, AURSAE T 5.

7.4.6 ALK hbm S48

WERBATFTIF Student.hbm.xml, AT LA 2 MyEclipse 1) HBM SCHFgnf sy, s
Source Fr%8 i 1] LU B SCHIIEARAS, a0 N RS B TR

<?xml version="1.0" encoding="utf-8"?>
<IDOCTYPE hibernate-mapping PUBLIC "-//Hibernate/Hibernate Mapping DTD 3.0//EN"
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"http://hibernate.sourceforge.net/hibernate-mapping-3.0.dtd">
<l--
Mapping file autogenerated by MyEclipse Persistence Tools
->
<hibernate-mapping>
<class name="dao.Student" table="student" catalog="test">
<id name="id" type="java.lang.Integer">
<column name="id" />
kkgenerator class="assigned" /3]
</id>
<property name="username" type="java.lang.String">
<column name="username" length="200" not-null="true" />
</property>
<property name="password" type="java.lang.String">
<column name="password" length="20" not-null="true" />
</property>
<property name="age" type="java.lang.Integer">
<column name="age" />
</property>
</class>
</hibernate-mapping>

M EBAUS T E ) — 7, ot FRA RS, BUAREMR{E (assigned), HifE
FTE AT R ik b2 5 A8 HEA TR K increment CELHY, XA oA Il % S B MBI 122 3
SRR K 1D AR5 + 1 A R, i b (R I HERE AR 1) P9 25 SOt T BT s

<generator class="increment" />

XA ) Hibernate AR #R A IE 58 T -
7.4.7 W5 NAE
5, B — AN () Java Gl SE iFile > New > Class ki —1 2K, % 2.3 i
iE47

HEclipse/MyEclipse4i s, Zmiifiafrdavafi/s) Kl Lk 48, ARDiE 5
PR

import org.hibernate.Transaction;
import dao.*;

/**

* Hibernate DAO [R5,

* @author BeanSoft

*/

public class HibernateDAOTest {

public static void main(String[] args) {
/7 2%tk DAO
StudentDAO dao = new StudentDAOQ);
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/7 FIFS

Transaction tran = dao.getSession().beginTransaction();
/7 EREE Java K

Student bean = new Student();
/7 WEEN
bean.setUsername("'ik—=");
bean.setPassword(''1234');
bean.setAge(100);

/7 FEANEHE

dao.save(bean);

1/ RAHS

tran.commit();

/7 K
Java.util _List<Student> results = dao.findAII();

/7 FIHFIER A AT Hs

for(Student o : results) {
System.out.printIn("45:" + o.getld());
System.out.printIn("#%:4 :""+ o.getUsername());

}

dao.getSession().close();

}

ARG PRS2 Run > Run 303% dioh T A L@ kx4, #41 Console #MLEH
R .

log4j:WARN No appenders could be found for logger (org.hibernate.cfg.Environment).
log4j:WARN Please initialize the log4j system properly.

Hibernate: select max(id) from student

Hibernate: insert into test.student (username, password, age, id) values (?, ?, ?, ?)
Hibernate: select studentO_.id as id0_, student0_.username as usernameO_,
student0_.password as password0_, student0_.age as age0_ from test.student studentO_
%i5:1

g F A

%5 :2

k44U

%i'5:3

P4k =

. ZJGI I LI{E MyEclipse Database Explorer i#E#1 €[] Table/Object Info ¥/ ik
Preview #7325 2l A MEHE, N EIFTs:
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7.12 KA s A R il %

7.5 MyEclipse Hibernate T B & H R4

7E L1 ORISR 28 KR A T anfel Peisi 58 1% Hibernate I HH IR &« SR 1
LESEBRE I & B B AR R R, Blhn—Xt 242555, MyEclipse 132 FEIX R 5L IAR
AR IR T G S 2H Ess e N 7Y, B HE & WL ¢ R A H HSQL gnf &5 .

7.5.1 kM TEMNSHEERHA

Rl

M2 K 7.9 Hibernate Reverse Engineering [i15 25 1 504N A0 16 1 -

IR

Eitipy

Java src folder

e L SO/, POJO Al DAO A2 B JITAE I 30 H SRS SOk

Java package

Wikt e, POJO 1 DAO A i T 7 (.

Hibernate mapping file

NI PR RS PE USSP

Update hibernate
configuration

B A i E B SC RS g Hibernate 1 & SCA .

Java Data Object

DN SRS SCA R AR A Ons I ) Bl il % (POJO).

Create abstract class

BB R G B MR AR, IXAN SR IR A LU (¥ 8
JROE R s, (ERR N TR AN S B

Base persistence | W FFE MG, BIANLBE POJO e it S 5e 144 F5R.
class

Java Data Access | AT il BRI S RIS B Uy et 4. H P el LAYE Basic,
Object Spring 1 JNDI DAO kb,

Generate precise | KWL R RN JE AL > “findBy" J7iA.

findBy methods

fi4n findByFirstName("name");

Use custom templates

i MyEclipse M velocity BERRCA AR H CUFIRRA.
22 MyEclipse H a7 135 B SCRY A 1) Iy 25k 3R I 245 B

Template directory

LT A OB SRR AR Y

% 7-2 Hibernate Reverse Engineering 1] 5 % 1 71

SN

FERTSCIIA-FL R B Finish JEUSE R T 175, sEBs L Next 42114 nr DLk
P 2 TUABEE, W NEFTR:
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7.13 Hibernate Reverse Engineering [1] 5 % 2 11

X U SR B B DS MG I 40 1 A R, AR S, A RS 20 2 IR AR AE,
—BOR UL LB ATEL T, PR B R s

IR

Rev-eng settings
file

Custom rev-eng
strategy

Type Mapping

ID Generator

128

Eiiipay

AR T R TR E AL LI LUSAEH]. Rl Setup... ##K
PRI I SO A B AT I SO
URARAS B — AN IZAE R RC B S 1 K2 B 3 A B3O

FEVFIRTEE A F 2 R R ) TRESRIE R, XA R AVFHR TR 7 50k A
S8 SRR TREAC B R AN 5. 27 (] B SR ) TR SR SKFRHK
TR,

Y AR E R Java 5# Hibernate 287, 51 4n
java.lang.String XfMV. string. XA E X AL T4 3 ) Customized
Type Mappings #I& ¥ A 5w B 205 B A gefd .

ID Generator J& Hibernate Wi SCAF LA N NA. ©E T FEAISSEHIH)
ME— 3 HE A Jaav K. &% 7.7 200 4 B Hibernate SCFY
R, WA TR ID BRSNS .

R BN EAXA SRS 3 WKAFAE, Hibernate Bt
512K BB A IRIEFE A ID AR,
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Generate basic
typed composite
IDs

Generate version
and timestamp
tags

Customized Type
Mappings

WERERERAS S A 2N L8, B a2l <RaE:a> mal

QSR AN RIS B 5 ELAT X 1K 2 N ANEE, B TS BAAR Sl 1 i
K" #xiE (string, long, %5), MAZSIHB—ASLk. Boo)g
<many-to-one> JGiz, HZEA TS Frid A En] SHrA9E T 46 A 1) B

QT SRAREE Y IX AN IR T (BR AR XA 7 20), = f)d <key-many-to-one>
TG FRAREE L1 ) A e P 2%

WA, %o "version" Fl “timestamp" 71452 1E A Rl 1 S SO AR

Jy <version> Fll <timestamp> #ric HHIL.

FVFIRRSRE —A HE X IJDBC %% Hibernate JEB 14, i
Length, Scale, Precision Fl1 Nullability A% &z #i%f B 7k (1) JDBC 2%

2% 7-3 Hibernate Reverse Engineering 1] %5 2 51 2% 9]
o TEIX—TUHHT R E 5 sl Next v Ak 25 f5— 00, B R I TREMPE S B . Wi

7.14 iR,

PR 2E iy 1 T b K AR T 24T i 2 ) TRE R o

2 HEFP I AN SEHE U i 7 2 15 35 5 H BXASRAILAS R G I ER, WA A
SCREAMEEIILE, HICIHIRM 2 B BLAE L HE . B2, MySQL IEASIRpAMEE, B
IR SCFrAMEE ) MyEclipse Derby, & AN RIEHE G, AHOCIC ARt B 3 HOLAE 1
HErR T, SRR AT LA 3 2 IR ARAS T

3 HE F PR U A DR IER 21024 i A (10 R IPRR P 1 AR e i) TR I ) A o

AHER U B T A 5 SO ) TR RE ) — S840 1 A A

KT TARKIES R UUZHE 7-4,
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o

7.14 Hibernate Reverse Engineering [i]5 % 3 71T

HETR

ik

Class name

ORI 224 TR P A (K0 B 0 S 2RI
LR

ID Generator

ARBN YT R P A ID A pids.

JDBC type

X ET AT JDBC A4 .

Property name

X 28 BT A R JE A

Hibernate type

SN 4 HTAI Hibernate 287,

Include referenced / referencing tables

AL BT TRE I TS R R S T &
A% LR e 5 21225 1 3R 1 2 7 K

Generate support for ListedTable(fk)->Unlisted Table
and UnlistedTable(fk)->ListedTable

A AR RIBR 1) 24 HIT A TR IR 1) 1 A S
) R (AR, X AT 22 i T L DI
AR

7% 7-4 Hibernate Reverse Engineering [1] 3 % 3 71 S8 ]
B TANAHNE, AR CLIEAT — X 22 R0 22 %) 22 B Wit SO AR T s
R o B SR AN A T DUEAT IR IR SR SR AR i, 81l G ] Derby i1 Oracle
AL, H MySQL 5.0 ANAT BL A B4 sl— Xt 2 853 2 6 2 1) Hibernate 4865,

7.5.2 {f/ HOL ZR%E 38

MyEclipse fu7 T —4 Hibernate #ifik 5 gt LA LA, RVFRIRYE 24011

Hibernate A& KT HQL EifjiEf].
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ThRE R IE:

o ANHEAZNTHIER.

e Hibernate Dynamic Query Translator 7Er N\ HSQL Zr it i 2 A §i 3 o 1
SQL iEf).

e Hibernate Query Results MK LIEH 2/ Ailigh B4R, 45 R0 JE T 2R
Properties #iLIA].

e Query Parameters #i K] LAR T KP4 T 5 A7 2 201 A ).

o I H kPR FRVFRREI D)3 AR ) Hibernate T H ) Hibernate fii &

T, T ES IFMyEclipse HibernateiZ i . VB A PRI IME, Wi )4k
5% HE (Perspective) VJgs.

PNk A 5 7 Package Explorer W) HibernateDemo JiiH, & b FCsEsrhik
H1 MyEclipse > Open HQL Editor..., BIW[$TJF HSQL #ufHds. Witz {4 by 2
MyEclipse Hibernate i#LK], 4B &R Ul H#IELIE .

R HQL e asth n 7EXGE 5400 hal BSCAFIHT T

7.15 777 HQL %miH2s
P28 )5, Blalf N HOL BRI T AW, W K KT R:
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K 7.16 HQL %’ 2% L1
EPAT HQL wEA), mLLfieh T HEA LHATIZEL. T A48 10 REPR AR5 B 8l 58 ik
hRE, W FEPTR:

7.17 HQL AU | 3hidr
FER: WARARTE HSQL JwlH-as Jridk vh I H A 518 0 T ICE, Wi SOl £ 28,
AN RN T AL 1 Refresh SN2k L1 4o 6 P S5 HO T 025 4
714k Query Parameters LK W] LLAT H 28011 HQL i54), W1 Bl Fs:

7.18 TS AU HQL £ ifi
XA LAFE B HQL Zwik 25 M DI REMI A & 3R 5 K10, A e T RL 24>, R A
i HOQL.

7.6 /g

AFERBHE T MyEclipse Wil JT & Hibernate N1, 3:M—NMl 1 ITF4h, hfajsas)
HIR MR T4 MyEclipse 71 Hibernate N )i fE . 3 F B Fi 450 Hibernate 4 it
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T, JTREE IR T IR SR T A TR TR BRAREZE 2B NKIER, (HEW LUERER
REERTT AR IR BRI v, BARPLE R AN NSRRI A 02, (ER RO AR 2w
(CEA P

7.7 2R

X AIH T 2 Hibernate A2k .
Hibernate Ky http://www.xiaxin.net/Spring_Dev_Guide.rar (PDF)
iV & 1]
(30
Hibernate Cao http://www.redsaga.com/hibernate-ref/3.2/pdf/hibernate_reference.pdf
hr 2% F | Xiaogang(Hf 238 1, 1.42M (PDF)

it EH) HTML#% 3 http://www.redsaga.com/hibernate-ref/3.2/html/index.html

B ) AR
http://www.redsaga.com/hibernate-ref/3.2/html_single/index.html

Hibernate — %% PPT }% MyEclipse  #: fF M 4 & H
http://www.blogjava.net/beansoft/archive/2007/06/14/124274.html
# % . MyEclipse Hibernate A 1 # 2 ( &% B 4 W M)

http://www.blogjava.net/beansoft/archive/2007/11/13/160288.html
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#HI\E F &K Web NVH

8.1 N4

AW A BT I MyEclipse SKIT & Web 35 H (£33 HTML, JSP, Servlet, Filter
MG & Java 25, JFHTRA, 1817, WA, AFFmd Ik —AMEH JDBC 4T
keI AT RTINS S WNE § 5N [P N1k SN

IS R 137 FH 552 Weeb )3 FHWE 2 a7 B 13 e aok ]9 264 301 Wi 8 9 1B, Firefox 5556 L ME
B4 R ZE M 0T, #JE T Web N VG,  Fr CUE N HE SRR 1. SR — A
Web W, HEJRE Java 2 AMEH), BIEEN T HTML, CSS, JavaScript %
AJAX, Flash, ActiveX ZEHiA. (RIEULIE: = AH3-Lo . P — BN E 21 Hie
SEA B R GURIRE T AACES 5t e e AN P i 0.NET, PHP, JSP, ASP it fi4t4 ROR
1, T DA RAI 2738 2 A6 LE ) (M) 7E Web J2FAR .

REENFZSHEZEMH: http://www.blogjava.net/beansoft/archive/2007/11/19/161502.html
MyEclipse 6 SEiFF & JHFEMAIATT 6 Web N[]FFA - ISP/IHTML/IDBC 3%

8.2 Web I H fIARE

8.2.1 Java EE ) Web i H 454
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8.1 Web N H &5t~ K

%1 Java EE MUEALE, — AN Web N HFE P DUANER 45
ANIFHZ

WEB-INF/web.xml S, RATHGIRMF (biE)

WEB-INF/classes H %, 4% /a1 Java 2 30pf (nfik)
WEB-INF/lib H 3%, Java 8FE 4 (*jar) (Alik)

AW PR

NTF H AT vl LA P 07 il 98U, (46 html, jsp, .gif, .jpg, .css, s, .swf

faray
~FFo

WEB-INF H 32—/ Xk, A medtt H W A8t a 1 . XANHZR T
(S AR AR AT, B S AN A% & T BB FE PR, 0 Serviet(iX L4l (5
IS FH 328 i A B ol A % 05 ks P26 1 mT e 17 1)), Web N HI 2P serviet R ELEZ 17 ) 1)
SCABARART STAT:, AR IR ST #5 T7 384T 5 Al I IR 98 U5 (G Java S8 SCAERIMEE serviet £ 1) JAR 3¢
PF), A& N R AL BRI B ST, R AT RRAF DL L AT T L B SO IR Le B e &
I, B HBE R EATA R Web N R Y LAV F5H, JSP/Serviet 57 3C#F
1 fig L ServletContext 15 f) 2 X A~ H s F ) 3CAF, 6 41 ISP A LAl o
application.getRealPath(“/WEB-INF/web.xml”) 5 il 2 R AT IR TSI E.  Web 25 8%
TORAEARI N A FE R 44204 WEB-INF H 3%

ERE: WERIRA Web W HIRERF R AW SR H X, B ek ik TAE GXRRA
(7] PR Al 55 48 S B DL AR BEANEL — 2, P DA I R LA

WEB-INF H £ & 35 R AT IR SF, —A classes HEf—A lib B3, DLEH T HE,

R A& FF (deployment descriptors) & J2EE Web [ R AN T 431 (1) — 3043 (0l A2 Ut &
ERENRSY, AR ). e IHEN R KA 53 B B Web B FEIP I
BCE . AT Web 23815, RATIRFTZ 440 web.xml (1) XML SCHF, FAi#{E Web [V
R IWEB-INF H3E F.

KA IRTTAT 2 Ff T ik

o 4 Servlet #l Web MAHREFRMEVIGHSE XTI Web N HFE T 4 S
IS IR AR A BB /b, 40 UL <param-name>, <param-value>Fric, #tnl LK
Servlet #ES4, XANSHTLILE init() J7vkTingk.  Struts 1) ActionServiet &l
i A ok R B E AT T E R E SO struts-configaxml (A7 E, A ITINEIE S TE,
Kwunit Struts HE4LH 21 (1) #%-FF FromBean, Action, Forward % .

e Servlet/JSP & X TLLh Web N HFEFH R Serviet 5# T4 135 1) ISP 19 Tt
EN. AuFE Servlet/ISP #1447, Servlet/JSP {125 DL & — /N ATk A .

e Servlet/JSP BHT Web 7825 11X 2o/ Bt N1 KW 21 serviet i1 ISP M 1T .

o MIME & TR Web N TFET AT AL 250 A A2, RIMERATT AT LAAE R AT 4
REF A PR AR € MIME 282,

o M FATTRT U R A 3R A5 R H R FH AR PR (R U 2l e ltan, vl DAFR 2
FATH Web N HFRF G T 206 5%, WG, Mg 2G5 0tm, LA
AT o

RATHERFFIE T LK B e ATz, AR M oL, AT, SimEE .

classes HH T itigidilf) serviet IR, il JavaBean. Wit —AMFE

4
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FEA AT AL JAR SCAF(Ban— A5 =07 APLATALRC T —A JAR SCfF, i Struts HEZE K%
struts.jar, MySQL %4 JDBC KA 344 mysql-connector-java-3.1.11-bin.jar 2%),
W2 e AT LA A3 lib B b (0 R s A ix Lo s i A0 i1l 15 #4112 613 classes H
H). Web ZEFFHIX A H 3R Ak serviet S HAWARIC, Wi, AN
w2 B A g classes Hak, LA lib H NI JAR U IX B VR AN 75 BB A (1) 412X
LB JAR SCAHAINE] CLASSPATH 1. Web 25888 H 2B X A H sk I S0 Web
IV LB ST GE N

8.2.2 MyEclipse Web I H A4

MyEclipse Web Project 5¢4x 3 HF E—15 #2311 Web N FH 1) H sk 4544 Wi~ B fon:

| 8.2 MyEclipse Web Project 4514

Web 35 H 11 bR LSk X s sre. F 3% R Java YA RIS 9% J5 2 S0 1 20t 3
WebRoot/WEB-INF/classes I [fi.WebRoot H 3% T KA 5 1) Web 15 H (1) H %4544,
B B R index.jsp, KA G 4452 d:\tomcat6\webapps\HelloJSP\index.jsp, Xl
JEIXAN H Rk 2 b . 17 WEB-INF, web.xml, lib, classes Hs&1EHNES% F—3
1) A 25 o

MyEclipse Web i H nJ LU i 8 i 52 [m) BiAT 10 H 75 0 Web J & Dy gk Gk o

HE: HfH—IHE MyEclipse Web I H I 4 1] DLk & A1 B IS5 4 L1847 .

8.3 flJ# Web Il H

AN B G 73— ISPHelloworld ) Web T H . #8528 File > New >
Web Project, A LA ZNE1%: Web I H i1 5, Wik 8.3 i,

7EIX N Project Name mi#ii A JSPHelloWorld, #XJ5it J2EE Specification
Level FIfiff) Java EE 5.0 HiE4H, )5 st Finish fiilsh o] LLAIEE Web I H T . A 5¢
G ) Web T H A 8.2 firzsAHEL.

VER : M RCAS ) J2EE Specification Level B kTRl F (1) R 45 %%, 49 4 Tomcat
4, Weblogic 9 L FRASIE £ $¢ J2EE 1.4, 1ff Tomcat 5, JBoss 4, mi# GlassFish X
(IR 2% 2 AT LAk $¢ Java EE 5.0, Java EE 5.0 A LAE 4l EL ik UM JSTL.
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K 8.3 &l Web Project X5 HE

KTBAMERTEN &GS % F R

IR ik

Project name | Il H A FR. WIUEA ) Eclipse Java TiH 4.,

Location e IX AN SR HE AL BRI H 1K) SCHK AR v o b e 7 8
Directory I H R ER AT UL B2 JE MyEclipse A sl TAEX H 3% R 4R ]

PLERAL T TAEX H &AM H e B2,
R PREERM T TERHRX PR —TFH3, KA Eclipse 25 11X Ff
(e

Source folder

Java JEAUHY H 5% — 417 Java B java SCHE. 3R Y 2 as i N 3 3
H % Java #i& g 12

Web root | XA H ¥ 7% web NI A2, WEB-INF H 3% LU R F 1 H 3. an

folder RIEXANFANEA T AT, BAH R E R CM K kch web i H k.

Context root | MyEclipsef] & A T H 23 & AiHrWeb i H i g A X AN 642 . ERAAEH

URL BT H 2T o AT 1R SO H S ? B U ) & A i 18 s e
IR 4%, Bl Amyapp/a, # H Hiik http://localhost:8080/myapp K
i X ANIH . AR ] LI AN A HE T P 2808 2o 4 A2 /NS S RE A
7.

J2EE fi € J2EE FIVEMRRAS o 75 ZERT A IR 454 1R SCRS K T ML T SR IR AR

specification
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level
Add JSTL 1.0 | Jii F k5K in Java Standard Template Library (Java Fr#EA i ZE 1.0
libraries BE LA RA) W JAR U305 H () <web-root>/WEB-INF/lib H% .

% 8.1 Hid Web Tl H 1)1 10 3t 1]

8.4 @ HTML W H

R FEEPRIIF R, — B (48214 Frontpage ok # DreamWeaver iX ¥ T, H
Bz, AL (BT ILED TR, WYSWYG) (1 RAZ S & M i (HTML) . K25 MyEclipse
(1) ] ALY D0 T G e 24 Ll e A LU AC IS 1 o DRTEAS Y A AL 2%

JABNEIEE HTML B2 0 EHEAR 2 R0 2, X HA W 1. JEHE58 0 File > New
> Html(Advanced Template); 2. % Package Explorer #LEf#] WebRoot H 3%, i
FEEEPE R S ) New > Html(Advanced Template). X ISHgeks2s it G 2 HTML
GUIT AT AE, i B s s

Bl 8.4 i HTML Ui 3

FEIXA X IEHES ) File Name (3Cf44) HEH 4 login.html, Template to use: CEAfH]
(IR A7) N FrAEE o Default HTML template (ERIN HTML A6, 55— NIl 2 5
WD o B il Finish %4158 %00 S . 75 MyEclipse 2 H HTML 248 8% 2K 47 T W 61 2 1)
SCAF, W 8.5 B AEIK HL ] DLAE UUTH B V-4 nT AL I8 e k) T p 2%, R ] DL A% X
TEF: E R R ] IR 8 S BT RS 2, 38 m] AR S5 ARRS T AR b 28 24 HTML 505
Properties PLENIEIR T MArE o2 W@ v, nf DUBRIE (6] — L8 0B 1) J P b AT 15 24
Hu )y v v A AR bR 25 2 [R] R B 4% T LUK PR AN DX S 2 TR R /N EAT TS, i i) b3t m]
DA KA s AR DX, miahi ) B 3 0 n] DA KA BoR b IX . sl Preview 445 n] BAR]
INF7E 1E A1 Mogzilla 3 % & 1 2 75 0 1 s ROk «

Mt Palette R, HTIUEN IZA2 M LR THIAR D AT LAZE BN B 1K L8 5 FH (AR S F
Badi N BT oy, G, B, RPRIRAITERSFE . HTML-Basic HLin 51 HiH
FMFEEAMTTCE, M HTML-Form FIIZIH TR HI0E,

IRAEFRATTHE T 1) N A8 E5 AN 5 28 Sl e RN 2% ) i 3 BRLAT 0 PR B0 UF 1) LT, AR5 A
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i TR LR N AT S5 1 8.1,

¥ 8.5 HTML % 2%

<IDOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<title>&¥x</title>
<meta http-equiv=""content-type" content="text/html; charset=GBK">
</head>
<script type="text/javascript'>
/7 BN B AA RS
function checkForm(form) {
if(form.username.value == """) {
alert("H P AARE N ;
form.username.focus();
return false;

if(form._password.value == ") {
alert (%I ARE N 1) 5
Fform.password.focus();
return false;

return true;
}
</script>
<body>
WEx <br>
<form action="login.aspx" method="post" onsubmit="return
checkForm(this) ;">

HF4: <input type="text" name="username'><br>
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WA <input type="password" name="password"><br>
<input type="'submit" value=""%x" name="submitl">
<input type="reset"” value="HE''" name="resetl'>
</form>
</body>
</html>

T 8.1 login.html 5%
ORISR SR T, DA R KR R B R

TEHL 8.2 Bk
2, QIEEEAS DU R R R A T . RIS R, AT AR IR TR 2
login.aspx Mg ? #EiE Java th3C#F ASP.INET W? 2 %1%k 8.6 174k,

8.5 f# JSP TIH

AT R 2 IR O ISP UL« SE PR L ISP G 5 V8 22 Moy #2 A SCA A HTML
G AR AR AR o DRUHATT N 2K S TR B LIS R

JABNAIE HTML B 0 EHEA 2 M7 20, X B AW 1. 383580 File > New
> JSP(Advanced Template); 2. % Package Explorer 1K /] WebRoot H ¢, it
SEVERE R SRR New > JSP(Advanced Template). X IR 235 H1 618 ISP 7 [
PIXHTERE, FIlE 8.4 R AL, HFHZEAEXAMXHEHES Y File Name (SCfF4) HEF A
result.jsp, #XJ5 55 Finish 341 BT @)X A~ ISP LT

R : Template to use A7 {4~ FAEPH R Z ISP Ak il DL A, 491 40 =2 #F ISF,
Struts SF5F IRIAL,  XAE T LU TR IR

)5 MyEclipse £xH HTML ZwfHas kT FFRIGIEE SO, S C 2 sdE e 8.5
JEH R, AFIR A Palette L% TR % ISP RFH N ZE, Mdniias i/ CHo Rt e, t7
FFEBIEH (R AME A ALY SHonThEe, 1 N EFR:

8.6 ISP Zwf a1 A4 A gt e/
, UIRTEAR R G R .20, S AR R, S ANE SR T U R AR . R A
MyEclipse (1] ISP Zifi a5 nf UKD I R N A A LSy (FEHILRE AT 1K) ISP nfH 4%
ZHTIE AN KA o
DRAEFRAT PRI AN LI A QR 2655 1 R 3 PR T 7 P 266«
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<%@ page language="java” pageEncoding="GBK”%>
<html>
<head>
<title>&xgi R </title>
<meta http-equiv="pragma” content="no-cache”>
<meta http-equiv="cache-control” content=""no-cache”>
<meta http-equiv="expires” content="0">
</head>
<body>
15k ${message} 1!
</body>
</html>

T 8.3 HRkgi Rl result.jsp
FEIXAN TR BRAT RS ISP 2.0 BRI EL RIAAUk WoR & %45 115 B, ${message}ifi it —
Bt EL ik, &M request 5 session HL i A k.44 4 message (1)@ 1, Hszmt &
getAttribute(“message”) 2R 5 L BN N 2 o ok o XA A H e Z 24, 2
BRI ISP i — ek e HAERLEZ 1, LTk B REdR M, Haet e e a
LA R L B R
HR: EL RIEAAGELE J2EE 1.4 (1) Web i H TP . Wi REST5AE J2EE 1.4 1) Web Il
H b g 50X AN OUTHT, 6 PR A4
L R${message} /! |
(LR

<%

String message = (String)request.getAttribute(''message™);
if(message == null) message = "

%>

186 F<%h=message’h> T !

HIEI

8.6 flj# Servlet

Ja sl Serviet ISTIEHES Z 07X, XENAGWH: 1. EFET File > New >
Servlet; 2. ¥ Package Explorer #LEMIH, mMdifigikse b~ g i) New >
Servlet. XAz 258 i Serviet ZEFIXTEHE, WK 8.7 s« fEX AN X UG HE 1 [¥) Package

() MEFHI A servlets, Name (Z54) #ir A\ LoginServlet, #RJ5 il Next 4224 n] LAHE—
B SO AT Finish 3281 HE5C X AN 17 5, AT E R Next
FHIRIE N B R — 20 (158 T
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K 8.7 Hrid Serviet KXF1HHE

X — A LLEEE Servlet (11522 (Superclass), LA E1f#F(Modifiers), 7%
[ (Interfaces), WLFHIR (Template to use) LK —#8i%T5 (Options). Options 1]
PLE PR B4R & 1 77 (Inherited Methods), Sdfyi&#s (Constructors), #IiHk
A% 5% (init and destory) DL doGet, doPost, doPut, doDelete, getServletinfo
7. TEAE SUEZS 7% Servlet R 54 .

25 Next #4815, EdENBEN, wE web.xml (17 3 00f, Wik 8.8 fin. HiE
KR 2 AE, FRATI/EX BLAE Servlet/JSP Mapping URL Al AMES %\ /login.aspx. iX
ANEEAR AT LIS R R — M, TRt 2 LS Serviet ()5 4% AT LIEATAT B R F 4570,
U1.do, .php %5, &5 sl Finish #4015k 5 i) e Servlet iid FE.

R Servlet (WU Eg 12— ZELUITAR, 83 ix.do 17 B, 1 HA BRI A/*.do.
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K 8.8 B, WH web.xml L &
XEHESCH f5, 45 20 web.xml FUEr A& LoginServletjava, nJLLFE %] web.xml
M2 T AZIAN T8 Serviet & X, W1 K fios:

<?xml version="1.0" encoding="UTF-8"?>
<web-app version="2.5"
xmIns=""http://java.sun.com/xml/ns/javaee"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app_ 2 5.xsd">
<servlet>
<description>This is the description of my J2EE
component</description>
<display-name>This is the display name of my J2EE
component</display-name>
<servlet-name>LoginServlet</servlet-name>
<servlet-class>servlets.LoginServlet</servlet-class>
</servilet>

<servlet-mapping>
<servlet-name>LoginServlet</servlet-name>
<url-pattern>/login.aspx</url-pattern>

</servlet-mapping>

<welcome-file-list>
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<welcome-file>index. jsp</welcome-file>
</welcome-file-list>
</web-app>

THEH 8.4 INAT Servlet i I web.xml
Z It Servietst G ok T, AT LA & i ServietF5 SR It N B £ Thig . 1IX~Serviet
R 37 M) B 42 . http://localhost:8080/JSPHelloWorld/login.aspx, A& & ke IEH
BNETRHWE? A 2 M it

8.7 G Filter(GXyE%%)

SRR T A TR T BT e — AR I R Ik BE AR, SR e b SO BBRAT 1) RBUNT , 2517 SR AT
RN GZIP i Dhreml, F P BCRREHImT, 5555, SRt &t MyEclipse AN H 4201
HyERR . 7RI B UG T A M v Tomceat 2 BLE- A ST i) @ iy i 8 2% o

LR File > New > Class, K@ld—14°4 TomcatFormFilter 25, 44
filters. SRERIAI BT W T Fis:

package filters;

import java.io.lOException;

import javax.servlet.Filter;

import javax.servlet_FilterChain;

import javax.servlet_.FilterConfig;

import javax.servlet.ServletException;

import javax.servlet.ServletRequest;

import javax.servlet.ServletResponse;

import javax.servlet.http.HttpServletRequest;

import javax.servlet.http.HttpServletRequestWrapper;

public class TomcatFormFilter implements Filter {
/~k-k

* Request. java

* X HttpServletRequestWrapper #EATH 78, ANFEH KM DIREIFRELR ML T
A1) HttpServletRequest

* PP IIEE . e LR —RI%T Tomcat BRIAEE T 1 SC i BE3EAT fif v iy 2
FEFF M Request 5 LI )

* request XZHIN[ .

*/

class Request extends HttpServletRequestWrapper

{

public Request(HttpServletRequest request) {
super(request);

}
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/**
el il PR ) EE ) P R
* M\ ISO PR F] GBK.
*/
public String toChi(String input) {
try {
byte[] bytes = input.getBytes('1S08859-1");
return new String(bytes, "GBK™);
}
catch (Exception ex) {

}

return null;

}

/**

* Return the HttpServletRequest holded by this object.
*/

private HttpServletRequest getHttpServletRequest()

{
return (HttpServletRequest)super.getRequest();

}

/**

* BB - BIE T e g

*/

public String getParameter(String name)
{

return
toChi(getHttpServiletRequest() .getParameter(name));

}

/**

* WS HYIEL - BIE T e .

*/

public String[] getParameterValues(String name)

{

N
Wi

String values[] =
getHttpServletRequest() .getParameterValues(name);
it (values 1= null) {
for (int 1 = 0; 1 < values.length; 1++) {
values[i] = toChi(values[i]);
}
}
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return values;

}

}
public void destroy() {

}

public void doFilter(ServletRequest request, ServletResponse

response,
FilterChain chain) throws 10Exception, ServletException {

HttpServletRequest httpreq = (HttpServletRequest)request;
if(httpreq.getMethod() .equals('POST™)) {
request.setCharacterEncoding("'GBK");
} else {
request = new Request(httpreq);

}

chain.doFilter(request, response);

}

public void init(FilterConfig filterConfig) throws
ServletException {

}

}

E 8.5 IIyESLALY
RGBS web.xml I Servlet 5& X, UG FIARISE 41 Fros:

<?xml version="1.0" encoding=""UTF-8"?>
<web-app version="2.5" xmlns="http://java.sun.com/xml/ns/javaee"’
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
Xsi :schemalLocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app_ 2 5.xsd">
<servlet>
<description>
This is the description of my J2EE component
</description>
<display-name>
This is the display name of my J2EE component
</display-name>
<servlet-name>LoginServlet</servlet-name>
<servlet-class>servlets._LoginServlet</servlet-class>
</servlet>

<filter>
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<filter-name>TomcatFormFilter</filter-name>
<filter-class>filters.TomcatFormFilter</filter-class>
<ffilter>

<filter-mapping>
<filter-name>TomcatFormFilter</filter-name>
<url-pattern>/*</url-pattern>
<[filter-mapping>

<servlet-mapping>
<servlet-name>LoginServlet</servlet-name>
<url-pattern>/login.aspx</url-pattern>

</servlet-mapping>

<welcome-file-list>
<welcome-File>index. jsp</welcome-file>

</welcome-file-list>

</web-app>

THH 8.6 I T i JE45 11 web.xml 7%
T A AL ARMACES 20 2 BN TR I JE 2% TR LS5 L.

8.8 QIR EYEE Vi 7 )= (DAO)

fif Web . F — MR BEAN UG 1) B0 PRS2 A K AT REIRT,  DRLIECASY e A28 45 I I N s 122
il Dy fg.

Y SRR EIEER, B 5.2 G KR E LA A A TR .

9 DR EIMAIDBCIKEN R, IS % 5.4 5NIIDBCYK =) #IBuild Path —5.
X BT SAE FH MySQL £ 85 72, 6F T Web I H ok U in N 8 SO E R R S, K
mysg|l-connector-java-3.1.11-bin.jarix 4 3CfF & i3] WebRoot/WEB-INF/lib T, MyEclipse
2 ARSI LT H KA .

P TR EAIE AR, SRR EIE T ) Student X4, XN IR ORAE ML 15
K 1B s e e (R B A IR . ARSI R

package entity;

/*x SEESRIE S

public class Student {
private int id;
private int age;
private String username;
private String password;
public int getld() {

return id;

¥
public void setld(int id) {
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this.id = id;
}
public int getAge() {
return age;
}
public void setAge(int age) {
this.age = age;
}
public String getUsername() {
return username;
}
public void setUsername(String username) {
this.username = username;
}
public String getPassword() {
return password;
}
public void setPassword(String password) {
this.password = password;

W5 H 8.7 Student SZi4K
BeE et AN IR E YT N %, 1§25 % 5.5 45 IDBCHI 2K — W INEE . FTAE T
XN SN daots B, 25440 StudentDAO., HYRIL W Fros:

package dao;
import java.sql.SQLException;
import entity.Student;

/**
* AR T
* BeanSoft@126.com
* 0.1 2007-12-21
*/
public class StudentDAO {
/**
* R FH P A4 R R B A
* username H |4
* password 14
* LIRS, ARR[EInu L
*/
public Student FfindStudent(String username, String password) {
try {

Class.TorName(''com.mysql . jdbc.Driver™);
} catch (ClassNotFoundException e) {
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e.printStackTrace();

java.sqgl.Connection conn = null;// s J7E k4

java.sqgl .PreparedStatement pstmt = nulll;// %455 4k

java.sql .ResultSet rs = null;//45 54

String sql = ""'select * from Student where username = ? and password

= ?"://SQL

try {
conn = java.sqgl.DriverManager.getConnection(

"jdbc:mysql://1ocalhost:3306/test?useUnicode=true&characterEncodi
ng=GBK", "root", null);

pstmt = conn.prepareStatement(sql);

pstmt.setString(1l, username);
pstmt.setString(2, password);

rs = pstmt.executeQuery();

if(rs '=null && rs.next()) {
/7 GRS, ARk
Student student = new Student();

student.setld(rs.getint(1));
student.setUsername(rs.getString(‘'username’™));
student.setPassword(rs.getString(‘'password™));
student.setAge(rs.getint('age'™));

return student;

}
} catch (SQLException e) {

e.printStackTrace();

} finally {
/7 6. BRCRYE, @UIAEFinal VyiE ) P iR E g oc A BE T
try {

rs.close();
} catch (SQLException e) {}
try {

pstmt.close();
} catch (SQLException e) {}

try {
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conn.close();
} catch (SQLException e) {}
3

return null;

75 5 8.8 StudentDAO ki i a2
2 UEAE U R Z TR T 58 AT A B2 5K A AN ? XL KRR 43 2 IR B Re s AT
T2 NGAETF A, AT — 2 Dhhae. 488, I00H BN TG BT AR &L K
A Serviet AT T .

8.9 & Servlet G &K

IAETRATAT LB Serviet KA DAO EACHAR J5 I S S Thhe T, wE S
SRS, S mRresultjsp. U5 Serviet ARG TR TR

package servlets;

import java.io.lOException;

import javax.servlet.ServletException;
import javax.servlet_http.HttpServilet;
import javax.servlet_http_HttpServletRequest;
import javax.servlet_http_HttpServletResponse;

import dao.StudentDAO;
import entity.Student;

public class LoginServlet extends HttpServlet {

public void doPost(HttpServletRequest request, HttpServletResponse
response)
throws ServletException, I0Exception {
Student student = new StudentDAO() .FindStudent(

request.getParameter(‘'username’™),request.getParameter(*'password™™)

if(student != null &&
student.getUsername() .equals(request.getParameter(‘"'username™)) &&

student.getPassword() .equals(request.getParameter('password™))) {
request.setAttribute("'message", "I ;
110455 5 H  #sessiont
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request._getSession() .setAttribute('student’, student);
} else {
request.setAttribute("'message’, "KMK');
}
/G R R
request.getRequestDispatcher("'/result.jsp'™).forward(request,
response);
}
}

15 ¥ 8.9 Servlet I & AW i
Ft, XIS RN H IR ST .

8.10 &Am, EFrAAm, EATMPANH

i 4r 7 Nt L fE Package Explorerff & ik 35 H =5 55 StrutsLoginDemo,
R IEFSE ¥ Run > Run As > 3 MyEclipse Server Application, 2 JiMyEclipsen] g4 i
AN RS 28 538, i b LR R 4525 2 — Bl WMy Eclipse TomcatJf it OK #2411 )7 ,
s B Bl R A B T R AT N IR IG R Bk S5 #s o S Tl kAt 24T Webil H difI7E4I
KiES% 6.5.2 RS A RATNA, 6.6.1 HahRS A —TTHRINE, TEREM RS &8 P
AL N TN RS A AT LU s 2 S TR e S A e
SRIG BN 28R AT IR T o 7EServers ML ik i 45 8%, 2 J5 Sl i T R E i @
P LAs AT B B iRk 554 o

MR 4528 A Bhse Y m, At T ERE b @ e B R 4T TF 00 B R0 IR, AR R N M -
http://localhost:8080/JSPHelloWorld/login.html k#7535 7, a1 K B Fis:

8.9 f£ MyEclipse HH T 1 % I U

FEZE HAR T P 42 A AN e AT AE R 2 AL 44 7, B0 7K =, PR NS, AR5 R AT,
AT DL R R A R T

IR FURE T ISP B, A8 MyEclipse <3 B3I ISP B £k 554 b, (&R
FEUT RO — S E SO, IS AT T TEF R AT o W] FH R ATX AN H
We? FATRLALE Servers HLE Bk PrscAn (I H , AR5 i AL T RA B Bk HH A
i, BEEEIH b4 e FE . Redeploy, 1 8.10 . 2 JaMias v 0wk nT BASE
JRTE T R AT R o
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K 8.10 HHAAmIiH

8.11 ik ISP N H

t 6.6.4 IR K A AN 544, MyEclipse ] L% Web iy HL i 2K 5k # ISP
Ui, Serviet AT IR B dn AT LA ISP A% AT B MR 4%, SR B W AL, 2R )E LA
B A B R SS2% o 91 2 U7 lindex.jspit I GE L S, FATT o] MBS bR
4 (WBUud B L (s s ), AR5 s iDebug ML L Resume el R4k 4824 T 44
AT, BT LA B & AT S5 Rt 5. W B s:

K 8.11 &M F IR EL AR ISP Wi
X HE K index.jsp L KPR ISE Bl R Fis:

<%

int a = 1;

int b = 2;
out.printin(a + b);
%>

TEHL8.10 H R ISP T 5 AL
A R 28 AT LUAR 7 468 14 B e A7 0 e R 3 g, G e A A 1 S
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8.12 MILA Web T H N Web FF R IhgE

MR ER T A E R T HA W WTP, Netbeans, JBuilder 25 HI4E ¥ Web T H ,
MAZiE L MyEclipse BTl ) Web Iii H, 784 MyEclipse ¥R 4% &t 47 kA, AR
SEHRE . XFRELL F AL MyEclipse SEHLFLER: MyEclipse > Project Capabilities >
Add Web Project Capabilities ... k)53 MyEclipse Web Capabilities [/, 41 FK&/R:

& 8.12 MyEclipse Web Tii H [ &
FEIXASGHEHE EHF Web 3 H 4R H 3%, #idi Web Root Directory 471l (1) Browse...
sk, 2 JEWE EFSCUi B S (Web Context Root), k& iE 1) Java EE it
A (J2EE Specification Level) J&, rfiidi Finish #4515 st 4 ur 5 H A T Web JF & 3
RET, G st nl DA 6] & EAT R AT S5 HAE

8.13 HAWKE
AR T I, KA L T AT BTG g AT B
8.13.1 &% Web T B BRI R E

EPEE R Window > Preferences, #1Jf Preferences XIGHE, 7EIREIM Fik+%
MyEclipse > Java Enterprise Project > Web Project, Kt ¥ & Web Il H [ EZRA
-&E’ ﬁD‘FF)?ZT—\‘:
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8.13 &% Web i H (I ER A B &

71: Template A28 7UA] LA¥ & Web T H IR, (055 BRIA MRS H 44 LA Web W IR
HKIAFR. 1M7L Build Path Fr%5 00, Wn] LIS 2 H 04K WEB-INF/lib T i) jar 54
& zip XA RAT RIS 7% L. Deployment AR T B T 4100 H A7 76 AR 1) B dn f] 3047 K
fii. Tag Libraries r% U m] LIE S— 26 17 2 XRS5 (1 Dud AR5 B

Britz 4b, 3 nr LIS AN H (1) Web ZhfigdEAT 15 . sidiSK R Project > Properties
AT LAFT TTI00 H (0 8 P R HE , 3 I 7T LL s i My Eclipse > Web 5 ST — S8 b BE 1 E
wrFE TR

B 8.14 &SN H (1
8.13.2 45 Web T H N\ =& IhRe

5 SEBR FF R H AN ] T 4 (1) 22 4E Web 350 H Th ] Hibernate, Struts, Spring 540K,
LIS HORT LU I 5% 8 My Eclipse > Project Capabilities 48 J& i 48 75 248 F (R4 A,
S T LK of IV (18 24 P R SO N 2 i 30 H vp e 2251 & Struts AT Hibernate B A,
S IR T SE 5 Add Struts Capabilities 1 Add Hibernate Capabilities i LL T .
wrr B R
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K 8.15 I E ZHEBL IT K Ih g
8.14 “ J.JA] f

M 55\ web T H IR 5EA I FIF D B AR 7 HE 2 HEAER P W 2,
PEJRAE IE AT %I\ username FI% Y 555 3] result.jsp, A4 B Wos" 18 8 5%
${message} T"? 1l message A EonHik, XJEHTA?

B IXJE PR BRI IR 25 B AN SRR ISP 2.0 hiiE R 1 EL #eik . 3 W SR A fg
SERAE T IRALLIRARI ISP IR454%, IXAPG OL T 5] LAAs AT R8s I F 110 i 45 45 18 ¢
MyEclipse Tomcat 5# Tomcat 6 H HAfi i8] 8.3 #1i%$% T Java EE 5, HiA 2 tHELE ) 8
U CUBC R 25 2 U Tomeat 6. W A ARARA I il 45 2% vl B 2 R IR, L 42
AR & B Tomeat 5.5 ANSZ 7 EL Rk s

W SEAE R AT IRiE, SO R (AR
[ & Re{message} / /|
BESCA

<%

String message = (String)request.getAttribute(''message™);
if(message == null) message = "

%>

1% sk <h=message’> T !

B,
8.15 /Ngk

TERTERAVN A T Ik, Kedin, 3847, W, 8 Web WAL, XEEREEE T LA
JET AT Web (I H 6l 4 Struts, JSF A545. JIEASE,  ARKEE Qe 4 A
MyEclipse Wi I 5 Web Tt H A7 — AN KEUR T, JF 0 EHTA SER 251K Web HERLEAT TF K
I FEA
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8.16 %%kl

S

BRF R, 7 LS ERAEADSHER T HRUCREREAA L ENE, AR
A BLB R IMAA T ok

FHR M T

MyEclipse 6 52 M FF & VF i W B AN 7 10 ISP X fF Ltk F &
http://www.blogjava.net/beansoft/archive/2007/12/15/164704.html

H %% 7 Jakarta x o £ ¥ o o om — A~ K
http://www.blogjava.net/beansoft/archive/2007/01/05/92087.html
JSP " J%, i Bl % iE i A

http://www.blogjava.net/beansoft/archive/2007/08/03/134334.html|

Resinfili4- % (PR ZE Lk TomcatlfLt, RZMuEH )  http:// www.caucho.com/download/
JSP ‘B 5 Mk http://java.sun.com/products/isp/

i #h JSP/Servlet H B # 2 il £ ~ #
http://www.blogjava.net/beansoft/archive/2007/10/26/156063.htm|

Tomcat 5/6 GBK % f & 58 £ # v v 3k B oW B OB ol i &
http://www.blogjava.net/beansoft/archive/2007/10/09/151368.html|

=3 24 :servietAPI2.1 Hh 3'e Jil Axt
http://www.blogjava.net/beansoft/archive/2007/11/02/157665.html
Jii el ik fift JSP Ui ¥} i Al
http://www.blogjava.net/beansoft/archive/2007/11/09/159374.html
ff M & 9 & M & WM ISP H 5 HTTP & %4 )
http://www.blogjava.net/beansoft/archive/2006/11/22/82704.html

B
F
5E

an>
[aay

Tomcat JSP Web FF /& HIELAG [a] f/h 45

1. A DI R LA [r)

SCA PR Gt i R0 g Al s ) G i AN — 3

1) KA san it gnts, rTLUHC AT I, RIS ARE;

2) 45 T SO — AR 2 R AU B A% FH 15 G AR Aok s ST 7455 2.

<meta http-equiv="content-type" content="text/html; charset=GBK">

3) WER ARG I XP AR P AT SR, e s iild.
2. ISP BT LA )

1) page 84 pageEncoding="GBK" X245 i WU AR A7 I Gt a1 R 5 i
1ISO8859-1 i AN RELRAFILF;

2) page 1541 contentType="text/html; charset=1SO8859-1" 1415 A vt i —Ff ik
WAL SE 1B — T i .

WA ISP ELAY TR, — ol B 2, i HAVE ARG 3N as e At A RE 4 dis, & AN RE
3. KHAHEAZIELAG ] & (Tomceat $717)

1). POST (LAY
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a. T S DN W A A R B 1) G A 2 R A B T A TR g B, T AN & AR 4R AT S5
ISP I )Gt i A R E 1. I AT B T I £ 4 0 v B )l — R 119,191 - GBKK.
b. b3 7 R AR SR IS H 1 g
request.setCharacterEncoding("GBK");
c. WAL IESR 7 Uk MY, Tomeat 487 T —ANILRL:
apache-tomcat-5.5.23\webapps\jsp-examples\WEB-INF\classes\filters\SetCharacter
EncodingFilter.java
web.xml
<filter>
<filter-name>Set Character Encoding</filter-name>
<filter-class>filters.SetCharacterEncodingFilter</filter-class>
<init-param>
<param-name>encoding</param-name>
<param-value>GBK</param-value>
</init-param>
<ffilter>
<filter-mapping>
<filter-name>Set Character Encoding</filter-name>
<url-pattern>/*</url-pattern>
</[filter-mapping>
2) GET J7 A MELIY
Jfl setCharacterEncoding() ANfEfi#vk. TOMCAT [H—A> BUG, GET J A%k #h 25
s 2 HY 1S08859-1 Zifith. AIE e K GBK Jr=.
String username = request.getParameter("username");
System.out.printin(username);
11 Bt SEHUS Je in i) R e
byte[] data = username.getBytes("ISO8859-1");
11 AR T 10— 1 4 PR A 9 1) - 7 e
username = new String(data, "GBK");
NG
JTAT I S (B T B fE 1K GET  FRELAS e ) #8 FH 48— 1) 9w i (GBK ¥ UTF-8), i AN2s il
FiL AL i) .
4. FIREpEEK— R AN R R S BN LI () R, RICAS = A 2 b 2 S PR AN e DB 4%
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BHE FF& Struts 1.x N H

9.1 /A

KREHNES AN http://www.blogjava.net/beansoft/archive/2007/11/26/163354.html
MyEclipse 6 St % FF & oF fi# # B AN 1 7 Struts A [ FF K,
http://www.blogjava.net/beansoft/archive/2007/12/18/168600.html  MyEclipse 6 5k ik F
RUHEAAT] 11 Struts S EA%

Struts, B JjHilik/E http:/struts.apache.org/ , XA KPR LTS, B AR
FIRAG T RN SN AT RS T WebJZMVCHER IR FFIRAESE . Struts H JiT 70 1 7 AN hRCAS, —
AEFIAN LA, XARA H AR U e, W AMIE) 2, SR8 T4 N2 501Kk
T E 52 ¥551 tnJBuilder, Netbeans, MyEclipse5%%, 5—/MAA ) f&Struts 2 CH R 8t
A F) I ik ik 4 - hittp://struts.apache.org/2.0.11/index.html ), ‘& 5ZFx &5 FWebWork
(http://www.opensymphony.com/webwork/) Ff &[], XARARIStruts 1 ok i565¢ 4 il &
MAFIHESE, AEER, 4, WREE NS, #RAMEE.. Ak H ik vFStruts 2
W AR T S, SR bR A AT IR B 2 i fa T AR EOR —2INGE,  BRStruts 1 JF
Kitit. FrAMyEclipse H Bk it HAfStruts 1Bt 7 3504, M8 A %A % Struts 2 $24iE
Y. R AN, 28 (ER AL Struts LXRASI N 2. AN A5 75 Strutsfae K (1 38wl
JE A BIERIGEE .25 (FormBean) LU R s il R A B 29«

H T ERZE T f# Struts HEZL, JRAZULE T i MVC BB, Struts HoRI 2 5L T
MVC &, MVC BRI T Smalltalk 155, B HLL R =ANE04i: A
(modeD) [ FLI& (view), Fi#% (Controller) .41 N3 S T X 4. KT MVC XM
o, WU N B TR

K 9.1 MVC %51 &
P = S W R R TR

HIr ik
B2 (model) IR EE N G o B SRR o B X 5
L (view) VAR o, e R B S 1 AR
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fithlas (Controller) | & SO A A AT HIN AR 1, & FHORERAERLY. (model)
QIEAESES

XLENE SR T2 R . TR2ZEAMI 7okl SEKASE, X T KR uX ARG, el sk
T ARHUIE K ZE R ME— R —ANIRES . TP 2R S 2 b5k o JLEE M AAFAIIEAME B nT A
HEAEe, WU EEEEZ T, 0] DUE SRR, o] L B ZEEA £k
FIRMES, XS T2 MUE, NEEQER, eEBNE RS — N, Seda®
RS PEIEY, TR R R LERAE R, ARRE T LSRRI 20K EE CIRES
POf)-> AL, n] DUE B SR T GRHD 28X — BRI R U B A 2 1
WA, Bke—Boe e i HE A .

W4 Struts SEELK) MVC 54640 R TR

& 9.2 Struts SZHLK MVC HEZY

BETORIBATR EAH— T Struts (1 TAERFE. XHTF>RH Struts HEZLY Web N FH, 7
Web N H A sl a2 2 F 914646 ActionServlet, ActionServlet M struts-config.xml (A4
MO B R AU AT AR &M B0 S, 40 Action FRILR A7/ ActionMapping
P L i

BRI U, Struts HEAZ S 45 1 2% (ActionServiet) ¢ I A1 IR LA TAE . Bl ds & —4
Servlet, fliliik web.xml BCE 1% H 305 31 Serviet, 132HUEC & SC 4 (struts-config.xml) 1AL
B, NR[E N struts BEHA AL AN ) ModuleConfig X% . Bt & SC2EH f) Action Wt
SE CHEMRAFAE ActionConfig £E 4.

7 Struts N HHZNN, <540 Struts Fe & SCHFH IR EE BRI AL, I eI
JBAE config G AHK JavaBean KIS H . HILAMLEhVEAE Web 7845 8 BhiN B 3h 58, #)
A SE R, ER IS URL VST B SR AR I A7 LA.do 252 1) URL 83K

24 ActionServlet HI 2]—AN% 7 KIS, AT HAE BT
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K| 9.3 Struts HIFHATIRFE
MyEclipse %} Struts [ FF A $E4t T 207 AL 132K, A5 EIEE B 30 i Struts 28721 H
Ik, LA S 7 648 FormBean, Action, LLJ% Struts Ao & SCFE&E4E, H4 A0 DL
F 4 Struts [FIHCE SCAR22 6 H 250 N AT Rk, X AE4ED T Web N PR &+

S R AR e Struts TFR— MR RSN, R )5 HA @
AN Hibernate KT —/Nli 1 70 GUENREIN 27 £ 3R 0TI o

9.2 A& Struts I H

AN UnfT{E MyEclipse H 417 Struts 3 H .
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9.2.1 flE Web I H

LATFEALE MyEclipse W EIE—NHH Web AL7 /5 1E 7 Struts 2754
(Struts Capabilities)fitk. A 4 2423 T @) d— 4 StrutsLoginDemo ] Web Jii [
EPESEHL File > New > Web Project, #J LU 8814 Web T H #1H 5, Wik 8.3 fizr.

753X A& [ Project NameH 4y A StrutsLoginDemo, #X )5 i% 11 J2EE Specification
Level Fif)Java EE 5.0 ¥k, #/q SdiFinishf8lstnl LLal@WebIi H 7. S5
JEMIWebZit H f1FE 8.2 FronAifbl. #E4lidfE1E S 8.3 Al Webli H .

9.2.2 M Struts FF & IhEE

Web Tl H Gt 5¢ B a, A3 B4y e Struts DhRg . X MEEVER LUB R 7E Package
Explorer #1000 H A s _EA B S, RN SRR MyEclipse > Add Struts
Capabilities, W& 9.4 fizn; A IEFER . MyEclipse > Project Capabilities > Add
Struts Capabilities, #&55tiE3) TN Struts Dygernl <, w1 9.5 Jizx.

Kl 9.4 1t Package Explorer #L&| b H IS N Struts D g a3

SN Struts Dy REXT I HE R ERAE — Bk Ui AN 7 248 ol v LS, 48Rt m] DU 75
B G o ek TR R R AR ) . filn: LA 2 Base package for new
classes MVRAEAFINAE . 1XH S L% 4 Struts 1.2 4% Struts fUhlcA R 1.2 BIv].
WA B 1.3 BIRHE R IL MyEclipse HELES G, ToiER BT ERIRAE . FEXASX IR HEH (1)
IR Ho s SR s
Struts config path 552 T Struts it & S (— k2 struts-config.xml)  FIA7 N &,
AL A Browse #7241k &2 Struts specification A4 H T AIZER Struts fRAS s
ActionServlet name 5% 747 F web.xml 1] Struts #%.0» Servlet 14 7; URL Pattern
MR E T ¥ 43845 Struts #4510 URL 257, Base package for new classes 77 T4
FIZRIIERNEL; Default application resources NF5 @ T BRI B Frfb B SO Rk
HE Install Struts TLDs I F& 7R A2 75 %3¢ Struts [FFRZE AT
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162

K 9.5 ¥shn Struts TfEXEHE
ANINT Struts DhEerIIH H &4kl 9.6 Fros.

A LA R S0 Web T H N T Struts
1.2 (25 (Struts 1.2 Libraries), &7
struts-config.xml LA Struts [) TLD (A
( struts-bean.tld ,  struts-html.tild ,
struts-logic.tld, struts-tiles.tld 245), LLA %
HE2% A validator-rules.xml. 2415 H % A7 st
X2 BB SRR B ARIRSS 441 Web
N WEB-INF/lib R, AR 7. XX
i 30 struts-config.xml i v LAFT I ) AL,
(I AR B DL fe v vt TR, JEH 7,
MEATE AT LLAE sre H 4SS

KA
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K] 9.6 Struts i H H 54514

9.3 f¥H Struts TH

MyEclipse 6 %I Struts [ R FEME T A M2 R, AFEHCE ST fa a8 A FE W 1T 25
e B SR, Struts ZAFAI S, LUK Struts BRZS AT AL B S

9.3.1 Struts At & X1 4ntE 2%

n 9.2 Hi 48, Xili struts-config.xml 5t v] LAFT T Struts BCE SO 2%, Wik 9.7
FTR o " RERE SR A0 N FHAR P 10 AR, 1O AN FF & [ A K Q] B 47 PRI 4L 2R 44N 30 43
HAEIRA M. 54k Struts gidEasde it 7 RINM AR T i, AFURTT PUE 348
X PO DU, XML SCHERI HTML B2 thaT BAAlgE Action, 4J Forward Fil1-J-
Action SKCIE 5 Forward. LA Action F1 ActionForm kA0 R AR, A DL (0 5 Sk
LRI Forward H4AH S99 Wt ISP UL T E K o AEIX Nk B B XL ISP i T 5%
# Action 5T SCE T LLFT TF0) Y. (1) B 0L 2 T 18 0K

R WU XA, 7R AT A B B ik Export As JPEG, SRE1ES
TR SCFARAE R AE TR B — AN SO T LURE & ORAE A IPG 4 X1 B v SCAFHEAS A o

K 9.7 Struts X% 128

THA LM SXASTN A T UGS 24 iy e 148 i A1 PR P 0E AT RO AN 4 /) S

(P3AE, A FH B E BE Crl+-sk 3 Crl+=I01m] LU AT ORI 46 /N A o 53 ARSI 3= 5
EE’J View 5N LA R mie] LU, Hr—ANJE View -> Auto Layout, 7%l
TR IR IXAN E 80 A 8 A AN AT HUES (9, & T DU R 48 R 24 i AL B B sk AT A J g
(=
MR EYHR ) Source FRZE, WIAT LAY BIRCCE SO PR S g o D) R] %
TR, U A Design ARZERIAT . 1 b B B AR AL Ut BT s

|<?xml version="1.0" encoding="UTF-8"7>
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<IDOCTYPE struts-config PUBLIC "-//Apache Software Foundation//DTD
Struts Configuration 1.2//EN"
"http://struts._apache.org/dtds/struts-config_1 2.dtd">

<struts-config>
<data-sources />
<form-beans >
<form-bean name="userLoginForm"
type=""com.yourcompany.struts.form.UserLoginForm" />

</form-beans>

<global-exceptions />
<global-forwards />
<action-mappings >
<action
attribute="userLoginForm"
input=""/userLogin.jsp"
name=""userLoginForm"
path="/userLogin"
scope=""request"
type=""com.yourcompany.struts.action.UserLoginAction'>
<forward name="failed" path="/userLogin.jsp" />
<forward name="'success" path=""/userLoginSuccess.jsp" />
</action>

</action-mappings>
<message-resources

parameter=""com.yourcompany.struts._ApplicationResources" />
</struts-config>

TE 9.1 /M Struts it 'E 1
MIRIF RN G 0] AT A MOX B AR, T g R4 ) 25 70 2 5 I B S A 2 S AE (R E R T 4
PAZLEA N R HR /R B fEgm R A b 4% B ALt 2o .

Ji4b, outlineCRA) P IR 7R T AT &S s, Wik 9.8 MR, [FFET)
ki R P 5 JES Rl PR30 st 1 ST X (R B8 SO o il Outline #1423
HAH GG Struts ZLARIRISEER, i ch % B R S ERLIRURE 1] LA S Bl AH BY. (1) 05 135 A R ) T i 22
(L. W 9.8 AT

AN RS AR H RN, T RAFT TR Struts Flow Overview, MRHFIESF
Windows>Show View>Other , 7 i H [f] X} 1 HE T & $% 45 55 MyEclipse Java
Enterprise>Struts Flow Overview, #nfCAFIFFILALIE, @il 9.10 Frs. EXAKEERT
YRR B ) 2w B DL SRR A BT E A e R I XA e ] b e A B R A (s
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T s IR 23), FATTAT LA (78 EU AR AR B L Rade e A7, A7 s A8 D B I e s 3
X Bl WarCraft 111 LRI RE AR ez 4 04RGP AME iR B 2% K R R TR B
T

9.8 Struts it & A KNI

K] 9.9 Struts Flow Overview 4§ & % Ji7 x5 2K AR H 1] %7 EE

9.3.2 Struts Ak

LR Struts T H A1 LR AR R

o JSP Ui

e Action

e ActionForward* (#1n])

e ActionForm** (ZRH)

o Struts #EHIAFRF: struts-config.xml
* ActionForward 2 struts-config.xml SCH5E XH <forward> 45 H, 2 X T4 Action i
AT 58 e 5 BTt N IR A%
** ActionForms 7] LLH Dynamic Forms (B3 KAV, XA 7 o] DU A 5
P11 ActionForm kA2 0T [ 2R B (1 .
7t MyEclipse @I gx 0 g (IAE—Fh (B 7 3C4F struts-config.xml v BLZER I Struts
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TFRBge S Az ) Al A 3 AN ] 05 2R 58 1k

FR 1 %IESEH File > New > Other..., #£ New ¥HEHES B IF MyEclipse > Web-Struts
> Struts 1.2 (8 1.1, 1.3, /EE: — € EHILATERE M Struts fRA—2X) , SRJ51EFE Struts
A T, W NE9.10 BioR, T LU S AR AR ) 3 1A .

9.10 MXFIEHEMEFE Struts 411} 1) T
XU FALFE: Struts 1.2 Action, DataSource ($(#iJ5), Exception (%), Form, Form,
Action & JSP, Forward, Message Resources ([ Frfb#JE 304, Module (Fidk, AE
D, Plugin (Jft, #4 Spring B H)D 45,

73X 2: ffi ] struts-config.xml f#) Outline #LE, ‘&R LLYE struts-config.xml SCAFSw 425 4T
JEER], Wik 9.8 fizn. M Outline #IE b, R0 LAFEARAT— AN 1915 i AT B R
i BT R PRAESE 5, AR S A0 ) SO T S R R 2 A, B R AT H ) 3 G A A (1)
A1, il 9.1 Frors 5Py 22 s s Outline PR ¥4 61 U 4 H AH SC R A 2 Struts
LAFI SR, ARt I IR SR IR T LA Sl B (R 06 TR HESR G R R eI e &, ikl 9.8 4
M~ E s

9.11 1t Outline ¥/l rh 14 sl #1524 Struts 414+

75 3 wilEl 9.7 Pronil Struts e s BT, R — MR RIS A Struts
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M T . FTIF S0 struts-config.xml J5 ] DLE 3 Struts Bt & Ui 2S . 759w 45 )
FPRAT LA Design MK T 328 . AE BRI LT LAt Palette b i (4240
KA ICER, BT CAZE WA A b S A R E B A e 22 1 ) SR BRI, A& 9.12 FoR.

9.12 fExihas b A G e LR CESem
0.4 JwEFRNH

9.4.1 MR Hbx

TEIX 073 BATPRE B RS I R0 gt — AN X S PRI 10 A9 1, P RASEH0L 5 5 B 1) 19X 3l 65 5 Ty
At D T ZEMANISPOLIRI AT, —NHREERH P 85k, 5 AN NRR G R . X
WA BT TR 43 4 T 44k userLogin.jsp A1 userLoginSuccess.jsp. A 7 /L H] g1 fiifrix A
B, WG S R U RN, AT 2K - EE e ) [R] userLogin.jsp U I 2o HHE
R GRS NAARNIATEE RS loginUserFailure.jsp T .. XA IR AEWE 9.7
fiR, 27% 9.3.1 Strutsi & SCAF 4 25— 17 N 7¥

9.4.2 BIEEF NI H

FeAr1se k)4 userLoginSuccess.jsp Tl BARFLAE L RIFE 1 L0 i i 2 R 2
(1) ISP GUihl, AHEIXFEMOZ R FATRT LIME Brd Form, Action and JSP [ 5K ]I}
IS — AN LA AH S Action F1 ActionForm.

VTR, S Palette T HA B "ISP" TH, SR)5 P Aidimifi, HtnTAgft
Hradt ISP UM )4, Wil 9.13 A7, £E File Name Ab%i A userLoginSuccess.jsp,
ARG sili Finish 3281 R G B ok B T, it R W& 9.13.

e LRGSR B R AR T AT IR B ) ISP 3T

Mg, BT IG5 9.2 Frosiia] .

HE: el LM EL RIAX B #H ISTL, B B <bean:write
name="userName" scope="'request" />%%#4 ${userName} RIn], Ailar$e &K H
T Java EE 5 A1) Web [ FH LA RS AT AERT R RA (1) R 4545 Lo
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K] 9.13 M AF AR IEEE ISP $241 I 55 i i A7 >k A1 ISP LTI

<%@ page language="java' pageEncoding=""GBK"%>
<%@ taglib uri="http://struts.apache.org/tags-bean’” prefix="bean™ %>
<%@ taglib uri="http://struts.apache.org/tags-html" prefix="html" %>
<html:html lang="true'">
<head>
<html:base />
<title>&xHEI</title>
</head>
<body>
fRlUf <bean:write name=""userName' scope=''request’ />, IROLEFHI!
</body>
</html:html>

THH 9.2 s Ui
XATMARM S, ME— RN e <body> br%E BRI IARAD, 352 3T EDAL TN H 1
request Y[l ¥ userName R (1fH. KL, 7652001 action 2, FEm
request X R &E N 4A userName [F)JE k.

9.4.3 fHFHAE Form, Action 1 ISP [ S0 8 X84 14

27 9.3.2 StrutsZ1 {10 5 — W I NZS, I 7 i (ARG & 75 Struts it & SO st 4 b iy
F R G P New > Form, Action & JSPZHRIN, SRAHT AN F. MM g X
FormBeanff], %il4 9.14 7.

7F Use case #bHiA userLogin, Z G EMEESBHEIMEA. Name 4 EIR1IZ&
formBean 145, XAF1 struts-config.xml SCHF formbean & X ixfN: <form-bean
name="userLoginForm" type="com.yourcompany.struts.form.UserLoginForm" />, Form
Impl AP EHER T Form [ EARSZILSE, FATTLLES New FormBean gt
FormBean), mi# & Existing FormBean (C.{f7t[f) FormBean), i : Dynamic
FormBean (%)% FormBean).

Form Properties Fr2& o1& Form g PE. i Add FHR A A~ 3 5 Jg@ 2k -
userName HI password. VUi Fan& 9.15 Fiox, 4¥sIn25 i AMER RHE, 75 ISP
input type HiEFE passowrd, X5 A Add AL JEYE, Wi )G i Close 424wk
A DAZE RS 2 s Jm M A BTN ISP input type B i) LU S AR ikt N ) ISP i\
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FTU 1) Struts R IPFRBAS.

9.14 #r&t Form |5

9.15 [i] Form Hsin)@

Fg p U HE S ISP 452, X — U E & AR formBean XV 1) Struts 3K 5
BN TLIH, IXANTUERKES F Struts Form R8RS BT AT T4 FormBean [1)JE . Bk
IE L R IX— TR S EHE Create JSP Form & AREH ), EiX HErh b & e, KRG T
[ f) New JSP Path #5 {llf%i AE (e /form/userLogin.jsp (ERIAE WL T IBAE WebRoot [
fform 1-H 3t 1) & h/userLogin.jsp BIH] . iX—IhfE4axt & ARH SE R ! kR T A ¥
T AT WAERE HTML bRZERR . X — P I EE W& 9.16 .
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9.16 A= ik Hda A\ BT
R e B B E Methods FR&%, 1 fif SOl L, 3 LI B A 1) S HE AR 25 4wt
FRAT o A5 UE — DTSRI AR A6 2E O B2 ) FormBean S8 UEAN TR E 7 i&61 11 reset Al
validate, SEBsIT A @ vFe fRIXET . s EPR:

’9.17 M5k

W7, 2k — G g FormBean A OGN B DA SE M T o slidiNextd& sl 5 mh v] LA
A Action ) 1n] FXTUEHE, Wi 9.18 . {fEiX— i) LG BG4 IR @ 1t 48 S LT
T XFEATE TR AT LA LT A AT AR 5 5o 48t m] DUORR 75 2 5 HAH I B 7« Path
JE AR E T 5 I Actionddl ik i Sa A U7 I (1) 4%, 1 an A vh ) JuserLoginds 5 Ui In) 1R % 15
/& . http://localhost:8080/StrutsLoginDemo/userLogin.do. 7EAction ImplHa] DLk $£
ActionZE 14228 (Superclass), 47 #5 H 4 H] DispatchActionth 17 & 5 5 f#, DL R
% (Type) . fEXTUFHER N A 5 Mass, 73l &Form (R 51), Parameter (Z4), Methods

(77, Forwards (%), Exceptions (). X THI%# K, B T FormfliForwards
KPR N BT EEA, e n] DL, X PN R85 G B Action BT G I (1)
FormBean#lActionForward.

Form #5451 [1) Attribute 455 T Action [1)JE1E, Scope W455E 11X~ FormBean [
A1 JE30], Validate Form S IEAE N T 2 T & 541 FormBean L[ ¥4 1iF /5 ¥ (validate(),
2% K 9.17), Input Source F5& T RKFPKRIE G, XA THSERUERBUS R, TF
N IE S Struts 1045 .

Parameter #3251 N &7 T org.apache.struts.actions.DispatchAction ,
LookupDispatchAction, MappingDispatchAction ix 465 {1 i A 2547 5 X

Methods ##% NEx T 2411 Action BLIEI /7v%, BRiAiLH public ActionForward
execute(HttpSerlvetRequest...)Bl 7],

TR e A — T EAE A 52 Forwards #7325 F 1) ActionForward 52 X . i Add
PR AR I FT ) Forward, 764 ) New Forward Xf1iHE) Name H%i A\ success, Path
fiy NMuserLoginSuccess.jsp, siifi Add FHLEE NS ) Forward. 8 J5 AL N
% failed, #4% 4/userLogin.jsp 1% —A> Forward. ) sl Close #4401 45 dos it
o XWEn] LL7E Forward 415 & 2 WA WA G @ 4 (%) Forward, W1~ ¥ i 7«

B mili Finish $281, 5 R Z0ak ek TR e . 125G Struts it & SO/ gw iR 28 oK
2 HILWINIZS I Action AT Form PRGN Y Forward, ‘o SRE 9.7 AH4LL, XAV
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struts-config.xml P2 ANE 5 9.1 A . 534k n] A 2I7E sre B R 2 7 WA Java X
4 :  com.yourcompany.struts.action.UserLoginAction I com.yourcompany.struts.form.
UserLoginForm, §]FFX P2 a] BUR AR G I ACRS ) LT 48 L& AR il 1 o

K] 9.18 {14 Action [ 1] 5 6 HE

9.19 1% Hr Forward
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9.4.4 HEEA RHIARES

e E—4%, KR O A AR T o T ZM i ——F FHE e &2 Action 2811
ARSI S5 B8 FIWr,  SEkE H 8 ) UserLoginAction 2K (1) execute() /772

public ActionForward execute(ActionMapping mapping, ActionForm form,
HttpServletRequest request, HttpServletResponse response) {
UserLoginForm userLoginForm = (UserLoginForm) form;//
Auto-generated method stub
return null;

TH 9.3 BRIAM) Action SEHL

R ORI E] T Form K XTSI 4 &G 1288 UserLoginForm. 7] DAVE R
FIBIAME OL T FEA ¥4 Action F1 success 2i# failed (1) Forward iE482K, return null 3
HMRER—DNTEHM . IAEIMAG X aeA W, AW R, WEELER
userName #1 password HIME#SSE "myeclipse” (J if {EAJ R 24T 8 LS E) . S J2 1)
i, Bt userName fR772] request fEHIVERIN IR [F] success X4~ ActionForward, iX
FE{E userLoginSuccess.jsp il LU s Sk I 7 4. iR IER gk [ 2] failure 1X
A~ ActionForward. & 7, SEAEE S AR HL a0 R P

/*

* Generated by MyEclipse Struts

* Template path: templates/java/JavaClass.vtl
*/

package com.yourcompany.struts.action;

import javax.servlet_http.HttpServletRequest;
import javax.servlet_http.HttpServletResponse;
import org.apache.struts.action.Action;

import org.apache.struts.action.ActionForm;
import org.apache.struts.action.ActionForward;
import org.apache.struts.action.ActionMapping;
import com.yourcompany.struts.form.UserLoginForm;

/**
* MyEclipse Struts
* Creation date: 12-26-2007

*

* XDoclet definition:

* path="/userLogin’ name="‘userLoginForm"
input=""/userLogin.jsp" scope="request' validate="true"
* -forward name=""failed"” path="/userLogin.jsp"
* -forward name="'success" path=""/userLoginSuccess. jsp"
*/
public class UserLoginAction extends Action {

/~k
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* Generated Methods

*/

/**

* Method execute

* mapping

* form

* request

* response

* ActionForward
*/

public ActionForward execute(ActionMapping mapping, ActionForm form,
HttpServletRequest request, HttpServletResponse response) {
UserLoginForm userLoginForm = (UserLoginForm) form;//
Auto-generated method stub
ifluserLoginForm.getUserName().equals("myeclipse") &&
userLoginForm.getPassword().equals("myeclipse"))
{
request.setAttribute("userName", userLoginForm.getUserName());
return mapping.findForward("success");

}

return mapping.findForward("failed");

THI 9.4 I T kAW Action SEHL
FEH R RMATR 23 A I R AR o
W ARAEAT Y S P A AT T R TR SO N 2, IO S OnE A, AR 2D
1. &k MyEclipse H3hAzp1) Struts & HHA UL userLogin.jsp YA I 5T i gt
GBK FH S G R 4%, AHax AN 0L i v] UE £ MyEclipse BE% n] M4k 27~ Struts b
N IEAE Properties FLEI TP REATAH S FIRME i, W] 9.20 iR . fEgmE A o R LATF
THREIEARNS, R nT LAYEgmt g O vk s b BB O o, BN ZE, fEH] Palette U
A DA I R 2 A 4 L PR N 380 > i 1
18 i AR 7 B T

<}0 page language="java" pageEncoding="GBK">
<%@ taglib uri="http://struts.apache.org/tags-bean" prefix="bean"%>
<%@ taglib uri="http://struts.apache.org/tags-html" prefix="html"%>

<htmi>
<head>
<title>JSP for UserLoginForm form</title>
</head>
<body>
<html :form action="/userLogin'>
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14 - <html:text property="userName'/><html:errors
property="userName"/><br/>

#4: <html :password property="password"/><html:errors
property="password"/><br/>

<html:submit value=""§:x"/><html:cancel value="I}y"/>
</html :form>
</body>
</html>

F 9.5 B XS AR I ok P SO

%] 9.20 Strus JSP %i%H 4%
2. AR AT gmAt it nE g, 33 = FAT i F Tomceat ik 45 2% (A5 3 T A4 175 B2 N IR ANl
KR P FormBean Ik IR LS AN 7= AL A SCELIS ) . 2% 8.7 G gEFilter(WLJE4) —
TN 2R A E PR A IEAD, B AT DA AT RS BB R B A I H o I A
AT it yE 5 (I WebRoot/WEB-INF/web .xmI 5 il :

<?xml version="1.0" encoding="UTF-8"7>

<web-app xmlns="http://java.sun.com/xml/ns/javaee"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" version="2.5"
xsi:schemalLocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app 2 5.xsd">

<filter>
<filter-name>TomcatFormFilter</filter-name>
<filter-class>filters. TomcatFormFilter</filter-class>
<[filter>

<filter-mapping>
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<filter-name>TomcatFormFilter</filter-name>
<url-pattern>/*</url-pattern>
</filter-mapping>

<servlet>
<servlet-name>action</servlet-name>

<servlet-class>org.apache.struts.action.ActionServlet</servlet-class>
<init-param>
<param-name>config</param-name>
<param-value>/WEB-INF/struts-config.xml</param-value>
</init-param>
<init-param>
<param-name>debug</param-name>
<param-value>3</param-value>
</init-param>
<init-param>
<param-name>detail</param-name>
<param-value>3</param-value>
</init-param>
<load-on-startup>0</load-on-startup>
</servlet>
<servlet-mapping>
<servlet-name>action</servlet-name>
<url-pattern>*_do</url-pattern>
</servlet-mapping>
<welcome-file-list>
<welcome-file>index. jsp</welcome-file>
</welcome-file-list>
</web-app>

HH 9.6 A T i uE s )5 10 web.xml
9.4.5 KAf, BATIHMLR

P istT 0 st fEPackage Explorer g & Hhik 5 H 45 £ StrutsLoginDemo,
RIGIEF S HRUN > Run As > 3 MyEclipse Server Application, 2 JiMyEclipsef] 2 i
AT RS 28 5138, i Hh LR [ AR 45 45 2 — Bl WiMyEclipse TomcatJf i i OK 241 )5 ,
4y B Bl R AT B B R AT N R R AR SS 45 . T el A, 1247 WebIit H dif) 4l P
K5 % 6.5.2 MRS es AN, 6.6.1 HahlRssas—THINE, SEREMIARSS 4 & it 2
ALS % S R RS .t mT DT ¢ S S T F S R A S
ORJG S BN IR S 28R AT IR T o 7EServers L thik il gs 48, 2 J5 ki e T B A L @
TR LU AT AR B IR 5545

25 48 Ja s e ga, il TRAS B @3 Ak IT T s A, SR e S b ik
http://localhost:8080/StrutsLoginDemo/userLogin.jsp KT IFE XU, 41 F K Fs:
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9.21 7 MyEclipse 14T 13 Yo 25 a3
R P 4 5N myeclipse, FH A myeclipse, SR fiidess, winl LA R &
KR T, SWIR:

U7 myeclipse, #RC&EEBIN! |
o TUTHR IR 25 T HTIR [P 2068 S LTI o X AN A (1 15 2R 55 196

9.4.6 ZxX 8. A JDBC SZPLBF?

163 8 mEANY T i fii [} IDBC + JSP RIEBUG e, iERIEE — N infpkix
A~ Action B TH] 1) 5 S 3 UFAC RS 24k B JDBC DAO ke sizif 2

9.5 47’5 Struts ¥4 Hibernate {14 MW A
AT A EIT K KT Hibernate 1143 TS =27 A5 1 N
9.5.1 40 B v B

53 DUN I R REAC SR B 0 2 — B0y, iR gl 1 1 LA
1. BEAN DU E AN M 1T U 25
list.do?page=0// /7 /&7 URL
int currentPage = Integer.parselnt(request.getParameter("page")):// 7 75 MK 24 i 7 #4
currentPage 7% & il H K45 7 a2 W 2] 758 Lt
2. B IR 2 DEE
int pageSize = 5;
1) S NESH e A S i s
4T select count(*) from table , #&J5HTLAEXH totalRecordCount.
2) AR — DT EARE 2 S R DT
AT s B ] DARYE — T Bos 2 D8 R BRSO (R 9 Sl
T 5 M TTENAZAE 2 A2 D):
int totalPageCount = ((totalCount + pageSize) - 1) / pageSize;

if(totalPageCount == 0) {
totalPageCount = 1;

}
I EHOR R TR DT 1.
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4. B vALHY
ISP BRI R, ity SRR S DO 4 F 0Tk A2 5 4 HH Ao 8 0 ke, el A
SERTH TG 22 DU SCAS . A A S K DRk T JavaBean Bl bR 7 o
R U R
F—711 list.do?page=%{currentPage+1}
E—1t list.do?page=${currentPage-1}
TERT G Wos bR e, H A b S vy b Bk ik P BB 2 -1 ek Lk
UEE K A8 L
<c:if test="${currentPage > 1}">
[ E—UsEs: ]
</c:if>
<c:if test="${currentPage <= 1}">
[ E—oupseA ]

</c:if>

)Gt forEach KB R
<c:forEach items="${users}" var="user" >
${user.id}
${user.username}
<c:/forEach>

—RIE Sl B AR B B

<script>
11 Tk e 2
Il Z5 A5 TSR RITER, FIIAKE, NHHESE
function jumpPage(input) {
11" GRS AH [R5 A ke
if(input.value == ${currentPage}) {
return;
}
var newUrl = "/StrutsPageDemo/list.do?page=" + input.value;
document.location = newUrl;
}
</script>
FE| <l-- #i HTML SELECT Jo#, FRiEd Uuy i mgmd -->
<select onchange='jumpPage(this);>
<option value="1" selected>1 i </option>
<option value="2" >2 1i</option>

</select>
WS N AMELLH P A R B v, B WX A s
A T

AR 5y SEBL, ARG R
A TS <input type="text" value="${currentPage}" id="jumpPageBox">
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<input type="button" value=" B¢ # " onclick="jumpPage(document.
getElementByld(jumpPageBox"))">
o RIVZNT JFE, M EL FRIEAM ISTL KL,
5. i) DAO mi#k% 2
1) $#24tEIC %L select count(*) from table , #XJ5 LA totalRecordCount
SRJE ] DATHE R S 0T G 9 /I sk BRI B 45 R DB 2 1A 2 1)
totalPage = (totalRecordCount / pageSize) + 1;
2) $RAEy T A 1) 5 vk
pagelList(int currentPage, int pageSize)
SREUM currentPage * pageSize, pageSize * (pageSize + 1)iX /4> 2 [u] i K s £ .
JDBC JHikrks<Hl, $447 select * from table SK3KEL—AN A& 5) (1) ResultSet, 44X
Ei}%ﬁﬁ:
rs.absolute(currentPage * pageSize);
FEIX IR T O, Fdllgs th— 524 1) 56T IDBC #1351 DAO K75 i AU 4 h

import java.sql.Connection;
import java.sgl.ResultSet;
import java.sql.Statement;
import java.util.Vector;

/**

* Pager, %71 JDBC 2.0 ®ahMLflM4r 1FEF, /£ MySQL, SQLServer, Access, Oracle
A
* @author X1 KA
* @version 1.0 2004-8-12
*/
public class Pager {
[** Used database connection */
Connection conn = null;

public Pager() {
}

/**

* Iy ULTRE, AR [EY UK EE(IDBC 2.0 SEHL).

*

* @param currentPage

* T A A N 1 TFAAAAL, 0 AZhKCh 1)
* @param pageCount
* (UNTEIRTES

*

* @return a Vector - £ 4515
*/
public Vector pageData(int currentPage, int pageCount) {
Vector results = new Vector();
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String tableName = "table_name";// H &b {5 44

ResultSet rs = null;
String sgl = "SELECT * FROM " + tableName;
Statement stmt = null;

try {
// TODO: open connection

I AT R B 2 R AR TE

stmt = conn.createStatement(ResultSet.
TYPE_SCROLL_SENSITIVE,
ResultSet. CONCUR_READ_ONLY);

rs = stmt.executeQuery(sql);
int count = recordCount(); // =i 5¢%k
int totalPage = (int) Math.ceil(1.0 * count / pageCount); // & 7 [Hi%{

if (currentPage <= 0) {
currentPage = 1;

}

11 RS YE ], AN [

if (currentPage > totalPage) {
currentPage = totalPage;
return results;

}

if ((currentPage - 1) * pageCount > 0) {
Il % 845 RAE A 2 257 0T
rs.absolute((currentPage - 1) * pageCount);
}
Il rs.absolute(0); 7t ODBC R33N i 5% java.sql. SQLException: Cursor
// position (0) is invalid

inti = 0; // Readed pages

while (rs.next() && i < pageCount) {
i++;

// TODO: Read each row and process to value object

ValueObject bean = new ValueObject();

// TODO: Read value to value object

result.add(bean);
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} catch (Exception exception) {
System.out.printin("Occur a error in " + getClass()
+ ".pageData() : " + exception.getMessage());
1 exception.printStackTrace();
} finally {
closeJDBCResource(stmt);
closeJDBCResource(rs);
closeJDBCResource(conn);

return results;

}

/**

* 30 0] 22 A A Al SR R R
* @return int 3% A3
*/
public int recordCount() {
int allCount = -1;

String tableName = "table_name";// 4B 44
String sql = "SELECT COUNT(*) FROM " + tableName:

ResultSet rs = null;
Statement stmt = null;

try {
// TODO: open connection

stmt = conn.createStatement();
rs = stmt.executeQuery(sql);

if (rs.next()) {
allCount = rs.getint(1);
}
} catch (Exception exception) {
System.out
.printin("Occur a error in " + getClass()
+ ".recordCount() : " + exception.getMessage());
} finally {
closeJDBCResource(stmt);
closeJDBCResource(rs);
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closeJDBCResource(conn);

return allCount;

}

/**

* Close a jdbc resource, such as ResultSet, Statement, Connection.... All
* these objects must have a method signature is void close().
*
* @param resource -
* jdbc resouce to close
*/
public static void closeJDBCResource(Object resource) {
try {
Class clazz = resource.getClass();
java.lang.reflect. Method method = clazz.getMethod("close”, null);
method.invoke(resource, null);
} catch (Exception e) {
e.printStackTrace();

/**
* Test page.
* @param args
*/
public static void main(String[] args) {
I3 0T, BB — GO, SRS Ml
Vector data = new Pager().pageData(1, 5);
/ TODO: process value object, 5 {2544
for(int i = O; results != null && i < data.size(); i++) {
ValueObject bean = (ValueObject)data.get(i);

i 9.7 JIDBC 43 it DAO R4
AT RIR FH (1152 H Hibernate K581 1 DAO. Hibernate ] Query X% nJ LLsE
WAy T, WA 512 setFirstResult(int first)fll setMaxResult(int max) 23 B 1 A ) 45 1
[R5 first FFAG 2 max 45k, #aihBiur R AL max 45, W< iR B 205k 45 R IR 40 .
Hibernate (15 & S<HL2y A 20 AR o ZE I R R IE RS8R LU S I S8 0. 7l AR T

Query g = session.createQuery("from Cat");
g.setFirstResult(currentPage * pageSize);
g.setMaxResults(pageSize);
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| List | = q.list();

9.5.2 flE StrutsPageDemo i H, MMA Hibernate J & Ihhg

T SE T A i 1 51 1R A BN 44 O StrutsPageDemol ) Web i H , 7 Rk
WAk Java EE 5.0, SRJEIMAStrutsHF &K Yifit. 25 fHiE ¢ $.MyEclipse > Project
Capabilities > Add Hibernate Capabilities ... 2K 247730 H il AHibernate JF & Zhfig, %
P EFRATTIE BEMYSQL, V4 b B A 0T g H B AR ) ) R v T R ARE 2% 7.4.3 RN
Hibernate Capabilities FIA5 0 H 5 1A 25 .

9.5.3 kM ILE4AR DAO 2

FATIXANTIH w050 e 24 2 LR — B H i Student 2, L kRS % 5.2
BIEEORIERE — TN E. BEES% 7.4.5 MR TR fJava POJO, i
W SCAERIDAOAM 7.4.6 %A I hbm ST 5 4 (1) A 78Kk A2 i DAO 22 AR, /T LUKS Ji
KRS H BN BRI AT, R dao CGEBRIEH FIXAML A WV 1% F5 48T com.abe.student.dao
EFE R BB 0 4 7D o AEIXANDAOK T T Z NS VU TG AN 738, T 15480
g% B H % Hidao. StudentDAOHIA 1R 77 15 (K4S h .

/**

public int getTotalCount() {
Query g = getSession().createQuery(‘'select count(*) from
Student');

List cc = q.list(Q);

Integer a = (Integer) cc.get(0);
return a.intValue();

}

/**

* Oy TR EE

*

* currentPage

* AT, A1 JH

* pageSize

* B U0 s

* ARSI - List<Student>
*/

public List FfindPagedAll(int currentPage, int pageSize) {
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log.debug("'/r &™) ;
try {

if (currentPage == 0) {
currentPage = 1;
}
String queryString = "from Student';
Query queryObject = getSession().createQuery(queryString);
queryObject.setFirstResult((currentPage - 1) * pageSize);
queryObject.setMaxResults(pageSize);
return queryObject._list();
} catch (RuntimeException re) {
log.error("'find all failed”, re);
throw re;

5 5 9.8 Hibernate 73 it StudentDAO.java f{hi%

9.5.4 wWELHRANHE

— kUL, NSRRI DAO 2 BT, NS5 =L T T R 2R @ AW, P DX B
JEHEAT 0 TUAL BEG BEAE ML 7 . ¥EF% File > New > Class #id—4~4 4 manager.
UserManager ] H k4558 GXAM A4 AT AR SE B i )58, A NS5 4E domain, biz 1],
TP, BB S ERIRD, AR Frs:

package manager;

import java.util_List;

/**
* F LS5 B
* BeanSoft
*/

public class UserManager {
/** JH P DAO */
private dao.StudentDAO dao = new dao.StudentDAO(Q);

/**
* R B
* EARGISE
*/

public int getTotalCount(){
return dao.getTotalCount();
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/**
* SRR T

*

* pageSize

* YUl
* mﬁ;ﬁ\iﬁ

*/

public int getTotalPage(int pageSize) {
int totalCount = getTotalCount();

// 33 S
int totalPageCount = ((totalCount + pageSize) - 1) / pageSize;

return totalPageCount;

ks

/**

* Oy DU A

* currentPage g, M 1 JFih

* pageSize i REd &

* I EHEYE - List<Student>
*/

public List findPagedAll(int currentPage, int pageSize) {
return dao.findPagedAll(currentPage, pageSize);

}

75 B 9.10 Hibernate 43 1 DAO 444
EANR TR T =AUk E RIS 2000l 3, FHE T — AR5 DAO JZ5LHLIK
O3 VLB () i

9.5.5 A Struts FHEMEEIE
Wh, BATTEQIENAD ICEREWXANIH . — A %2R ISP TUfi/E R I

J2, HLEEDREHURE o DU AE R, S AT DO, I R UK HTML BRI CAs
S, PR LB OLER o P SRAE T S, AR N T A BRIAAE . TS B R R

<%@ page language="java'" import="‘manager.*,java.util._*"
pageEncoding=""GBK"%>

<%@ page contentType=""text/html;charset=GBK"%>

<Y—— FAVER ISTL ki Bl --%>

<%@ taglib prefix="c" uri="http://java.sun.com/jsp/jstl/core" %>
<%

String path = request.getContextPath();

String basePath =
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request.getScheme()+"://"+request.getServerName()+":"+request.getServ
erPort(Q+path+"/";
%>

<IDOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<base href="<%=basePath%>"">

<title>{]/" 3R </ title>
<meta http-equiv="pragma' content="no-cache">
<meta http-equiv="cache-control™ content="no-cache">
<meta http-equiv="expires'" content="0">

<style>

/> EHEIMA BARE A M LR N R Tfe >/

a:hover {color:red;text-decoration:none}

</style>

</head>

<body><b>H] F 5K T </b><br>

<Y%-- F 5 --%><br>

<table width="80%" border="1" cellpadding="0"
style="border-collapse: collapse; " bordercolor="#000000">

<tr>

<td><b>MH F ID</b></td>

<td><b>H F %&</b></td>

<td><b>PAE</b></td>

</tr>

<c:forEach items="${users}" var="user" >

<tr>

<td>${user.id}</td>

<td>${user.username}</td>

<td><a href="edit.do?id=${user.id}">Bf</a></td>

</tr>

</c:forEach>

</table> H:${totalCount}/ )"

#E${currentPage} i/ ${totalPage} il
<Yh-— T ST AR, AP BER R A SO PR - %>
<c:if test="${currentPage > 1}'">
[ <a
href="${pageContext.request.contextPath}/list.do?page=${currentPage-1
Y>> E—Ti</a> ]
</c:if>
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<c:if test="${currentPage <= 1}">
[ b= ]
</c:if>
<c:if test="${currentPage < totalPage}'">
[ <a
href="${pageContext.request.contextPath}/list.do?page=${currentPage+1
Y>F—m</a> ]
</c:if>
<c:if test="${currentPage >= totalPage}'>
[ F—7T1]
</c:if>
<%-- #itft JavaScript BEEAIS —-%>
<script>
/7 DUk R AL
// ZH B TSR ITE, Bl ANE, N RIAESE
function jumpPage(input) {
/7 TUREAR A A gk e
if(input.value == ${currentPage}) {
return;
}
var newUrl = "${pageContext.request.contextPath}/list.do?page="" +
input.value;
document. location = newUrl;
}
</script>
3
<t—— fitll HTML SELECT o3, JRigH 4y gty —->
<select onchange="jumpPage(this); ">

<c:forEach var="i" begin="1" end="${totalPage}''>
<option value=""${i}"

<c:if test="${currentPage == i1}'">
selected
</c:if>

>H${iYi</option>

</c:forEach>

</select>

AU <input type="text" value="${currentPage}" id="jumpPageBox"
size="3">

<input type="button" value="k#%"
onclick="jumpPage(document.getElementByld(" jumpPageBox"))">
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</body>
</html>

H I 9.10 index.jsp 7 KR 2 ISP XY

A Actiontf S AE W iEHI ), % 9.3.2 Struts4L 4 S — 5K N A8 56 &
Actionff)[n] 5, i WifEstruts-config. xmlIff) B it A b i i 8, ZEFENew > ActionBIAT
e I 2T Use caselbfis Alist, 2R 5 rithForwardshras Ja s in—A 44 hdisplay it 14
“hlindex.jsplfiForward (2% 9.4.3 fli B i Form, ActionF1ISPf) [ 5 ¢ G FE 41 {1
A . SERUE AR K 9.22 s RN R ActionZS [REAS A AR T i, N0
M B CE S 515> DO JZ 5 (RS sk v DL T o JLos AR A e 9.1 oo CRI T
WD REE, ANDERE R ST T MERD:

9.22 43 TN H ) Struts v fE

package com.yourcompany.struts.action;

import java.util_List;
import javax.servlet_http.*;

import manager.UserManager;
import org.apache.struts.action.*;
public class ListAction extends Action {

public ActionForward execute(ActionMapping mapping, ActionForm form,

HttpServletRequest request, HttpServletResponse response) {

/7 Sy By

String pageString=request.getParameter(*'page’);

if(pageString == null ]| pageString.length() == 0) {
pageString = "1";

}

int currentPage= O ;

try {
currentPage = Integer.parselnt(pageString);// ajiiy

} catch(Exception e) {}

if(currentPage == 0) {
currentPage = 1;

}
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int pageSize = 3;//%4: 00 oA 4

/7 EHHE

UserManager manager = new UserManager();

List users = manager.findPagedAll(currentPage, pageSize);

request.setAttribute('users”,users);// {4717 44

request.setAttribute(''"totalPage",
manager .getTotalPage(pageSize));// {417 itk
request.setAttribute("totalCount™, manager.getTotalCount());//
PRAF LR L
request.setAttribute(''currentPage’, currentPage);// {547 77y
return mapping.findForward(*'display');

TP 9.11 ListAction 2 [1J5HL
HE: JFF Action ZEAZRBERL— AN ActionForm A RE ], X% &M Spring 3F4F—
JEHAFC RN AOP, 10C, Web #8\% T LA RS T Spring s MERE, HERUE AR MR
SRR L, AR TR R FRA TN HERE R R XML PC B S A2 S AR I

9.5.6 KA, BATIFMIR,
W5 % 9.4.5 RAG, IEATIHMRR—5 19 2 RATFHIZATILIR H o 4R 54T TR W 2848 A\ 1

1l http://localhost:8080/StrutsPageDemollist.do KIMNR I 4 TN H o« A5 R iR C4Y%%
HIHE AR M) Student& A i A T —LE PR B0k )

Kl 9.23 43 N H s T 45 R
9.5.7 4.3]: W{TH Hibernate+Struts SLIBE S H 5B ThEE?
7 E— K] LR BB BOX AN EERE, s e LAEE R 404 HER, ISR RN )
IR 2. EREENER:, B — T EASZIMESH T IhEER ? ##78: DAO

HELEU TR, 2 AR AR N Action T, VEEMBIERAL TASEON id,
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BT ARAFIXAS id, SR HIE I DAO REHUR & SEMSRIIfE R, SRJET0E request ))&
PErR IR B 45 5 6 GO s, 576 AT BUER EL Rk AOREEHO M 5

9.6 /N4

AFEREEANH T W MyEclipse $REETFF & —AN G N AL T Hibernate [¥)53 TL W
H, %‘ﬁxﬁllﬁ‘]ﬁ@‘ﬁ%T Struts [HSCREE .. HREAFE, HS LS TRR, AGREEER
PR ) (1) Struts N 0T K !

9.7 ZERH

Struts {22 BORHHXTIL 2R 21
http://www.blogjava.net/beansoft/archive/2007/09/08/143642.html  Struts i ¥ i ik
http://www.blogjava.net/beansoft/archive/2007/11/16/160876.html #H: MyEclipse Struts
1.x #fE(PDF% )
http://www.blogjava.net/beansoft/archive/2007/10/17/153565.html  Struts 1.2 1) HTML
PRARE B (duser.name) W i N JavaScript 2 56 IF
http://www. bloqiava net/beansoft/archive/2007/08/28/140522.html (%% # ) ( Struts in
Action ' 3L SRR
http://www.jamesholmes.com/struts/struts-console-4.8.zip Struts Console, —FH iz T
() Strutsic & SC /-4 i 2%

Struts 2.0 2% (%R 5. http://www.blogjava.net/max/
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#1TF JF& Spring MH

10.1 &4

ARBERINE LS A BT <<Spring JFARFRFATT>>1 208 LT 2R A0
(AR 5) http://www.blogjava.net/beansoft/archive/2007/05/09/116258.html ; MyEclipse
55 JF k& Spring + Struts + Hibernate [ £ i AL A (K 1.5 /N )
http://www.blogjava.net/beansoft/archive/2007/10/07/150877.html .

AFE FUN Spring [ 10C, AOP FE s 2 1 A5 3 In LA S (138, Lk 6 AR OC 1) T
R FEREMSBEATIRIE 1Y T M. T 2C T Spring (1495 48 nl 1835 Wkifg:, BB _E5G T Spring
PISCRY L P B 2, FE SR ACTE N AW 3EAE b, U238 mT DL BAT I SR AH OG0 A8 50 1 15 v Rk dk
ITHERIZIRIE S o T4 %2 1) Spring Web MVC #5%), B =% R JENENHET .

10.1.1 Spring &

Spring, HICEBEUER R, i REELLH SRIXAHELLL Java Tt kN G KR
N, FCE 5 M2 www.springframework.org,  H Rt icA S 2.5, ATRALER 7 R sk R 3
FITEHEIRIE, PARIS LR, e B R E— T S

M A4 Spring MR, BERFEEL: Interface21 A#][# Java EE £ Rod
Johnson 5 T —A5. (Expert One-on-One™, J2EE Design and Development) (it
PO DM R AR, PR A (J2EE Wit T R gmFEa ), e B KAtREt
T EJB (2.0 JRAI)) BFp Rl 5, AIEn] 25 T 3 TS kS S HEAE,
IR S TG RN BB e, g 5 oK) Spring HE4Y . J5—JF4A11) Spring 1 H CLF
ZOEE T 10C (P R, Hosihod H RO 77 20 A get F set J732) Jrifl, JaokE H
B, I TIRZ B8, #lin DAO, AOP, ORM, Web %545, H{VER /&
(15 R% B35 AT (PIREZE 5 THT, Ft DAAT I & A Rk “ T RER K7, & B A4 72 Spring
AR 3047 NNK Spring & — DM HESE, JLFEE T Java BRI TT
AR AR SR B e AR IXEEA AT g I e, DR BEAE I R R,  Java EE BOREES,
IUAE R B N FHEEAE N I i e e S Ok HESS T, W _EJFAR T A ROR AIEE T-HR7E 1)
Google Guice 10C ZF#MIG . 1ERNFF RN TRUL, Kt Spring i WL it & 1
AOP k4 Hibernate A HahF 4 A BEIThAEE, 1 Spring H AT Web HEZL I %A
GIARE Th IR b A8, By LI T — /N AT AR : SSH(Struts + Spring + Hibernate),
Web 2 &g e MER Struts i BNV S5JEHESE Spring 750 A7 HUCECH 22 i i vk g 2
Hibernate, Ay T —FiH WIKTFEMF T 5, XET7 S EBORIIGFAL S St B KRB A2
XML BC &S RZ T o #ef)uhiid, H Spring K7 EHRGEM 0] A L& HIY, RZE
T ERSEIT %, S THEARAN G KY, Java A IR BT 1E I LM i v )7 S FIHESE,
Java F27 AR A A I JCE) Java HERL, M54,

$#£3) Spring MZH 1, AEANY Rod Ay — N&E Spring BUZ14E: (J2EE
Development without EJB) (Expert One-on-One™, J2EE™ Development without EJB™,
Rod Johnsonwith Juergen Hoeller), 444 10.1 fiis.
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Spring TN AW Z (SALHEMEMEE XHESEASAEMBZ, N
Plain-Old-Java-Object (POJO) JFk, FIM LN HFEFIF A, BN HFEFIF R, BlFFA
JETFF R LA R VT i FE(AOP), R Je o AT ZURENG 25 5 RS ) B 5 i % 11) Spring
R, AR EE A KIT R POJO N, SRIF5IAN AOP R E T K

44k (DI, Dependency Injection) ? R ¥RE AN T A D, F% C4 4k
PGNP NI R I A 100 AT C4, B T H SR, XA T IRA 1T
W) E A RIRER G 59— R ke, 2020k H b LS, PP R 200
AT CAYEZS, SRIGURTT LAVESSEAN IE— R 32, 1K AH > T URE T ZE R R N T 200 2
JT C4, PR PRANENIE S AL & WAL, AEL R B AT PRAE AT A B R AT b 75 22X
SEEZy, Wb, S HIACE SRR, Xig T 5 —AN K 10C EHl R, Inversion of
Control), =EIRILE N TFEHLE [ MR, &8 G AE A RHES RGN
% (KEP).

K] 10.1 Rod ) Spring % 1. J2EE Development without EJB

t+4. & AOP (Aspect Oriented Programming, W HYIE4GE) ? X TEMRE H
BA AT FBARRENE, W ZSANE] 1t 25 5 B . BB UR IR A A& R T
BT MBRRAUEI A AT R, RARENS T, WTLCE S AOP I ). FTHITE, A
Wrs TG, A NERBUR 3 ARG, RIVERANAIR “Or27, & iR kBl
DAY BENS FL AR I AR VI I8 T, B A SBATI T . 52 Web FF & it i g 2 it
SEIXAEAI, AR —A AOP BT XA RIBERIE A — 2, w2 bl (Aspect).
GRS OL FURICREARILVITH (RS IRAFAE, ZEMTE B0 P AR AR B A T T, 4F
T, XA AOP, HLEIAXIR T BT A5 .

Spring (1 FF A& KB - O N HEE S XML FLE SR 41235 Rl %5 #£ 11 Bean AL HI%E
fERIBCE M7, Spring 1R N 53 W] LAELIE IR RSP (1) &N 3000 CE Rk ok, Al v
BeaE XML LB ST, BEPZAT IR Spring el "% 7" Gl slE vIaa i a
(IR B FR o R I AL gl 5 3 1R 48040 T DR 2 IR DI 3] g — AN S () - I
L), HHEBSEREE XML BCE SO, RE G TR . 76— S ol ~ e
AT B P PR o XN I RN SR B AMR KI5 2 A, a0 75 B 5l R AT

191 KA



MyEclipse 6 Java JT&H SCHFE

KRBT &AEB S . Spring X X 46 a) @ i) B4 44 TR AR ITT =X, S i TR
BRI YEA N T, SCRFGRBE ) (T AR #Addiik, Spring 2% H ATE AR AL LT HUHT 4
ANXAER)DRE: reload, AR (12 FERT G N8 10 2 2 SE 41

W2, Spring 1ESERR TF A T BNRAT 2 M ? & 2 Wt & SSH (Struts + Spring +
Hibernate) X &M% T, '©HEI T DI f1 AOP HiA, B NFH'E + 25 = J7 g AOP,
PRz 554 (flin ACEGD .

YER: Spring HPEA DR N FURAESCEHESE B T — Z A R oe, XS
Fph—/> 2MB £ 1) Spring.jar »& ANGESEIUATAT B INTRERT, A0 06 20RO 1) 1L & HE S 6
FEAR Ntk Y Wl HOEFF K DI ORI AOP, AN ZE &k, NS ZEEn—A4
commons-logging.jar . & 7 i #i., Spring T H 1) 5 /N KM E FE B & spring.jar +
commons-logging.jar.

WY, BT IRAERE, WMUVMRCEA fa ! 0 T 1 X2 RNl Spring B
EIB (WH)# & KRB Bt HSERp ol MR BRI H 2R 0 2520, i T

10.1.2 MyEclipse i Spring J & ShRE /v

MyEclipse $#&4t 7 X[ ¥ & Spring 5l H (15245, B4&: ¥ 0 Spring 2814, Spring Bt &
Prgmia ey GRS SR AE R AT ), Spring Bean € SRR 7 BA R N e dis 122
H 24 Bk Spring DAO (344 Hibernate 5# JPA) 130 FF.

10.2 FFREHH Spring NMA

AN TRA T2 FF e —ANEH 17 51%) HelloWorld 1] Spring %1+, ib#A4™ Bean I i
IR,

EE: M AANNE AR EAE NS — N O R 2 AL ? X2 KR
Spring FRURS ffUZ SEFH A5G, R I H HFEAMEA Le N UL IRIRFE 75 2 — <5 D)4 31 IDBC 115K
W, —4 NEY)¥: 3 Hibernate (1SR 7870 FEILI 7] B2 i fd . a2 IX MG oL, FRAR 7]
— AR N AR AT AW ? Wi — N 0 HRE R —ANSEE, L ERe iR L, T #%
FIf 4% 1

10.2.1 25T H A Spring Zh&k

TG AT LA AT = 2R Java T H , 40 Web, EJB Z8#80] LL, X EEIH H # AT LU
Spring Lhfig. BL{EEFESEE File > New > Java Project, 7 Project name /A
HelloSpring , #&J st Finish #Z IR A1 —A 118 Java T H .

Tt H A se ¥R JE sk aT AN Spring FFAINRE T o BT H YN IN Spring ThAE, 15T
[ SR

1. 7 Package Explorer #{E#£$ HelloSpring Jii H ;

2. ¥Fk, M MyEclipse =¥ #:3%# MyEclipse > Project Capabilities > Add

Spring Capabilities ... k)33 Add Spring Capabilities [1]5, %[4S 10.2 73,

XA H Kk, URATELE R s Finish 3280AT T

NTHRFRMEZ PEE, FZENE— FIREAREHE LI & L. Wi 10.1 Pios.

| & | g
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Spring version

Spring hieAs, — ik Spring 2 FLEH

Select the libraries to add
buildpath

to

the

EREE NI H R EEAR R . XA
Spring M 4% IS EAT T il 43, il
Spring 2.0 AOP, Core %5%%, 5100 H (177
TR UL BRI S B EE . AR SEAEAN TS
FEWRLG AR TR, e AL T OK T .

View and edit libraries...

s SR A DB SR iR

JAR Library Installation

HEFE IAR HKPEN 2520, R f ks H
S B s FH R R NN B A2, T8I (1 ) 75 2
feo -~ B RACHTE 10 JAR SCHFIARSE ST
IONEPYETIH X Ay & T A OB
MyEclipse AT I K 8 T LKA

Tag Library Installation

MBEH T Spring Web (¥ & 75 B R @ bRy
SO I 22k H 3k

% 10.1 ¥3 0 Spring T BEXT 1 HELE I fifiidk
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10.2 4350 H I\ Spring Ty fE ) 30 1 AE PR 55— ORI 28 — 5T
WHRAE XA AE S — T a5k 7 Next 42811 A2 Finish, A4 ) (1958 00 w] LA & ]
B4k Spring bean & X 3CF. ATLLHFTE Spring bean & X CfFEE kAN A K (New
B Existing), AT ME I Spring Bl & U4 T (& Folder I File i£50), #7148
siili Finish #2815 m] LLSE SGZs i Spring JF R R id fE . Jse s it H SCFan i1 10.3 Bk

ATLVER| R F S MA T Spring %028
FEscfr, mH M Ebs B2 TANE AN S
JEAR, BRIt 2 AMEZ 1A Spring (1R E ST
applicationContext.xml. XX AN SCAFxk
A LAFT T Spring o & SCF S 2% .

W XN, WR
Spring FF A R 2620 HE A4 1 SC A
%454 Spring bean Bt & . Al LS A
VPR Refactor > Rename SR 5 i\

T4 AN ]
10.3 AT Spring 2 FEAYI FA A kA
FULTF (A TAEE 65K, B FRRT LT TR T «

10.2.2 I Bean BMEEE R

IAELE IR IR AP A Bean, Father Fil Son 28, SR 5 Bk 24T FR0T (A B )L 7o iR
EITHE, 1T, YEESE File > New > Class 4G @ AN, HYEIS W R s

/%% 5% </

public class Father {
private String message;
private Son child;

public Son getChild() {
return child;

}
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/**

public void setChild(Son child) {
this.child = child;

public String getMessage() {
return message;

public void setMessage(String message) {
this.message = message;

/**

* fTHIT

*/

public void sayHello() {
System.out.printlin(getMessage());
getChild().sayHello(Q);

LY */

public class Son {

private String message;

public String getMessage() {
return message;

}

public void setMessage(String message) {
this.message = message;

/**

* JTHIT

*/

public void sayHello() {
System.out.printlIn(getMessage());

195

V& B 10.1 Father 1 Son 2%

T, BRI KREBY Spring MECE SCEIMAPA Bean & X, JG8Id. & CfF
applicationContext.xml T FF XN b 2%, AR 5 74 4R 2 sl A Bk £ . Spring >

KA
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New Bean )1 387 Bean 14 5 . XA S W& 10.4 Fis, Al 126 E X Son 24/ bean.

K 10.4 Fr#d Spring Bean [#)[] T
{£ Bean Id &b\ son, Name &bl LU A/son GXAM@PEH AT AHD, Bean class AN
Zhw X4 Son, RJETREXIXAS Bean BT IE, riidi Properties #7345, AJ5
il Add.. FE R JEZ g e a5, ] 10.5 k.
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a) ZRIA Spring type 4 ref, fiili Spring type RHzHERE+ value J& 1

b) #'& bean [¥))E
K 10.5 ¥ i Spring J& X G HE
LR PR E R NES, s Finish 328 DG TEAE, 7T 25— F EXHEHER Finish $%4,
—> son [f] bean i€ X T -

HE: B4 Spring MBLE UG 2 ME, BlaEHm AR R, w5k
WRAENE, FEMRBELAX AN SHRNZ .. SIEHEF IR 2 8 AR Spring IS &
SOOI B C B S B G, BIAME A28 T, n BLS UR KK 102 Spring B & 4
SEAYAR SISV AR T IR AE, AT 0 e IS VAR . 554h Bean Id 4b K
RE5 - REFIT, 1 Name U AT DU N — SRR BR 14060 a0/, - DRI AE S5 TR R #84 Struts
IFEFPIS, 2 H 2] name.

[FIFER), FeAInT BLE X Father 1XA4 bean, FT AN /& 7E Bean Id 4% A father, Name
Abny Ll N ffather GXANJEPEt il AN1ED, Bean class AbMi N E e X254 Father, k)5
FXHIXAS Bean [HJ@MEH TS, Aidi Properties #3255, AR5 s Add.. 245K JE Shs N
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JE k)RR, BT anE] 10.5b (1) message J& YL value ZEHI A LA, BT EFRIN—A
XJ child 151, BARERVERE it Add #2415 7E Wil 10.5a 1) Reference Hii ANINI &
i) Son bean f) 1d: son, TiXt [ Name (JgEPE42) Féi A child.

BT IXEHE, AHGMIIF R TAERR A 5E T« IXIHE A F applicationContext.xml A]
PLFE BAHOCH) bean 5 X XML ARRHE A T, WA Pis:

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">
<bean id="son" name="/son" class="Son" abstract="false"
lazy-init="default" autowire="default"
dependency-check="default">
<property name=''message'’>
<value type="java.lang.String">JL¥</value>
</property>
</bean>

<bean id="father'" name="/father" class="Father" abstract="false"
lazy-init="default" autowire="default"
dependency-check=""default">
<property name="child">
<ref bean="son" />
</property>
<property name='‘message''>
<value type="java.lang.String">%%:</value>
</property>
</bean>
</beans>

TE 5. 10.2 bean 5 X 3 applicationContext.xml
TR S X AR S F B AR, BRI T — 2N B JE P, SEbr b, son iX
A bean (152 SCnT LUK & 0 Wi B s

<bean i1d="son" name="/son" class="Son">
<property name="message''>
<value type="java.lang.String">JLF</value>
</property>
</bean>

TEHL10.3 KA bean & X

10.2.3 Spring Beans #LEF Outline L&

MyEclipsef&fit T Spring Beans #LKl, #eW% RO 4w Xifbean, JfRt—2 T ALT
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HoRBeanZ MG R . MEHALESE Windows>Show View>Other, {E# H %G
HE 3 $67 My Eclipse Java Enterprise>Struts Flow Overview, #ir] LAFTFFHRIA,

Wik 10.6 . Bl 7R T A 1 Springic & SO LA L b i L fBean . JIS4 Wi 7w
BeanZ [ R KW ? rihida b o] LLG BIPEEE R, AR, EHEShow Graph
ool AfE g A b B rBeanZ RIS R E T, Wil 10.7 Pros. [RI 6 n] LG BIX AN i
fU% T Open Config File (J]JTEC & ), New Bean CHidBean), New DataSource and
SessionFactory CHraE i #i ¥ M4k 1.] ), New Hibernate SessionFactory CH#
Hibernate<s1fi I.) ), New DataSource CHrit#i#iiii), Properties (gEE) SFThfRES IR,
XL T RE K 2 FIEHR T KA G, fEAR G 10.6 Spring s 72 & — 15 P44

10.6 Spring Beans M & J I R 3R

K 10.7 Spring Bean <& H

KRB R T 2R AL E S, FE Bean Z [RIRHHC R UAF LR R, HEER TR
() id LRSS R JE e, 76 bean BTl v LAFT G E SO g R4 I 407 26 B f¥) Bean i
XML 4k, XA BRI 24 1K) Bean KRN JUHATH .

74k, MyEclipse i&7EgmfH Spring A& SO AL T XN Outline ¥, wT LA )
TR N B REGE 7 Bean JfU7 MAHC D fE. EALE EWoR T bean 5E X, LUK J& P AT
R e bean (7111 father (1] child J& P LLH7 3k WD AEAIE] EXGE X IK) Bean i A]
PUEE B 78 XML & SO )5 o 1 ki Outline R B =241 U 33 H AR 9% i) 61 2 Spring
AR A E TS, EALE I bean & SC_E i A B AE R A DG IR Bz B
KR AZHNHET .
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%] 10.8 Outline #1.1&
%E,WSmmy%ﬁ%Jwa%%EPmk@eBmMmh%E¢u@Eﬁﬁﬁ,@%E
SRR

10.2.4 BATHRIMAR
FIIX LA — AR L] T Ih e A TR R e 5, AT 3R S WIS IR AR AT Rz 1T

AR 5e AN Spring KSLEILTIE I Hox, 5 —MIRRZORiEE ST, XK
KU N HR:

public class TestNoSpring {
public static void main(String[] args) {

Son son = new Son();
son.setMessage (" E & Julfi JLIFIL, L4%)LEIE! )
Father father = new Father();
father.setMessage (" AL A FUEN AT ™) ;
father._setChild(son);
father.sayHello();

TE R 10.4 ANMEHR Spring HMIER S
EPEZEH Run > Run 12171245, 330100 Mok

AL A S ANA
LEIME)LLFDL, L) LAEI!

I AHE TR ARG E —A Spring WA KRS, AL FRATIN AP 4 5 1RO L B SC
o XA N Pros:

import org.springframework.context._ApplicationContext;
import
org.springframework.context.support.ClassPathXmlApplicationContext;

public class SpringTest {
public static void main(String[] args) {
ApplicationContext ctx = new
ClassPathXmlApplicationContext("applicationContext.xml');
/7 14 bean id 3K
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Father father = (Father) ctx.getBean(''father');
father.sayHello();

// HHfibean name 3kHX

Son son = (Son)ctx.getBean(''/son™);
son.sayHello();

¥ 10.5 FET Spring (MR
XBACES H 23y B s T bean (1 id Al name J3KEL bean X % SE6ff Jr ik, W LAE
R T H2FA RS, id T name LR BATZNI1, ME— 22505 name HRT DUSEHI%E
TR FAEINT, XAEJS TS Struts (B ESA — e &
P Run > Run 3847 XA 2E)5, 32000 N 4

log4j :WARN No appenders could be found for logger
(org.springframework.context.support.ClassPathXmlApplicationContext).
log4j:WARN Please initialize the log4j system properly.

S

LT

LT

AT LATE A R s T, XY Spring 1 T LOGAJ 3X AN TFIEAE 2k A5 &
B PLIX A )@ T, 7 LOGAD IMELE X A] o 76 sre H 3¢ MO FC B SCfF, &
P34 File > New > File, SCfE44%i log4j.properties, SO 241 R 7

log4j.rootLogger=WARN, stdout
log4j.appender.stdout=org.apache.log4j.ConsoleAppender
log4j.appender.stdout.layout=org.apache.log4j.PatternLayout
log4j.appender.stdout.layout.ConversionPattern=%d %p [%c] - %m%n

I 10.6 log4j HMC & SO

AN TREABCE S, FOsT R LI S gt k. UIAEIET Web 2T A I
fie, AN TG A e 3 Spring Ja & SE B M S E . 72T & Spring #41% H
W, ZHA NGB 404 FHR PR EEABUEM HEE RGO, X R # 2 A —
PR REASEAFAE

WV AAFIIESpring (RC & SCIFA A A/, dn REUERUE R e i S s AR5 a7 o,
ANty B S A E N 1 T, i B Mibean g SO HLIT Y -
<property name='‘message''>

<value type="java.lang.String">JL¥f</value>
</property>
KRB R SO T LT, lan /4 value A48 IME) L FE 8k Son 2 )5, FHRIEAT
FeFy, 33005 ik 1

Son
Son

o 1Lt Spring MSCREE & H R BIB AT Bean [FE, SR LA mFEmAE, ] XML
PC B SCAT AT LA R DI AR P ) o
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10.2.5 @Al in# %A~ Spring Bl & XX

FESCBRIOIT A, I H AR 55 BB 70 J2K Spring Bl B SCAF 7 e SR JE 1
deyr, it bizxml, dao.xml F55%, IRILSCEATTI A AR AILE A RE AL T SCIF
R I I 2 BEA AR DX, A IR AN N Dk i 25 tH I bean (1 id B ER R . 2551
¥ BIMIRATE T B RCE SO, 4400 applicationContext2.xml, 41 F R :

<?xml version="1.0" encoding="UTF-8"7>

<beans xmIns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://www.springframework.org/schema/beans

http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">

<bean 1d="son2" name="/son2" class=""Son" abstract="false"
lazy-init="default"” autowire="default”
dependency-check="default">
<property name='‘message''>
<value type="java.lang.String">)JL¥f2</value>
</property>
</bean>

</beans>

AR SO E LT —AN4 0 son2 (¥ bean 8. A WAl E AN I 4y SO L E AR B, ]
I BEALE P JSORA A SO P I BC AR EWE ? B A N XA N2 4y ORI Spring AR
(FPRLAA SRt 1 T

import org.springframework.context.ApplicationContext;
import org.springframework.context.support.ClassPathXmlApplicationContext;
1 A SO s BAE R ¥/
public class SpringTestMultiFile {
public static void main(String[] args) {
ApplicationContext ctx = new ClassPathXmlApplicationContext(
new String[]{"applicationContext.xml","applicationContext2.xml"} );

/I #4E bean id 3KHX

Father father = (Father) ctx.getBean("father");

father.sayHello();

Il fR¥Ebean name FRHL

Son son = (Son)ctx.getBean("/son2");

son.sayHello();

}

WVER ClassPathXmlApplicationContext RIMIEARIEN T — NAF RS, XFE
AT LA gk 2 Bl &S0 T 47 T, 3sATIXAMRE, ST DA B R 4

SR
JLT
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L2

IREF, F320 T P4y e B SO B SRR R

BAIN IR BOYSE B TT A, JEILE Web JZI9TT A, 2830 25 T BLP D I
HABARZ , HBLZ 47 Spring BC B SCPFIE L. X T REFHIRBEME 2240 SO 2 Wil 4 Spring
IE:AIN e

10.3 FF%& Spring 1.2 AOP W

KA RF R — DRI 1, FBIRFSS N AN TR A0S, B —
DIFEABAT T AR P, BAET QQ, L MM, IXAEIS ARG TR ELSAELE, D T RAR I
LAAMELE, X GBE L AT 0 ) 42 D )

R AEBERNYT ZF AOP LI, AR, AESERrItH rh 24 ] — Rl ar Lo
IBBIHIT (A2 Spring ) AOP fEZ L, searBiRiftfeRae), Hei itz
%, THAEBLALC—H, W50 “T7 TN RS, KAEEUE T2 BRI T
FEN TR, AN TR A Qo S5k, WERAETUH Tl AOP )5 Rl 2 R4t
MIPATRCR KR FRG, HRACEA S PESUEA . 0E B RGUME IS, RRBIR,
R AT e . S 4h 2 T A EEH] AOP #EfIR 554 LIl Hi&, BUHAEMRSS &
EATEIA D RRAE S, R R B H e, H &% 2R, Dlid. o
H, ORI e DS o o T 5 2 I BEBGR BIR K, A S YE b R &

10.3.1 JF&R Man X%

AT H AR R, OB A, A1 H AN Spring JERDIRE,  ASE RSN
library [ 2H4E Spring 2.0 AOP Libraries JIA#EK . [K 24 Spring 2.0 [{2RFE & 4% 1.2
(1, BTCAIX g F 2.0 7. T H 44 Springl_2A0OP. £ FRBATE R A AKX,
fEI QQ AV MM XNy, A — AR EIE. W T, SNk

=
* HAWIQQFMMPIMT I I AN S, s — M A IE k.
* BeanSoft
*/
public class Man {

private String name;

public String getName() {
return name;

}

public void setName(String name) {
this.name = name;

}

public void qqQ {
System.out.printIn(&/EWIQQ™) ;
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public void mmQ {
System.out.printIn("FE/EHEMM ") ;

W5 10.6 Man 2556

10.3.2 JFRETEE4N (Before advice) f%: FBI

T 5EM— Bt Spring 3R 1 9% T+ Before advice I/44:
Ar &4 (Before advice ): FER-ERE A (join point) ZRTHATHESN, (HIXAWEIARE
BH IS s AT AT CBRAR B —AN ).
DU A UL S — N W A B R 45 SR IR 5, 1] DA I W 25 SR AT B HE e LAAE Ay a6 2 1) I
L AEUEY), B YRR D7 R ERER, (E R IX AN I R I REAEAR AT Sy ST AT, 75 Wil 2k 2¢
AR X T, XN GG “WE R VRGN T ARIX /NS 2% 2] IDK BT A6
IR, R IZIX AN AR

import java.lang.reflect._Method;
import org.springframework.aop.MethodBeforeAdvice;

/**
* IO A Rl AR SO I BT AT Bl A SR AE SR o
* BeanSoft
*/

public class FBI implements MethodBeforeAdvice {
public void before(Method method, Object[] args, Object target)
throws Throwable {
Man man = (Man)target;
System.err.printIn("FBI K8 + man.getName() + "IEFE#HT " +
method.getName() + ™ i5&0. ™);
}
}

JE L 10.7 FBI 28

10.3.3 MM Bean

B J AR, AR AN AP RN R, EEAZ H A, B RERER AL T FBI
A B . XX AT 23 ProxyFactoryBean 11—/ osfl, X447 T4
org.springframework.aop.framework &, HHARGEEEXME L] KHPE T T, B
WO T IR T o 47T, FAHEMN Spring Bl B U AR LR KK

<?xml version="1.0" encoding="UTF-8"7>

<beans xmlns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://www.springframework.org/schema/beans
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http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">

<bean id="man" class="Man">
<property name="‘name’'>
<value type="java.lang.String'>5k=</value>
</property>
</bean>

<bean i1d=""fbi" class="FBI" />

<bean id="civilian"
class="org.springframework.aop.framework.ProxyFactoryBean'>

<property name='"target''>
<ref bean="man" />
</property>
<property name="interceptorNames'>
<list>
<value>fbi</value>
</list>
</property>
</bean>

</beans>

JH . 10.8 Spring AOP it & 3 {-Jif% applicationContext.xml

FEIXAN SR, 52 T S bean: man F foi, #5285 18 198 Lo B 4% L3 )7 7€ civilian
XA bean e b, EEPEECE IR HAr (target) & man, Hogidtfr AR AL R
frI%f % (interceptorNames ) fbi, HARBEAT AR TAERI X %, w2 X 4> ProxyFactoryBean,
EAY T OIS R AR, (FUR IR WAR G W 45 R TR B CRAL 3L, TRsie FBI.
fAiBAd:  man &4 T civilian, ‘&4 ProxyFactoryBean Wifs, Wi B ac4s FBI AR, 1R
AR, MR RAEK, KA civilian, FIRA FFBI T Fril, X 2SR 2:46 man,
AR man 78 S8 bR AR 1 TR AN AELE 1), BT AR HUREEKR civilian, IXFEIEA BRI FBI IIAFAE -
IR A bean KR

K 10.9 Bean <& K
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10.3.4 WMRAEAT

OK, B 5itit, HA Y FRMEHEA SRR, BETAT T LS — NI R k&

import org.springframework.context.ApplicationContext;
import
org.springframework.context.support.ClassPathXmlApplicationContext;

public class AOPTest {
public static void main(String[] args) {
ApplicationContext ctx = new
ClassPathXmlApplicationContext(applicationContext.xml');
Man man = (Man) ctx.getBean(civilian™);

man.qqQ;
man.mm(Q);

}

55 10.9 Spring AOP A5 i
BAT—N, kT LR T4 ) B AR

log4j :WARN No appenders could be found for logger
(org.springframework.context.support.ClassPathXmlApplicationContext).
log4j:WARN Please initialize the log4j system properly.

FBI KIsK=IEAEHAT qq WG5).

FBI KILsK =1EAERET mm 353,

FAEMQQ

FAEHL MM

ARG ? FBI IEAE R — 2% —3)), IO SRRSO R AR 5 o AR IR % 0] LA
Tfi# AOP It F2 T . I man 1XA> bean [ATA—AN k2 /i, #bssFisciman GHAD fbi
XA bean FH45 AN IR AR &, IXL(E BFE /775 (method), 2430 (args) LA Hx
X% (target, XHE man X050,

I RARAE T ACRS % ctx.getBean(*man”), B4 B I GEARSHIR R, BT LUX
R A 2] FBI ik MR (5 B T o BER 14 T

log4j :WARN No appenders could be found for logger
(org.springframework.context.support.ClassPathXmlApplicationContext).
log4j:WARN Please initialize the log4j system properly.

RAEIIQQ
FRAEI MM
10.3.5 AOP &/ RIAH L&

MEBMCET T —/MRFE H1¥ Spring AOP #il1, IUAERLLE KK i H A 4H— N AHCI
M, XLE(EERE T Spring 1 303k
71 DI (AOP) it 7y b —Fhffy BER BB RE e 4, L IR 7 sComAbh 1 I 170 0
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%9nfE (OOP) AL, BR T2 (classes) LAk, AOP $&4it T 7/dr, VI e ik
B, By 2 AN RBFXT R 58 . (R JORE W ERIE M
(crosscutting ) JF £

A RE L) AOP M. IXUEARIE AL Spring ¥f A ). AERJE, Spring R
WIFAEE R EA: WR Spring fEH] B SRR, 2243 84 N .

D7 (Aspect) : — AN SIRREAL, IXANSGE MATRES I 2 AN . HH5
FHE J2EE N T — AN TR OGE AR EF (M) F. - 7E Spring AOP H1, 1]
T AT DA W 28 (B F AR A% D B Al 2R b DL @Aspect AR iE
(@Aspectd AUHE) KL,
F#RE (Joinpoint) + FEFEFP AT I FE B BEAMRE R 1) A5, B e T R I A
BH AR H (% . 4E Spring AOP i, —ANER N A1E AE TR
iT. @ HH— org.aspectj.lang.JoinPoint 257 (1 ¥n] LIEE 41 (Advice)
(1 =R SR EE AE R
A (Advice) : EVITHIHEAREE FEHZ i (Joinpoint)  EHATZ1E. w4l
&M, Hdfuds “around” . “before” F “after” 244N, AR
WA JG TR/ AT IS « P2 AOP HESE, £uHF Spring, #iie LA 24 72E 780 A ,
HefEdr—A DUEFE pi o oD A AR B
YA (Pointcut) :  ULECHEERE S (Joinpoint) KT s SN — M)A iR IA
SR, FEAEIE AR XA DI RIS L pi FISAT (BT, AT FEAMRE & A FR 7 VE R 6
PN s 238 2 Ana] FIZE 42 5 VT AC /& AOP [ #%.0y: Spring S48 Aspectd P 4
ik,
7/A (ntroduction) :  (LFR KN EEA A (inter-type declaration) ) . A
ARSI (0 7V E B AN KA 7B . Spring RVFSI AL (LUK AN R
SEPD BUEATHACER T % i an, fR ] LS — N5 I AKAE bean 5531 IsModified
B, DMER AL
H#rxX% (Target Object) : #—AE#H Z /M) (aspect) T4l (advise)
FIx % . WA NS #4 (advised) X%, BE4R Spring AOP & it iz
ATIPARBESEILN, XK GKE & —A #/CH (proxied) X%,
AOP f{Z! (AOP Proxy) : AOP HEZLGIZMIX %, HIKSLHLDIHIRZ) (aspect
contract) (HLHHMAN T EMATEThAE) o #F Spring 1, AOP fRELAILLE: JDK
G AR #H CGLIB AR HE., yER: Spring 2.0 I 51 A1 T B
(schema-based) K& FI@Aspectd Frid: MAS (P U) 75 B, T FH I 28 XUk 1)
PR, ARER IR EE .
HA (Weaving) : V]I (aspect) EREFIIL G N R FRM e E 6% b, I+
Bl — AN IE SN (advised) XTS5, X LLZEGw e (1 Wifd H Aspectd 4 i
2, KInERRIEATI e K. Spring A A4l Java AOP HEZR—FE, 7EIEATHS
SEIMZAN

TH AR

207

Hi e % (Before advice ) :  {EHEERE A (join point) Z HHRAT B SN, (HIXAS
WA RE PRI AT BT (BRAE ST — D RE) .
B[4 (After returning advice )+ #EREER S (join point) 1 5E KE AT
@ %En: Fln, —ANEEE AR R, ERRE.
P S SR SN (After throwing advice) = fEJ7 vl H S 38 HY ISP AT 138 40

KA
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® iy (After (finally) advice ) : 43R »TE H A RHERAT IRE AN (NIRRT
IR AR IR D
® I ZEW 4 (Around Advice ) . Ul —AMEE T (join point) HIIEKN, i 5ETRH
TR I SR — Pl AN 2 . BRG] LAAE 7 VR R AU 56 8 SLIAT R
EA SRR M Gk AL P AT E  T B IR I E AT 1 O PR S S e 4 R
AT
INGER AR B T —FO@ AN AL . G 55 T8k AOP HE4E,  filtin Jboss, LA K EJB
3 WA UGEm WRATS UMD |, #HIREZem 4.

P Aspectd —Ff, Spring FEALFTAT IR RN,  PATHETE AR S I a7 H 1038 AR R 8K
IMFFLERIIRE. B, WK R T B — AN E B R MR S 9247, AR FH Sl
I RESE LRI RE RN, (E SR URE ] After returning M40 AS A& @A, T EAIE
(P30 AN A AT DU A3 G FE AR R AR T o, JF ELREOE BERR Z W E M k. L, RANTR 2
W H JoinPoint (JF Around Advice) (1] proceed() 777k, BiASEA A I iR 8,

7t Spring 2.0 ', MBS EAEEASRA, IR AT A& 288 (gl in—A~
JHEPAT G R EHESE A AE @ A S E0m A 2 A H — S0 504

PIA R (pointcut) FEE: s (join point) VLELIHES & AOP [ OCHE, XA AOP AW T
LA BRI R THEOR . DI SATAS e 1@ %1 (advice) nj sz T OO JZIk.  #
r, — AN B X 45 HY around 8 AT DARE R B — 2R ES 22 AN ) G i i (R
WSS 2 A5

10.3.6 =T java.lang.ClassCastException: $Proxy0 %% HI g v 7 i

AL [ XA I 1)

FERKLAR aop HSHB 2 A /AMII 7RI, R e HE A T
AR P n R

public class AOPtest extends TestCase {

public void testAOP(){

ApplicationContext context=new
ClassPathXmlApplicationContext("applicationContext.xml");

try{

Man m=(Man)context.getBean("civilian");

}catch(Exception e){

e.printStackTrace();

}
/Im.QQQ);
/Im.MM();
}
}
IR AR dn 32 AE R e IR R B R A5 R T T
java.lang.ClassCastException: $Proxy0

at test.com.wgw.AOPtest.testAOP(AOPtest.java:16)
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V7 IR G AR g e

IEABRAH—FIXA 8= A SRR . {E Spring 1.2 F12.0 /1, TR LREAT
SEAAN A AL B S FTFRUEAE 2.0 BURITEAY AE, TEMIRL, 2 B AW H xRk
e, AR IERE KA IDK 18 RELE 2 5L T CGLIB [H2ARBR T, )il iist &
AT BRI RIC Bk AT DG R EATARHE . SR WSR2 Spring 1.2 (11, FRAHRF EH)X
AR 25 K2 745 0 Spring SRR,  ASSKN.iZi% 4% Spring 2.0 (K, A%
T Spring 1.2 ANEIXBAZAT AR, RATKIHE— T EAMEIIZA ) el

A A I, 24 T ProxyFactoryBean [ proxyTargetClass J& ¥ 4 true,
Rt AT LOC AT T o LB SO R

<bean id="civilian" class="org.springframework.aop.framework.ProxyFactoryBean">

<l-- EREXNEH, LA true FH CGLIB AMHBEHIGRE HAELRWED >
<property name="proxyTargetClass">

<value>true</value>

</property>

<property nhame="target">
<ref bean="man" />
</property>

<property hame="interceptorNames">
<list>

<value>fhi</value>

</list>

</property>

</bean>

FAEACH WOk ARHA BT 73 o
MR %, gl Man B82S IMan B2 H . EOER B
public class Man implements Iman

o XML IMan R4

public interface IMan {
public void qq() ;
public void mm();

}

o RTIXIFBR W K] Spring Be B SCAF 2B, I B AP A2 45 B AR 1 -

<bean id="civilian" class="org.springframework.aop.framework.ProxyFactoryBean">

<property name="proxylnterfaces">
<list>
<value>
IMan
</value>
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</list>
</property>

<property name="target">
<ref bean="man" />
</property>

<property hame="interceptorNames">
<list>

<value>fbi</value>

</list>

</property>

</bean>

I Y ORI 20 A, i T BB 1 4 . B ARG Java R4S Al e
M

IMan man = (IMan) ctx.getBean("civilian");

FHAR BT 7 it 2GS A, SR T I PR g 2t ) CAS e HE PR 1030 T o A ORI SCAS T A
22 Spring (1 J7 304

7.5.5. XFFEHEATACHL
WERAR T AR — AR MA SR B—ANEE E 2RO, IAE G2 B

MBAETA L E 55, AfFEAE Person #2101 FAT7G ZE8 A1 —N0U 4 Person 128, &
B SRS . R P EBL R, R0 LARLE Spring /] CGLIB AR, MiAZE3IZS
RF, X HFERISAHIE il ProxyFactoryBean (] proxyTargetClass J&PEi% h true. H4R
S fEJ7 SR I ) 4 L R T AN 2 28, (AR st B ARRS — & TAER, I8 N3 SEILEE LI 2R
R AR A M. CRERSOUT, Spring ARG . & PR IR RIR A Sy AR 3 SEBr i it
TR R MR, B e A AR 7 0.

WVFRAT EURBERSAEAT T D0 T RSB ] CGLIB, - 2 R RAS T 111 1IN it IX A AL o

CGLIB il AEia AT 2R il A IR IR 7 IORBATAREL AR . Spring Fid B IXANE 1128
XS IR H AR G T AT R . 78Sl T #etfids (Decorator) #5i5X, fEilAIZIN .

CGLIB [P B N0 P S E WK . SR, A7 L8 ZEH 5 8

Final JivAANRTLAgaE A1, DA EA A BERE i -

PRty EEAEAR ISR A2 AT CGLIB 2 1% A I Sh A ARHE A5 H 5 22 IDK.

£ CGLIB AU S AL )R B2 725 2 AR /M. £ Spring 1.0 71, AR P — a0

Ko HIK AT BEAERE ARAIAL o IXFIGOU T, 3R AR P A ol QL P T PS8 AN 122 18 5 P )
H
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10.4 JFk Spring 2.0 AOP N

Spring 2.0 SEIL T HIFIT M AOP Bl E, —Fuddt T XML Al & S, mTLUHAE
JDK1.4 I, F—MiiT @Aspectd Xk HkriE: (Annotation) #E4T AOP Jfk, W LAHIE
JDK1.5 RS bo ANghont FAT N ST S, {4/ Spring 2.0 AOP 1f15 Akt k. K
+ Spring AOP (¥ ¥ RLRIAH SRS I VR4 S, R LA 2 Spring (197 30 30RY

10.4.1 f§H aop HRZSLHL AOP

X P T SA X EEBE, PSR AT 32 2 X ProxyFactoryBean (K524, 1 H. H 8h%s
I bean € XA AOP Thig, ANETE 2 A0 & 05 REL (1) 575 445 H 4 711 bean
EXT .

T, MAEIETRATE AT H, 44 Spring2_0AOP, Jf4& 10.3 1 Py 254 & i
TR EE R SO BATFXAM T4, Man 5T T BEMUT & . T
J& FBLXANE, i B AT RSz e 0 T, K650 FrR:

import org.aspectj.lang.JoinPoint;

/**
* R AR R bR M T B AT Bl e SR A o
* BeanSoft
*/

public class FBI {
public void before(JoinPoint point){
Man man = (Man)point.getTarget();

System.err.printIn(""FBI &8 + man.getName() + "IEFE#HT ™ +
point.getSignature() .getName() + " iFzsh. ");

i ¥ 10.10 FBI J&y5HY
HERXA KRN )72 before(JoinPoint), J7ik4 W LLEERR], W LU —A™ JoinPoint 2§
BB H, Wl IS BH 225 1% before(), {HAZAXAERE A (JoinPoint) X4k T i
ARXIFEAAA KRG B, A ESE, B G555, Bt DL— Mgl H &l sk it
& ke
FET AR MRS AR, FCAFT LA AR, RN e 307 0 12 man
XA~ bean. WARGUITF HrR:

import org.springframework.context.ApplicationContext;
import
org.springframework.context.support.ClassPathXmlApplicationContext;

public class AOPTest {
public static void main(String[] args) {
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ApplicationContext ctx = new
ClassPathXmlApplicationContext('applicationContext.xml'™);
Man man = (Man) ctx.getBean(''man™);

man.qqQ;
man.mm(Q);

}

TEHL10.11 MRS AOPTest YY)
XN T &5 FA L ) =2, W R BT s

log4j :WARN No appenders could be found for logger
(org.springframework.context.support.ClassPathXmlApplicationContext).
log4j:WARN Please initialize the log4j system properly.

FBI KIK=1EAEHAT qq iG3).

FAEMQQ

FBI KILTK=IEAESEAT mm %30,

AL MM

NI ARCE S, SR FR SRR E S

<?xml version="1.0" encoding="UTF-8"7>
<beans xmlns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:aop="http://www.springframework.org/schema/aop""
xsi:schemalLocation=""
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-2.0.xsd
http://www.springframework.org/schema/aop
http://www.springframework.org/schema/aop/spring-aop-2.0.xsd"">

<bean i1d="fbi" class="FBI" />

<bean id="man" class="Man'">
<property name="'name'>
<value type="java.lang.String" > =</value>
</property>
</bean>

<aop:config>
<aop:pointcut id="manPointcut"
expression="execution(* Man.*(..))" />
<aop:aspect id="beforeExample" ref="fbi">
<aop:before pointcut-ref="manPointcut” method="before" />
</aop:aspect>
</aop:config>

</beans>
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JH R 10.12 AOP XML #4 X & 34514 applicationContext.xml

F XA B SO AR RIS B4 10.8 JEATX EL, W LAE B AN ASIA) :

1. FESCHMIFLIIAN T aop v 23w, RS L EHMART R .

2. i aop:config Fr%kie X AOP, ANJffiff] ProxyFactoryBean >k & SL—ANHT T

bean.

RN H— FIXANEE . A bean 158 SLHV A 4 KA, — AN REANRIXNS, 5
—NMUGE B A J5 IR 13 - 110 aop:config e X T A 11 AOP # # {5 5. aop:pointcut
EX T —MNINR id 5l TV RME— 25, 1l expression & X T PIA SHI#RIA
X, WA E XBRE R TAAE R ? a2 Rn—Rs, BIH#UT (execution)
Man X% T A JiER XA oL, Xt 2R iEL execution(* Man.*(..)) & XHT{E,
Man.*(..)3%& 7~ Man KT 7ik. # ke, FF2e X—AMY)H, A aop:aspect K X,
B ref J@PETR 2 TRXA VI AT N1 bean 52 X id, X HLR [ foi iXA4> bean 285 TAr%%
aop:before MFE7R T 24Kk T 4 4 manPointcut VI £ CIEAL R/ (1 pointcut-ref J& 7
fixE, pointcut-ref ="manPointcut™, #tifiH 44 before (17575, XA 754 T aspect H
M E SRR bean H, X H 2 fbi (B ref="fbi"). 52 Spring #UTHIIXH G, S HBIN
X LEACID BN 1 R JE 1) Bean & X (JF &K K H ProxyFactoryBean X#EIHLHE]D,
ARG AT 3R bean IHEEAE EAEZFEA TS, Xt A4 L SCIR B IRR R L 5
Vi Al 5ok ) man XA~ bean, X FIEEEE S BT IR R . WX BLE 2 Spring 2.0 H %
& X —/~ AOP [f] bean 28, {/98RJE AT I, XML SCAFFIME S ARG N T IR, THEEH
181 e 2 ) FIBR A

AT IIVEN 27 Bkl n] LLEY 132 Spring 7% U1 6.3. Schema-based AOP support

ri-

—
10.4.2 fFFtRE (@Aspectd) £ AOP

R SCR R H T Spring:  "@Aspectd"ffiH] T Java 5 bR, W] LLRE D) T RS B Ok
fflJavaZs. Aspect] 5 K Aiilf] Aspect] project Chttp://www.eclipse.org/aspectj) F 5|\
TiXF@AspectI X . Spring 2.0 i T flAspectd 5 —FEIbRVE, 1 T Aspectd #21}t
) —ANEFRAG) 55 (pointcut) f# A FIITHEL

T 4 Spring it & 1 [Tl @ Aspect aspects, 7R 20 1 45 A Spring X1 3T @AspectJ
aspects IBCE 2 Fr, EECH (autoproxying) Tl 402 752K HiX L) f. HE L2
& Spring s HIWT—> bean ZEAATH T ANEREANUIRIE A, JFHE 0 A A orH N k4
DAL TR, FF B a8 snoe 15 W gkEA T .

TR AEARIP) Spring AL E SCAEH 5N FAIIGE K S H Spring % @Aspectd (13 #F:
<aop:aspectj-autoproxy/>

7] LU I AR R 16 application context HHs Nt K & UK JE F @Aspectd 37
<bean
class="org.springframework.aop.aspectj.annotation.AnnotationAwareAspectJAutoProxyC
reator" />
PR BAER N I FE 7 1) classpath W1 5] A/~ Aspectd FE: aspectjweaver.jar F
aspectjrt.jar. FA1IXH A1) MyEclipse, 7L Spring JF A DIRER T4 A BN T 1X £4
RIEAT, TFHEFLRET .

5E MY Aspect: 7E)7 H@Aspectd SCRFIITESL K, 1E application context 715 I
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fERMH — A @Aspect VT (#1115 @Aspect brit) 1 bean #BKi4% Spring H sl 5] 3T
fic & 7 Spring AOP.

EXYIN A Pointeut: BIZEENAE @Aspectd Hrit X&) AOP i, — AN %4
T gk AN (1 7 v SORSRAEE, IR H U SRIAAX T @Pointeut Arid k&£ R (FERT)
N REA BT iEWAURIF] void 287D, AR L2253 R 10.12,

W7, 5IHTIRALR, BATFEN AL TIRERHIAOPLIH T, XANH
14 - & Spring2_0AOPAspectd, UHf— 15 Jin A T Spring# .0 FIAOPZEFE J5,  #it vl LA
TR T « MakHELE: 10.4.1 {fi/Haop b2 SZILAOP—, iX— NI H (KA AT AN H
TrEN 1 EBRANTEAE G FBIZE GRS, ISR R SEI DT FIPIA s 3C, Wl R FrR:

import org.aspectj.lang.JoinPoint;
import org.aspectj.lang.annotation.Aspect;
import org.aspectj.lang.annotation.Before;

[
* A AR R SR S DT B AT L SR AE S
* BeanSoft
*/

@Aspect

public class FBI {
@Before('execution(* Man.*(..))")
public void before(JoinPoint point){
Man man = (Man)point.getTarget();

System.err.printIn("FBI k¥ + man.getName() + "IEAE#HT ™ +
point.getSignature().getName() + " iHzh. ");

JE L 10.12 N T Aspect briE ) FBI &
XA @Before J5 i ff) " execution(* Man.*(..))" & PN TR VI ik =, HiE
SCRI b5 2800, RRIRIEHAT Man 281 BT J7 1R IR fil & b 7 v AT
i TXF B, XML BEE SCH KRR, AW R Fs:

<?xml version="1.0" encoding="UTF-8"7>
<beans xmlns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlIns:aop="http://www.springframework.org/schema/aop"
xmIns:tx="http://www.springframework.org/schema/tx"
xsi:schemalLocation=""
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-2.0.xsd
http://www.springframework.org/schema/tx
http://www.springframework.org/schema/tx/spring-tx-2.0.xsd
http://www.springframework.org/schema/aop
http://www.springframework.org/schema/aop/spring-aop-2.0.xsd">
<aop:aspectj-autoproxy/>
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<bean 1d=""fbi" class=""FBI" />

<bean id="man" class="Man">
<property name="name''>
<value type="java.lang.String">7k=</value>
</property>
</bean>
</beans>

TE L 10.13 FET Aspect HENCHE ) Spring Bt & 14 applicationContext.xml

B IX AR AT 5 04RAS 10.22 AHXFLE, AT LLE BIAS A 2 Ab A A
1. A THIRMAK<aop:aspectj-autoproxy/>iE X ;
2. LT <aop:config>kREE ) .
Al LA B IX R 7 U5, AOP [T A FIRC B AR A ST B . iX /& DK 1.5 5| AbriEJT
RIGTHRIVEFAL o IR GG RO, S w2 S O A DA 20 F B 2 PR A RS T

FRE: FXEIRAGE L <bean id="fbi" class="FBI" />X—"beanftJig X, &
) H ZAOPAR BT S e A Wl e G T 1A 17, AR i mansy G A QB o it
T

5 WA A b — 15 T B 10,20 2 —HFE, ST ) b 1 45 AR it

10.4.3 FFRIFEESN (Around Advice) AOP NH

Z P LLEEA 44 Around Advice, JEA AR I, —NMERIYIX S DR om A
(1) AOP Zhifig, WL BT I AOP #nf LI TIXANSHL, 8if BiEige it AOP ThRE, N
PSZHLX AT CL T, Bl B SCEE R Jboss SRR - ANERIKE EIB 3
@Aroundinvoke XAMFREAX B DI REFIME &L —FE R, EIB 3 FXANFRIT SEELF- A -
T fi# Around Advice 13 B T EEMR JG S2ME & o AR AR R 5 R R A7

W7, BAERE—AIH, A Spring ThHAER AOP 41, ol THEk: b—ANI H 30t
Sl IFEA 4, XA H fiv 4 A Spring2_0AOPAround. FRATTESZELAN R () FBI A B,
KA By R, AMUBEENIE K =S AT 2053, BERefEsk = EE MM INRH Ik
fl! 1T, ARAES AT 28l , FRATE G FBI R 52 2 W] SEFLIE AN ik R 1 -

import org.aspectj.lang.ProceedingJoinPoint;
import org.aspectj.lang.annotation_Around;
import org.aspectj.lang.annotation._Aspect;

/**

* TSR R SO BT AT S L RAE
* BeanSoft

*/

@Aspect

public class FBI {
@Around('execution(* Man.*(..))")
public Object before(ProceedingJoinPoint point) throws Throwable {
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Man man = (Man)point.getTarget();
System.err.printIn(’'FBl &I" + man.getName() + "Bl IELEIAT ™ +
point.getSignature().getName() + " iEsl. ");
/ Rk = HIMM
iT(point._getSignature().getName() -equals("'mm'™)) {
System.err.printIn('FBI ¥[H1E ™ + man.getName() + " JEMM. ');
} else {
/7 proceed() J7ENGAL R I TTVARRE Ak AT
Object object = point.proceed();
System.err.printIn("'FBI %£H" + man.getName() + "CU &5 1 " +
point.getSignature().getName() + " %z, ");
return object;

}

return null;

75 10.14 Around Advice SZELIF FBI ALY

DRSS A DL L B SRR AN 1 A, DHERAERE B PITE R

log4j :WARN No appenders could be found for logger
(org.springframework.context.support.ClassPathXmlApplicationContext).
log4j:WARN Please initialize the log4j system properly.

FBI Ik =B EAESEAT qq W3,

FAEMQQ

FBI KIMFK =5 T qq &),

FBI Ik =B IEAESEAT mm 3530,

FBI CKPH bk =T mm ¥53).

TS UAE AT LA 5K =B “ RAEH MM” XM BB TIE, FBIRIhIFIE T 9k = %
g AL I 1, X R AR I B IR ) BT AE . BE R )2, Object object =
point.proceed(); iX FJACHSIE IR G T oK ZIMPAT AR, FEAIE AT DO AN SR T B 2, 64T
2 RN . public Object before(ProceedingJoinPoint point)ix A 7 v2: ik [FI4H w2 7k =
PATAEFITE M EIE R BIE, e AT 8 ok o) DLSEIUR SN, N T gis X AN ik FEgE T B4

BAME R —FlIz S, K= RBLA Qg FBIL AT T, A i ST AR R, W R FTs:

/**
* HAAWMQQAEMMEL A SR = MT A AN S, e — M 4 a k.
* BeanSoft
*/
public class Man {
private String name;

public String getName() {
return name;
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public void setName(String name) {
this.name = name;

public void qqQ {
System.out.printIn(&L/AHQQ™) ;

public void mmQ {
System.out.printIn("FE/EHEMM ") ;

public String sayHelp() {
return " ##&, ZA&' +getName()

THIE 10.15 AT KRB RER Man 2548
XBARIS H B T — > )73 public String sayHelp() kA B Ahsk, Wk RMATR 2 Fos o
SR, FBI I CA 24 T ok = MATAT A&, JF HadknT DLOY R g vk = AC, FBI IR
TEIXFEANL:

import org.aspectj.lang.ProceedingJoinPoint;
import org.aspectj.lang.annotation_Around;
import org.aspectj.lang.annotation._Aspect;

/**

* IO A R AR SO S R T A AT B A SR AE S
* BeanSoft

*/

@Aspect

public class FBI {
@Around('execution(* Man.*(..))")
public Object before(ProceedingJoinPoint point) throws Throwable {
Man man = (Man)point.getTarget();
System.err.printIn(’'FBI &I + man.getName() + "B AT ™ +
point.getSignature() .getName() + " iFah. ");
/7 ZE sk =M
if(point._getSignature().getName() -equals(C'mm'™)) {
System.err.printIn(""FBI #[Hil " + man.getName() + " MM, ™);
} else if(point.getSignature().getName().equals("sayHelp")) {
System.err.printin("FBI /744 " + man.getName() + " #1425 IRl ik 47

return "4 " + man.getName() + " . I AL HIREF .
} else {
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/7 proceed() J7VENGAT IR I TT VA RRE ARk AT

Object object = point.proceed();

System.err.printIn(""FBI %" + man.getName() + "C&5E | ™ +
point.getSignature().getName() + " 5z, ");

return object;

}

return null;

R 10.16 EAMIWMAIBH L, WE¥EThRER FBI AR
PSR = AR MM T, Ak g, FBI IS v DL E 8B, R K 11
BR “HH, FAEK= R R K =, BHALHIRE ", B R IWAT N, k=
(I A KA AN GTE R A T A4

R BATERMRIE, AU T X sayHelp() /7 v 1 H -

import org.springframework.context._ApplicationContext;
import
org.springframework.context.support.ClassPathXmlApplicationContext;

public class AOPTest {
public static void main(String[] args) {
ApplicationContext ctx = new
ClassPathXmlApplicationContext("applicationContext.xml');
Man man = (Man) ctx.getBean(''man');
man-qqQ;
man.mmQ) ;
System.out._printin(man.sayHelp());

WEE 10,17 MRk
HE R E SO T A 5, FAEIsAT XA, 153 2

log4j :WARN No appenders could be found for logger
(org.springframework.context.support.ClassPathXmlApplicationContext).
log4j :WARN Please initialize the log4j system properly.
FBI Ik =B EAESEAT qq W3,

FAEMQQ

Lot k=, WIAEL AR

FBI RIK=CA%EHT qq iH3h.

FBI ALK =BILRE LT mm 353 .

FBI CKEBHIE 5K= MM,

FBI Ik =W EAE3E1T sayHelp 53],

FBI R ok = HIACHE URABA AR LT .

R ! XA 2 AOP [WELIEE FTAE, F AOP M H id>k, SEAE KM/
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OK, KT AOP ] IT A TR BRI 35 —Bedk o AEJR T 1O RS E N, &
ATESAE LT AOP [ 4545 FLI) Ak

10.5 Spring ¥HRETF K

Spring 52 ¥F JDBC, Hibernate, JPA Al iBATIS “5%di ZE VS M H AR HE & IT R, FHE
Pt TSR 55 By RE, o S 4 8 #8 5 Hibernate FF & 1 3CFF H 80 9145 8 3
Dife GRICfS b —17 551 Around Advice Wik ? 7E 7 VEATTFUA 45, fEEPUT RIS, X
At Spring H AOP SEHLI H 2l 3 55 AR DI R, H 2 5t I & ME BE NG & SO 4l okt
Spring + Hibernate 4144 &t EJB 3 (Session Bean + Entity Bean) [ % 45X, MyEclipse
X AH IR R ESCH e T R b it 1 A iil SCRF, ARG DataSource, SessionFactory ][] <3, LA
JFE Hibernate + Spring Jx [ _LFER A4 il T Spring HibernateTemplate 1) DAO, H &5 4%
WA AR IS 2 (BRI FSS), v DA A2 SE B T A IR 22 o FRAT T 2248
S AR, BUR SO T LT, AT E LR AT 4 Spring #5455 API, KZ
T H A 27 L BVRS I 955 APL, iR K 24000 H I AT 2 21734 X1 EIB —Ff

10.5.1 DataSource 1 JDBCTemplate 7+ &

javax.sgl.DataSource /& JDBC S ) — A1, HIRIRIZEE L h .

¥ 10.10 DataSource 2] 5E X
o =85 F 1 7B s & 8 public java.sql.Connection getConnection() T, X451k
FH R RS B (0 B0 R 42, axX AN 1 1) 32 B H (W2 T A AR 7 B SRECEOHE R34 452 (1) g i o
2R % IDBC % F:th A9 B #RFE At T XX AL L s HE . Bl Spring i de it 1
org.springframework.jdbc.datasource.DriverManagerDataSource.

TSR Spring T E 25t /& org.springframework.jdbc.core.JdbcTemplate,
XANEA] URC & DataSource KT & 3T IDBC M, Hse i de b4 mas, R
A R A 3 B e v] LABAE OBl Spring BU & SCAF R EEATRCE R T, i TR
JdbcTemplate gi A4 3 Spring 125, X il DataSource A& AT Spring & A~ —#f
(1), PIUBAA AMESE SE A TR N (B BT AR AR THEZL),  HIAE Ll 15t HE 22
FEMHEI2RPE, IXHURHER IR X A FHUARME DR o DRSS Ay A0 T i o

Frigt—/NJavalil H SpringJDBC, #RJ5ik+E¢ FiMyEclipse > Project Capabilities >
Add Spring Capabilities ... >k)331Add Spring Capabilities[i] 5, % 341K 10.2 7).
WZ% 10.2.1 2570 H A Spring Dy fe— 1 N 2K T el R & W] . SR EIF K
Spring JIDBCH [, fif LLk £ Library ()i % Spring 2.0 Persistence JDBC Libraries, 41 F
S
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K 10.11 ¥shn JDBC )%

FE T KRG T EAEIDBC I IR B I Ak, 1 FLATHI My SQLAHE 4, DAtk 5 ] 5.4 3 IlJDBC
UK #Build Path—15 ] 2 A B i U H o a0 BAEF 2 e PR i A, g
X5 N I IDBCER B I AN 3K

B ROk — M1, 25T DataSource ), X B FH RS 00 5K ULI Spring SCRY
HERE AN DriverManagerDataSource, Bl 15 HIX AN %42 3] MySQL s 32 3 47—
AR A, SCIRBI TS A E i ThRe. Brdt—A~2K DataSourceTest, JLUEACH QI
Jr7Rs

import java.sql.SQLException;
import org.springframework. jdbc.datasource.DriverManagerDataSource;

public class DataSourceTest {
public static void main(String[] args) {
DriverManagerDataSource dataSource = new DriverManagerDataSource();
Il EREHBHIH5)H 58

dataSource.setDriverClassName("com.mysql.jdbc.Driver");

dataSource.setUrl("jdbc:mysql://localhost:3306/test?useUnicode=true&characterEnco
ding=GBK");

dataSource.setUsername("root");

dataSource.setPassword("");

Java.sqgl .Connection conn = null;
jJava.sgl.Statement stmt = null;
jJava.sgl .ResultSet rs = null;

try {
conn = dataSource.getConnection();// M 2775 JE B #1757 % 1

stmt = conn.createStatement();
rs = stmt.executeQuery(‘'select * from Student™);

// 5. SoR&R A H
while(rs.next()) {
System.out.printIn("%i5=" + rs.getint(1));
System.out.printIn( = EH=" +
rs.getString('username'));
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System.out.printIn( ="+ rs.getString(*'password'));
System.out.printIn("4#=" + rs.getString(age™));
}
} catch (SQLException e) {
e.printStackTrace();
3} finally {

try {
rs.close();

} catch (SQLException e) {
}

try {
stmt.close();

} catch (SQLException e) {
}

try {
conn.close();

} catch (SQLException e) {
}

TEH 10.18 F- AT FH A i U ok 7 in) 2l 22

RET AVE SR AR RS IR A AL, 22 T — B Bl 4G, TR
PR 2 WU T MBI SR, AR FPoRURMA R B o B 170 ANEEEISSER 3h
MySQL Hii Bk 554, ARIRISATIXANR, AT 1) 15 0K RE A5 2 1E 5 IO th G R s

log4j :WARN No appenders could be found for logger
(org.springframework. jdbc.datasource.DriverManagerDataSource).
log4j :WARN Please initialize the log4j system properly.

G 'r=1

SR =

#ih=1234

Fie=21

9 AN T, ¥R Spring i E ) DataSource K 5N . B 4% XU 4T IF A
applicationContext.xml, fEgufas 41 e, RGiES% A 10.8 Outline 244
HRI N ZE, sty Outline # B F=J2 LI 5 H AH OC G105 Spring 2114 50 5L, 2R )5 1E$F New
DataSource, ozl HHIEFSEEHE, 1] 10.12 Prox.
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K 10.12 @ Spring DataSource )%} ifHE

£ Bean Id H i N 55 bean 1 id, 1X HLIU{E 24 dataSource . fEX§ i HEH ) DB Driver
N RAE R R R BRI e i R, X i & E MyEclipse Database Explorer i#EAL
BP0 (B LBRATME I G2 mysqls IXANER:, &2 a5t N IFEE S B URL
(Connect URL), Jxsh 2535 (Driver Class), )4 (Username) fl1#&44 (Password)
LIS . 5 4h Spring SR FFEIETE: JIDBC J5 R KF INDI 5 R IK), Jad— o A
Fr INDI By i IR 5 28 TR i, XN T AT LLZE DataSource A5 (il i #4830 T V)4 1K
10.13 £ Y)#: T Use INDI DataSource 2 J& IR0 TFHE « ZEIX AN X I HE HR 48 75 224\ Bean 1d,
X H 2 jndiDS, AT E A Data Source [ INDI Hidik, X 4 jdbe/mysql, 44 a] Ll
AN 44 (Username) root Al 5 (Password). %A TiXE6{ 2 5, #X)5 i Finish
FHILJE R I IEAE,  Boe s T AR IR AN TAE . B /515 2011 bean FLE U0 N FiR:

<?xml version="1.0" encoding="UTF-8"?>
<beans
xmIns=""http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">
<bean id="dataSource"
class=""org.apache.commons.dbcp.BasicDataSource">
<property name="driverClassName"
value=""com.mysqgl . jdbc.Driver'>
</property>
<property name="url"

value=""jdbc:mysql ://localhost:3306/test?useUnicode=true&amp;chara
cterEncoding=GBK">
</property>
<property name="username' value="root'></property>
</bean>

<bean id="jndiDStarget"
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class=""org.springframework. jndi.JndiObjectFactoryBean'>
<property name=""jndiName" value="jdbc/mysql*'></property>
</bean>
<bean 1d="jndiDS"

class=""org.springframework. jdbc.datasource.UserCredentialsDataSou
rceAdapter'>
<property name=''targetDataSource'>
<ref bean="jndiDStarget" />
</property>
<property name="username' value="root''></property>
</bean>

</beans>

TEH 10,19 i T HdEUEECE (S B 1 applicationContext.xml

K] 10.13 £z Spring JNDI %4k U5

TERCE SO —3L £ T 3 4> bean, 43Jll/&: dataSource, jndiDStarget i jndiDS.
A& IDBC (IEHEUE, S 1 BN RN INDE AR, HOAS I SIZ R 1 i) 16 I 75 224 )
jndiDS. 7EIXAMI IR A T2 dataSource, i HLFF B SCE ISE IS, B BRIAE
(172 Apache [FIEd e & Hat DBCP AR sLIn e, 7oix BEATTZE MU Spring HA 1
DriverManagerDataSource, /Ui 2% org.apache.commons.dbcp.BasicDataSource
& 2k org.springframework.jdbc.datasource.DriverManagerDataSource . A It #i £ (1)
bean Mt & S (8T INDI ) JEARIS A0 R .

<?xml version="1.0" encoding="UTF-8"7>

<beans
xmIns=""http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://www.springframework.org/schema/beans

http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">

<bean id="dataSource"
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class=""org.springframework. jdbc.datasource.DriverManagerDataSourc
e'">
<property name="driverClassName"
value=""com.mysqgl . jdbc.Driver'>
</property>
<property name="url"

value=""jdbc:mysql ://1ocalhost:3306/test?useUnicode=true&amp;chara
cterEncoding=GBK">
</property>
<property name="username' value="root'"></property>
</bean>

</beans>

THH 10.20 fiH Spring 2045 ¥ applicationContext.xml

LR A TRA B b (R AC RS MUt - Spring BT ALIAEEYR bean K5k, Bk
K4k SpringDataSourceTest, H 5234041~ .

import java.sql.SQLException;

import javax.sqgl .DataSource;

import org.springframework.context._ApplicationContext;

import
org.springframework.context.support.ClassPathXmlApplicationContext;

public class SpringDataSourceTest {
public static void main(String[] args) {
Il MSpring @ P R EHER
ApplicationContext ctx = new
ClassPathXmlApplicationContext("applicationContext.xml");
DataSource dataSource = (DataSource) ctx.getBean("dataSource");

jJava.sqgl .Connection conn = null;
jJava.sqgl .Statement stmt = null;
jJava.sqgl .ResultSet rs = null;

try {
conn = dataSource.getConnection() ;// Mk il 4 3% 2
stmt = conn.createStatement();
rs = stmt.executeQuery(‘'select * from Student'™);

// 5. SoR& A E
while(rs.next()) {
System.out.printIn("4i5=" + rs.getint(1));
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System.out.printIn( A EH=" +
rs.getString(‘'username'));
System.out.printIn("#4=" + rs.getString(''password™));
System.out.printIn("/ =" + rs.getString('age™));
}
} catch (SQLException e) {
e.printStackTrace();
} Ffinally {

try {
rs.close();

} catch (SQLException e) {

}

try {
stmt.close();

} catch (SQLException e) {
}

try {
conn.close();

} catch (SQLException e) {
}

TEH 10.21 8 H Spring s Uk Ui a2l 22 S A SpringDataSourceTest

AR ANGG H 10.18 HHLE, AN A2 AR AAE T BLAE AR IS0 52 56 4 A I il SO
J7 M Spring A ds G, TTLLE 2 Java AU EL D> T2 LSzl > A S DA
T Spring (URCESCAEHD, I HELE BRI E RS e RES T, ZERAI A, H
g ZAB U B SR AT BA T o AU IR AN R 2 A DAL ARMAOK 75 o 3K AN SRR T 45 R AN LK)
10.18 [FACHS IR T G5 R BATALATT DXl o

IAARTT I e — A7, SUEAET] JDBCTemplate K52 JklRIFERIThAE . 56k 5 1]
—1% Spring B 7 SO IR E CE 245 BiE 2% H 7 30 11.2. FIA JDBC & L2RSEH
JDBC HIEABEMERLEE — 1IN ED:

JdbcTemplate /& core %00 . BT TE R T FEUR I DL BRI T A, i i
T AT IDBC HAE o eoids nf AFS BhFRATT ke G — 0 WL AR, Ll sl D¢ PO
%4z . JdbcTemplate #4521 JIDBC #% /LA ELHIFE, ol SQL B AJMIAIEE . $04T, 1Mt SQL
R () A2 B A B A v 4 R R T AE B 8 FRATT N AR . & T BASE R SQL i, BE T LA
FR AR, AT LA ResultSet FEAT 3 [ 0 EASEH . & 38 T LA 3k IDBC i 44 3L
4y org.springframework.dao e I, B, 5 EFE R R
fff H JdbcTemplate 1 4T % 5 2 75 22 4R 5 W 1 s SC IR — 41 32 2 >k <2 T ] o 42 10
PreparedStatementCreator [F] i $ 11 i i 4 & 1 Connection ] # — 4
PreparedStatement, {17 SQL FTATH S Z 4. CallableStatementCreateor S Hi[F]#+:
kb EL, HORS & A 12 CallableStatement. RowCallbackHandler 322 1 1) ) 54 45 (1) 4
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— AT R

BATAT LLAE—A service SEBLSHIE L4438 — > DataSource 5| F >k 5¢ 1k JdbcTemplate
sk, Al LL7E application context HC & —~ JdbcTemplate bean, kfit service fii
F . T B3 = 02 DataSource £F application context & /& Bt il % — bean, 2 —F & T,
DataSource bean ¥ {%i$45 service, 5 i F DataSource bean 14445 JdbcTemplate
bean. [X2% JdbcTemplate i i [0]3$% 1 A1 SQLExceptionTranslator #2 1145 A 2%, Ll
— A LR e SR L 4k K JdbecTemplate Sk e X 12K,

Bk T execute J5ik2 b, JdbcTemplate i $fit T K& &) ik, fEIXEedf) ik,
AARK— 8532 AR A A Y o Ee R [Al—ANEE Ccount) g55 B MUk [HIAT 45 L HL
1545 € HIRAE o 3X I FeAT T 7] LUAE T queryForint(..). queryForLong(..)&# queryForObiject(..)
J7i%.  queryForObiject /732 H1 kKR A1) IDBC 2880 G ke i di & () Java X%, i
R WO Y InvalidDataAccessApiUsageException 54 o

B TR B A A 7, JdbeTemplate i34t 7 —41iR 0l List 455 (K55, List
HH )RR —T000 BY AE)R (A 45 R (1 —47 . R )2 queryForList ik, ik
BE—A~ List, 1% List dfR—4 k@ —> Map 5%, XN EdE FE R —47; i
% Map A — T006 B A O EA T T ) R — B .

W7, A5 7TXEERE, BATHATLIANIE JDBCTemplate 73 85 Fh 8411 5 0 vl (L3 1,
06 W) 75 B R RN SR U 1) Edi e, DR A BLRAT 1 BB 2 bean B & SCARE & A
e, R IRIC BSOS AR B s

<?xml version="1.0" encoding="UTF-8"?>

<beans
xmIns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://www.springframework.org/schema/beans

http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">

<bean id="dataSource"

class=""org.springframework. jdbc.datasource.DriverManagerDataSourc
e'">
<property name="driverClassName"
value=""com.mysqgl . jdbc.Driver'>
</property>
<property name="url"

value=""jdbc:mysql ://localhost:3306/test?useUnicode=true&amp;chara
cterEncoding=GBK"">
</property>
<property name="username" value="root'></property>
</bean>

<bean id="jdbcTemplate"
class=""org.springframework. jdbc.core.JdbcTemplate'>
<property name="dataSource’'>
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<ref bean="dataSource'/>
</property>
</bean>

</beans>

TEH 10.22 JA Spring JDBCTemplate fic &1 &L [1) applicationContext.xml

WAERTF R AN INRSE, BAEPIFE D ThRE, — &R & ID 2 1 M il sk g
Yoy Gy ERoYWE, W TET SR T B R sk, XS24 04 JDBCTemplateTest,
FLoe A I s

import java.util_List;

import java.util _Map;

import org.springframework.context._ApplicationContext;

import
org.springframework.context.support.ClassPathXmlApplicationContext;
import org.springframework.jdbc.core.JdbcTemplate;

public class JDBCTemplateTest {
public static void main(String[] args) {

/7 M\SpringZsas R

ApplicationContext ctx = new
ClassPathXmlApplicationContext("applicationContext.xml');

JdbcTemplate jt = (JdbcTemplate) ctx.getBean("'jdbcTemplate'™);

V4P B R SRe

String name = (String) jt.queryForObject(''select username from
Student where id = 1", String.class);

System.out.printIn("*#E#4="" + name);

V453 EZ SIS
List<Map> rows = jt.queryForList('select * from Student');

for(Map row : rows) {
System.out._printin(row);
System.out.printIn("%i'5=" + row.get('id"));
System.out.printIn(C"#/EL4=" + row.get("username'™));
System.out.printIn("#f%4=" + row.get('password));
System.out.printIn(C'4:i#=" + row.get('age™));

TE - 10.22 {H IDBCTemplate Vs ) i 22 (1)l i 24K IDBCTemplateTest

AR Run > Run RBATIRA, LA S5 R0 F BT

|Iog4j:WARN No appenders could be found for logger
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(org.springframework.context.support.ClassPathXmlApplicationContext).
log4j:WARN Please initialize the log4j system properly.

A=

fiT=1

A=A

#h=1234

Fhe=21

G 5=2

A DL B SE I FRE R ThfE, 1 JDBCTemplate AR UGB /DR %, (HEFTIE 2
PRAFIXAN AT LEIRIRN I T8, 5 WA IV 23710 ok — SE RN B BRT, UL 40 3 152 3
YA javadoc Ji RS e . JIDBCTemplate #4511 22 772 ] LIE ]

AAMHK K244 NamedParameterJdbcTemplate 71 SimpleJdbcTemplate 2535, i
AT 2T L BAT T

10.5.2 Hibernate ¥4 Spring JF &

AT WA H e F Hibernate & Spring #H17 7T &, 12 H MyEclipse H 77 [#] Hibernate
RIS A= il T Bk AR B 6T Spring 1 DAO 2K, %] Spring 1.2 #1 2.0 7 1 HBhF 451848
(i ik AOP SEIL) J7 =\l T B vy X Bl

10.5.2.1 GIATE, H®MLERFFRIIRE

ek AT @ — A %38 i) Java il H : springhibernate . R 5 iS5 % 7.4 6§
HibernateDemo i H — 5 [ N 2845 411 I H N AHibernate 3 & Dhfig. #4E12% 10.2.1
4525 H I\ Spring g — 5 i N 2545 15 B IN A Spring FF &R DI6E, 49 i 7 i Library 1) i
W EkHSpring 2.0 Persistence Core Libraries, %I 10.11 #MJIDBCE Fin.
PR ML, B BEATAEA N T Hibernate 71 & Dh g, SR J5 F NN T Spring 7T & Uike, 4
an & 10.2 g5 H A\ Spring M) GE 1) 50 TEHE R 55— ORI ES 00 BT BRI, ARSI AN )
RERI I S 3E —TUE, HiNextf&HLE T LLslihilt, mififa a2 ks, X—Jgd%
"] 1% & Hibernate ¥ 7 Spring ¥ 15 B0, Bl 2 e & — M i H I8 Hibernate fic & SC 14 1
Spring | ffLocalSessionFactory. #1[ 10.14 fii~, FA17 B4 LocalSessionFactory
Bean ldiiA\—"AMi, RHERiIAKIsessionFactoryslh il UL T . s iiFinish4240 ¢ X iEAE 5
SE BEANN INSpring L fit 4] 3 i R
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Kl 10.14 0328 =00 ¥shn Spring Bl E H Hibernate T-H

M4 %5, MyEclipse #527F src H¢ FaIEE—4> applicationContext.xml, AR
AR PR
<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">

<bean i1d=""sessionFactory"

class=""org.springframework.orm_hibernate3.LocalSessionFactoryBean

">
<property name="configLocation"
value="file:src/hibernate.cfg.xml">
</property>
</bean>
</beans>

E L 10.23 i LA Hibernate BL & SCF11) sessionFactory bean 8

SR ANE P A2 XA SO PR AMASES 20 5 B0 LIE 40, AR S DR DR kg BREl d SCF 42 7
Ak Hibernate Bt & SR, FAi175 2505 classpath Sk #rtk, EARJR KA LLZ % Spring
W SCSCRY ) Resource CHRYRD) — W IINZE, ILAEBRATTE M St S FEALARMACHS 20 11 N 918 24
H

<property name="'configLocation"
value=""classpath:hibernate.cfg.xml">
</property>

o TXAF R AT LAGEE St SR B A B MR S5 4% L A AN A SR RRIGT. 2 07 T I T AR S B0 At A T
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BT

HE: AL A N Hibernate IhRE, JE¥ I Spring LhRg. )T — P46 % T 54 7p0e 2
AHAHL, ES% A 10.8 Outline 274 TN ZS, ridds Outline R K42 4L 55 HAH G
(K617 Spring 41EEI3E 9, 4R J5 % New Hibernate SessionFactory, i3 5614 Hibernate
ST L) IIXHEHE, Wil 10.15 fios:

10.15 {7 Hibernate 431 1) [a] X G HE
TEIXAREHE ] LU & Bean Id, FFouE 215 51 H BB 1Y Hibernate FL'& SO (ke
Reference existing hibernate config file, e.g., (hibernate.cfg.xml)?), £ A] LA 5L
€ X DataSource 2R )G E @ TE (Properties) FlIL %5 (Mapping Resources) [f]
77 kA —/ Hibernate SessionFactory. {/j Kt # &, #RJ5 il Finish #4411,
CIPRAFAIG B 10.23 —FEELE SO 2

10.5.2.2 kA TR Spring ¥4 Hibernate ] DAO

ok, BAFESH 7.4.5 {FH 0] TRERGEE fiJava POJOZ, BRI LA HIDAO
— 5 A 2k 1 #IMyEclipse Database Exploreri& #1548 5 >k A= s Hibernate S /A Al
WSO, VEAH B ERNARRE nTAEE— 4 4R AT T IR A AR & Student, BT AS R )&V
XFIEHESS — DU DAOKE I v] Uik Spring DAO T, il 10.16 7w .
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K] 10.16 A=k Spring # 4 Hibernate [¥] DAO #1113

sidiFinish¥ s, 5%, sl LLoE AR IO ZE R 1o RN 7.4.5 AdH] e 1) T RS
P E i Java POJOK, WG LA MIDAO— 19 FT A B HIAES AR L, AR A BLIAE 2B B
ARG EA M, — 3o 2 TSRO, e BT A R SR T 1 s :

10.17 Spring ¥4 Hibernate 935 H SC#E P 2%

S A AU StudentDAO . java HIUEAS, X A2 LT Spring [ DAO 2K:

|package dao;
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import java.util._List;

import org.apache.commons.logging.Log;

import org.apache.commons.logging.LogFactory;

import org.hibernate.LockMode;

import org.springframework.context.ApplicationContext;

import
org.springframework.orm._hibernate3.support._HibernateDaoSupport;

/**

* A data access object (DAO) providing persistence and search support
for

* Student entities. Transaction control of the save(), update() and
delete()

* operations can directly support Spring container-managed transactions
or they

* can be augmented to handle user-managed Spring transactions. Each of
these

* methods provides additional information for how to configure it for
the

* desired type of transaction control.

*

* (@see dao.Student
* @author MyEclipse Persistence Tools
*/

public class StudentDAO extends HibernateDaoSupport {
private static final Log log = LogFactory.getLog(StudentDAO.class);
// property constants
public static final String USERNAME = "‘username";
public static final String PASSWORD = "password";
public static final String AGE = "age";

protected void initbao() {
// do nothing

public void save(Student transientlinstance) {
log.debug(‘'saving Student instance');
try {
getHibernateTemplate() -save(transientlnstance);
log.debug(''save successful'™);
} catch (RuntimeException re) {
log.error('save failed", re);
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throw re;

public void delete(Student persistentinstance) {
log.debug(‘'deleting Student instance');
try {
getHibernateTemplate() .delete(persistentinstance);
log.debug('delete successful'™);
} catch (RuntimeException re) {
log.error(‘'delete failed", re);
throw re;

public Student findByld(java.lang.Integer id) {
log.debug(‘'getting Student instance with id: " + id);
try {
Student instance = (Student) getHibernateTemplate().get(
"dao.Student", id);
return instance;
} catch (RuntimeException re) {
log.error('get failed", re);
throw re;

public List findByExample(Student instance) {
log.debug("'finding Student instance by example™);
try {
List results =
getHibernateTemplate() - findByExample(instance);
log.debug("'find by example successful, result size: "
+ results.size());
return results;
} catch (RuntimeException re) {
log.error(""find by example failed"”, re);
throw re;

public List findByProperty(String propertyName, Object value) {
log.debug("'finding Student instance with property: " +
propertyName
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+ ", value: " + value);
try {
String queryString = "from Student as model where model."
+ propertyName + "= ?';

return getHibernateTemplate().find(queryString, value);
} catch (RuntimeException re) {

log.error("'find by property name failed", re);

throw re;

public List findByUsername(Object username) {
return findByProperty(USERNAME, username);

public List findByPassword(Object password) {
return findByProperty(PASSWORD, password);

public List findByAge(Object age) {
return findByProperty(AGE, age);

public List findAII() {
log.debug("'finding all Student instances');
try {
String queryString = "from Student';
return getHibernateTemplate().find(queryString);
} catch (RuntimeException re) {
log.error(""find all failed", re);
throw re;

public Student merge(Student detachedlnstance) {
log.debug("'merging Student instance™);
try {
Student result = (Student) getHibernateTemplate() .merge(
detachedlnstance);
log.debug(''merge successful');
return result;
} catch (RuntimeException re) {
log.error("'merge failed", re);
throw re;
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public void attachDirty(Student instance) {
log.debug(*'attaching dirty Student instance');
try {
getHibernateTemplate() -saveOrUpdate(instance);
log.debug(“'attach successful'™);
} catch (RuntimeException re) {
log.error('attach failed", re);
throw re;

public void attachClean(Student instance) {
log.debug(‘'attaching clean Student instance™);
try {
getHibernateTemplate().lock(instance, LockMode.NONE);
log.debug(‘'attach successful™);
} catch (RuntimeException re) {
log.error('attach failed", re);
throw re;

public static StudentDAO
getFromApplicationContext(ApplicationContext ctx) {
return (StudentDAO) ctx.getBean('StudentDAO™);

T B4 10.24 StudentDAO.java ALY

ATy M — R IXAMAS, 1 561X AN 2848 & B HibernateDaoSupport, %25k F T Spring,
B T IR HibernateTemplate ] /57%: getHibernateTemplate(), 1fii HibernateTemplate
KA A Spring MR HEMMAHARMUH, ZFIFH M 12.2.3.
HibernateTemplate — 5[ 2. fEX B IATAFTH AN HIX AL, R ZIXA DAO
SEOL T ERAT, MMBR, EIRSRRM IR, HE, EEEU D LB DR S5 AR, [l LT
Hibernate —#z [N 7%, FATI%01E Hibernate [ /715U AE S5 N AT A e BERI I 45 53,
JITLL MyEclipse A2 15X AN AR & 6L 1), (RS TSI >R i ads 75 ZEE— 20 (15 R i
o

BTk, BTS2 7.4.6 A il hom SCAE— 1 1K P9 2908 S50 AE B (R e B S A Hp ) 32
AR NS AR, X LIS R E SChincrement.

SR, EAFM B, DR AR BT & B MyEclipse 7EIX AN AR AR 1 FE b TesR A
B Hibernate Bt & SCAERINABE R Mapping SCfF. & hibernate.cfg.xml A BR&S
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SO, B i ARSI S R R R A 20 s «

<?xml version="1.0" encoding="UTF-8"7>
<IDOCTYPE hibernate-configuration PUBLIC
""'-//Hibernate/Hibernate Configuration DTD 3.0//EN"

"http://hibernate.sourceforge.net/hibernate-configuration-3.0.dtd">

<I-- Generated by MyEclipse Hibernate Tools. -——>
<hibernate-configuration>

<session-factory>
<property name="‘connection.username">root</property>
<property name="connection.url">

Jjdbc:mysqgl://1ocalhost:3306/test?useUnicode=true&amp;amp;characte
rEncoding=GBK
</property>
<property name="dialect">
org.hibernate.dialect_MySQLDialect
</property>
<property
name="myeclipse.connection.profile'">mysql5</property>
<property name="connection.driver_class">
com.mysgl . jdbc.Driver
</property>
<mapping resource="dao/Student.hbm.xml" />

</session-factory>

</hibernate-configuration>

JH . 10.25 45 Hibernate Bt & SCH NGB AE 1T dao B SCA:

BJh. PEE N SFERGES T S applicationContext.xml RN 7F, 55415

<?xml version="1.0" encoding="UTF-8"7>

<beans xmlns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://www.springframework.org/schema/beans

http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">

<bean i1d="'sessionFactory"

class=""org.springframework.orm.hibernate3.LocalSessionFactoryBean

<property name="configLocation”
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value=""classpath:hibernate.cfg.xml">
</property>
</bean>

<bean id="StudentDAQO" class="dao.StudentDAQ">
<property name="sessionFactory">
<ref bean="sessionFactory" />
</property>
</bean>
</beans>

T B4 10.26 StudentDAO.java 1A LHS

SCPRHAMATR 23 R 25, A2 3 IR DAO 2511 bean & . AR Af 13X 4~ DAO 1]
RS HBLCTE DRAF BRI 1 DL o W SRDLAEIR S 5 AL R M Spring F3RIUZ 4> DAO [f) bean
S, ARG IR R, VRS IR T I Dt

R EERVFRRUT T i A4S R IX 4> DAO:

ApplicationContext ctx =
new
ClassPathXmlApplicationContext("applicationContext.xml');
StudentDAO dao = (StudentDAO)ctx.getBean(*'StudentDAO™);

Student user = new Student();

user.setPassword(*'pa'™);
user.setUsername(*'spring dao'™);

dao.save(user);

TEFRATI 7 (MySQL £0dii 22D, AR R IMERARAFHE 2 T 1 iX A2 Hibernate 14,
4 MySQL 5.0 s& N2 #F IDBC [ 45 AE ) ! an 4t —Fh S g8 45 10508 22, 49 Derby,
Oracle 5 # SQLServer, RENFEMIRIN: B BA RAFEE !

10.5.2.3 H] Spring 1.2 KIS 55 AAERIAE P 55 HRAT i -3

RIS A=A, BB EKG Spring BC B SCAFE S NN Spring 1.2 AU 1 354540 HE
ke, &5 1) applicationContext.xml [N 2401 K Fix:

<?xml version="1.0" encoding="UTF-8"?>

<beans xmlns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://www.springframework.org/schema/beans

http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">

<bean i1d=""sessionFactory"
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class="org.springframework.orm.hibernate3.LocalSessionFactoryBean

">
<property name="'configLocation"”
value="classpath:hibernate.cfg.xml">
</property>
</bean>

<bean 1d="StudentDAO" class="dao.StudentDAO">
<property name="'sessionFactory">
<ref bean="'sessionFactory" />
</property>
</bean>

<l-— i/~ Hibernate 3 1) F&EFHABIRILAZFHFLSH -->
<bean i1d=""transactionManager"’

class=""org.springframework.orm_hibernate3.HibernateTransactionMan
ager'>
<property name="'sessionFactory'>
<ref local="sessionFactory" />
</property>
</bean>

<bean i1d="StudentDAOProxy"

class=""org.springframework.transaction. interceptor.TransactionPro
xyFactoryBean'>

<V—— VEEXANEM, R XES % Spring R CGL I B/ nl s A 5 (1)
10.7.2Z%50R 9y, W2k true i FICGLIBA AR5 % 5 DAOHE H —->
<property name="'proxyTargetClass'>
<value>true</value>
</property>

<property name=""transactionManager''>

<ref bean="transactionManager" />
</property>
<property name="target''>

<ref local="StudentDAQ" />
</property>
<property name=""transactionAttributes'>

<props>

<V X R RS 4 T USRI i, e — FAmE b ——>
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<prop key=""*">PROPAGATION_REQUIRED</prop>
</props>
</property>
</bean>

</beans>

TH 10.27 AT Spring 1.2 J5 L8340 35 (1) applicationContext.xml

T, BAERATEE—ANRZE Springl_2TransactionDAOTest.java, HyFAULE
i kPR
import org.springframework.context._ApplicationContext;
import

org.springframework.context.support.ClassPathXmlApplicationContext;
import dao.*;

public class Springl_ 2TransactionDAOTest {

public static void main(String[] args) {
ApplicationContext ctx =
new

ClassPathXmlApplicationContext("applicationContext.xml');

StudentDAO dao = (StudentDAO)ctx.getBean("'StudentDAOProxy"");
Student user = new Student();
user.setPassword(*'pa'™);

user.setUsername(*'spring dao'™);

dao.save(user);

}
}
TE L 10.28 I AR R AR A7 H 28 Springl_2TransactionDAOTest
HE: LTIXAMUEME X, ES3% 10.7.1 #110.7.2 WM AR TRE 25 .
FEETRA VTR IR, ARG RS, T LUG 20800 i £t s BLAE T ods 2 5L
108

10.5.2.4 A Spring 2.0 HJ aop A tx 7= B A\ ECEAF PR3 55 2T 17 i

ALAE R Spring 1.2 J7 A5 AAHR ARSI, AN ATk S
Spring 2.0 M B X FH kg . Frd— A Spring At & S C¥ b1l
applicationContext.xml & #l—4y, Fr4RITT) applicationContext2.xml, HH Py 2155 Hh
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WwrprR (AR GES 2% Spring B 7 ORI 12.2.7. A FE S9!

<?xml version="1.0" encoding="UTF-8"?>
<beans xmIns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmIns:aop=""http://www.springframework.org/schema/aop"
xmIns:tx="http://www.springframework.org/schema/tx"
xsi:schemalLocation=""
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-2.0.xsd
http://www.springframework.org/schema/tx
http://www.springframework.org/schema/tx/spring-tx-2.0.xsd
http://www.springframework.org/schema/aop
http://www.springframework.org/schema/aop/spring-aop-2.0.xsd">

<bean i1d="'sessionFactory"

class=""org.springframework.orm.hibernate3.LocalSessionFactoryBean

<property name="configLocation”
value="classpath:hibernate.cfg.xml">
</property>
</bean>

<bean i1d="StudentDAO" class="dao.StudentDAO">
<property name="sessionFactory'>
<ref bean="'sessionFactory" />
</property>
</bean>

<l-- FE—/ Hibernate 3 [ FHSEAMSIARILBZEHFLH -->
<bean i1d=""transactionManager"’

class=""org.springframework.orm_hibernate3.HibernateTransactionMan
ager'>
<property name="'sessionFactory">
<ref local="sessionFactory" />
</property>
</bean>

<aop:config>
<V—— PINAHRW T A4 Tdao . StudentDAOI FT AT J5 N 7 AR S 45 LA -—>
<aop:pointcut id="daoMethods"
expression="execution(* dao.StudentDAO.*(..))" />
<V—— @ SCTRER TR AR, X5 %] txAdvice -->
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<aop:advisor advice-ref="txAdvice"
pointcut-ref="daoMethods" />
</aop:config>

<V—— XERSWEMEAE, FANFELSEHESTIHE transactionManager -->
<tx:advice id=""txAdvice" transaction-manager="transactionManager">
<tx:attributes>
<V—— JREWRLET VLTSNS, X HEWE — FaiinA, w] BAE ARk
HIMATER 715 -—>
<tx:method name="*" propagation="REQUIRED" />
</tx:attributes>
</tx:advice>

</beans>

TE L 10.29 {H Spring 2.0 7 #4511 applicationContext2.xml

BT, BAETATAT LA o )2k —MIHASE Spring2TransactionDAOTest.java, kK
DRIX AN 2L T A W] ) AOP I SCAF

import org.springframework.context._ApplicationContext;

import
org.springframework.context.support.ClassPathXmlApplicationContext;
import dao.*;

public class Spring2TransactionDAOTest {

public static void main(String[] args) {
ApplicationContext ctx =
new
ClassPathXmlApplicationContext("applicationContext2.xml'™);

StudentDAO dao = (StudentDAO)ctx.getBean(*'StudentDAO™);
Student user = new Student();

user.setPassword (" fi4'™) ;

user.setUsername("'spring 2 Fi5CHMNEA™) ;

user .setAge(200);

dao.save(user);

55 10.30 Pk 5 B X F 45486 Spring2TransactionDAOTest.java
W7, MBI, AKRUASG LTI I AOP IRFE Sk IEM M, RiE 2
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log4j :WARN No appenders could be found for logger
(org.springframework.context.support.ClassPathXmlApplicationContext).
log4j:WARN Please initialize the log4j system properly.
Exception in thread "main' java.lang.ClassCastException: $Proxyl

at
Spring2TransactionDAOTest.main(Spring2TransactionDAQOTest. java:11)

KR AR ? Spring 2.0 [ SCRSH B HIAN 2 35 & 1) AOP W] LU H B4t EEACRE 1) 2
(A2 Rk B2 T IDK (4% R BRIA 2 CGLib IZRACERmR ? SR TBA Ik, s T, B
VFiXs2 Spring [1—> Bug M. B/ ardg KR, fURMA —MEEHE X, kBl
StudentDAO.java, il'&SEHl—~42 11 IStudentDAO:
public class StudentDAO extends HibernateDaoSupport implements
1StudentDAO
o RJFTATEE — /L1 1StudentDAO (R] LUl i F Ay Dy R A B, 1EF¢ . Refactory >
Extract Interface, 7EXJiGHEN] Interface name Ab#ir A\ 1StudentDAO, 4R 5 i FH 65 HE
T ZE MR TR IS, fea sith Finish $EHRIRT, Wi o

K] 10.18 FME RN
), I JE AR R AR 4 R TR -

package dao;

import java.util_List;

public interface I1StudentDAO {
public abstract void save(Student transientlnstance);
public abstract void delete(Student persistentinstance);

public abstract Student findByld(java.lang.Integer id);
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public abstract List findByExample(Student instance);

public abstract List findByProperty(String propertyName, Object
value);

public abstract List findByUsername(Object username);

public abstract List findByPassword(Object password);

public abstract List findByAge(Object age);

public abstract List findAII();

public abstract Student merge(Student detachedlnstance);

public abstract void attachDirty(Student instance);

public abstract void attachClean(Student instance);

157 10.31 IStudentDAO.java

X gt B ) Spring2TransactionDAOTest.java FL i (4GS &2 B EhA R T -
I1StudentDAO dao = (IStudentDAO)ctx.getBean(''StudentDAO™);
o T, WUGBATINAZE Spring2TransactionDAOTest, SRR B4t g, o] MR =%l E
P O AmARER T .

10.5.2.5 A Spring 2.0 fi@Transactional FRIEMFRESRZ HE (BEHE)

W7, B EERARAGLER, MIZ TS W aop:, txeflid, &
FRER— AN, SEAER R T ! Spring AN 2Lk TRATH SAH U 2 475
INEPRD X LE A H 2

BrZ it ! XEEAMINHESG—FhIME, HET@Transactional FriF (1 Spring 355
g, XM7Y .

HRE: BARIXM T RS R S Nk, SRIMAITE 2L IDK 1.5 [ISCRE, MR
EFRATTI I H P AS B e) B, AR & Tomeat 4 + JDK 1.4 1%, SIAEGAT E—AMi#
VUEIR

1 2EBATTH) DAO K] LA S OR SEBILEANE 1, (R B E ISR, HIF Lo
AR Gl R TR s

package dao;

import java.util._List;
import org.apache.commons.logging.Log;
import org.apache.commons.logging.LogFactory;
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import org.hibernate.LockMode;

import org.springframework.context.ApplicationContext;

import
org.springframework.orm._hibernate3.support._HibernateDaoSupport;
import org.springframework.transaction.annotation.Transactional;

/**

* A data access object (DAO) providing persistence and search support
for

* Student entities. Transaction control of the save(), update() and
delete()

* operations can directly support Spring container-managed transactions
or they

* can be augmented to handle user-managed Spring transactions. Each of
these

* methods provides additional information for how to configure it for
the

* desired type of transaction control.

*

* (@see dao.Student

* @author MyEclipse Persistence Tools

*/

@Transactional

public class StudentDAO extends HibernateDaoSupport {

THIE 10.32 AT HF554r7E 1 StudentDAO . java

AN DR ARMAS 23 2 BN IR RRIEACRS o AR S FRATTFE ZEBT AN B Spring B & SCAF

Cls L) applicationContext.xml &2 H#|—4r, HEay4RI0]) applicationContext3.xml, #f
HA MBS B CRAKE X2 2% Spring B 7 CR11 9.5.6. fiif] @Transactional
ﬁiﬁ)

<?xml version="1.0" encoding="UTF-8"7>
<beans xmlns="http://www.springframework.org/schema/beans"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlIns:aop="http://www.springframework.org/schema/aop"
xmIns:tx="http://www.springframework.org/schema/tx"
xsi:schemalLocation=""
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-2.0.xsd
http://www.springframework.org/schema/tx
http://www.springframework.org/schema/tx/spring-tx-2.0.xsd
http://www.springframework.org/schema/aop
http://www.springframework.org/schema/aop/spring-aop-2.0.xsd">
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<tx:annotation-driven transaction-manager="transactionManager’
proxy-target-class="true"/>

<bean i1d="'sessionFactory"

class=""org.springframework.orm.hibernate3.LocalSessionFactoryBean

>
<property name="configLocation”
value="classpath:hibernate.cfg.xml">
</property>
</bean>

<bean i1d="StudentDAO" class="dao.StudentDAO">
<property name="'sessionFactory">
<ref bean="'sessionFactory" />
</property>
</bean>

<I-- AU/ Hibernate 3 [ F55 4 HARRISE AaE PIFSSH] ——>
<bean i1d=""transactionManager"

class="org.springframework.orm.hibernate3_HibernateTransactionMan

ager''>
<property name='sessionFactory'>
<ref local="sessionFactory" />
</property>
</bean>
</beans>

T 10.33 i HAw i A B 5545 1 applicationContext3.xml

AR v FRDRE AR A48 2 gl 2 FRATT I — T OG0 W B AE S, AT R A — T AR
tx:annotation-driven AR5 B T 7 EAG A S A LRSS AR 1) bean & X WX Y
AT H] StudentDAO XANKIIHE, FEIA—AFriE, #tHNHIEL EIMAFSE I RE.
BT AN 2 W F S S H YR ? X B R FEE ST
transaction-manager="transactionManager" ix 4~ J& 1t >k & W H 0 2
transactionManager X bean 1€ 5545 BlLgs, WA ECE SR By 2T
proxy-target-class="true", J&M{ERKE I EEE T3 D S 2 TR MR A . iR
"proxy-target-class" JEME & E N "true", AR TRMRHEREIEH CXr 72 CGLIB
JE cglib.jar /£ CLASSPATH ). f1 5 "proxy-target-class" JE{H % & A "false” mi#iX
BT NS, B AbRHER) IDK He T8 AR AR . IX LA AT StudentDAO
e AN, AR, BT EIMAXA AN EE . B IX A TR AT L,
RIS A DR 2

5 Ja BATER AN — NIRRT g, 2S84 0E: Spring2AnnotationDAOTest,
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AT

import org.springframework.context.ApplicationContext;

import
org.springframework.context.support.ClassPathXmlApplicationContext;
import dao.*;

public class Spring2AnnotationDAOTest {

public static void main(String[] args) {
ApplicationContext ctx =
new
ClassPathXmlApplicationContext(*'applicationContext3.xml');

StudentDAO dao = (StudentDAO)ctx.getBean(*'StudentDAO™);

Student user = new Student();
user.setPassword ("™ ;
user.setUsername("'spring 2 HriEd4-ACHINA"™) ;
user.setAge(200);

dao.save(user);

T 10.34 WRARTE 7 X545 1) Spring2AnnotationDAOTest.java

e, BATIEANE, OK, s, mTUEZEICEHIT, WREEm T .. X4
FEFRATE B B AT P S AL BRI, af DU KA R DK 5 [RIRRyE: B g O Ko 4
T Py A 5

10.5.2.6 f#f HibernateTemplate SZIL4 A #

#84 HibernateDaoSupport 1] T HibernateTemplate, i F e K474 e ? K4
FAIMIE Hibernate 1] Session X% e 32 F543 7L, 4R1M H A Spring 1 APl 2 F A FIX
FERARRE I . e Ik, FRATHLF B Cok4TiE, W) StudentDAO H DA R [ 77325t T EA
SEILY L -

/**

* ] hgll BT AR

* @param hql HSQL #rifjiEf)

* @param offset JFUGHUCEIEN Fhr

* @param length SZHCEEIC AL

* @return List %3 4E

*/

public List getListForPage(final String hql, final int offset,
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final int length) {

List list = getHibernateTemplate() .executeFind(new HibernateCal lback()
{

public Object dolnHibernate(Session session)

throws HibernateException, SQLException {

Query query = session.createQuery(hqgl);
query.setFirstResult(offset);

query.setMaxResults(length);

List list = query.list();

return list;

3
D;
return list;
3
& " 10.35 HibernateTemplate 43 11 Ifi
HARGABEAT 4> 0, 2% 9.5 4w’ Struts#E & Hibernate [ 43 TUW H — 15 1 N 2%
10.6 /N4

AFEANGT Spring ¥ 10C, AOP FI#4 JDBC, Hibernate [JFF 4, ikt T [a—/~m)

R, ST 2RO RS, TAT H A T RS bR R I8, A&k T4

TN Spring FH4-HR)Z S X T ki, HUT R 2y Rl

PASERHE R TAE T, ) LGS & S B ok £8 e i SR i ok 7 28, RS I8 4B vk 5 58 AR 2

B, HE Spring MIMEEACRENE A GRG0 H RIS 20 BN s =5 i fg

KK (Fagiil, Spring AU AR 2 A LA AT SO, A S 5 EE K%
T

10.7 %%k

10.7.1 MyEclipse &/ Spring+Hibernate o AR FEEE 7] B R Af v 75 1

1 MyEclipse () Azh4E g £ Spring + Hibernate [ DAO i< HELA
RE DR AT BN H A2 mT DL v 00 ) 1) R, S DR A BRI AR J ) Spring fic e SC A HLTHT ¥
BTSSR, Bt &% commit Hibernate transaction 13 T LA TGI8 A7 H s .
IR Spring XA "EEE" AERAMERAA, FrLAFZ B SRR, RrIE
T RORLE TR MR T L A AR, N R S R AR E T LT, R
NI R B 2RI XXX HESE, T B A LE i e 1n] BRI A Bk} BE ) I8ROk,
AT JRmHPHERAE S, RESRERZH TA Summer HEZL, tARSHHOEA, HRATH
SRR AR, B NIRA S B AN .

247 U =




MyEclipse 6 Java JT&H SCHFE

fifh- PR 7R A B SO UM N (e SRR A A, AU B E B AME S, 5 Wt o2 1
WOLAE, UG AR RIS 55 BB 5 5T LUE R I R4 55 2] Derby, Oracle 454

8 7, WAHIERI NG, A Spring B IZI6 2 I A B2 HEE X

1. H Ecipse WIEMZ HEhEMKT UsersDAO Jipin—ANBz 1, BRI BT 105
AW, Bl 1UsersDAO, IMAE LK HIE 4 T IDK 198 A ACEE 7 sUSEBL
Spring AOP R TAE, thAT5—Ffif sk Jr AR CGLIB T AR 20X 20 7, XA

Fsitig.

public interface 1UsersDAO {

public abstract void save(Users transientinstance);

}

public class UsersDAO extends HibernateDaoSupport implements IUsersDAO {

public void save(Users transientinstance) {
log.debug("saving Users instance");

try {
getHibernateTemplate().save(transientinstance);
log.debug("save successful);

} catch (RuntimeException re) {

log.error("save failed", re);

throw re;

}

2. B E SCAELS SRR UsersDAO IR ER SR AT 35 45 57 B
<?xml version="1.0" encoding="UTF-8"?>
<beans xmins="http://www.springframework.org/schema/beans"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">

<bean id="sessionFactory"
class="org.springframework.orm.hibernate3.LocalSessionFactoryBean">
<property hame="configLocation"

value="file:src/hibernate.cfg.xml">

</property>

</bean>
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<l-- UsersDAO implements IUsersDAO 1 -->
<bean id="UsersDAQO" class="dao.UsersDAO">
<property name="sessionFactory">

<ref bean="sessionFactory" />

</property>

</bean>

<l-- LL'F#4 Bean transactionManager #1 userDAOProxy & #iMARINZ, kil &
HE >

<l-- A}/ Hibernate 3 1) H55E A MAIR AZEHFLSH >
<bean id="transactionManager"
class="org.springframework.orm.hibernate3.HibernateTransactionManager">
<property hame="sessionFactory">

<ref local="sessionFactory" />

</property>

</bean>

<l-- XAMRERIIE B ST MM ATFINZE, A WK A A 0 AT 55454,

TRAEI WA HEAE hibernate (155 5%, X4 TG k0 B8 B b AT o8l , 0k 2 B ok B A
UsersDAO (1)1 5 #l B84 11y i IXAMREEXS % userDAOProxy; FLAAK LR B AL target
ZHOB IR E TIXAX G EKE UsersDAO A % AT AAHE;

o DR R B sh A4, B LUIX BLA 44y UsersDAO 1% — N2 10 1UsersDAO, H Al
e A IRk B E K) UsersDAO IACEE TA4E, A fitil: Spring 7 f-AF 58 (IR A 3h3T
JF  Hibernate ff] Transaction JF #& A2, B J& ¥ transactionManager [ & )
HibernateTransactionManager -->

<bean id="userDAOProxy"
class="org.springframework.transaction.interceptor. TransactionProxyFactoryBean">
<property name="transactionManager">

<ref bean="transactionManager"” />

</property>

<property name="target">

<ref local="UsersDAO" />

</property>

<property hame="transactionAttributes">

<props>

<l-- XRRYIEZE T LIRS0, St — T eriE L >
<prop key="*">PROPAGATION_REQUIRED</prop>

</props>

</property>

</bean>
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</beans>

3. B A, ORI UsersDAO ¥t #2461 userDAOProxy, fij H.
51 H AR BB KA IUsersDAO, 15 M5k 2 it ClassCastException, A4 Jit K 2 2%
Spring ] AOP SZILIBAF N2, tHATLLH cglib SKfg k.

JR AR A

UsersDAO dao = applicationContext.getBean("UsersDAQ");
dao.save(users);// FI BETCIELRAT B, DR AT 9355 81
B

IUsersDAO dao = applicationContext.getBean("userDAOProxy");
dao.save(users);// MAEN 1% OK T, KIS T

10.7.2 MyEclipse 21 Spring+Hibernate FoiERAEEIE ) B AR R ITEE 2 -
F CGLIB SRSZIEH &

/NIRRT R IDK BACEENLHIK S 45 A B U 0T &, A EGESR B A
JRRIGL 1) 1 5 3 A AT B AR — A DAO 4 A RE TAE. B4 5y — B LU B ] S (1 At v g
FtEH CGBLIB, AIUANHS 581, A4 NTHJE Spring 2% SCRS i N 2%

7.5.3. 3T JDK F1 CGLIB ffREE

EAVNAE R UL SCR, MR T XN T—DNHN S CEERARB N5,

ProxyFactryBean /& 4 ¥t i sa il it — 4k T IDK I8 72 CGLIB FARH

Y7 ProxyFactoryBean 75 % G 3L T IJDK i CGLIB ACHE ff) FAKAT A AERRAS 1.2.x
A 2.0 A AR . IAE ProxyFactoryBean ftX T-Hahfrdl#: 07 mifEH 175
TransactionProxyFactoryBean AL X o

WA T SR ACTR ) F AR G 102 i TR a7 B b bR e ok H AR IO AT SEIAT A
W —MEET CGLIB AR B B . IX 2 i a7 5t, PR IDK QB BT L,
WA R BAT A IDK HATARBE AT e 75 HAx bean MUK AE ASRMIACHY, it
interceptorNames J& 45 H THEA 051K . HEE—NET CGLIB AR ELK Bl G gl R Af
ProxyFactoryBean [] proxyTargetClass J& 4 5 &0 false. (IR ZIXFpE &L T XX A
JEPEREAT VR B B, RS N bean [ U RERR, A BLARIX BN RIS
P, EAEVF2 AL T T EEIRE O

WMHRABRBLRT A (RFHFEL) B0, A4 0] 8RB K2Rk AR
ProxyFactoryBean [¥JIit & K 58 .

% ProxyFactoryBean [ proxyTargetClass J& 4% ¥ 4 true, #4—43ET CGLIB
ARELRE G o SXAERLE A R, AR T M EUREN CORIIE T BOE I —2) .
%224 ProxyFactoryBean [f] proxylnterfaces J& 4 ¥ &4 — AN EH A2 ME s 04, 1
proxyTargetClass J& 44 1% E oA true 53R % S b FH 25T CGLIB (1R .
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% ProxyFactoryBean [f] proxylInterfaces J& gk ¥ & — i E 24N e e D4,
—ANET IDK AR BRI . Bl AR EE SLELITE AE proxyinterfaces J& 4 L4 i
3210, S H ARSI T 458575 proxylnterfaces Ja It FL i B 942 11 DA &, — B85 % 1,
R AT B S S B350 B )2 L0 AN 23 SEI IS LS AR A2 1

WIE ProxyFactoryBean [f] proxylnterfaces J& %A # K E, (HE HFRZSH T A

(B8 #H W %) #:11, H4 ProxyFactoryBean ¥ H KM EIX AN HARR O LI T 20—

B, —ANET IDK AR AN i o Bl SRR A EE 4 R B PR T S B I A

SR L, X AILE proxyinterfaces J& M 71 H bR SEI RN B2 D A Dl & —FERT . SR,
XN S 2 D T A A DL R N TR T e

UF T, PEANIR XA T 5.

FH MyEclipse ) H & ESIIfRE /1 Spring + Hibernate ] DAO 7 IFHE2s LA
R DR A7 Z 8 F A2 m LA ) 000 1) [l i, 32 DA R RO AR ) Spring c e SC A4 HL 1t v A
EXT RS ERE, 2% commit Hibernate transaction 134 i Bt LA AR AE 5. B
WA IER R T 7532 beginTran, save, commit, {HZFLAEH/D> T tran [ ACHS %5
AR W42 fik Spring XA "B ARRARERAA, PrLAE 2 AN 2 R, il
BT PR TR BEMR T W8, AR EASE, HZRE 5 2 kg e s BL T,
BANIFEAMR B G LR XXX HESL, T2 B0 i — A e v RN 7 TR} R 0 IR,
BT IRHFTRIGE S, NESCREAZEH T4 Winter HEZE, HASHLOWA, MR ATH 2
FEREN R BEAE ], A MRS 5 B AV,

fifp P 7 AR AE BE B SO MR AN (e AOZFEA, BTSN BC &, A5 W o R R AR,
JIT L AR AR B BRI < 55 B g vl AR ) O #cdle 21 Derby, Oracle “5%54fs 17

1. EHE SIS 5K UsersDAO N AR ER Sk k4T 354545 1
<?xml version="1.0" encoding="UTF-8"?>
<beans xmins="http://www.springframework.org/schema/beans"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-2.0.xsd">

<bean id="sessionFactory"
class="org.springframework.orm.hibernate3.LocalSessionFactoryBean">
<property hame="configLocation"
value="file:src/hibernate.cfg.xml">
</property>
</bean>

<!-- UsersDAO -->
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<bean id="UsersDAQ" class="dao.UsersDAQO">
<property name="sessionFactory">
<ref bean="sessionFactory" />
</property>
</bean>

<I-- LR~ Bean transactionManager F1 userDAOProxy & ¥ AN 2, Hk
BLEHS >

<l-- FHH]—4 Hibernate 3 (1) F 55 A MACHE A EHFSH >
<bean id="transactionManager"
class="org.springframework.orm.hibernate3.Hibernate TransactionManager">
<property hame="sessionFactory">
<ref local="sessionFactory" />
</property>
</bean>

<l-- XAMRERIIE B ST AN A TFIZE, 53 IR A A AT 45454,

TRAFIN A 5E5E hibernate (15555, IXHF Joidkons Bt FEBEAT o sh, At ok 22
UsersDAO (1 Hb 77 #RELHE 11 8 X AN BT % userDAOProxy; H A & ML & 7F target
ZHOR R F5E T IXADRTZXERP) UsersDAO i ST

A, DA R AT AR, AT T R AR A JFORBLE Y UsersDAO IARER TAE, A feik
Spring 7 1% 12 £ #5 19 & @ 35 47 JF Hibernate ) Transaction Jf4& 755, Bl & 1%

transactionManager AC'& ¥ HibernateTransactionManager -->
<bean id="userDAOProxy"
class="org.springframework.transaction.interceptor. TransactionProxyFactoryBean">

<-- HEEXAMNENE, TR ESOESHE LIRS E R, LAY true fTH]
CGLIB A A5 hil%m 5 DAO #2111 -->
<property name="proxyTargetClass">
<value>true</value>
</property>

<property hame="transactionManager">
<ref bean="transactionManager" />
</property>
<property name="target">
<ref local="UsersDAO" />
</property>
<property hame="transactionAttributes">
<props>
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<l-- XHRITVEZE A AT LUK R0, SeiE — T eiE L >
<prop key="*">PROPAGATION_REQUIRED</prop>
</props>
</property>
</bean>

</beans>

2. B FARES, BRIV UsersDAO [l 5 #8244 1M1l userDAOProxy, K4

M7 CGLIB, FrLARAEL AN I R

JR AR A

UsersDAO dao = applicationContext.getBean("UsersDAQO");

dao.save(users);// T RETCILIRAT S, oA S 91455

B

UsersDAO dao = applicationContext.getBean("userDAOProxy");

dao.save(users);// AN Z OK T, KAFHSIRALT

10.7.3 Spring XIS H B K

http://www.blogjava.net/beansoft/archive/2007/01/19/94882.html
$T Apache DBCP [#%d i Bk B R (J5i )

# ¥ : MyEclipse Spring A 7 # & (& & J7 #L M M AOP ] 1 )
http://www.blogjava.net/beansoft/archive/2007/11/27/163416.html

5 H HibernateTemplate S i) i il ¥ )
http://www.blogjava.net/beansoft/archive/2007/10/10/151702.html
L2 % : Eclipse I 4 Z Spring IDE

http://www.blogjava.net/beansoft/archive/2007/10/02/150127.html|
IBM FF & M5 Spring &5 (E48H3):
http://www-128.ibm.com/developerworks/cn/java/wa-springl/ Spring %7%1: Spring #E
ZafE 4 — —Spring AOP A1 10C 788\ 1]
http://www-128.ibm.com/developerworks/cn/java/wa-spring2/ Spring &%, % 2 &8
/% 24 Hibernate i . Spring— —Hibernate 4% K/Eid4 Spring AOP
http://www-128.ibm.com/developerworks/cn/java/wa-spring3/ Spring &%, % 3 8
4y HEXN Spring MVC— — il Spring MVC A SEAT N TR IT
http://www-128.ibm.com/developerworks/cn/java/wa-spring4/ Spring &%, = 4
4% Spring JIMS Wi ELALH 1-2-3— —Spring JIMS AV JE Ak BEAR 42 111 S 2%

K B WL IR M 35 Chttp://wiki.redsaga.com/confluence/display/RSTEAM/Home )
RS E =

(Spring JF&FEm) AE&: Xiaxin (EWr) PDF #%:\ 169 7, 1.02M K #ithiik:
http://www.xiaxin.net/Spring_Dev_Guide.rar

http://www.redsaga.com/opendoc/OpenDoc-IntroduceToSpringFramework.pdf
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SpringFrameworkfifi& #J1%: DigitalSonic PDF #i{ 24 71, 322K

Spring 2.0 Reference (F /7% TFM) #liF: DigitalSonic 2006/10/22 5k HTMLIRA
Hodik: http://www.redsaga.com/opendoc/Seam2.0/html PDF/RA(509 1T, 3.74M) &b
ik - http://download.gro.clinux.org/jaction/spring2.0-reference final zh cn.pdf ,CHM/JixA
(2.2M) ~ # H ik :
https://gro.clinux.org/frs/download.php/1828/spring2.0-reference final zh cn.chm
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%+ _-%F JFk Struts 2 + Spring W

F T FFRSULS 2 + SPHNGAH (.o 1
X R 1 2 RO 1
12,2 FEESHUIS 2 TFR AL vttt ne e 6
12.3 TFREEASUULS 2 FEF oottt 7

R 1 S O OO 8
12.3.2 JFIRHEUOWOIIT ..o 10
12.3.3 MBI BRI I oot 16
12.3.4 FETPOJIOMIACHONTT L vt 18
12.3.5 H & XAction VR LT oo iR REXBE.
12.3.6 KA — — BT oo, iR REXBE.
12.3.7 RHIGTE oieeee e iR REXBE.
12.4 SHULS 2 HEATSPIING. c..ecveveeeeeeeeeeeeeee e, iR REXPE.
12.5 SEHLSCIE FAL R oo iR REXBE.
12.6 W D7 [ reqUeStEEISPRT B ..o, iR REXFE.
12,7 7B oo, iR REXBE.
12.8 BELUE oo, iR REXBE.

AT A4 Struts 2 [FEATF & LA AT Spring H#EA N FF A« 1E2E# NI
G GABII R, JEARTERIA4 Struts 2 A ARIMAE SRR, AR 8) T3k,
T E PeLHs Struts 2 A INIREK . 55— R, RIRZ RN CAITG T Struts 2 (5§
& WebWork) IURFE, I, A A>3 Ay B R BERTIX A HE S — Lo sl A SR A 40
WA, TR ERRARYE W L Struts 2 B4 Spring [ SCRY AT S 2 IR, AR R
MBANFAA, Bt O MM, £ Bl SO EE S T,
BZAET 2 AN/NAFAG Tk, AR T 25 kU Ok, Struts
2 WREEIEM AN, BrURE X IYIESE T, BECRIEEAREITk, A
AR T T30 b Struts 2 & H 2R T T KFRF AR 552, R ERAY B 3%
HAFRKIRANMEI MR F 3 E—F, A R A P .

AR 44 Struts2+Spring+Hibernate #45 & &K Jj: Spring 345 T Web JZ4E
B2 JG, TRk E Spring 24 Hibernate 62 JPA 2 H g HEZE, HFR /2 A1 Web JZHESE
BAEERRRMN . AEEH O B b s T XS, B Fimx /a5
Struts2 + Spring + Hibernate/JPA/J EHEZL = (Struts 2 + Spring) + (Spring +
Hibernate/JPA/FLEHESY) . RISLAEAR T GIEAE b, FRgh& b —FE M2, &ar Ll 3R mAR 1)
SRS Hibernate 538 Ho e HEAL [ I 72 o

12.1 48

EE IR JFR Struts 1.x WP RATE LM E /44 T Struts 2 FiStruts 1 2 [H] R R .
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WebWork Chttp://www.opensymphony.com/webwork/) & —ANJj IR & A 4855 I Web )2
FERAESL ., ML PORI AT T3], WebWork 1 FiStruts 1 &R 3T, K
SRS, XARILE T M H 2 gk R [ SR Eeky i R 2 1, T Lk P AR (A %
FormBean, JT& A 0758 Hi4# 9 request, responsefiisessionix$exf %, T i) 16 75
BB LR R Bk e B (ActionForward). 4R 1iTWebWork 2 2 J5, ‘& KAHGIN T 4fitEHL
i, R, OB, LLRPOJOII T A, FEXTT R N 01 bt il JiS 2 [frequest, response
SENT G, U e 1)l i 3R [BI String R BRI Rl 58 i, A T ok, JEs T — R pyse g
Bean, il& S HEREUFIActionst %4 = h—, M FIISF—iE b T 55 — AR WebHESE (1) 25
b (AR /2 Spring MVC RIILAE A 11tk 245 B £ Struts 1 (1850 1, B TIOCHISpring
BN A, LI ERE, X R A RN LTS I Web T K AE S 1 )5 Rl 2
—). WebWork 2 1 TR KN I K AR 7 A 40, 1 St 2 HE AL S s kS ik T N kA
Be B S g S AN BN 2R, A AN S FNOCIIBL AL T, KL TALZE ) — ST
A S A EAR o 0T DL S BN K 1 —HE SO AN A e H 55 () We b JZHE AR 13,
WebWork 2 AL RT DAL AR EAZ O e () 2l 423, AR I H I 75 2k B i3y
M2 S GXIEANSpring WAZ ZEAN 2 IAGEIE ) o AIB4 58 —AAWeb ZHESE,  H Akt A
L, 3 U AR HE HH ISFIY 2.0 MOAKG & SRS FROGELE SO/, 4libsid (Annotation),
POJOIIFF A, R IXuieH —AWebJFRAESE? A4l SCRY, AR Struts 2 tHIEERE
AT TCHE B S+ e AR I TF R TAE, B RX AN . PRI HESE, P E SO
B, EEAEFHAESE, 2EXMLA+ o SRR S N e N —EEREACINE 'R T GEA
RGE K T A5 AN A ) AR A Tl, $ESIAXD, —AMESR R E SCIERFRZPE, 2
IR ARSI S . EH MOE T 7 HIavalliWeb/ZHEZLRE 5 FHAL, drvEfh CRZKHH
— R DRRRSE ), JT R TR (B Visual Studio NET ASE A KD, TFRA
TR o AR — R THRAR R R, AT AE T .

Ja >k Struts 1 WebWork #4769, KX —ile KA Apache HE4SIXE AW T, {55
Struts XN YRR T, HEH T Struts 2 fEZE, KEAERS, EREEIET MVC
B TT R HESE, Frfs WebWork 2 (AR S e iX AR o Hi— 2L SOR 367250k Struts 2 3t
& WebWork [f1i /- fl i dr 4, B & SCHVE Bk, Sk k5 H iy kAt i antt .
ARy Struts 1 AT WebWork 2 /588 K F RN s 0AE T, LR RI R, Ti3R7E#
HISCREE TSR A . bR TS Ip imfeskss, EEs il &5 4h, Struts 2 16372
Fr AJAX ETT R CHAT/ZE T DOJO HEZL ML), AR EHEL CAMUARFR T ISP
TURREZR ), DURAGAENLE], SRR T — 4210 Web JZHESE.,

FEE: Struts 2 Al Struts 1 RIS IEAGRSY, QG SCHRRIEC & SCHFEA—FE, Struts 1
IREF I LME A fEI2 4T T Struts 2 2K, 7] LA EA & IS O HESE |

DU 2 Ty 7 9 il R AR A 4«

o JFA

o BHLEF - NHFERBHRFLF o Maven JEUR AT LIRS 1T & B
H.
SRR — MRS B N AL T HTTP AAESE B2,
HORMIARAE (Tag) - AL UK S (1 3R B AR 25 UL BT A R b 28 v LAY
DRI

o HAWEHEEHE (Checkbox) - B THFERMIALEEAAS, THAEE EHEREK
HH SRR T 4 D) e
RIGHEEIEE — BOHR BB 0 5 —MEE (action).,
BIFHAJAX ZRE — TRl FIARUE Struts brZE MU —E0 AJAX HR%5,

2 PURSES



MyEclipse 6 Java JT&H SCHFE

AT LA A FL PR R G5

o J{EHI Spring &R — fliH] Spring [ Action VR ARG R, LEMS
BAMAERAM S E S o (FI 25 Plexus? )

o WHMPIRRERS — 7] LUK AP 45 R LI JasperReports, JFreeChart,
Action #, s#FH SR M7 R R

o POJO B — RFE ActionForm! o] LT JavaBean SKHfiFkdm A
wE A B R E S Action 28 b m AR IS T HEBIRN T eR 2R ALK
JeR !

o POJO Action — AL ZAE N Action 2K — FLasBz L1 2] !

o TJrEIHRANLE — I AR SCAFEI TS IHESY . TERG THRCE ! RYR
AL JavaServer Faces, JasperReports, JFreeChart, Tiles... ...%%
PINEZ L SRS

o WEIREL — AEStruts® WEE, HBITEIHFR L E

o ERMAMERICIR — HEBEL BIRNR A BT .

o METIRMAction — T LLH MR Struts® Action, ¢ R M AT ] K481 £
HTTP XI%.
o HEBAMERINME — BRI ZRMECE . KZEHER M E T H= A
BAMETTUAE, BATTLR L. HFHEEAE X
o A5 HEENXMEHIE - FEH AT LA E A Action iRk FE . Struts®
A DU AR 2L 77 2ok AR
B — 0 P E RS T CUAE i n) iR S
ST RS — Bk FreeMarker FfREIT] & Xbr%s. AN E %Y
taglib API! 574 3% /# ISP, FreeMarker, Z{ X Velocity #5455,
Struts 2 HEZEK T ()7 ] /& Apache License, Version 2.0, A LU i 17 1) 3 4>l 72 352 «
http://www.apache.org/licenses/LICENSE-2.0. 48R &1 LL % 2% F T F AT A S v b 3k 1
. EHIbrER (Logo) Tl RHTs:

1847 Struts 2 T3 R A4AE: Servlet APl 2.4, JSP API 2.0, Java 5 (& 1fi/1] j4
WA, 12471 IDK1.4). R3] i% Ui H Tomceat 5 8% B = ACAS il 3 A AT AnT 1)@ T

Struts 2 AT IR RSN IL TR : Web il 254 5 SIfEHT struts.xml, BIaa400 B SCHF,
Action PRI SR TR, FIARAHESE — ] ;i sk XXX.action —Struts 2 i jE#s X % 1
] (Object Factory, #JLLJE 43 /& Spring)fild: Action 2K il —HAT IOC FIHLHE 2%
RS IT R I SEL, SO BAR, BT e Action X% — A Action 1 H 4
ST — IR A 25 R (Result) B 72 7 ALK 2 —~ W 23T 2on CEUAER R b
B

KTHILZE M, W R — 2 P0RHA N : WebWork 2, 5E2F5 /& Webwork +
XWork #1842, Webworkl.x AT, FEAHESKA TSRS (GELL Struts 1.0,
1 WebWork 2.0 2 J&, Webwork #4543 /N5, Bl Webwork 2.x +XWork 2.x. 24
— MR G, W RIERAS 2 TN XS R Action 8K, SRS Webwork 2.x HESE 2
i JJ; HttpServletRequest. HttpSession. ServletContext s, FkEHAZ I3 A 1K)
Map SEHLH, b2 )5, Fra 8RR el Map githittr, Mk i s i 5
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Servlet API 170, 22t, Webwork B TAEMMBSS o, ik fkissy XWork #47 F—24
AbFE . MOX BT LA S| Webwork F1 XWork 22 [alf{47) 43 250, Webwork % XWork $2it
TN Serviet HIHMNEEHgs, ¥ Serviet HISCHIEEF B XWork T i 5138
P, T XWork K 58 S Br IR AR 25 18 AT RE S . IXAE—3k, LL XWork A%,
TS ME W PR e 2 A, Bl SIS R AR & Z [ P4 . B4 Struts 2 W, 52
XFE—> Struts 2 #%.0F f5 +XWork (15231, Hor (1) XWork {73 $ATF1 Serviet API JE K1)
FRRALFE, M0 Struts 2 HIAZ%L 2 R AL Serviet J2 524 B SE T I BB (b B, HEifg
XWork & T ixX o5 AT 4, XPEp Sl T — Ao T R HESE . XWork AH T — M
PE—FERILEHELR AL, R — A e B IR AL B+ Serviet #RHESE . T LR K 7B I1
E3# Struts 2 —FHAPIALL jar S0 struts2-core-2.0.11.jar Al xwork-2.0.4.jar, i H.5E
ik N BB 2w — AN SO P i 52 X E org.apache.struts2, 1 i — 4N SCAF R ) 2
com.opensymphony.xwork2, H R AE T It ARBHT A 2H I N BRI 2 (5 2 H
EHEANRIEE IR B . ©

N T T TGN A, FRABHAESIM — R OCT Strutsl A1 2 A SCAIFEIX L CR
WBIWAZLE RS2 TRD:

R b
Action 2§
Struts1.x 23K Action 282y H — Ml 325 Struts1.x i) —ANFEA ) T 75 T 1) 52 2 4 R 110 A 2 18] )
O gifE.

Struts2 ) Action ZE5ZHL T —A> Action # 1, & [A] HoAd 4z O — i RSB al e ¥R H 52 LIRSS . Struts2 31
fit—~ 4201 ActionSupport [k Bl — M F 32 10 . 248%, Action 42 AN A o AT {4 ] execute
TR POJO X4 m] LU 24 4E Struts 2 f#) Action X%k

LR

Struts1.x Action A2 G, K HA — AN SEPERIEHITTA K. FEISEERIGIE R T — 2 RS, JFH
EETF R T BRI . Action BEUS AR LR 22 42 B R AP 1

Struts2 Action % G R — M RARSLHIR G, PrELBAT LR 2 M . (SCERH, serviet A dsgnty—
ARV BFRINE, I HA S SRR D .

Servlet i

Strutsl.x K Action 284 #i T Servlet API, 24 Action #% i Jl i, LI HttpServietRequest #1
HttpServletResponse 15 45 544 execute Jiik%.

Struts2 ) Action FIZE25 ¢, Servlet bR SCHEERIA i 11K Maps, S Action B (1)l Struts2
H) Action TJ LAy il 55 # 1) 1 K (W0 R T Z M GE) o (H A, AT B8k o BCHE BR I Ath T 2 H U )
HttpServietRequest 5% HttpServletResponse.

UlNes

P Struts1.x i 22 jn] B2 execute J5ERTR T Serviet AP X AF AR EAR B T 2588 E=T7H9 &,
4 Struts TestCase, $2fit T —4% Struts1 FIRERINT % ClRBFATINLD

Struts2 f] Action A LUBREHIGAG . BB @k R skt e AR N AR S Rt R AR 75 B i

WA
Struts1.x i FH ActionForm %} % Rigik#i AN . % Action —Ff, T 1 ActionForm 25 B3k, A
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I*) JavaBean AREfEA ActionForm i, R #E 4w Al 2 KRINFEKIMIRH A . DynaBeans HJ LAy F K
YEA AR ActionForm FIZERAIEE . H2, TR AIRERAET iR (A1) D4 fF/E R JavaBean (i8R
SHAH LA javabean) .

Struts2 HAZAEH] Action JEHEAE RN ETE, WER T X8 —ANMMAXN RN TR MAJBIEAREA HA(T)
JB LI rich X745, Action JBMEAETS L web TUHI_L 1Y taglibs Vil . Struts2 237 ¥ ActionForm 2.
rich Xf G R, AR SX %, e EmM A x4 . X7l ModelDriven ¢ fij4L T taglib X POJO %
A5G

RixXES

Struts1.x %4 JSTL, Bl e ISTL MRENXIES . REXESHEANEEN LB, (AR ES
Rl @t SRR .

Struts2 ff ] ISTL, {HZth3ZFF—A B iR KR R Gk 30 5 — —"Object Graph Notation Language”
(OGNL).

R (E e 2 T iH

Struts1.x {f FAxE ISP HLHISK IR % S 2 5T LK 3¢

Struts2 {if H]“ValueStack" £ AR, ffi taglib & s il B 17 A 75 ZHE AR T Cview) AR R0 E K -
ValueStack S fo i/l i — 2 51 4 FRAR Il {H SR AN [5] 1 J A FEH 00T (view).

KA

Struts1.x ] ActionForm J& 145 #i & String. Struts 1.x fii i Commons-Beanutils SK#H T EE e, B4
T—NK, ARG A EPIRE .

Struts2 fifi FH OGNL AT A4, RAEEEAKN I F N SR #4525 .

BAIE

Struts1.x 32 #F7E ActionForm [ validate J5 %9 F3hie K, 535 @id Commons Validator (14 &R .
[Fl— AR LV A F RS N2, AR T X %

Struts2 SZ#Fill L validate 7775 XWork feRHERRIEATIRH: . XWork 15 HE LA T 24 J 2R3 5 LI
I RN AR5, K SCHF chain K561 @

Action $ATHEH

Struts1.x 54— 1411 Request Processors. (WD, LT 571 Action 14145
AT (¥ A= o LB

Struts2 Y FrE T £k 2 HEAR (Interceptor Stacks) A% Action BEE A [F] 14 iy B3 . MR AE g iR 7
BRI Action — 2 AfH .

B ELA IR 1), H T MyEclipse 6 X Struts 2 {7 & i BT BT 8210 50
Pt AR T BAT PG AT IR jar SCHRIT I, AN i 22 RIARLLER Struts 1 K,
HIF RS FEE R I Z

HEA T WG 2 AR IR K 5 7 AT 3R EX Struts 2 (9T & £, Struts 2 B4, i
ff) HelloWorld ¥ FF %, BAAIET POJO (1) HelloWorld FF ik, B35 Tl T4 4 12 10 8 55 o 191
StrutsLoginDemo ] Struts2 45, FEINA S UENUHIFNEBRAb g 8, e AT 28 i fe] i
H Spring ¥4 Struts2 ki i Spring ¥ & &1 -
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12.2 F# Struts 2 FRE

B2k S Strutsf i, B LAY i) HE 7 st http://struts.apache.org/2.0.11/ , 5 M R b
http://struts.apache.org/ k2 J5 fiiliStruts2 M EE N, 594k a] LA i3z PAWikKi T 240 240
(K4 2k SCRY ZEhttp://cwiki.apache.org/S2WIKI/ . 244Kk Ml #i & 2 5 A IR 4ed 16, FrR
Z RREA SRR I HT, AW ] I A R

HT"MyEclipse 6 H & ArStruts 2 I, PIULIRATAIT TR E0E . 7o s b
AHidikhttp://struts.apache.org/download.cqgi, B A3 A Struts [ N v, @11 12.1 s
ELAF AR TR IR R AE X AN DUIRT P [R5 Struts 1 A1 2 1 R8s, o Ae U Th 7 (152 Struts 2,
HATARAZ 2.0.11; R 7R 2&Struts 1, HETHRASE 1.3.8. SEKFEE R 2 M M AL
RES

K 12.1 Struts | #% 7 i

W R ETR, E IR MR 2 2R SR A e AR (Full Distribution), K/ 86MB,
A4 2 struts-2.0.11-all.zip. XM HESERE, RSk AR R, AR T Rl 5 A4
RPN AL S AR 4] DUR B F % struts-2.0.11 RSB JLAS T
H %

apps | B T WUA war WIEURoRBIN L, A e, 525 T LUk A 2] Tomeat 5 tH
CINRSe/ R EEs N

docs | 4% T javadoc, LAMTEZR TR ESERIAS, mT LA index.html FFAR L, sl
U F P R D A R A N A, AR AJAX, S BAR SRS,

j4 {35 T T IDK 1.4 A (A% 0028 2 LR e T L

lib G T Struts2 14 ff A% SR A )

src PAHE H %

*£ 12.1 BB HRANH

o WIRBEH FAFTE UG, B RE TE, SR A0 ) HAL PO OREH], WA,
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SO NHKZRBIMA (Example Applications), K/hA 22MB, {452
struts-2.0.11-apps.zip. ‘E & T L 5EEAN apps Ha FRIVUA war 7= @I A, EAT1E:
struts2-blank-2.0.11.war , struts2-mailreader-2.0.11.war , struts2-portlet-2.0.11.war ,
struts2-showcase-2.0.11.war. & —AN ek s BN, K~k 3.26 MB, 345 Helloworld
MR BRI EEE]1, A AMENZ ST+ 38 AN TSR WA B e s ol o 58 — AN 2 1)
J1 (Portlet) 11+ SEVUANNDE RREIF, Hingt 7 LA Struts 2 B KR DIRER)
~ol, fuFE actionchaining, ajax, chat, filedownload, fileupload, jsf, modelDriven %%

faray
=Fo

T k&4 A (Blank Application Only), K/NJ& 3MB, X {4 &
struts2-blank-2.0.11.war, XA A R AB RS LERTAN RAT AR T o S8 TR
1) Struts 2 AN, 7EERIALE) WEB-INF/lib H3 N8 7 REDLAS jar S0
commons-logging-1.0.4.jar , freemarker-2.3.8.jar , ognl-2.6.11.jar ,
struts2-core-2.0.11.jar 1 xwork-2.0.4.jar WAL F-AL & | Spring #7304 LA K& WebWork 11
S04 struts2-spring-plugin-2.0.11.jar, vl L TIE MG R T « B4, fEARTEE,
PR T IX AN P 0 WU 21 Spring Jd 14 jar SCA Rt AT s N (R T & - 7EIX B,
BATEER A H—FIX 5 A jar SCHF

struts2-core-2.0.11.jar Struts2 [z 0

xwork-2.0.4.jar XWork 2 &, Struts2 #%.0AE 4 i 2 AT AE

ognl-2.6.11.jar Object Graph Navigation Language (OGNL), Z{lF EL
LIS — R T05 M S R IA A E &

freemarker-2.3.8.jar Struts2 AT ui bric NI ] freemarker %5, W
T8 8 el AR AL struts2 (1) ui BRAc A% R EEE T
BIR

commons-logging-1.0.4.jar | Apache fj Commons Loggin {1, %% 718 it H &8 1,
A H 31 Logdd k% JDK 1.4 {34 o & kA 16
util.logging H &

FHE T2 ERKHIZEE (Essential Dependencies Only), K/NA 4MB, X452
struts-2.0.11-lib.zip, LA SCF 2 RIGERE T lib H FRFTa SO R BaE T
Struts 2 [T OFIEF 284, e an 2 BT SE SN I TF A, S USAEEAS H 3 R I
A jar SCEERCE] Web 13T WEB-INF/ib B3, 30R: FUR R .

R R (153 52 CR%(Documentation ), it W 5 #440 (#) docs H 3% ; ¥EAAHB(Source),
X SRR sre Fs%; ATREMT JDK 1.4 BRI JAR 32 (Alternative Java 4 JARs),
XV SE AL j4 H %o

W2 F AT RN RS, R TFLOLH T Struts 2 FIZS% kL, B Bkt JF
ROLRAZ, W LLHE T KB E (Essential Dependencies Only), HSAH]%
HE, WRMAER, AL T2 MNA (Blank Application Only) BiwJ, i
AHEERNAEMINE Y], 3 N kR K 52348 (Full Distribution).

12.3 FFRHE — Struts 2 M H

ARATERA K AT F L 1K HelloWorld 174, LLEEET POJO ) HelloWorld 714, HiE
X Action J7VERRBCAT, Heds Bl PR A5 LR 1) 8 5%k~ ] StrutsLoginDemo H Struts2 45,
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FF AN BAER LA B A o

12.3.1 #E&THE

BATFEALE MyEclipse T EIEE—HH Web I H, JE eI ER Struts 2 257
FEC B SCAF . BUAEFRAT R AN — AN 44 0 struts2hello () Web 1 H . ZEFE 5 File > New >
Web Project, nJLLEZIAIH Web I H 1 1a 5, il 8.3 . 73 XTIEHER Project
Name H%i A struts2hello, X5k J2EE Specification Level FIfiff) Java EE 5.0 ik
H, fJa i Finish $8hn] LB XA Web IiTH T .

HH G2 G, BATFE L EIMAStruts 2 (2. E T LIS %121 TN E N
B M SE A0k 1) S struts2-blank-2.0.11.war, #:3 FIWInZIPEE & WInRARZ i s 45 41 F
R T e S LR (RS b, AR5 B SR IIWEB-INF/lib H 56 R 1 5 ANjar SO 52 11 2124 R Web
i H ffiWebRoot/WEB-INF/lib T, ELARM LA KB 14T 1 25 DIk 2Windows ) SC4F
WEAS hak X 5 AME AR R ijar SO, SR 4 R PREERECH I +C R e AT & I B BT A £,
SR G FATTF V) # B MyEclipse 1) 7 11, £t B b /2 8 3%k 4 Package Explorer #1114
struts2helloTii H ) H %75 AiWebRoot/WEB-INF/lib, 2 J&i#% FHR4ERECtI+V, #J5 X jar
A EE 23 # MyEclipse it A 235 H ) Build Path, £ HU 80 L8 30 H 197 2 Referenced
LibrariesZ F.

LB R RBATIE T B A I yE 28 R BRI & SC/F . FRATIEIC AT LLRT I
Struts 1 J£7E web.xml 7501 action servlet 1975 Xk TAER, {H2 Struts 2 W2 7523 M —
A FilterDispatcher, XA~ Filter ##0TH G K (%)l 14 Struts 2 HEZL W IEARSS, SR ERIA
A N RATIAR AT LU ik g action R IIE SRR TAE . B AIAE AT SO web.xml (78
BAIWTE BT WebRoOt/WEB-INF/ ), 4% HEKLARMASH 2 AR AD K ik 38 2% 0 A\ 2L &
S, SRS AR TR

<?xml version="1.0" encoding="UTF-8"?>

<web-app version="2.5" xmlns="http://java.sun.com/xml/ns/javaee"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app 2 5.xsd">

<filter>
<filter-name>struts2</filter-name>
<filter-class>
org.apache.struts2.dispatcher.FilterDispatcher
<[filter-class>
<ffilter>

<filter-mapping>
<filter-name>struts2</filter-name>
<url-pattern>/*</url-pattern>
</filter-mapping>

<welcome-file-list>
<welcome-file>index. jsp</welcome-Tile>
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</welcome-file-list>
</web-app>

— WAV IR, EX IS, AT Lit<url-pattern>/+</url-pattern>f& 4y
<url-pattern>*.action</url-pattern>.

FER kM AW ? LARTY Struts 1 HIIFR, JEZEAE WebRoot/WEB-INF/ H 5% Al i
B A struts-config.xml, JSAIAE Struts 2 [FF A WE, 0752 — NI BCE SCHR T, B
ANFI e T BRI H (6 sre Ha N, 404 struts.xml, 430 H KA LG, A2
W52 %] WEB-INF/classes . HSA7E src Hg Faidifidd, EPEH New > File, #:4
LEFHIEHES ) File name AWM AME TSR struts.xml,  miidi Finish 4281 5K ]
SPAEHESS, HIATHT FRXANIX AN struts.xml STEE. AR5 T RS (U5 A RS 6 25 i F B
7N

<?xml version="1.0" encoding="UTF-8" 7>

<IDOCTYPE struts PUBLIC
""-//Apache Software Foundation//DTD Struts Configuration 2.0//EN"
"http://struts.apache.org/dtds/struts-2.0.dtd">

<struts>
<package name="'default" extends="struts-default'>
<l-- 7EXHRINActionE X -—>

</package>

</struts>

o B 0] LU ST DR Wk 1K 28RS N B G ds b, TR —— AN T o AT LI 2K
ANECE SO LT package, ‘EZRBLT Java RIS (A Java [ package [#AH L
ZABR T T DM AN SO, B e L2 AN, WA e SRS, B Java AL A T
A, HSZELE AT LUK Action 2028, RIJ4r BRI ) package A7, B EEE 2 IX e 2 |]
A CUE ARk, GFERAARAS, action WUFAESEAN AT LAGRAR . 25401, FRATTE TN H K 8
OE X, AT —A> action AT A4k e . 75X HL A LUF ) extends="struts-default", X
AN, TR AR A R IX N s AEMEELWE 2 4T JT S0 F WEB-INF/lib/struts2-core-2.0.11.jar
T B H S R A A struts-defaultxml S B 2 X T — > £l <package
name="struts-default" abstract="true">, ‘& N A TN HFEFHAL T KR I BIARLE  Strus
2 fRATIC B SR A 25 B B AR ERAR AL H 55 N AR SE In#E struts-default.xml B (£
X FHERTBRATTH 405 1) struts.xml. ERS G BATIG0 S 55—~ HelloWorld 71451 (1) IR i,
LAk EFE N8 package F1 action 15 S5 3.

T34, Struts 2 IS ZANEE U E X7, XAESERR R, TR A o 4
P, B AnSsi T 7 FRAR G AR S5 ON user.xmlo 3XAN SO R A 2 L T R BRIA struts.xml
A% U —HER), BdE e o A, FIFEIRAE sre Hag AR R, s 8AE sre &
IR T HS. HEWE, RATTFHEEE include F54 A FIERIN struts.xml S
[RIAT . R AZE—A struts.xml 74 :

<?xml version="1.0" encoding="UTF-8" 7>

<IDOCTYPE struts PUBLIC
""'-//Apache Software Foundation//DTD Struts Configuration 2.0//EN"
"http://struts.apache.org/dtds/struts-2.0.dtd">
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<struts>
<include file="user.xml"/>
<include file="/util/POJO.xml" />

<package name="default" extends="struts-default'" namespace="/a" >
<l-— FIXHZINActionE X -->

</package>

</struts>

o ARAERXMG LT, TR BT BAGHG AE LR & SO IR package & X 1. Xh
F& Struts 2 (1 AMRF L, BB SRR N L

VR B RS T AR RT, AEFRATTI 5 R ANEOX T T R T, B LRI 1 Struts
B 7 IR ] BE B BIX ML

EMONIE, BE CLRBELF T Struts 2 [T AAEL T .

12.3.2 FF & HellowWorld

BUAEN2H T 1K 4 2 (IUES SR, KT e D40 KR AR A fi— /Ml i — T K
Z 1. OK, BRAEFRATHRIT K —AN 517 F 1K) HellowWorld %11

B, W Java 2 F example.HelloWorld. #E#:5% . File > New > Class, mi# 1
T ER LS e, RIS IXHEHES, i\ Package 4 example, Name
3 Helloworld, st Finish 424015 BIADR IE A0 . IUAE FRAT PR HARASAE 5k Wl F B

package example;
import com.opensymphony.xwork2.ActionSupport;
public class HelloWorld extends ActionSupport {

public String execute() throws Exception {
setMessage("RIF! Struts 2! ');
return SUCCESS;

}

private String message;

public String getMessage() {
return message;
}
public void setMessage(String message) {
this.message = message;
}
}

XA Action We, K A] LLE F'E &4k K 4 com.opensymphony.xwork2.ActionSupport i% />
2, AT A e LS v, R SHE T4 public String execute() throws Exception
b, X B IRA TR EAR L TR B, R R E Action 28 5 11 )E PE message I kA H
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"IR4F! Struts 2/ "o XA VAR IR [MIME K H - SUCCESS, S ko2& 4 AR
ff)"success”. HBAIXAS success Wil BIWEHL W ? Fr LAEE N R TA b 75 EEAE L & SR
R IE AN AL AT U7 1], LA R s I TR 45 R Sl s DL TR A%

BLAE, £E struts.xml A —A action € X, W1 R A B AL RMA R 20 BT :

<?xml version="1.0" encoding="UTF-8" 7>

<IDOCTYPE struts PUBLIC
"'-//Apache Software Foundation//DTD Struts Configuration 2.0//EN"
"http://struts.apache.org/dtds/struts-2.0.dtd">

<struts>
<package name="default” extends="struts-default'>
<I-- fEIXHINActionE X -->
<action name="HelloWorld" class="example.HelloWorld">
<result name="success">/HelloWorld.jsp</result>
</action>

</package>

</struts>

. ALLF F] action 147 (name) 4 HelloWorld, ‘& 12%(class)jt example.Helloworld,
AN e AT — AN S5 R DU AT LU s /Helloworld jsp.

W7, BFRBMEQEXANEREMR ISP XM, EHEEH File > New >
JSP(Advanced Template), 7EiX A X%f i HE H ) File Name (3Cf 4 ) HE %A
HelloWorld.jsp, X 5 sithi Finish $ZH1RIATAIELX A ISP Uil . K KK HelloWorld.jsp
RIVEAREAE SO T T Fr s

<%@ page contentType="text/html; charset=GBK" %>
<%@ taglib prefix="s" uri="/struts-tags" %>

<html>
<head>
<title>Struts 2 fijl</title>
</head>
<body>

<h2><s:property value="message"/></h2>

${message}

</body>
</html>

EANTUIAEH T Struts 2 AR AT EL F£iA R IREN Action 25+ BT e X IF) message J& 7.
X—f)<%@ taglib prefix="s" uri="/struts-tags" %>l st MM hil-/struts-tags T [ 3 FeFr 25 %,
I REA NS U AT XA I AER FLE 2 25 480 B AT Struts 2% 3 {fstruts2-core-2.0.11 jar
L 1K S FMETA-INF/struts-tags. td B T, ZEX AN SISk A iX 4 — B :

<?xml version="1.0" encoding="UTF-8"?>
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<IDOCTYPE taglib PUBLIC "-//Sun Microsystems, Inc.//DTD JSP Tag Library 1.2//EN"
"http://java.sun.com/dtd/web-jsptaglibrary_1_2.dtd">
<taglib>

<tlib-version>2.2.3</tlib-version>

<jsp-version>1.2</jsp-version>

<short-name>s</short-name>

<uri>/struts-tags</uri>

K AT LA = 2R R A (K <uri>/struts-tags</uri> Wil i 5 ISP SC 5 | A taglib = B 5L i uri &
PEVCRE, XFEER 2] 75 N bR UALE T . TomcatZEWebfR 45 4% 2> H 80 Nk i fjar ¢
PN IIMETA-INF1- H 3% R R HdFRId e OO, IR AR A A A4 i 2 HEZRAN TG B4 d SO S )
FIWEB-INF H 3% T 1R A

A I, B—ATHE IR T o b T T2, FAXATH 1) H sk 451
WL KK, Wik 12.2 g,

K 12.2 struts2hello i H H 3% 4514

AR & R AT JGi24T, #1JFInternet Exploreri i 28 5% MyEclipse [ 5 [\ Web i % 2%,
BT bk Sk #4700t http://localhost:8080/struts2hello/HelloWorld.action » 154
F 2 O LT AT A S, WA “UREF! Struts 217, W EIITR:

12.3 #—> Struts 2 f&F

12 KA




MyEclipse 6 Java JT&H SCHFE

WA AT R — AN IF AR T o

FER: MR, AR Struts 2 TN EM—LERATE, AKX S % R HIE
WA DU E B AN RN N, HENTE N, BJE R S ORE RN

AL, FRATIA f] B[l i — F PR AT VR AR : 15 S5 H P Vs il il HelloWorld.action, #& 5 Struts
FILgE2s M struts.xml HEHT ] name &y HelloWorld [¥) action 52 3, MBI L3 T % M
I3 example.HelloWorldAction, #2535 St AT S 17772 execute() >k & message
JE A “UREF ! Struts 2117, AR IR [FI{E"success” ] action & X A F] name i success
f) result & X, 11 L IE Hsdik & /HelloWorld.jsp, JiF L3 sl k% 31 ISP W #E4T S ow,
[ e K 2534 = 2 Action 2R LT message J& PR FasR thnl DALk ISP Ui ffrvsinl T, X4
SRR Struts 1ARA—FEMIH Ty . FFLART, A0 H SV request X%, WE BN,
ZJGA REREHT 6 1) ISP BTG 1) B o 33X AN ik B 1 1) 5 5 A2«

HelloWorld.action — example.HelloWorldAction.java — execute() - success — /
HelloWorld.jsp — # 4 message /#14 — %,

PRk [AEi— T example.HelloWorldAction, ‘W, #kzk |9 ActionSupport, TfjiXA
BESZHLT com.opensymphony.xwork2. Action % 11, XAN2KHET XWork, ‘B e X
LU

package com.opensymphony.xwork?2;

public interface Action {
public static final java.lang.String SUCCESS = "success";
public static final java.lang.String NONE = "‘none"';
public static final java.lang.String ERROR = "error';
public static final java.lang.String INPUT = "input";
public static final java.lang.String LOGIN "login™;

public abstract java.lang.String execute() throws java.lang.Exception;

3

CXFERF W 1T SUCCESS 1A /& Wk HL K 1) . SUCCESS \NONE . ERROR. INPUT
LOGIN JLAN AR d s e T B LZRIRAME . 17 execute() 77k, MEHREAS Action [
ANEJ7, BRAEGL T XWork #3 FH4E Action [ execute() )52 LASE Y 538 AL FE
IXFEXT T FRATTH Action 2R, H5 a7 1) 5 20l A& L 5230 public java.lang. String execute()
throws java.lang.Exception IX /N7 VE eI LA T, & IR [FHE & — AN 57 d 2R 1 AR 0 44
AN A AL E ORI result drid . BIERIZT (1) HelloWorld 28ia 5 —Fh 5, &
HESH D . ROV ERETH I Java 28 example.HelloWorld2 #1717, HACHE
LU

package example;
import com.opensymphony.xwork2_Action;

public class HelloWorld2 implements Action {
public String execute() throws Exception {
setMessage ("' RIf! Struts 2! );
return SUCCESS;
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}

private String message;

public String getMessage() {
return message;
}
public void setMessage(String message) {
this.message = message;
}
}

o i R struts.xml (1] action FUE, K H: class J& & il example.Helloworld2,
PRI, #3225 AR S —FE 1

A, WAV KEE struts.xml. EEEREINZ Action (U5 I HubE, e ¥ in) Mtk
HIAN R K vsE, — 2 package 1) namespace & X, — 42 action ] name. &
IR, ALK AH—F package br2s (52 58 41 % -

Bt W | B
name = ety a4
extends 1 Gk H LIRS A ERAT N
namespace | & Z:2 1 U 44 7 [ 4
abstract 1 AR (BN AT LN E action)
#* 12.2 package 5E¥% @ 11512
HAR—AE L A, BATEERHOEN A H—F Struts 2 HIHTMS ——&:

F&— PP HIKRXS action, result, result type, $2#i8%, DA AF g AT AL, MAENIRCh—A
AR ERRCE Foen T . MRS BRI, e A Java IR SARAMEL, RO eI g
J&, TTUA ZA Ay (i) dIpk, EnT DA A (28 dkoR. M B S )
package JCHE A FHE - PMUBAREN: name. extends JEYEE A ER, &R LY R
YA —ADaE 2 A LT — AT A Ry, PHERERER, DL action FUE . I ERE
2 i B 28 i), i A3 "extends™ 5 | FH I AL A 20058 AR M AT RL Z /T . 38 S ml ik (1)
abstract JEMEMIANE T 7 —AEANE, LT Java g5, & nl LAV actioin fiL'E .
Mrixrz@ied, WA namespace J&H 2% RATN action (17 in] B AR 5 1
B BT DR FRAT TR G 22 A 42 A RN action S SCHUBRMSE . e BRI, k2
TP AR DBEA R H 5%, g, #F84 Root Namespace, ‘B0 A
Pj i) Web N FRR B SO0, X BAl TR~ A B0 A0 2 A8 0 a2 Hh Vs i) /struts2hello. Hg (1)
W, —Mekui LUITk, filtn/user, WA 145 41096 1) action & XARIN T —ANATgE (A
SRIXFEIFAS RN BT, B AR IAT 4 11 (1) & S (1) package & A :
<package name="default" extends="struts-default" namespace="/test" >, H
WIRATIHE JE, ATV Action [ ARHG 2 02«
http:/localhost:8080/struts2hello/test/HellowWorld.action, 44X $AT 45 ik & —FER . SR,
R4 Strus 2 30, XA 44 A FAFE SRR, s ] IR A B G 3
PiCHE 58 % 4 prdoes H s F Rl BLAR B, o owT DUV ) 3L AR 2 SO RS E D W
namespace-configuration.html — &5 HITEGI 4, 280 T — BN R UG, AT DU H S0
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BRORXS ATV R AR 5, )8 action 1) name JE¥E T, &AM action
) 5E Xt s .
<action name="a.HelloWorld" class="example_HelloWorld">. XM {%Actionf]ijj
] 12K 228 i http://localhost:8080/struts2hello/a.HelloWorld.action. &1 S #4:# F— B
FrtE| [ inamespace="/test" [ & W INBERTE, EHU7 W) BRI S A8 il
http://localhost:8080/struts2hello/test/a.HelloWorld.action.

FE: XIHMEtir AA4niELE action i) name A”a/HelloWorld™ 17 A 17? &% 2. B
INTE DL N AT 1 I RARKEAE name FEFHRIE (“17), B0 E — AN 8 1 : <constant
name="struts.enable.SlashesInActionNames" value="true"/>, {LiXAJikII{E struts Fr25MH)
JEIRERRS o 5346, BARATALEARRH T A s (.7, G aHelloWorld, BB 5 (“-7),
ul: a-HelloWorld, $R1T—BOR UL A HESFIX PR, A IX 25 FHOEELE Struts 2 L)
JavaScript F1=#i(theme) LA, B AJAX SCHRES . SR IRANE 2 FH S 1 iy
&3, ltn BT By 44 o aHelloWorld 58 I N %4k a_HelloWorld

A6 T Action [FE X2 5, BATKRERIESR result TR EAMWMEH: B, &
feft— 24 LA FR. —A Action 1] LUR AL T-"success" 8 "error X ALK ) 44, i
ATEIEILE Mg K, B result JCEEBIRME T P& REE (Result Type).
K2 H A R T H I (] B ) e o) — A ISP U s Bihie,  ARTMAR 22 1 (0 5 SRR TR
ATLMERIY, il XSL, i, FreeMarker #i# Velocity , CL&HE M, 5 2t
— P RIREE R MDD . XA THA TR IRIX N A T, A F S
i 2R MY: Dispatcher Result, ‘& F R34 W48 9841 41 ISP, 1T~ Struts 2 HEZE K AL
T B, T EAFRATII result JTCER UM S B ORIR Deif . 156N, Struts 2 &K
BRINTC B SO SCT BOAM S KA, W R k.
<result-types>

<result-type name="dispatcher"
class="org.apache.struts2.dispatcher.ServletDispatcherResult"  default="true"/>
</result-types>
CEA T ISP gk rh 1) foward . PRI, EARE SR FRATIE TG B ST BUR AT 4R E type,s
{HAE e S BN dispatcher ZE5 AN, BTLL, e RI5eHE A I 7 000
<result name="success" type="dispatcher">
<param name="location"> /HelloWorld.jsp</param>

</result>
o 144 success [1) result & X A LLgE—244 1% name JE 5 4 -
<result>
<param name="location">/HelloWorld.jsp </param>
</result>

o LA, IRiE T LI I i param JoER, FRON B4 U5 (GXAE Struts 2 FAF IR
1918 ] A KR A7 D

<result>/ HelloWorld.jsp</result>

AMERET- AN result s CnT DU ] 522, 55 T 2 AN IRIFEBR A8, 60 40 R T -
<result name="input">/Login.jsp</result>
<result name="success">/success.jsp</result>
A AT DA SR -
<result name="input">/Login.jsp</result>
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<result>/success.jsp</result>

HAh, e RS RRB AL, MR EEEN, ERELE: <result
type="redirect-action">Menu</result>,
BJo, BT Struts 1 B GlobalFowards, Struts 2 37 35K 5463 T i Result
& XN 4R, Bl Global Results:
<global-results>
<result name="error">/Error.jsp</result>
<result name="invalid.token">/Error.jsp</result>
</global-results>

BJE, ARBIERER ISP 7 HelloWorld.jsp, 7] LAFE 3] Action &1 J& 7 O 4
AT request X%, IXAEIRATTRD AT LLE TS Struts (4525 property Sk ia), 8] LUE T EL
Tk FOR B X T SEBR IR, BATTBRZIE I fEREH] EL RIAZF ISTL (Wl FH e
T FEAESE iy (S LeARARUE RN 28 5 2 Bl 1 1 8 AR5 o AT Alg? 28Nl 7, &
WRATLAHT I H 42 H Struts 1 FIAREFEMLT), BIEARE & XM Struts 2 K55, fRA] LA
MU Z KM TAESRW, i H 2] Struts 1 A2 1#S 28 Shliny T4k 2 Struts 2 F XA .
H2WE, W MR T OEL AN ISTL, IUAEURE T Ze— 3 bR Bt nT LA T o X3t
— ELEEAR TR 1R bR E R S BT T HE S G RE IR U A, PT e P RO RS A P S e e 4 T4 s F A
FEEPRBEN), TERARENGIRGT, BREZHELUG WY MYy . 7, RATARBZ
W2 Action KB LAELA EL RiIAACKTF R, THBATH 6 A S KT
request.setAttribute )VIXAEARIY T, HEZEA G CEALF 70 10 TAE, BRATAIEZEM
Servlet 2R 25 Ik .

12.3.3 A ERLEE

FLSEAE Struts 1 H i SCRE I BR A 00 B 2, 8102 1 3 3 S 8 A7 4 Hh S SO R (1)
U D% U el 5 2 PR AN [) 40 8 9058 SC APk 08 s Sl 0 SR ST, A S I A ) S R A
KL LA R . TAE Struts 2 1, E R4k B SRR E R R 2 . AL B A
struts2hello A 3LA, I E BRAE SR BE

BB ISP SCrE, AR R EBRL IS, BEUE 1 HelloWorld.jsp JEAR Y
THEAR

<%0 page contentType=""text/html; charset=GBK" %>
<%@ taglib prefix="s" uri="/struts-tags" %>
<html>
<head>

<title><s:text name="HelloWorld.message"/></title>
</head>

<body>
<h2><s:property value="message"/></h2>

${message}
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</body>
</html>

o AV H KL RMA B 20 5 — N E B L AR, text ARZE R Bk EPRfLE R, 110 name
JEPEEUE HelloWorld.message NI 5 W 1) Ja S0 1) 3= 4t

AR AT 75 24T sre T (1) example 0 R d—AN@PESCf;, 444 package.properties.
St1E Package Explorer 4L W%+ src FIf) example 1, 4 il A #EE P New >
File, $RJ57E3C1E4 i N package.properties, 75 7E4] FF 14w e B A LU R 4 25

HelloWorld.message= Struts 2 is up and running ...

o UL E OB R A H J5, 3 3) Tomcat it 55 4% . B & AEIE D YD BE N HbohE
http://localhost:8080/struts2hello/HelloWorld.action 4% N [FIZ= 48 5, B A 31130 W 2 (K An
U 7R: Struts 2 is up and running ... X UL Struts 2 2 F ) HOX AN SO R IR
B A A 25 ISP LT 2K B

W R R R TR SO BB A IR 2 I T RRE A B R — i S, Bh
package_zh_CN.properties, 7500 R:

HelloWorld.message= Struts 2 \ub542f\u52a8\u5e76\u8fd0\u884c

o ATIIXBESCF 2 Java CFEFIIHE X Unicode 4, ‘EXT NI IE: Struts 2 7804577
AR B A NDUFA3 BIIX B U740 2 2 528 H DK ¥ bin Hsx Falri)— M 24710 L
H. native2ascii.exe. ILFEKZ 1T LLEFE Windows (525 FFis > BT, 7EHH IXHEHE
T emd, G aiRIGH, BEmA1T. MREBOEREL T REM PATH A& H,
A LLEEN native2ascii, HNWE, #tEEA c:\jdk1.6.0\bin\native2ascii, )&% FIE1%E, #ial
DUEATIEATH T o XA THBR AT ? R, KEAE LAY, Z 5% T
Bl ARJE T e SCERF R R R T o IXANRERE AT o

C:\Documents and Settings\BeanSoft>c:\jdk1.6.0\bin\native2ascii
Struts 2 JH3hIFiatT
Struts 2 \u542flu52a8\u5e76\u8fd0\u884c

o MEH G E A M ke ? fEXAN AT % 1 b a4 8, P idmid, 2 )G
F BUBRHEAE AN IGE 7 4% Struts 2 \u542f\lu52a8\u5e76\usfdo\u88ac, i Hith % 11, RJA
We, f% NeA I EIZESE (R Enter 88D, whEEHEE & H12] Windows [FBIIHR 7T, 25
[0 2] MyEclipse f)gmas i 1, 2 FYEERE Ctrl + V ASISEAT LA T o 2 )G PR HT & A 5
AT, WA U], el DUE BIARR Wos 1 e R T — S0 SO R R G
B TR ) WL P M DX R A A S, XIS PR [ g, AR R B IR PR SR IRV
T IR, ERSEEL TR E bR

M2 A5 Action JEH g AN g Al FH IX A [ Br A6 (0 B2 U5 S0 2 Bt K4k A
ActionSupport 28T BL, B REE T AN getText(String key) )5k, al LLiEFRAT 518 (2
R B A0 () 9 S SO o LS AR T R 1) T 1 R SRR 1 L B Ak v R SO,
com.opensymphony.xwork2.ActionSupport.getText(String, String)4%:4% 22 /> # #id {7712
ANEAYR AL, BATKRERLITSS K HelloWorldAction.java A G #.

package example;
import com.opensymphony.xwork2.ActionSupport;

public class HelloWorld extends ActionSupport {

public String execute() throws Exception {
setMessage ("' fR4f! Struts 2! ');
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System.out.printin(getText("HelloWorld.message"))
return SUCCESS;

}

private String message;

public String getMessage() {
return message;

}

public void setMessage(String message) {
this.message = message;

}

}

o WY, HEFRAIIEAT, ENEART U, #in LA R MyEclipse (1) Console #i K H {2
ISR AT

Struts 2 33N IFisqT ‘

o XU B LI RECT I PR A T B S v LU BB T 00 4 B A SR U SRR A, I
eI R AR R PR o ANiE iR T DA 2 T EORAR ) 1B s [ s A B SO,
YResouceBundlei 4k I\ Eclipseddiff, B L8l g BB AL I T H . E X A=
NS TR TR EZE R

T4, AR IATFT EAE G b R BR AT S I gty 280, I8 G Wie ? 14k, 3
fI1{E 3 package_zh_CN.properties HUE A 47473 2500 B Bl i B4 :

HelloWorld.welcome=\u6b22\u8fce\u4f60 {0}

EXS IR A TAF s g {0} WERTTEE 2 B8, KRS N1L{2)55, LRSS
PR IBC A0 AT, B AE ISP T I (A RS -

<s:text name=""HelloWorld.welcome'>
<s:param>jk =</s:param>
</s:text>

o AT, TS En: POlfR sk =, mEF e FIanda{1yE5%), mdk
LI Z [f<s:param>T-F5%5 . ActionZEHie, AT LU FH getText(String key, String =
F 0SSR, X o] DU v getText("HelloWorld.welcome”,” 76 =)t 4
SEARZ B, WTLME YAk getText(String key, List 24071/4). =T EH Rkl
ResouceBundleft/Si 2 W7, HSHEARLERKSH TR,

Struts 2 P E FRAbER T BoR 307 BASR, BT DUINTER R, RIPUFSETF 256G, fEGi
PATIE 2 QR LA IX A 1) 8

12.3.4 #F POJO [ Action R

n12.3.17 a5 ik, ActionZS Rl LLIEFE4k K H ActionSupportZE a7 S Action
10, BRif, Struts 2 B SCRFPOJOTE Al & il JavaZi [l Action, TR A i LB E s
2 ¢t 4 S public java.lang.String execute() throws java.lang.Exceptionix A~ /7 45k
ALY, Ak SEIL L S AR L, X RUNIISFEAER BRI . XA T T T
KNG, T ActionZE BN ) FIRAAU A, FHELE A &, [+ DU EH AR .

MSAIAEWE, FRATEK: L1 ) HelloWorld (1) Action 5+ H POJO 77U s . 14k,
Bk Java 2530 fF example.HelloPOJO. #2525 File > New > Class, 30 i THAZ I
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(G =, 2T T B AR B RE 1, %1\ Package i example, Name 4 HelloPOJO,
sy Finish #2250 5 BU R 2R G e . BLAE FA 1R JLARASAS 6 Gn R s

package example;

public class HelloP0JO {

public String execute() throws Exception {
setMessage("'iklf! Struts 2 P0OJO! ');
return ''success';

}

private String message;

public String getMessage() {
return message;

}

public void setMessage(String message) {
this.message = message;

}
}

o NI LU BIXAN A Gk 2k QAT a0 ST 1, FUR—A5dE 1 Java 261fi
Co ATAXNRINANT —A4 4 message [F)JgE 1, 2RSS 72 execute OVHAT T &% & &
Y message MIMH N FFF " 447! Struts 2 POJO ! "HIH4E, 2 Ja stk [\ — AN 5%
Hi'success”, ‘BT —ANSHHLEE, RN T RREFTERINE

FFRWE, whELE struts.xml FIIA—AS action & X, ARSI B AR AHASH 20 T

7N

<?xml version="1.0" encoding="UTF-8" 7>

<IDOCTYPE struts PUBLIC
""-//Apache Software Foundation//DTD Struts Configuration 2.0//EN"
"http://struts.apache.org/dtds/struts-2.0.dtd">

<struts>
<package name="'default" extends="'struts-default" >
<l-- EXHRINActionE X -->
<action name="HelloPOJO" class="example.HelloPOJO">
<result>/HelloPOJO.jsp</result>

</action>
</package>

</struts>

o« FUMAHT action [ name 24 HelloPOJO, ‘& 2 & FRATTNINI S = 1) example.HelloPOJO,
[ W g5 R /2: /HelloPOJO.jsp.
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U T, KEA LM Ei12.3.1 A I FER A HelloPOJO jsp, LIS :
<%@ page contentType="text/html; charset=GBK" %>
<html>
<head>
<title>P0JO rfij</title>
</head>

<body>
<h2>${message}</h2>
</body>
</html>
o IXAN VU I SR 1 S P EL ik 0K message J&PEME K, 11 [FIFE
IS HHAHELE A Action 28R EEHUR G N request X% 1. #E3X B8 T E /s POJO+EL %Kik
RIFR, FATEA S FATAT Struts 2 $55E 2 E bRid 4

B, K H B R AT G IEAT, TR N A, BN R ) Mk Sk AT R
http://localhost:8080/struts2hello/HelloPOJO.action. U1 EIRHE 2 Gl L T — 4707
| #iF ! Struts 2 POJO! |
A2 FAT POJO Wl KIh s 1 T o

HE: TEHOR—NREME, WmERXEIRMELE ISP T H] text pr%k iR
FE PR R, SRITCER, M1 Action 2t [ AR TSIk L E brib i B0 T,
IXIF R A FRATTH Action ZEFR AT IXFEIM TR . XFMEDL T, IRLZ04kK H ActionSupport
%,
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